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INTRODUCTION 

This book provides system architects, technical consultants, and IT management the tools to 

design  system architectures to deploy SAP applications on SAP HANA. Explore production and 

non-production systems, deployment options, backup and recovery, data replication, high-

availability, and virtualization in detail. Dive into on-premise deployment options and data 

provisioning scenarios. Walk through scale-up and scale-out options and data partitioning 

considerations. Review the advantages and disadvantages of storage and system replication 

options and when to use each. Clarify how to leverage HANA for single node and distributed 

systems. Dive into a discussion on software and hardware virtualization. 



 

 

26 Production 

This section covers the introduction of Production. 

26.1 Basic Data 

This section contains all the information needed to implement the master data of the Production Planning 

and Control System. 

26.1.1 Bill of Material 

You make the settings for your BOM system in this step. 

26.1.1.1 Control Data for Bills of Material 

In this step, you define central modification parameters and default values for your BOM management 

system. These settings apply to all BOM categories (for example, material BOMs, document structures, 

and equipment BOMs). 

26.1.1.1.1 Define Modification Parameters 

Modification parameters are generally one-time settings for BOM management, which you should not 

change after you start using BOMs productively. In the standard system, default values are 

defined. 

In this step, you define the following central settings for your BOM management system: 

- BOM validity maint. 

- Low date 

When you create or process BOMs, the default date is the date defined in your system as the earliest 

processing date (01/01/1900 in the standard system). 

- BOM validity maintenance 

If you activate validity date maintenance, you can specify a valid-from date when maintaining 

BOMs. 

If validity date maintenance is not activated, bills of material are created as of the current date or 

the system low date (1/1/1990). 

- EC management active 

If you activate engineering change management, you can make historical changes to BOMs 

with reference to a change number. (This means that the status of the BOM both before and after 

the change is stored in the system.) 

In this step, you only specify whether engineering change management can be used for maintaining 

bills of material. In step Configure history requirement for BOMs, you define whether you want to 

make the use of engineering change management a requirement in certain cases. 
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- Hist. reqmt variant 

Use this indicator to control when history requirement applies to new variants or alternatives in a 

BOM group. 

- Sub-item document 

You use the Sub-item documentation indicator to define whether changes to sub-items are 

documented. 

- Create BOM header with parameter validity 

Technical type 

- Mult. BOM inactive 

You can define that no further alternatives can be maintained for multiple BOMs. 

- Variant BOM inactive 

You can define that no further variants can be maintained for variant BOMs. 

Bill of material item 

- BOM item explosion type 

If you create a BOM item with reference to a change number and change the valid-from date (in the 

change header or alternative date), then this can change the sequence of validity periods of a BOM 

item. 

The indicator BOM item explosion type specifies whether and according to what rules, the system 

determines a unique change status, when you display, evaluate or change a BOM to a date in the 

overlap period. 

- Description variable-sized item 

This indicator controls which text is displayed in BOM processing for a variable-sized item. 

- Repeated effectivity via external item ID 

This indicator ensures that an item that already exists under an external item ID can be used. 

General settings 

- Unit 'piece' 

In the standard system, this field contains a unit of measure for "piece". You can change this unit. 

This unit is the base unit of measure (BOM header) or the component unit of measure. Base unit 

of measure for: 

- Equipment BOM 

- Functional location BOM 

- Document structure 

- Standard BOM 

Component unit of measure for: 

- Text item 

- Document item 

- Non-stock item without material master record 

- CAD active 

If you want to maintain BOMs from a CAD system, set this indicator. This activates an additional 

field in the BOM header and BOM item, which tells you whether the BOM header or BOM item 

was maintained from a CAD system. 



 

 

Note 

If you deactivate engineering change management, changes to bills of material are not recorded. 

The modification parameters defined here apply to all BOM categories. 

Default settings 

The following settings are made in the standard R/3 System: 

- Validity date maintenance and engineering change management are active. 

- The current system date is the default valid-from date. 

- CAD is active. 

- Explosion type for BOM item: blank (no additional interpretation) 

Recommendation 

Use the standard default settings. 

Actions 

Define the central defaults for your BOM maintenance system. 

26.1.1.1.2 Define Default Values 

In this step, you define the following default values for maintaining bills of material. 

- Base quantity 

This is proposed when you create a BOM. The component quantities in the BOM items are based 

on the base quantity. 

- BOM status 

The BOM status is used to control activities in related application areas. This default BOM status is 

proposed by the system when you create a bill of material. 

- The size unit (mm) 

This is the default value for the size unit, which is proposed by the system in variable-size 

items if you do not enter a unit. 

- The variable-size item unit (pieces) 

This unit of measure for the number of variable-size items is proposed by the system when you 

maintain variable-size items. 

Note 

The default values set here apply to all BOM categories (for example, material BOMs, document 

structures, and equipment BOMs). 

Requirements 

First process step "Define BOM status". 

Recommendation 
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Use the default value for the variable-size item unit. You are advised not to change this parameter. 

Actions 

Set the default values you require. 

26.1.1.1.3 Determine Explosion Mode 

Use 

In this Customizing activity, you can set the explosion mode. Once you select the BOM category, the 

explosion mode lists the options available. If you select document structure, the explosion mode displays 

the following options: 

- Execute the Explosion in ABAP 

This explodes the document structure with the ABAP specific logic. 

- Execute the document structure explosion with item validity in HANA This explodes the 

document structure with HANA specific logic and the time validity of the document structure 

items is considered. 

- Execute the document structure explosion without item validity in HANA This explodes the 

document structure with HANA specific logic and the time validity of the document structure 

items is not considered. 

Note 

You can use this customizing only if HANA is used as the primary database. 

Though the customizing is set to be exploded in HANA, this is not the case always as the other input 

parameters are checked for explosion. 

For example, if the customizing is set as Execute the document structure explosion with item 

validity in HANA, it also checks the other input parameters for explosion like single level or multi-level. 

If it is single level explosion, then it is executed in ABAP. 

26.1.1.2 General Data 

In this step, you define settings that apply to the entire bill of material. 

26.1.1.2.1 BOM Usage 



 

 

For one material or technical object (equipment, functional location), you can create separate bills of 

material for the individual organizational areas involved. For example, you create separate BOMs for 

design, production, and costing. In this way, each area is dealing only with the specific data it requires. 

Example: 

- The design BOM includes all the components of the product and their technical data from the 

design point of view. This BOM is generally not linked to any order. 

- The production BOM contains all the items required from the production and assembly point of 

view. Only items relevant to production, for which production data (such as the issue storage 

location) can be entered, are required. A production BOM does not contain any packaging materials 

required in the shipping department. 

26.1.1.2.1.1 Define BOM Usages 

In this step, you define the BOM usages. 

When you define a BOM usage, you define the configuration of the item status. The item status is made 

up of a number of indicators in the BOM item (for example, "relevant to production", "relevant to 

engineering/design", and so on). The item status controls how the BOM item is processed in related 

application areas. 

For example, the production department requires a BOM with all the items that are relevant to 

production. These items are first copied to the planned order. When the planned order is converted to a 

production order, the items are copied to the production order. The production order tells the production 

department which materials and assemblies it has to produce. 

Note 

- If bills of material already exist which have a BOM usage, you can no longer delete the BOM 

usage. There are also restrictions to the changes you can make to the definition of the BOM usage. 

- You should only activate the indicator "Relevant to plant maintenance" for BOM usages which are 

to be used in plant maintenance. 

Example 

You can define BOM usages as shown in the following example: 

 BOM usg Prod. Engin.Spare PM Sales Costing 

1 + . . - - . 

(Production) 

2 . + . - - . 

(Engineering/design) 

     + = You must make an entry 

     . = You can make an entry 

- = You cannot make an entry 

Here, BOM usage 1 "Production" is defined such that BOM items in BOMs with this usage 

- must contain the indicator "relevant to production" 
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- can contain the indicators "relevant to engineering/design", "spare part" and "relevant to costing" 

- cannot contain the indicators "relevant to plant maintenance" and "relevant to sales and 

distribution". 

Default settings 

In the standard SAP System, a number of BOM usages are defined. 

Recommendation 

Adapt the predefined BOM usages to your requirements or define new BOM usages. 

Actions 

1. First, decide whether you want to maintain separate bills of material for the different organizational 

areas within your company, or whether you want to maintain bills of material to be used in several 

areas. Please note that, if you choose separate bills of material, the bills of material then have to be 

maintained separately. 

2. Define BOM usages according to your requirements. 

26.1.1.2.1.2 Define Default Values for the Item Status 

In this step, you can define default values for the various item status indicators for each BOM usage. 

These values are proposed as defaults when you create new BOM items. 

Note 

Please note that you may want to change the item status in BOM items, even though you have defined 

defaults here. 

Requirements 

First complete the step Define BOM usages. 

Before you can enter the following default values, you must complete the corresponding steps: 

- Spare part indicator: Define spare part indicators 

- Indicator for relevance to costing: Define relevance to costing 

Recommendation 

We recommend that you define default values for the following item status indicators for each BOM 

usage: 

- indicators which you defined as required when defining the BOM usage 

- indicators which are the same in 90% of BOM items (in BOMs with this usage) 

Example 

You have defined BOM usage 1 as relevant to production. The item status is configured such that all 

items 

- are relevant to production (required entry) - can be relevant to costing (optional entry) 



 

 

When you set default values for the item status indicators, the system checks the BOM usages you 

defined. 

In this example, the indicators are checked as follows: 

- The Indicator: item relevant to production cannot be deselected (required entry). In the BOM 

maintenance functions, this indicator is set automatically for all items and cannot be cancelled. 

- Since the item can be relevant to costing, the default value X (fully relevant to costing) can be set 

for the Indicator for relevance to costing. This value can be overwritten in the BOM maintenance 

functions. 

Actions 

Set default values for the item status indicators in individual BOM usages as required. 

26.1.1.2.1.3 Define Copy Default for Item Status 

When you create a new bill of material (BOM), you can use a bill of material with a different BOM 

usage as a source to copy from. 

In this step, you define copy defaults.  These control how item status indicators in items in the existing 

BOM are copied to a new BOM.  You can copy all the item status indicators, or only some, or add new 

indicators. 

The following rules apply when you copy BOM items: 

- If there is a copy default for a BOM usage, this is used when copying the items. 

- If no copy default is defined, all the indicators which are allowed in the usage of the new BOM 

copied when you copy an item. 

Note 

The copy default describes the scope of the item statuses in the new bill of material. 

Requirements 

First complete step "Define BOM usages". 

Actions 

Define copy defaults according to your requirements. 

26.1.1.2.2 Define Material Types Allowed for BOM Header 

In this step, you specify which material types in conjunction with BOM usages are allowed for the BOM 

header material. 

When you make these settings, you can make a generic entry in the fields for the BOM usage and the 

material type. This means, for example, that you can enter an "*" instead of a specific BOM usage. This 

stands for all possible BOM usages. 

When you create a new bill of material, the system checks the material type as follows: 
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- The fully qualified (non-generic) entries are checked first. The generic entries are checked 

afterwards. 

- You can define that the use of the material type in combination with the BOM usage is "allowed/not 

allowed" by setting the indicator. 

Example 

You can define which material types are allowed for creating BOMs as shown in the following example: 

 BOM usage Material type for allowed/not allowed 

BOM header 

1 * + 

1 ROH - 

* = generic entry (all possible entries for a field) 

For BOM usage 1 "Production", the material type "ROH" is not allowed for creating bills of material 

(indicator -). All other material types are allowed (indicator +). 

Requirements 

First complete step Define BOM usages. 

Note 

In the settings for the item data, you can define which material types are allowed for BOM items 

(material items) in combination with which BOM usage and which material type of the BOM header. 

When you make your entries for the BOM usage and the material types for the BOM header and BOM 

items, the system checks whether the material type is allowed for the usage you entered. 

For example, if you do not allow material type "ROH" for the BOM header for usage 1 in the current 

step, it is not possible in the settings for the item data to make an entry that requires the system to check 

for the material type "ROH" for BOM headers. 

Default settings 

In the standard SAP System, all material types are allowed for creating bills of material of all BOM 

usages defined. 

Recommendation 

If you use the BOM usages defined in the standard SAP System, you can use the standard settings 

defined here. 

Activities 

According to your requirements, define which material types are allowed for the BOM header in 

combination with which BOM usage. 

In the step Allowed material types for BOM items, you can define which material types in conjunction 

with BOM usage are allowed for the BOM items and which material type of the header material. 

26.1.1.2.3 Define BOM Status 

Via the BOM status, you define which other application areas can use a bill of material with this status. 



 

 

- In the different areas in a company (such as costing), the BOM is exploded according to the 

application. When you define an application for a certain area in the company, you select the status 

indicators in the Mininum requirements of BOM status dataset that the BOM status must have 

before the BOM is read for the BOM explosion. 

- In MRP, the following indicators are checked directly from the definition of the BOM status: 

- Explosion in MRP 

- Released for orders 

MRP only reads BOMs whose BOM status has at least one of these indicators. 

- Exception messages are relevant to MRP only. You can allocate an exception message to a BOM 

status which must be checked by the MRP controller. 

If a BOM whose status has an exception message allocated to it is exploded in MRP, the exception 

message tells the MRP controller that he may have to correct the planning result manually. In this 

way, you can exclude materials requiring manual correction from the total planning result. 

You define exception messages in the IMG for material requirements planning. 

Requirements 

Before you can allocate an exception message to a BOM status, you must complete step Define and 

group together exception messages. 

Note 

Do not delete a status if bills of material with this status exist. 

Actions 

Define BOM statuses according to your requirements. 

26.1.1.2.4 Define Laboratory/Design Office 

In this step, you can define which laboratories/design offices or persons/groups are responsible for 

certain bills of material. You can then enter these when you maintain BOMs. 

Note 

Laboratories/design offices are also used in other areas, such as materials management. For this 

reason, do not delete any entries you did not define yourself. 

Actions 

Define areas of responsibility according to your requirements. 

26.1.1.2.5 Configure History Requirement for BOMs 

In this step, you define whether bills of material with a certain BOM usage and BOM status must be 

changed with history, that is to say, using engineering change management. 

Note 
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If you do not make any settings here, you can maintain bills of material either with or without history. 

However once you have maintained a bill of material with history, you can only change it with history 

after that. If you have changed a bill of material with history and want to change it without history, you 

need a special authorization. 

Requirements 

If you want to define BOM maintenance with history as a default, the following must apply: 

- First, you must complete step "Define BOM usages". - You must also complete step "Define 

BOM statuses". 

- In step "Configure modification parameters", you must activate 

- validity date maintenance 

- engineering change management 

Activities 

Define for which BOM usage and which BOM status changes to BOMs are to be made with history. For 

Document structures leave the field BOM usage empty and only create the BOM status for which a 

change number is obligatory. 

26.1.1.2.6 Change Message Type 

Use 

For some uncritical messages from the BOM area (message class 29), the System Message Category is 

variable. 

The following message types are sensible for the changeable messages from the BOM area: 

- No Message 

- Warning 

- Error Message 

Standard settings 

Changeable messages with the message type for the standard system are contained in Customizing for 

BOMs. 

Activities 

Select the new message type from the list of possible entries. 

Example 

For the following messages, you can change the message type Warning into the message type No 

Message: 

 095 Group BOM 

 358 BOM is only changeable via & 



 

 

For the following message, you can change the message type Error Message into the message type 

Warning Message: 

 793 Sales order item & & canceled 

26.1.1.3 Item Data 

In this step, you define the settings for BOM items. 

26.1.1.3.1 Define Item Categories 

When you enter a new BOM item, you must assign an item category to the item. The item category 

defines the attributes and functions of a BOM item. It controls field and screen selection for detail 

screens in BOM maintenance. 

The item category answers the following questions: 

- Is a material number required? 

- Is the item to be used in inventory management on a quantity basis ? 

- Is the item a text item only, with no other functionality? 

- Is the item to be used as a variable-size item with the option of entering individual sizes ? 

- Is the item a document item? 

The document item category allows you to enter a document which you created using the 

document management system. 

- Is the item a class item? 

For configurable material BOMs, you can enter a class in which materials or documents are 

classified. When you assign characteristic values during BOM configuration, the class node is 

replaced by the object with the required characteristic values. In this way, the workload involved in 

maintaining BOMs with many variants is reduced, because you no longer have to enter all items 

individually and assign selection conditions to them. 

- Are sub-items supported? 

- Is the item a plant maintenance structure element? 

If the item is a PM structure element, the system does not check whether the material is maintained 

in the plant. This item category should only be used for items which are used solely for designing 

plant maintenance BOM structures. 

- Is the item an intra material, which comes into existence between two processing units? Intra 

materials are only supported in master recipes. 

- Are negative quantities supported? 

For certain item categories, it can make sense to allow both positive and negative item quantities. 

For example, co-products that are kept in stock are entered with a negative item quantity. 

- Which detail screens and fields appear and are maintained? 

The item category control key is used to define the screens and fields to be displayed and 

maintained for each item category. 

Note 
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- When you define new item categories, please note that not all attributes and functions can be used 

in combination with each other. The system checks the combinations. 

- It is very important to select the correct item screen control key. You can either use existing item 

categories to help you, or ask your consultant. You cannot define new item screen control keys. 

- Do not delete any item categories which have already been used in bills of material. 

Default settings 

The following item categories are supplied as standard: 

- document item 

- class item (only for configurable BOMs) 

- stock item 

- text item 

- non-stock item 

- variable-size item 

- PM structure element (only for plant maintenance) 

- intra material (only for master recipes) 

Recommendation 

Use the standard item categories and do not make changes to them. Only create new item categories if 

the functionality you require cannot be covered by the standard item categories. 

Actions 

Define new BOM item categories if required. 

26.1.1.3.2 Define Object Types 

Various objects can be used as BOM items. For example, a BOM item can be: 

- a material 

- a document 

- a classe 

- an intra material 

- no object (for example, text item or non-stock item without a material master) 

For each BOM item category, you can store an object type here. You see the object type on the "general 

item overview". 

Standard settings 

Object type Object of the BOM item 

M material 

D document 

C class 



 

 

I intra material 

" " no object (blank) 

Recommendation 

Use the settings in the standard system. 

Actions 

Change the abbreviation of the object type, if required. 

26.1.1.3.3 Define Allowed Material Types for BOM Items 

In this step, you define which material types you want to allow with which BOM usages and which 

material types for BOM headers for creating BOM items (material items). 

When defining these settings, you can make a generic entry in the fields "BOM usg", "Mat type headr", 

and "Mtype BOM item". This means that you can enter an "*" instead of making a specific entry. This 

represents all possible entries for the BOM usage. 

If you want to determine the permitted material types for BOM items in equipment BOMs and 

functional location BOMs leave the field Material type BOM headerempty (blank). 

When you create new BOM items, the system makes checks on the material type as follows: 

- First, the fully qualified, non-generic entries are checked, then the generic entries. 

- You define whether the combination is "allowed/not allowed" by setting the indicator. 

Example 

You can define which material types are allowed for creating BOM items as shown below: 

BOM usage BOM header BOM item Allowed/not allowed material type

 material type 

 1 HALB * + 

 1 HALB VERP - 

* = generic (all possible entries for a field) 

For the combination of BOM usage 1 "Production" and material type HALB in the BOM header, the 

material type VERP is not allowed for creating BOM items (indicator -). All other material types are 

allowed for this combination (indicator +). 

Note 

For the usage you select, the system checks whether the material type entered is allowed for the BOM 

header. For example, if you do not allow material type "ROH" for the BOM header, you cannot enter a 

combination with material type "ROH" for the BOM header. 

Requirements 

First complete the following steps: 

- "Define BOM usages" 
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- "Define allowed material types for BOM header" 

Default settings 

In the standard SAP System, any combination of material type for the BOM header and material type for 

the BOM item can be used for all the BOM usages supported. 

Recommendation 

If you use the BOM usages which are defined in the standard SAP System, you can use the standard 

settings defined there. 

Activities 

Define the allowed material types for BOM items according to your requirements. 

26.1.1.3.4 Define Variable-Size Item Formulas 

Variable-size items are used to store the required dimensions of a raw material in the BOM item. 

In this menu option, you can define new formulas to be used for calculating the quantity of variable-size 

items. 

The quantity of a variable-size item is calculated as follows: 

- If you do not enter a formula in the BOM item, the sizes are multiplied together. 

- If you enter a formula key, the system uses the algorithm stored under this key to calculate the 

quantity. 

For example, see Formula key 

Activities 

 1. Define new variable-size item formulae according to your requirements. 

26.1.1.3.5 Define Spare Part Indicators 

The spare part indicator is used to identify a BOM item as a spare part. This indicator can be used, for 

example, to create lists of spare parts. 

In a BOM explosion, you can use the spare part indicator to restrict the items selected. The indicator 

does not interrupt the explosion of the BOM to the lowest level. There are two steps to the BOM 

explosion: 

- First, the system explodes the entire BOM, regardless of the indicators selected to restrict items. 

You do not see the result of this explosion on the screen. 

- Second, the system reads the indicators selected to restrict items, such as the Spare part indicator. 

These indicators work as filters. The result of the explosion you see onthe screen only includes the 

items that fulfil the selection criteria. In this case, only the items with the spare part indicator you 

select are shown. 

Example 



 

 

Spare parts can, for example, be grouped according to maintenance cycle. Spare parts that need to be 

replaced after a machine runtime of 100 hours are given spare part indicator A and spare parts that need 

to be replaced after 500 hours are given spare part indicator B. 

Actions 

Define the spare part indicators you want to use. 

26.1.1.3.6 Define Material Provision Indicators 

The material provision indicator identifies a BOM item as a material to be provided. This indicator is 

read in MRP. 

In a BOM explosion, you can use this indicator to restrict the items selected according to material 

provision indicator. 

The indicator does not interrupt the explosion of the BOM to the lowest level. There are two steps to the 

BOM explosion: 

- The system explodes the entire BOM, regardless of the indicators you select to restrict items. You 

do not see the result of this explosion on the screen. 

- The system reads the indicators you selected to restrict items, such as the Material provision 

indicator. 

These indicators act as filters. The explosion result you see on the screen only includes the items 

that have the material provision indicator you selected. 

There are two types of material provision: 

- Provision of material by a vendor 

- Provision of material by a customer 

Material provided by a vendor 

This indicator controls MRP. Only set this indicator for a material component if the material master 

record of the header material supports subcontracting (Special procurement field). The special 

procurement key for subcontracting means that all components of the BOM are provided free of 

charge to a subcontractor for further processing. The items are copied to a subcontract order. 

- If the item is provided to a vendor, do not enter a material provision indicator. Dependent 

requirements are generated for this item. 

- If the item is already at a vendor's premises and is not provided by us, enter an indicator for material 

provision by a vendor. 

No dependent requirements are generated for this item. 

Material provided by a customer 

This indicator is not currently active. 

Actions 

1. Find out which types of material provision occur in your company. 

2. Define your material provision indicators accordingly. 

26.1.1.3.7 Define Explosion Types 
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In this step, you define the procedure for exploding an item to determine dependent requirements. These 

settings apply to material BOMs. 

Explosion types refer to certain special procurement keys for a material, which are defined in the material 

master (MRP 2 view). 

The following three special procurement keys are relevant to explosion types: 

- Phantom assembly off 

You use the Phantom assembly off indicator, to determine how an assembly with the Phantom 

assembly special procurement key is exploded. 

If the header material of an assembly has the special procurement key for a phantom assembly in its 

material master record, the standard SAP System: 

- Transfers dependent requirements for the superior assembly directly to the components of the 

phantom assembly 

- Generates planned orders or purchase requisitions for the components of the phantom 

assembly 

If you set this indicator, dependent requirements are also generated for materials that have the 

Phantom assembly indicator. 

- Switch off planning 

Using the Switch off planning indicator, you define that the MRP run does not generate 

dependent requirements for the components of a BOM. This indicator is relevant to the following 

strategies in MRP: 

- Planning without final assembly 

- Planning with planning material 

The components and assemblies of the finished product are produced in advance. However, the 

finished product is only finally assembled when a sales order is received. The replenishment lead 

time for some components, such as bought-in parts, can be very short. These components do not 

have to be planned before you receive a sales order. If you select an explosion type that has this 

indicator for a BOM item, no dependent requirements are generated for the material component. 

- Direct production/direct procurement off 

The Direct production/direct procurement off indicator determines how an assembly with the 

Direct production (collective order) or Direct procurement special procurement key in its 

material master record, is exploded. 

In the standard SAP System, components with the special procurement key Direct production 

(collective order) are produced directly for the superior assembly. The planned order for such 

components is linked directly to the superior assembly. 

Dependent requirements for components that belong to a collective order are marked as such. The 

system generates a special planning segment under the "direct production" heading. 

If you select an explosion type in a BOM item for which this indicator is set, direct production or 

Direct procurement is switched off for the component. 

You can also define for an explosion type whether the item is relevant to long-term planning and in 

which form dependent requirements are displayed. 

- Switch off long-term planning for an item 

Long-term planning allows you to simulate MRP across all low-level codes in parallel to normal 

planning. However, if your BOMs are very large, long-term planning slows down your system. 

For this reason, you can control planning for individual low-level codes. This indicator specifies 

that an item is ignored for long-term planning. 



 

 

- Dependent requirements indicators for individual and collective requirements This setting 

has a higher priority for the BOM item than for the requirements explosion setting in the material 

master record. 

The Individual requirements indicator shows that requirement quantities for the dependent 

material are shown individually on the level above. Set this indicator if you want to include the 

following stocks: 

- sales order stock 

- project stock 

The collective requirements indicator shows that the system can group together requirement 

quantities for the dependent material. 

Activities 

Define explosion types according to your requirements. 

26.1.1.3.8 Item Data from Related Application Areas 

In this step, you define item data that is relevant to related application areas. 

26.1.1.3.8.1 Define Distribution Keys 

In this step, you can define the distribution strategy (four-character distribution key) for each plant. A 

distribution strategy is required to define the distribution for the planning table. 

The distribution strategy comprises the distribution function and the distribution type: 

- Distribution function 

You define the percentage of the quantity to be produced or consumed after a percentage of the 

production time has elapsed. 

- Distribution type 

You define whether the requirement is to be distributed discretely to the points defined for the 

function or linearly according to the definition in the distribution function. 

Preconditions 

You must already have defined the distribution functions. You do this in the step entitled, Define 

function in Customizing for repetitive manufacturing. 

Note 

The use of a distribution strategy is most useful if you work with repetitive manufacturing with 

production orders and for process orders. 
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The distribution strategy is saved in the material master record in the production version. 

Action 

1. Create the distribution function. 

2. Create the distribution type. 

26.1.1.3.8.2 Define Relevancy to Sales 

In this step you define the indicators with which you can flag a BOM item as relevant for sales. In 

addition, you define the usage for the BOM item. 

Note 

The usage indicator is mostly used for text items. 

Actions 

1. Check which BOM items are relevant for sales and what the respective usage is. 

2. Define the indicators and the corresponding usage: 

- Specify a single-digit alphanumeric key for the indicator. 

- Specify the indicator of the item usage. 

The range of usage indicators can be displayed in the possible entries. 

- Enter a description to explain the indicator. 

3. Check that the appropriate ID is entered for the bill of material items. 

26.1.1.3.8.3 Define Relevancy to Costing 

In this step you create keys that you can use to mark as relevant to costing: BOM items or the material 

components in a work order and the operations or suboperations in a standard task list or work order. 

In the standard system, the indicator X is linked to the factor one (fully relevant to costing) and a blank 

indicator is linked to the factor zero (not relevant to costing). 

If you want to devalue an item in inventory costing, you can define additional relevancy to costing 

indicators and link them with factors for a percentage devaluation. These factors are only used in 

inventory costing. 

In standard cost estimates, modified standard cost estimates, current cost estimates, and order cost 

estimates, items with a relevancy to costing indicator are always treated as fully relevant to costing - no 

devaluation takes place. 

Activities 

1. Choose "New entries". 

2. Enter an alphanumerical key as the relevancy to costing indicator and give it a name. 

3. Save the relevancy to costing indicator. 

4. Process the activity "Define Price Factors". 



 

 

26.1.1.4 Alternative Determination 

In this step, you define procedures for automatic determination of alternative BOMs for individual 

organizational areas within your company (such as sales and distribution, costing, and so on). 

There can be several bills of material with different BOM usages for one material. For multiple BOMs, 

there can also be several alternative bills of material for each usage. 

Since each of these different BOMs represents a different BOM explosion, you need to define a 

procedure for selecting alternatives automatically. 

There are two steps to automatic alternative determination: 

1. BOMs are selected according to usage. 

2. An individual alternative in a multiple BOM is selected. 

You define which procedure is used for alternative determination in related application areas. 

26.1.1.4.1 Define Order of Priority for BOM Usages 

In this step, you can define different priorities for BOM usages. 

- The procedure for automatic selection of an alternative BOM is shown as an application. From this 

application, the system determines, for example, a selection ID. This selection ID encodes a specific 

order of priority for BOM usages. 

When you define a selection ID, you need to know which applications you require. For example, if you 

define an application which you only want to use for exploding BOMs in costing, your order of priority 

should only contain BOM usages for which items relevant to costing are supported. 

Note 

Even if you only use one BOM usage, you need to define a selection ID. First priority is then defined for 

this one BOM usage. 

Requirements 

First complete step "Define BOM usages". 

Recommendation 

First read the whole section on alternative determination, then work through the individual steps. 

Actions 

Define the different orders of priority for BOM usages according to your requirements. 

26.1.1.4.2 Define Applications 

In this step, you define procedures for the automatic determination of alternative BOMs. Each procedure 

is represented by an application. This application controls BOM explosion in different areas of the 

company. For example, different BOM data is relevant to costing than is relevant to work scheduling. 
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The automatic determination of alternatives is controlled by settings in the material master record, as 

well as by the application. In the material master record, you can define how alternatives are selected in 

the "Alternative BOM" field. You can have alternatives selected according to: 

- order quantity (lot size) 

- date 

- production version 

The following criteria are defined in the application: 

- order of priority of BOM usages (selection ID) 

- priority of one alternative of an individual multiple BOM, depending on date You can define for 

each application whether the settings made in step "Define alternative determination for multiple 

BOMs" are active. However, these settings are only active if 

you define in the material master that alternatives are selected by date. 

- production versions 

If you have chosen alternative selection according to production version in the material master, you 

can define here for each application whether this setting is active. If you define that this setting is 

ignored, alternative BOMs for the material are selected according to order quantity (lot size) for the 

application concerned. 

- BOM status indicator 

Only BOMs that have at least this status are read for automatic determination of alternatives. 

Note 

The different organizational areas in a company (such as sales and distribution, costing, and so on) define 

which procedure (application) they want to use for exploding BOMs, depending on application-specific 

criteria. For this reason, please note the requirements of the individual organizational areas within your 

company when you define applications. 

One exception to this is MRP. This area enters a selection ID, not an application. 

Requirements 

First complete the following steps: 

- "Define order of priority for BOM usages". 

- "Define BOM statuses" 

Recommendation 

First read the whole section on alternative determination, then complete the individual steps. 

Actions 

Define applications according to your requirements. 

26.1.1.4.3 Define Alternative Determination for Multiple BOMs 



 

 

In this step, you can define for multiple BOMs that the system is to use a particular alternative BOM as 

of a certain date. 

Note 

Please note that the settings you make here are only effective for the automatic determination of 

alternatives if 

- you have defined your applications accordingly 

- you have chosen alternative determination by date in the material master 

Requirements 

The multiple BOMs for which you want to determine alternatives must exist in the system. 

Actions 

Determine alternatives for multiple BOMs by date, as required. 

26.1.1.4.4 Alternative Determination in Related Application Areas 

In this step, you define how automatic alternative determination is carried out in the following related 

application areas: 

- inventory management 

- production 

- MRP 

- costing 

- sales and distribution 

- plant maintenance 

The individual application areas determine which process is used to explode BOMs, dependending on 

application-specific criteria. 

26.1.1.4.4.1 Define Alternative Determination for Inventory Management 

In this step, you define how the automatic determination of alternatives is to run from the point of view 

of inventory management. 

For example, bills of material are automatically exploded for the defined application and the chosen plant 

in the following processing situations: 

- When you create an order, network, or project, stock materials are automatically reserved. 

- For a "goods issue with reference to a BOM", stock materials are automatically copied from the 

BOM to the goods issue transaction. 

- If subcontracting is defined for the header material of a material BOM, the material is ordered as a 

subcontracting item in a purchase requisition, purchase order, or scheduling agreement. The 

subcontracting item can have sub-items. These are marked with a material provision indicator in the 

BOM item. 
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When you create a subcontract order, the system automatically determines the components for the 

subcontracting item. 

Requirements 

First complete step Define applications . 

Actions 

Enter an application for each plant. 

Note: 

You can configure alternative determination for inventory management only for plants for which settings 

for goods movement exist in the IMG for Inventory Management (Define default values). 

26.1.1.4.4.2 Define Alternative Determination for Production 

In this step, you define how the automatic determination of alternatives is to run from the point of view 

of production. BOMs are exploded according to this application for the chosen order type in a specific 

plant. 

Requirements 

First, complete the step "Define applications". 

Actions 

In the standard system, you define the order types per plant in the IMG for production orders. One of 

the parameters that you choose is the BOM application for alternative determination (Define order type-

dependent parameters). You can change the application here. 

26.1.1.4.4.3 Define Alternative Determination for MRP 

In this step, you define how automatic alternative determination is to run from the point of view of MRP. 

BOMs are automatically exploded according to the selection ID you enter in the selected plant. 

Requirements 

First complete step "Define order of priority for BOM usages". 

Actions 

In the standard SAP System, only one BOM application is used in plant maintenance. In this step, enter 

the application that you defined for plant maintenance. 

26.1.1.4.4.4 Define Alternative Determination for Costing 

In this step, you define how alternative determination is to run from the costing point of view. 

Product costing with quantity structure determines the required quantity per product from the material 

BOM. 



 

 

In the IMG for "Product Cost Controlling" (Product Cost Planning -> Product Costing with Quantity 

Structure), you first define the quantity structure determination ID per plant. Then you maintain 

various control parameters for setting up the quantity structure. One of the parameters for alternative 

determination in multi-level BOMs is the BOM application. 

SAP standard settings 

The quantity structure determination ID ++++ is a fixed setting, which cannot be changed by the user. 

With this setting, the costing data for a material is checked without any restriction. 

The standard setting for the Costing (PC01) application is defined such that the following selection 

criteria are taken into account: 

- Selection ID 

- Alternative determination 

- Production version 

- Indicator for BOM status Released for costing 

Requirements 

First complete step Define applications . 

Actions 

Enter an application per quantity structure determination ID and plant. 

Note 

You can define the alternative determination for costing only for plants for which quantity structure 

determination has been defined for product costing with quantity structure in the IMG for Controlling 

(Define quantity structure determination ). 

26.1.1.4.4.5 Define Alternative Determination for Sales and Distribution 

In this step, you define how alternative determination is to run from the sales point of view. This is 

relevant, for example, for pricing, which is controlled by the item category of the SD document. 

In the IMG for Sales and Distribution (Basic functions -> Pricing -> Pricing control -> Define pricing 

per item category), you define how pricing is to run. The item category controls, for example, the type 

and scope of pricing, as well as invoicing and inventory posting. 

Some of the item categories that are defined in the SAP System are: 

- inquiry item (for the pre-sales period) 

- standard item, free-of-charge stock item, text item (for standard orders) 

Standard settings 

For inquiry items, the standard setting for the application is Sales and Distribution (SD01). This setting 

is defined such that a fixed alternative is determined as per a certain date. You define this alternative in 

the step "Define alternative determination for multiple BOMs". 

Requirements 

First complete step Define applications . 
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Actions 

Enter an application for each SD document item category. 

For multiple BOMs, you can also define per item category whether the user is to have the option of 

choosing an alternative manually. If you allow this option, the selection screen for BOM alternatives is 

displayed. 

Note: 

You define pricing for the SD document item categories in the IMG for Sales and Distribution in the step 

Define pricing per item category. 

26.1.1.4.4.6 Define Alternative Determination for Plant Maintenance 

In this step, you define how automatic alternative determination is to run from the point of view of plant 

maintenance. BOMs are automatically exploded according to this application for plant maintenance. 

Requirements 

First, complete the step "Define Applications". 

Actions 

In the standard SAP system, only one application is defined for plant maintenance. If you want to define 

a different application, enter the name of the application here. 

26.1.1.5 Define User-Specific Settings 

In this step, you can define default values for users working with bills of material. You can 

change these defaults at any time. 

You can set the following default values: 

- For BOM maintenance: 

- Item increment 

- Item category for "New material items" screen 

- Item category for "New document items" screen 

- Item category for "New class items" screen 

- Material provision indicator - PM assembly (for plant maintenance BOMs) -

 For BOM reporting functions: 

- Dialog print option 

- Display sub-items 

- Display sub-assemblies 

- Direct where-used list 

- Where-used list via classes 



 

 

- Display objects allocated to classes 

Recommendation 

We recommend that you set the following defaults: 

- Item category for "New material items" screen 

- Item category for "New document items" screen 

Activities 

Define the default values you require. 

Further hints 

You can define default values for all users of BOM transactions by making one entry only. To do this, 

enter the default values you require for user DUMMY. 

When a user (Miller, for example) starts a BOM function, the system first checks whether default values 

are defined for user "Miller". If no default values are defined, the system proposes the default values for 

the user "DUMMY". 

26.1.1.6 Create User Defaults for Output Lists 

In this step, you enter user-specific default values for display profiles for BOM reporting lists. 

You only need to perform this step if you have defined company-specific list profiles and want to assign 

these profiles to individual users. 

Sequence for check and default values 

When you execute a reporting function, the system checks the default values for the display profiles in 

the following order: 

1. Entries in step Enter user-specific defaults for reporting lists 

a) User-specific entry (for example, user JONES) 

You only need to make this entry if you have defined company specific profiles for BOM 

reporting lists. 

b) Entry for user group 

In the user master record, you can assign a user to a user group (for example, KON-01). The 

system copies the default profile for the user group for all users in the user group. 

You only need to make this entry if you have defined company specific profiles for BOM 

reporting lists. 

c) Entry for user DUMMY 

In the standard system, each reporting function has an entry for user DUMMY. This entry 

contains the Standard profile. 

2. Data from reporting programs 

If there are no entries under User defaults for reporting lists that are relevant to the user, the 

system uses the data from the reporting programs. Each reporting program has a standard profile for 

displaying lists. 

Example 
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In step User defaults for reporting lists, the following entries were created: 

 User Program name Profile 

DUMMY RCS11001 SAPCSLBLMP01 (Standard profile) JONES

 RCS11001 B-CSLBLMP01 

If user JONES chooses the Explode BOM level by level function, (Program RCS11001), the default is 

the user-specific value B-CSLBLMP01, not the standard profile value. 

Requirements 

If you want to enter a user-specific default, first define the profile in step: Define profile for reporting 

lists. 

Standard settings 

There is an entry for user DUMMY for each reporting function, which contains the standard profile as a 

default. 

Activities 

To enter a user-specific default value: 

1. Enter the user for which you want to create a default value. You can enter: 

- Any user name authorized in the system 

- A user group defined in the system 

2. Enter the program for which you want to create a default list profile. 

3. Enter the profile that you want to use a default for reporting lists for the user you entered. 

4. Define what the profile is used for: 

- Display: DSPL 

- Print: PRNT 

5. Save your settings. 

26.1.1.7 Tools (BOMs) 

In this step, you copy data from other IT systems (for example, from your existing system) to the SAP 

System. 

26.1.1.7.1 Define Profile for Output Lists 

In this step, you define list profiles for the lists produced by BOM explosions and where-used lists. 

The display profiles define the layout for: 



 

 

- Display on screen 

- Printed lists 

In the standard system, each reporting function has one list profile. This is the default display profile for 

the function. If you want the function to produce a different list, create a new profile. To do this, use the 

display blocks in the Standard profile. 

List name 

The list profile determines the contents and layout of a reporting list. All of the profiles for one 

transaction (for example, Explode BOM level by level) are assigned to a list name. 

- Maximum block 

A maximum block contains all the fields that are allowed in a display block. For example, 

all fields in the list header, or the heading. 

Maximum blocks are defined internally in the SAP system, and can only be changed using special 

functions. 

- List profile 

A list profile groups together all display blocks (for example, list header or heading). The fields 

of a display block have field attributes, which you can vary (for example, position or color of 

the field). The number of fields in a display block is a subset of the fields in the maximum 

display block. 

Activities 

To create a new display profile, perform the following steps: 

1. Create new profile 

2. Display standard profile and select the display blocks that you want to change 

3. Enter display blocks for new profile 

4. Process new display blocks 

5. Check new profile 

Further notes 

You can enter user-specific default values for the list display profiles in the work step: Create user 

defaults for output lists. 

You define authorizations for list object maintenance in the following work step: Objects in variable lists. 

26.1.1.7.2 Data Transfer Workbench: Material BOM 

The data transfer workbench is a central transaction for the automatic transfer of data from a legacy 

system into the ERP system. It offers the tools required for the initial and subsequent data transfer. 

The complete documentation about the data transfer workbench is in the SAP Library: 
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CA - Cross-Application Components -> CA - Data Transfer Workbench 

The documentation tells you step by step how to carry out the data transfer, and which object-specific 

special features you should be aware of. 

26.1.2 Work Center 

In this section, you define default values which are taken over into the respective operation during 

routing maintenance and order maintenance. 

Work center data is an essential part of the components which make up PP-BD (Production Planning-

Basic Data). 

In work centers, you enter default values in addition to data which is used for the following business 

functions: 

- costing 

- scheduling 

- capacity planning 

- printing shop floor papers 

- shop floor control 

- confirmation 

This data enables you 

- to schedule operations in task lists 

- to cost operations in task lists 

- to carry out capacity planning for the work center 

Note 

The following sections allow you to configure the SAP System according to your requirements. 

Depending on the size of your company, its sector of industry, production type and the complexity of the 

production processes, you can work with a simple or a more complex model. 

Recommendation 

SAP recommends that you begin by designing a concept for the areas: 

- routing management 

- order processing 

- costing 

Once you have done this, you can configure the work center parameters effectively. 

26.1.2.1 General Data 

In this section, you can maintain central control parameters for the following areas: 

- category and usage of a work center 



 

 

- work center location and personnel 

26.1.2.1.1 Define work center category 

The work center category determines the data that can be maintained in a work center and, therefore, the 

functions (for example, costing or scheduling) for which the work center can be used. 

Each work center category is assigned to the applications (for example, production, plant maintenance or 

quality management) whose menus allow you to maintain work centers with this category. 

Each work center category has a number of screens assigned to it which the system displays when work 

centers of this category are displayed. The screens contain groups of fields (for example, scheduling 

data). Depending on the work center category, you can make field selections on these screens (for 

example, defining required entry fields). 

You can specify whether change documents are written for each work center category. In the line 

hierarchy graphic you can use different colors to depict different work center categories. To do so 

maintain the color for the work center category. 

You can maintain a status profile for each work center category. This entry is only taken into account for 

resources. If you enter a status profile, all the user statuses that have been defined in this profile are 

available for the resource. 

Note 

- You can define default work centers for each work center category and plant. The contents of the 

fields maintained in the default work center are automatically copied into the new work center. 

- If you enter the appropriate default values in the default work center, the time and work needed to 

maintain work center data can be reduced considerably. 

Actions 

1. Define your work center categories. 

2. Assign the work center categories to an application. 

3. Define the screen sequences for the work center categories in the menu option "Define work center 

screen sequence". 

26.1.2.1.2 Define Field Selection 

In this step, you can select fields for the following screens: 

- Task lists 

- Header screens 

- Sequence screens 

- Operation screens 

- PRT overview 

- PRT details 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 30 

All of the screens where field selection is possible are combined into individual screen groups (for 

example, all list or detail screens for task lists). 

For each screen group you define the modifiable and influencing fields: 

- For modifiable fields, you use an indicator to determine how the individual fields are displayed on 

the screen: 

- Field is ready for input (standard setting) 

- Field requires an entry (required entry) 

- Field is display only 

- Field is hidden 

- Field is highlighted 

If, for example, you determine for the list and detail screens for confirmation within the network 

that "work center" is a required entry, you must maintain the work center in all confirmations. 

- For the influencing fields, you determine how the modifiable field is displayed on the screen, 

depending on a value (for example, "work center" is a required entry for a certain order type). 

Note 

The field selection settings you define can be transported and will remain unchanged when you upgrade 

to a new release. 

If a modifiable field becomes a required entry because of a change to an influencing field, the system 

does not check whether this field is filled in objects that already exist. 

You cannot modify required fields that are already hard-coded for the application. 

Standard settings 

There are no default settings for field selection. 

The modifiable and influencing fields are defined for each screen group and cannot be extended. 

Activities 

You have several options for defining a field selection: 

To maintain the indicators for modifiable fields independently of any influencing value, proceed as 

follows: 

1. Place the cursor on a screen group. 

2. Choose the function key Modifiable. 

All of the fields that you can modify for this screen group are displayed. 

3. Maintain the indicators and save your entries. 

To maintain an influencing value for an influencing field and then the indicators for modifiable fields, 

proceed as follows: 

1. Place the cursor on a screen group. 

2. Choose the function key Influencing. 



 

 

All of the fields for which you can maintain influencing values are displayed. 3.

 Double-click on the influencing field for which you want to maintain a value. 

All of the fields which you can modify for the influencing value are displayed. 

4. Maintain a value in the field Contents and the corresponding indicators for the modifiable fields. 

5. Choose Enter. 

Your entries are accepted. 

6. Maintain additional values for the influencing field, or select additional fields using the function 

key Influencing. 

7. Save your entries. 

To maintain an indicator for a modifiable field and specify the values of the influencing fields, proceed 

as follows: 

1. Place the cursor on a screen group. 

2. Choose the function key Modifiable. 

All of the fields which you can modify for this screen group appear on the screen. 

3. Double-click on a modifiable field for which you want to maintain influencing values. All of the 

influencing fields appear on the screen. 

4. Place the cursor on an influencing field for which you would like to enter a value and select New 

Values. 

You see a dialog box. 

5. Maintain the value and indicators for the influencing field, and choose Continue. The values are 

accepted. 

6. Save your entries. 

Transport your settings, if necessary. To do this, select Field selection -> Transport. 

26.1.2.1.3 Define task list usage 

Use 

In this IMG activity, you can specify the task lists in which a work center or production resource/tool 

may be used. 

For example, you can categorize work centers into maintenance work centers or inspection work centers 

according to their relevance and their usage in maintenance plans or inspection plans. 

You can also allow multiple, cross-application uses in any combination. 

Activities 

1. Define the usage key. 

2. Assign the task list type to the usage key. 
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26.1.2.1.4 Standard Value 

In this section, you define parameters and allocate them to the standard value keys. 

26.1.2.1.4.1 Define parameters 

In this menu option, you define the parameters. You allocate these parameters to the standard value keys. 

You can assign any meaning to these standard values. The most common standard values are setup time 

or machine time per unit ("tr" or "te" according to REFA). Under certain circumstances, you also have to 

make further standard values such as labor time or cleanout times available for planning. 

In addition, you need the parameters in the formula definitions and for the definition of the formulas and 

methods of the CAP calculation of standard values. 

Note 

Please keep in mind that the meaning of the fields is specified by the key words. 

Recommendation 

You should select mnemonic identification codes if you want to use the parameters later in the 

formula definition. 

Actions 

Set up the parameters. 

26.1.2.1.4.2 Define standard value key 

In this step you define standard value keys. The standard value key determines the meaning of the six 

standard values in the operation. The SAP System assigns a parameter ID to the standard values of the 

operation and the work in network activities. 

The parameter ID in turn determines: 

- the key word displayed for the standard value on the screen, for example, setup, machine, labor, 

teardown etc. 

- the dimension (for example, time, quantity, volume) of the standard value 

At the same time, the parameter IDs are the names used for the standard values in formulas for the 

calculation of 

- execution time - capacity requirements - costs. 

Note 

A parameter which is to be used in a standard value key must have the origin "2". 

If you use capacity leveling, SAP recommends that you always enter the parameter key for the setup 

standard values in the same position (for example, in the first column) in all standard value keys. 



 

 

Actions 

Define the standard value keys. 

26.1.2.1.5 Determine person responsible 

With this key, you can identify a person or group of people responsible for maintaining the master data in 

certain work centers. 

These employees are not responsible for planning tasks but only for the maintenance of the work center 

parameters. 

Actions 

Define the people responsible for your work centers. 

26.1.2.1.6 Define move time matrix 

In this menu option, you can define the location group and the move time  matrix. The system uses the 

move time matrix in scheduling to calculate  the move time between work centers. You must enter the  

move time from one location group to another in a matrix for the calculation. 

Recommendation 

To prevent the matrix from getting too large, you should combine work centers located in the same area 

into one location group. 

Actions 

1. Define your location groups. 

2. Maintain the matrix for the move time. 

26.1.2.1.7 Define subsystems 

26.1.2.1.8 Define default work center 

In this step, you can create default values for work center maintenance. With careful maintenance of 

default values, you can reduce the amount of time and work needed to create work centers. You can 

define your own default values by plant and work center category. 

You can maintain the following default values for work centers: 

- Basic data 

- Default values for operations in routings 
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- Scheduling 

- Capacities 

You cannot use the transport functionality for default values. 

Prerequisites 

- Step Define work center category/link to task list application 

- Step Define wage type 

Actions 

Define default values for work center maintenance. 

26.1.2.2 Routing Data 

Within routing data, you can specify attributes for routing operations. 

These attributes can be specified in the following ways: 

- As default values in the work center 

These values are copied as defaults into all new operations created. 

- As references 

These values are maintained centrally in the work center and referenced from all the operations. 

In the menu option "Routing data", you can define defaults. 

26.1.2.2.1 Define control key 

In this step, you define the control key of an operation. The 

control key specifies: 

- The business functions you want to carry out with an operation 

- How the SAP System processes an operation The most important functions are: 

- Scheduling 

If you set this indicator, the operation is scheduled. 

- Capacity planning 

If you set this indicator, capacity requirements records are written when the operation is scheduled. 

- Time tickets 

If you set this indicator, time tickets are printed for this operation. 

- Rework 

With this indicator you specify that an operation is designated for rework. Make sure that this 

indicator disables the Automatic goods receipt indicator. 

You must post the goods receipt manually for the rework quantity. 

- Costing 

If you set this indicator, the operation is taken into account in costing. 



 

 

- Confirmation 

You set this indicator to specify whether and how an operation is confirmed. 

- External processing 

With this indicator you can specify whether an operation is internally or externally processed or 

both. 

- WIP batches 

You can control the use of WIP batches for an operation. 

You can control the use of WIP batches for an operation. If you allow the use of WIP batches, yu 

can enter WIP batches for an operation in the subcontracting confirmation 

Furthermore, you can control the goods receipt for WIP batches. You process the goods receipt of 

WIP batches in the confirmation using the Goods Receipt indicator: 

- If the goods receipt is allowed, but not mandatory, in the standard system the indicator is not preset 

but can be set if desired. 

- If the goods receipt is mandatory, the indicator is set and cannot be unset. 

- If the goods receipt is expected but not mandatory, in the standard system the indicator is preset but 

can be unset. 

- If the goods receipt is not allowed, the indicator is not preset and cannot be set. Note 

With individual-batch-valuated materials, you can only post the goods receipt of a WIP batch to a 

certain operation. You cannot post the GR of a WIP batch to several different operations. For this 

reason, it may not be possible to post a GR for a WIP batch because a GR for this batch has already 

been posted to a previous operation. 

Note 

If you subsequently change these specifications, data is usually also changed. 

Actions 

1. Check the existing control keys. 

2. Create new control keys if required. 

3. If necessary, create a new long text for the control key. To do so, choose Call Up Long Text. 

26.1.2.2.2 Define setup type 

In this step, you define setup types. 

The setup type specifies 

- how a machine or a work center is to be set up 

- who is to set up the machine or work center 

You define setup types per plant. You enter it to be referenced or copied for routings or work orders. The 

setup type is used in sequence planning to determine the optimum setup times for sequences. 

Actions 

Define setup types for every plant. 
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26.1.2.2.3 Define wage group 

In this step you define wage groups for operations and work centers. 

By assigning an operation or a work center to a wage group you can evaluate the work to be performed in 

the operation from a job evaluation point of view (for instance suitable for unskilled  labor or requiring 

special training). When you confirm the operation, you enter the wage group that was actually used. 

In the standard system the wage group does not affect payroll accounting in the ERP system. 

Note: 

A SAP enhancement is available for the interface between production planning and incentive wages (see, 

IMG for incentive wages, Integration with Logistics) You can use this enhancement to adapt the 

interface so that the wage group is transferred to the time ticket as the pay scale groups that are generated 

in incentive wages with reference to an order or a confirmation. Please note however that, 

- Wage groups and pay scale groups are maintained in different tables 

- Wage groups have three figures, pay scale groups eight 

- Wage groups depend on the plant, pay scale groups depend on the pay scale area, the pay scale type 

etc. 

In this case you yourself must make sure that the data is consistent. 

Activities 

Define the wage groups that you want to use in your plant. 

26.1.2.2.4 Define suitability 

In this menu option, you can define the suitability required in a plant for carrying out certain tasks. In 

addition, you can determine whether suitability is copied or used as a reference. 

Example 

Suitability for a task can be: 

- Certificates 

- Courses of study 

- Short-term training 

Actions 

1. Enter the plant for which you want to define the suitability. 

2. Define the suitability. 

26.1.2.2.5 Define type of standard value determination 

The type of standard value calculation specifies how the standard values of an operation are calculated 

(for example, using CAPP). You define the types of standard value calculation for each plant. 



 

 

Actions 

Define the types of standard value calculation for each plant. 

26.1.2.3 Capacity Planning 

In this menu option, you define data that is used to determine capacity requirements and the available 

capacities of work centers. 

Note 

If you do not use capacity planning, you still have to maintain capacity data because this data is needed 

for scheduling. 

26.1.2.3.1 Define Capacity Category 

In this step you can assign several capacities belonging to different categories to one work center. 

Capacity categories can be, for example: 

- machine 

- labor 

- setup crew 

- emissions 

You must maintain the available capacity for every capacity category (for example, shift start, shift end, 

calendar, etc). You can maintain default values for this data per plant and capacity category. 

Actions 

Define which capacity categories are to be available. 

26.1.2.3.2 Determine capacity planner 

In this menu option, you can define the person or group of people responsible for planning certain 

capacities. 

Actions 

Define your capacity planners. 

26.1.2.3.3 Available Capacity 

In this section, you specify different keys for maintaining available capacity. 
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26.1.2.3.3.1 Define shift sequence 

In this step you define the following: 

- Grouping 

Using the grouping you can create shift sequences and shift definitions for special areas (for 

example, different plants or different areas of a plant) and when maintaining the available capacity 

choose from between work centers. 

- Work break schedule 

Here you define parameters that describe the individual work break schedules in more detail, as for 

example: 

- Start 

- Finish 

- Break times 

- Shift definition 

Here you define the parameters common to several work centers that describe the individual shifts 

in more detail, for example: 

- Start 

- Finish 

- Break times 

- Validity period of a shift 

In Logistics (LO) you can reference daily work schedules from the personnel system (HR). If you 

reference a daily work schedule in LO from HR and this is changed in HR then this change has a 

direct effect on changes in LO. 

- Shift sequences 

You can assign the shift sequence of a capacity category as the available capacity at the work 

center. 

You define a sequence of shifts per weekday. The shift sequence represents a collection of shift 

definitions. 

In capacity planning the system uses the predefined values from the shift definition to 

determine the available capacity of a work center. The system calculates the following 

values: 

- the capacity 

- the actual operating time for the capacity 

Standard settings 

The SAP standard package contains settings for various shift sequences. 

Activities 

You should define the following: 



 

 

1. groupings 

2. shift sequences 

3. shift definitions 

4. work break schedules 

26.1.2.3.3.2 Define period pattern key 

In this menu option, you define the period patterns you need when cumulating the available capacity by a 

hierarchy or when displaying the available capacity graphic. 

A period pattern consists of several segments. You have to specify a number of periods and the 

period duration for each of these segments. 

Example 

           No. of periods   Period duration 

1st segment: 7 periods  with  1 day each 

2nd segment: 3 periods  with  7 days each 

3rd segment: 2 periods  with  1 month each 

Actions 

1. Define the period pattern key. 

2. Define the segments of the period pattern. 

26.1.2.3.3.3 Define version of available capacity 

In this menu option, you define the version of available capacity. 

Actions 

Define the versions of available capacity. 

26.1.2.3.4 Define key for performance efficiency rate 

In this menu option, you  define performance efficiency rates. In the SAP System, performance 

efficiency rates are used in costing and in scheduling. The system uses the performance efficiency rate to 

correct standard values in the operation to correspond with the actual expected costs. 

In every performance efficiciency rate key you enter a performance efficiency rate for costing and 

scheduling.You can define time-dependent performance efficiency rate keys, that is you can enter 

different values for the performance efficency rate for different validity  periods. 

Actions 
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1. Define the performance efficiency rate keys. 

2. Define the performance efficiency rate keys and their validity periods 

26.1.2.3.5 Work Center Formulas 

In this section you define the formulas used in capacity planning, scheduling and costing in order to 

calculate the following: 

- capacity requirements 

- execution times 

- costs 

26.1.2.3.5.1 Define formula parameters for work centers 

Formula parameters are used in formulas for capacity planning, scheduling, costing, PRT management 

and determining standard values using CAPP. 

A formula parameter is identifeied by a parameter ID. Every formula parameter is linked with a 

particualr field either in Customizing, the routing or the work center. When the formula is evaluated the 

parameter takes the value of the field. 

Origin of Formula Parameters 

The assignment of a formula parameter to a data field is defined in the origin. You can refer to the data 

field in the work center or the routing via the parameter-ID or the key word that is assigned to every 

formula parameter and is displayed next to the the data field in the routing or work center. Formula 

parameters can have the following origins: 

- Standard Value 

Using the standard value key you provide the work center, and thus the routing, with up to six 

formula parameters that you assign values to in the routing operation. 

- Work Center Constant 

In the work center you can assign up to six work center constants a value and an unit. 

- General Formula Constants 

You can assign  general formuula constants a value and an unit in Customizing formula parameters. 

- General Operation Value 

The formula parameter is assigned to a data field in the general operation data, for instance the lot 

size or the base quantity. In this case you have to explicitly enter the field name. 

- User-Defined Field from Operation 

The formula parameter is assigned to an user-defined field in the operation. In this case the the 

assignment of the formula parameter is controlled by user-defined field key, that you define in 

Customizing the work center. The key words that describe the data fields are not defined in the 

formula parameters, but in the user-defined field key. 

- Value from PRT Allocation 

 You assign  the formula parameter to a field in the PRT alloaction, for instance the PRT quantity. 

- PRT constant 

You assign the formula parameter a fixed value in the PRT master record.This formula parameter 

can only be used for PRT management. 



 

 

Note: 

You enter the meaning of the fields in the key words for work centers and routings and not in the field 

names. 

Please note that this step is the prerequisite for the step Define rounding categories and additional values 

key in Customizing for CAPP standard value calculation. 

If you want to use the parameters in formulas you should use descriptive parameter IDs. 

- The value that you enter in the std. value field is only used to check the syntax of the formula 

(apart from general formula constants). The system does this automatically when you create a 

formula in Customizing. You should maintain this field, specially if a formula parameter is used as 

a divisor in a formula. Similiarly the Standard value unit field is only used for checking 

purposes. 

Actions 

1. Define your formula parameters. 

2. Check the assignment of the formula parameters to the standard value keys. 

3. Check the use of the formula parameters in formula definitions. 

26.1.2.3.5.2 Define formulas for work centers 

In this menu option, you can define the formulas that you want to use in the following areas: 

- capacity planning 

- scheduling 

- costing 

You can use the formula parameters to which values have been assigned previously. The formula 

parameters can be linked mathematically using the following operators: 

- addition => + 

- subtraction => - multiplication => * 

- division => / 

Actions 

1. Check the available formula parameters. 

2. Define the formulas used in your company. 

26.1.2.3.6 Distribution 

In this step you define the distribution that spreads the capacity requirements over the duration of the 

operation. The requirements can be dispatched evenly or discretely to one or more points in time. 

You define the distribution by means of a distribution function and a distribution strategy: 

- Distribution function 

This function defines what percentage of the capacity is to be dispatched after a particular 

percentage of the operation duration has passed. 
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- Distribution strategy 

This strategy defines whether 

- the requirements are to be dispatched at the earliest or latest start date 

- the requirements are to be distributed discretely at the points defined in the function or in a 

linear fashion according to the definition in the distribution function 

- whether the time basis is to be the gregorian calendar, the factory calendar or the operating 

time for the work center. 

26.1.2.3.6.1 Define distribution function 

In this menu option you define the distribution function. You specify what percentage of the capacity 

should be used after what percent of the operation's duration. 

Example 

- Equal distribution function 

       Percent duration:  20  40  60  80  100 

       Percent load:      20  40  60  80  100 

- Strategy: Point in time 

Dispatch 20% of the capacity requirements after 20% of the operation's duration (20% at this 

point in time), another 20% of the capacity requirements after 40% of the operation's duration, 

etc. 

- Strategy: Function 

Continuous requirements distribution equally over the whole duration of the operation. You 

can achieve the same effect if you enter the value "100" for both the percentage duration and 

the percentage load. 

- Distribution with the maximum at the end 

First the capacity requirements rise only slightly, then rise sharply and level off at the end. 

   Percent duration:   20  40  60  80  100 

   Percent load:       10  20  40  90  100 

Actions 

1. Enter a description for the distribution function 

2. Define your distribution function. 

26.1.2.3.6.2 Define distribution strategy 

In this step, you define the distribution strategy. 

In doing so, you determine the following: 

- Earliest or latest dates of capacity requirements 



 

 

Dispatch of requirements at the earliest or latest dates of the operation 

- Distribution type 

Distribution of requirements at certain points in time or on the basis of a partially linear function 

whereby both distribution types use the distribution function definition. 

- Point in time 

Capacity load occurs only at those points in time which you have entered in the percentage 

operation duration and to the value given for the percentage load. 

- Function 

You define an interval using two related values of the percentage operation duration. Using 

the percentage capacity requirements the system determines a linear function for this interval. 

Capacity load occurs continually within this interval on the basis of this linear function. 

- Time basis 

You can use the following as a basis for the duration of the distribution function: 

- factory calendar 

- Gregorian calendar 

- operating time of the work center 

Actions 

Define your distribution strategy. 

26.1.2.3.6.3 Define distribution key 

In this menu option you define a requirements distribution in which you specify the distribution strategy 

and distribution function. 

Preconditions 

First you must have completed the menu options "Define function" and "Define strategy". 

Actions 

Define the distribution. 

26.1.2.3.7 Define default capacity 

In this menu option, you can define default values for capacity maintenance. You can define your own 

defaults according to capacity category and plant. 

You can only define default values in the capacity header and for the reference capacity. 

You cannot use the transport functionality for default values. 

Recommendation 

You should define the default values very carefully in order to simplify the maintenance of capacities. 

Actions 
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Define the default values. 

26.1.2.4 Costing 

In this menu option, you define the data required for costing operations. 

This data includes: 

- performance efficiency rates 

- the formulas used for calculating costs 

26.1.2.4.1 Define key for performance efficiency rate 

In this menu option, you  define performance efficiency rates. In the SAP System, performance 

efficiency rates are used in costing and in scheduling. The system uses the performance efficiency rate to 

correct standard values in the operation to correspond with the actual expected costs. 

In every performance efficiciency rate key you enter a performance efficiency rate for costing and 

scheduling.You can define time-dependent performance efficiency rate keys, that is you can enter 

different values for the performance efficency rate for different validity  periods. 

Actions 

1. Define the performance efficiency rate keys. 

2. Define the performance efficiency rate keys and their validity periods 

26.1.2.4.2 Work Center Formulas 

In this section you can define the formulas used in capacity planning, scheduling and costing to calculate 

- capacity requirements 

- lead times 

- costs 

26.1.2.4.2.1 Define formula parameters for work centers 

Formula parameters are used in formulas for capacity planning, scheduling, costing, PRT management 

and determining standard values using CAPP. 

A formula parameter is identifeied by a parameter ID. Every formula parameter is linked with a 

particualr field either in Customizing, the routing or the work center. When the formula is evaluated the 

parameter takes the value of the field. 

Origin of Formula Parameters 



 

 

The assignment of a formula parameter to a data field is defined in the origin. You can refer to the data 

field in the work center or the routing via the parameter-ID or the key word that is assigned to every 

formula parameter and is displayed next to the the data field in the routing or work center. Formula 

parameters can have the following origins: 

- Standard Value 

Using the standard value key you provide the work center, and thus the routing, with up to six 

formula parameters that you assign values to in the routing operation. 

- Work Center Constant 

In the work center you can assign up to six work center constants a value and an unit. 

- General Formula Constants 

You can assign  general formuula constants a value and an unit in Customizing formula parameters. 

- General Operation Value 

The formula parameter is assigned to a data field in the general operation data, for instance the lot 

size or the base quantity. In this case you have to explicitly enter the field name. 

- User-Defined Field from Operation 

The formula parameter is assigned to an user-defined field in the operation. In this case the the 

assignment of the formula parameter is controlled by user-defined field key, that you define in 

Customizing the work center. The key words that describe the data fields are not defined in the 

formula parameters, but in the user-defined field key. 

- Value from PRT Allocation 

 You assign  the formula parameter to a field in the PRT alloaction, for instance the PRT quantity. 

- PRT constant 

You assign the formula parameter a fixed value in the PRT master record.This formula parameter 

can only be used for PRT management. 

Note: 

You enter the meaning of the fields in the key words for work centers and routings and not in the field 

names. 

Please note that this step is the prerequisite for the step Define rounding categories and additional values 

key in Customizing for CAPP standard value calculation. 

If you want to use the parameters in formulas you should use descriptive parameter IDs. 

- The value that you enter in the std. value field is only used to check the syntax of the formula 

(apart from general formula constants). The system does this automatically when you create a 

formula in Customizing. You should maintain this field, specially if a formula parameter is used as 

a divisor in a formula. Similiarly the Standard value unit field is only used for checking 

purposes. 

Actions 

1. Define your formula parameters. 

2. Check the assignment of the formula parameters to the standard value keys. 

3. Check the use of the formula parameters in formula definitions. 

26.1.2.4.2.2 Define formulas for work centers 
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In this menu option, you can define the formulas that you want to use in the following areas: 

- capacity planning 

- scheduling 

- costing 

You can use the formula parameters to which values have been previously assigned. The formula 

parameters can be linked mathematically using the following operators: 

- addition => + 

- subtraction => - multiplication => * 

- division => / 

Actions 

1. Check the available formula parameters. 

2. Define the formulas used in your company. 

26.1.2.4.3 Edit alternative activity description 

In this work step, you define alternative activity descriptions. 

You use alternative activity steps, when you edit a work center on the 

Costing tab page. Here you can select a text, with which you want to describe an activity. You can 

choose from the following descriptions: 

- Description of the standard value parameter 

- Description of the activity type 

- Alternative activity descriptions 

Activities 

You create an alternative activity description as follows: 

1. Choose New entries. 

2. For each language in which you want to create the alternative activity description, enter the key for 

the alternative activity description, the language key and the alternative activity description 

itself. 

SAP recommends you use the same alternative activity description key for several language 

versions of the same alternative activity description. 

3. Save your data. 

26.1.2.5 Set up work center screen sequence 

In this menu option you can specify 



 

 

- the screens you want to assign to a certain work center category 

- the sequence in which these screens are to be displayed 

- whether scheduling types and cost elements are to be maintained 

- whether maintenance of the screens is required 

The following screens are available: 

- Basic data 

This screen must always start the screen sequence 

- Default values 

- Capacity data 

- Scheduling 

- Cost center assignment 

Note 

If you do not yet use a certain function, such as capacity planning, do not assign the corresponding screen 

to the work center category.  This way, you can simplify the maintenance of work center master data. 

Actions 

Specify the screen sequence for each work center category. 

26.1.2.6 Define graphics profile 

In this menu option, you define the graphics profile for displaying the hierarchy. 

Actions 

Define the graphics profile. 

26.1.2.7 Define Work Center Matchcodes 

In this menu option, you can assign any field from the work center master record to a matchcode. When 

searching for work centers by matchcode, you can limit the number of data records selected by entering 

data in these fields. 

You cannot use the transport functionality with matchcodes. 

Default settings 

The standard system contains a number of predefined matchcodes. 

Recommendation 

Generating a new matchcode for many work centers can slow down system performance. You should, 

therefore, generate the matchcodes when the system workload is low. 

Actions 
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1. Check the available matchcodes. 

2. Define new matchcodes, if necessary. 

26.1.2.8 Workbench Data Transfer: Work Center 

The Data Transfer Workbench is a central transaction for automatically 

transferring data from an old system to the SAP system. It provides the 

necessary tools as well as the access to standard programs for carrying out data 

transfer. 

You can find all the documentation on the Data Transfer Workbench in the 

SAP Library: 

    CA - Cross-Application Components 

         General Application Functions 

Here you can find out how to carry out data transfer step by step, and which object-

specific variations you should take note of. 

26.1.3 Execution Steps 26.1.3.1 Define Namespaces for Scopes of Generation 

and Valuation 

Symbols 

Use 

Scopes of generation  and valuation symbols, which you require to define XSteps and standard XSteps , 

are grouped in namespaces. The SAP standard delivery contains the namespace SAP, which furthermore 

contains the scopes of generation and valuation symbols provided by SAP. 

You define your own namespaces in this segment, which you can assign to both those scopes of 

generation and valuation symbols, which have been provided by SAP, as well as those that you have 

defined yourself. 

To be able to use the namespaces that you have defined, proceed as follows: 

1. You define new namespaces in this 

activity 

a) Create data categories for the namespace. The data category specifies the different data types 

that can be used in the namespace. 

b) Create the valuation symbols for the namespace that are used for the parameter definition. You 

must assign a data category to each valuation symbol. If you want to use your own valuation 



 

 

symbols, you must implement BAdI CMX_XS_SRV_SYM. To do this, access the 

Customizing for process management and choose Business Add-Ins in Process 

Management -> BAdI: Definition of Valuation Symbols for XSteps. 

c) You create the namespace for the scopes of generation. You must assign a data category to 

each scope of generation. 

If you want to use your own scopes of generation, you must implement the BAdI 

CMX_XS_SRV_GEN. To do this, access Customizing for Process Management and 

choose Business Add-Ins in Process Management -> BAdI: Definition of Scopes of 

Generation for XSteps. 

d) If the BAdI implementation for your own scope of generation contains further scopes of 

generation, you must list the namespaces for all scopes of generation used. The namespaces 

must all have been released. 

Example: 

You want to implement a scope of generation for all material components with batch 

management requirements. In doing so, you use the scope of generation For all material 

components which is provided by SAP in your implementation. In this case, you must 

specify the namespaces of both scopes of generation. You can also assign key fields to the 

scope of generation that are set directly from the scope of generation. 

2. Release the new namespace. Release 

name space 

Standard settings 

Note that even though the definition of the namespaces is client-independent, the release of the 

namespaces is client-dependent. That is, you must release the namespaces in each client that you want to 

use. 

To do this, execute the activity Release namespaces. 

For further information see Recommendations for multiclientoperation. 

Activities 

1. Define Namespace 

a) On the Defined Namespaces screen, choose the New Entries pushbutton. 

b) Specify a key and a description for the namespace. 

c) Save your entries. 

2. Define Data Categories 

a) Select the namespaces, to which you want to assign the data categories and double-click data 

categories. 

b) Choose New Entries. 

c) Create a key, a description and an item for each data category. 

3. Define valuation symbols 

a) Select the namespace, to which you want to assign the valuation symbols and double-click 

valuation symbols. 

b) Choose New Entries. 

c) Create a key and a description for each valuation symbol. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 50 

d) Assign each valuation symbol to one of the data categories that you have defined. 

4. Define scopes of generation 

a) Select the namespace, to which you want to assign the scopes of generation and double-click 

scopes of generation. 

b) Choose New Entries. 

c) Create a key and a description for each scope of generation. 

d) Assign one of the data categories that you have already assigned to scope of generation. 

5. Scopes of generation used 

a) Select the scope of generation, to which you want to assign the used scopes of generation and 

double-click  Scopes of generation used. 

b) Choose New Entries. 

c) Create the scopes of generation used with the corresponding namespace. 

6. Supported Key Fields 

a) Select the scope of generation, to which you want to assign supported key fields and double-

click Supported key fields. 

b) Choose new entries. 

c) Created the valuation symbols used. 

26.1.3.2 Release Namespaces 

Use 

In this activity you release the namespaces for scopes of generation and valuation symbols. 

Requirements 

The namespaces that are to be released have been created in activity Define namespaces for scopes of 

generation and valuation symbols. 

Activities 

1. Choose New Entries. 

2. Enter the key for the namespace that you want to release. 

3. Save your entries. 

26.1.3.3 Assign Standard XSteps to the Production Scheduling Profile 

Use 

In this activity, you can assign one or more standard XSteps to a  production scheduling profile. 



 

 

You normally define Execution Steps (XSteps) in the standard XStep repository or in the routing, which 

you then use to generate production orders. You can also reference or copy standard XSteps in the 

routing. If you do not want to reference a standard XStep in a routing, you can copy one or more 

standard XSteps into the production order via a production scheduling profile. 

In this step, you specify that standard XSteps are automatically to be copied into the production order via 

a production scheduling profile when the production order is created. 

Note 

With this variant, you may have to perform context maintenance of the XSteps for operations in the 

individual production order yourself. 

If you have both assigned standard XSteps to the production scheduling profile and maintained them in 

the routing, the system uses only the XSteps defined in the routing in the production order. 

Note 

You can also use this functionality for master recipes and process orders. 

Requirements 

You have defined a production scheduling profile and stored it in the material master record (view Work 

Scheduling) of the finished product that is to be produced. 

- You define the production scheduling profile for PP production orders under: 

Define Production Scheduling Profile 

- You define the production scheduling profile for PI process orders under: Define 

Production Scheduling Profile 

Activities 

1. Choose New Entries. 

2. Specify a production scheduling profile and the associated plant. 

3. Assign a standard XStep to the production scheduling profile. 

4. Save. 

To assign further standard XSteps to the same production scheduling profile you must create a new entry 

for each additional standard XStep. 

26.1.3.4 Set Early Assignment of Order Number 

Use 

In the standard setting, the system can only generate an XStep tree in the process order if you have first 

saved the order. In this case you see the error message "Generation not possible for orders with 

temporary numbers". You must first save the order before the XStep tree can be generated. 

In this activity you can set that XStep trees can be generated even if the order has not been saved. The 

error message above is then not issued. In this way the system assigns an order number to the order even 

though you have not yet saved it. The number assignment is lost if you cancel the order without saving. 

This means that there will be no order for this number in the order history. 
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Activities 

1. Assign the error message to the message type in question. 

2. If necessary, create a new version for a certain user group. 

For certain user groups you can define different versions. The effect of this is that the same message 

is issued as an error message to one user and as a warning message to another user. To do this you 

must assign the parameter ID MSV and the number of the version to the relevant user master data 

records. 

26.1.3.5 Standard XStep Repository 

26.1.3.5.1 Define Authorization Groups for Standard XStep Repository 

Use 

In this activity, you define the authorization groups for the SXS repository. 

Using the authorization groups, you can restrict the processing authorization in the SXS repository in the 

following ways: 

- You define different authorization groups for users with different task areas. 

- You assign the required authorization groups to the role, which has the responsibility for that 

particular task area (authorization object CMX_XSR). 

- You assign the roles to the users. 

For further information see Set Authorizations. 

Activities 

1. Determine which user groups or task groups you require in your company. 

2. Define an authorization group for each user group. 

26.1.3.5.2 Settings for Standard XStep Repository 

Use 

In this IMG activity, you make various settings for the standard XStep repository: 

- Specifications re system behavior in the check sum check 

You can export standard XStep objects and import them into a different XStep repository 



 

 

(see documentation in SAP Library under Logistics -> Production Planning -> Production 

Planning Process Industry -> Execution Steps -> Export and Import of standard XStep objects) 

For this purpose, the data is transformed into XML files. The XML file can be processed and 

changed in the XML edito. With the check sum check, you can control whether XML files whose 

content was changed following the XML export are allowed to be imported into your target system. 

The check sum check must be activated both in the source system and in the target system prior to 

the export or import of the XML files. You have the following options: 

- No message 

Changed files are imported into your target system. The check sum check is not active in your 

SXS repository. 

- Information/warning 

The check sum check is active. The system generates an information or warning message if 

changed XML files exist. The import into the target system is then continued. 

- Error 

The check sum check is active. The system terminates the XML import if the files have been 

changed. 

- SXS versions: Calculation of valid-to date 

At any point in time, there must be only one version of a standard XStep having the status Released 

oder Released for Test. You can use the indicator to specify that the valid-to date of a version is 

calculated by the system. No valid-to date can be specified for the version in the repository. 

If a valid version already exists for the standard XStep, this version ends one day before the valid-to 

date of the new version. The valid-to date of the previous version is entered by the system 

(See documentation in SAP Library under Logistics -> Production Planning -> Production 

Planning Process Industry -> Execution Steps -> Versioning 

- SXS Version: Automatic consecutive numbering 

The versions of a standard XStep are numbered consecutively starting with the number 1. The 

numbering cannot be changed manually. 

- SXS version: Approval procedure active 

If you set the indicator, an approval procedure with status management and digital signature 

strategy for certain status changes is active for the status assignment of the SXS version. 

- For the assignment of the status Released and Approved and Discarded, you can specify a signature 

strategy. If you make no specification, the single signature is used. The settings for the signature 

strategies are specified in advance in Customizing under Cross-Application Components -> 

General Application Functions -> Digital Signature. 

26.1.3.5.3 Define Reference Plant for Cross-Plant Standard XStep Repository 

Use 

In this IMG activity, you activate the cross-plant standard XStep repository by defining the reference 

plant. You can only define one plant as the reference plant. 

You can also invoke this IMG activity directly via transaction CMX22. 

The cross-plant standard XStep repository is a central repository for standard XSteps that you can use in 

different plants. In this way, you can reduce the maintenance effort for master data and ensure a 

standardized way of working in all plants. 

You will find the cross-plant standard XStep repository for the process industry in the SAP Easy Access 

Menu under Logistics --> Production Process --> Master Data --> Cross-Plant Standard XStep 

Repository. 
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You will find the cross-plant standard XStep repository for the PP area in the SAP Easy Access Menu 

under Logistics --> Production --> Master Data -> Cross-Plant Standard XStep Repository. 

The cross-plant standard XStep repository is a separate repository. The definition of a reference plant 

does not cause the standard XSteps that you have already created for the specified plant to be 

automatically adopted in the cross-plant repository. To adopt parts of the plant-dependent repository in 

the cross-plant repository, you must create this data in the cross-plant repository. The standard functions 

of the XML export or import are available for this purpose. 

The reference plant is a technical aid that is needed only to enable the release of the necessary 

characteristic groups for process instructions and process messages. 

Note 

- SAP recommends that you only create new standard XSteps in the cross- plant repository after the 

latter has been activated. These standard XSteps can then be used in another plant if required. 

- All characteristics that are also used in other plants to define XSteps must exist in the reference 

plant. 

Requirements 

You must have released at least the following characteristic groups for process instructions and process 

messages for the plant that you have specified as the reference plant. 

- Characteristic group PPPI_01 Process message characteristics 

- Characteristic group PPPI_02 Process instruction characteristics 

- All characteristic groups created by you in the customer namespace 

Standard settings 

The cross-plant standard XStep repository is not activated. 

Activities 

- To activate the cross-plant standard XStep repository, you must select the plant you want to use 

as the reference plant. 

SAP recommends that you subsequently make no further changes to the reference plant. 

- If you use the Delete Selection button to deselect the reference plant, the cross-plant standard 

XStep repository is deactivated and you can again set references to standard XSteps in the plant-

dependent repository. 

You must export XStep entries that you have created in the cross-plant repository and which you 

want to continue using, so that you can then use them in the plant-dependent repository. 

26.1.3.5.4 Define Translatable Process Instruction Characteristics 

Use 

In this IMG activity, you specify the process instruction characteristics that are to be translatable. 

You can also invoke this IMG-activity directly via the transaction CMX23. 



 

 

Standard settings 

The process instruction characteristics that are regarded as translation-relevant in the standard system are 

already displayed here and are thus translatable. 

Activities 

- If you have defined customer-specific process instruction characteristics and these are to be 

translatable, you must enter them here. 

- If you remove an entry, this entry is no longer translation-relevant and thus also no longer 

translatable. 

26.1.3.5.5 Define Preferred Default Language 

Use 

In this IMG activity, you can define the default language in which the system is to display the standard 

XSteps if the latter have not yet been translated into the desired target language. 

Short and long texts of all XStep objects are generally translatable in the XStep editor. A prerequisite for 

this is that the object to be translated is based on a characteristic that you have previously entered in the 

IMG activity Define Translatable Process Instruction Characteristics (transaction CMX23). 

You can also invoke this IMG activity directly via transaction CMX24. 

If you do not specify a preferred default language, as a basic rule the system displays the source language 

until such time as translation into the the logon language has been carried out. 

To translate XStep texts, proceed as follows: 

1. You must log on in the desired target language. 

2. Invoke the XStep in change mode and overwrite the texts in the logon language. 

3. Save your changes. 

The system saves your input as a translation. The texts of the XSteps are now available in the 

original language and in the language into which translation has taken place. 

Example 

You have defined English as the preferred default language. You have logged on in German and have 

created a new XStep. You have then translated the text into English. The XStep is also to be translated 

into French. A user logs on in French. Because there is as yet no translation into French, the system 

displays the new XStep in the preferred default language English. As soon as the French translation 

becomes available, it is displayed to the user when the latter logs on in French. 

26.1.4 Routing 
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In this section, you can configure your routing maintenance system. 

Note: 

Before deleting entries in Customizing, make sure that these entries are not used in any routings or in 

other task list application areas, such as QA task lists, maintenance task lists and standard networks. 

26.1.4.1 Control Data 

In this section, you can define the control parameters for routing maintenance. You can specify 

new task list groups when creating new task lists. 

A task list is uniquely identified by the following information: 

- group 

- group counter 

To access the various task list types, you have the following possibilities: 

- routing 

You can access a routing either directly using the task list group or using a material. 

- reference operation set 

You can only access a reference operation set by using the task list group. 

In addition, when you create a task list, you can enter an alphanumeric key for the task list group. This 

can be carried out in two ways: 

- Internal number assignment 

In this case, the SAP system assigns the numbers. 

- External number assignment 

In this case, you assign the numbers. 

For each task list group, you can determine an internal as well as an external number range. 

26.1.4.1.1 Define Number Ranges for Routings 

In this step, you define number ranges for groups of routings. 

To create a routing, the system requires a unique group number. 

You can create routings with or without a group. If you do not enter a group, the system assigns a group 

to the task list. The internal group number is within the number range you define in this step. 

You can also define number ranges for external assignment of group numbers. 

Note 

Make sure that the number range for internal number assignment is large enough. 

Actions 

Maintain number ranges for external and internal number assignment. 



 

 

Transport Notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.1.4.1.2 Define Number Ranges for Reference Operation Sets 

In this step, you define number ranges for groups of reference operation sets. 

To create a reference operation set, the system requires a unique group number. You can create 

reference operations sets with or without a group. If you do not enter a group, the system assigns a 

group to the task list. The internal group number is within the number range you define in this step. 

You can also define number ranges for external assignment of group numbers. 

Note 

Make sure that the number range for internal number assignment is large enough. 

Actions 

Maintain number ranges for internal and external number assignment. 

Transport Notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.1.4.1.3 Define Number Ranges for Rate Routings 

In this work step, you specify number ranges for groups of rate routings. 

To create a rate routing, the system requires a unique group number. 

You can create rate routings with or without entering a group. If you do not enter a group, the system 

internally assigns the routing to a group. The internal group number is within the number range that you 

specify in this step. 

You can also specify number ranges for external assignment of group numbers. 

Note 

Make sure that the number range for internal number assignment is large enough. 
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Actions 

Maintain the number ranges for external and internal number assignment. 

Notes for transport 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.1.4.1.4 Define Number Ranges for Reference Rate Routings 

In this work step, you specify number ranges for groups of reference rate routings. 

To create a reference rate routing, the system requires a unique group number. You can create reference 

rate routings with or without entering a group. If you do not enter a group, the system internally assigns 

the routing to a group. The internal group number is within the number range that you specify in this 

step. 

You can also specify number ranges for external assignment of group numbers. 

Note 

Make sure that the number range for internal number assignment is large enough. 

Actions 

Maintain the number ranges for internal and external number assignment. 

Notes for transport 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.1.4.1.5 Maintain Task List Types and Set SET/GET Parameters 

In this step, you assign number ranges previously defined to the respective task list types. 

You can also activate the following options for each task list type: 

- Write change documents 

- Last maintained value for the material (and plant of the material), group, and sales document fields 

appears as the default value. 



 

 

"Last maintained" refers to the last entry of a specific user and not the last entry in the system. 

If you would like to access fixed user values instead of the last maintained value, do not activate 

this option. Also select SET parameters and GET parameters in the field attributes of the 

respective field, such as the Material field. Entering a fixed value in the user parameters alone is 

not sufficient. 

Actions 

1. Assign number ranges for internal and external number assignment to taks list types. 

2. Maintain the remaining options. 

26.1.4.1.6 Define Standard Value Descriptions in Operation Overviews 

In this step, you maintain column headings for standard values on the operation overview. 

In the operation overviews for some task list types, such as rate routings and reference rate routings, you 

can maintain standard values. 

If all work centers where operations are processed use the same descriptions in the standard value key, 

the system dynamically determines a common description for the standard value column heading. 

If no common header can be determined for a column of standard values, the system sets the description 

from this Customizing table according to task list type. 

The same procedure applies when a sequence or a task list is created for the operation overview. 

Actions 

Maintain the standard values. 

26.1.4.1.7 Define Line Length for Long Texts 

In this step you specify the line lengths of the various texts in routing long texts. 

The length of the short text on the corresponding overview and detail screens (for example, 

operation overview) is always limited to 40 characters. If the long text has more than 40 characters, the 

short text will display only the first 40 characters. 

This table setting affects the long texts of the following objects: 

- Header 

- Sequence 

- Operation 

- Sub-operation 

- PRT assignment 

Activities 

Specify the line lengths for the long texts. 
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26.1.4.1.8 Define Profiles with Default Values 

In this step, you define task list profiles. A profile is a collection of default values for task list headers 

and operations. 

You can minimize the maintenance of task list data as follows: 

- Data from the material master is proposed 

- Data from the work center can be referenced or copied 

- Data from the profile is proposed 

You can enter a profile in routing maintenance. The values from this profile are proposed when you 

create a new routing or routing object, such as a header or an operation. This data can either be 

saved or overwritten. 

Example 

The profile contains default values for the status or for the operation increment. 

Note 

The values you maintained in the material master or the work center will be proposed before any values 

from the profile. 

Actions 

1. Determine the default values that can reduce the amount of maintenance work in your company. 

2. If necessary, define several profiles. 

3. Maintain the default values for routing maintenance. 

4. Maintain the default values for quality assurance. 

26.1.4.1.9 Define Field Selection 

In this step, you can select fields for the following screens: 

- Task lists 

- Header screens 

- Sequence screens 

- Operation screens 

- PRT overview 

- PRT details 

All of the screens where field selection is possible are combined into individual screen groups (for 

example, all list or detail screens for task lists). 

For each screen group you define the modifiable and influencing fields: 

- For modifiable fields, you use an indicator to determine how the individual fields are displayed on 

the screen: 

- Field is ready for input (standard setting) 

- Field requires an entry (required entry) 



 

 

- Field is display only 

- Field is hidden 

- Field is highlighted 

If, for example, you determine for the list and detail screens for confirmation within the network 

that "work center" is a required entry, you must maintain the work center in all confirmations. 

- For the influencing fields, you determine how the modifiable field is displayed on the screen, 

depending on a value (for example, "work center" is a required entry for a certain order type). 

Note 

The field selection settings you define can be transported and will remain unchanged when you upgrade 

to a new release. 

If a modifiable field becomes a required entry because of a change to an influencing field, the system 

does not check whether this field is filled in objects that already exist. 

You cannot modify required fields that are already hard-coded for the application. 

Standard settings 

There are no default settings for field selection. 

The modifiable and influencing fields are defined for each screen group and cannot be extended. 

Activities 

You have several options for defining a field selection: 

To maintain the indicators for modifiable fields independently of any influencing value, proceed as 

follows: 

1. Place the cursor on a screen group. 

2. Choose the function key Modifiable. 

All of the fields that you can modify for this screen group are displayed. 

3. Maintain the indicators and save your entries. 

To maintain an influencing value for an influencing field and then the indicators for modifiable fields, 

proceed as follows: 

1. Place the cursor on a screen group. 

2. Choose the function key Influencing. 

All of the fields for which you can maintain influencing values are displayed. 3.

 Double-click on the influencing field for which you want to maintain a value. 

All of the fields which you can modify for the influencing value are displayed. 

4. Maintain a value in the field Contents and the corresponding indicators for the modifiable fields. 

5. Choose Enter. 

Your entries are accepted. 

6. Maintain additional values for the influencing field, or select additional fields using the function 

key Influencing. 
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7. Save your entries. 

To maintain an indicator for a modifiable field and specify the values of the influencing fields, proceed 

as follows: 

1. Place the cursor on a screen group. 

2. Choose the function key Modifiable. 

All of the fields which you can modify for this screen group appear on the screen. 

3. Double-click on a modifiable field for which you want to maintain influencing values. All of the 

influencing fields appear on the screen. 

4. Place the cursor on an influencing field for which you would like to enter a value and select New 

Values. 

You see a dialog box. 

5. Maintain the value and indicators for the influencing field, and choose Continue. The values are 

accepted. 

6. Save your entries. 

Transport your settings, if necessary. To do this, select Field selection -> Transport. 

26.1.4.2 General Data 

In this section, you can: 

- configure the link to Materials Management 

- define the desired application areas (usage) and business-related functions (statuses) for task lists 

- define groups of people responsible for task lists 

26.1.4.2.1 Define Material Type Assignments 

In this step, you assign material types to task list types. If a material type is not assigned to a task list 

type, you cannot create routings for materials of this type. 

Recommendation 

SAP recommends using the assignments contained in the standard SAP system. Only make new 

assignments if the standard assignments do not cover all of your needs. 

Actions 

Check the assignments of material types to task list types. If need be, assign new material types to the 

task list types. 

26.1.4.2.2 Define Routing Statuses 



 

 

In this step, you define different routing statuses. 

The status determines the work areas in which a routing can be used. 

More specifically, the status controls the following functions: 

- release for usage in orders or for reference in other task lists (reference operation sets or reference 

rate routings) 

- release for costing 

- automatic consistency check before the routing is saved The status is used in an order for automatic 

task list selection. 

(see Automatic selection) 

Actions 

Define routing statuses. 

26.1.4.2.3 Define Task List Usage 

In this step, you define task list usages. 

You use the usage to assign routings to various work areas. Therefore you can create several task lists 

with various usages for the production of a material. In work orders, you can assign order types to 

usages. 

The system uses the usage in an order for automatic task list selection. 

(comp. Select automatically) 

Example 

You can specify that a routing is to be used only for Plant Maintenance or for goods receipt. 

Actions 

Define task list usages. 

26.1.4.2.4 Configure Planner Group 

In this step, you define planner groups per plant. A planner group is a group of people responsible for the 

maintenance of routings. You can use the planner group as a selection criterion for task list selection. 

Actions 

Create planner groups. 

26.1.4.2.5 Define Overview Variants for Object View 

In this step you can create individual object overviews in routings. 

These individual object overviews are called variable lists. 
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For each object overview, you create an overview variant. The overview variant specifies: 

- which objects are displayed, such as operations or sequences 

- Which fields are displayed for each object, such as dates and quantities 

Standard settings 

Object overviews and variants are included in the standard installation. 

Activities 

Proceed as follows to create your own object overviews: 

1. Create overview variants 

This section describes how you create overview variants. 

2. Define objects 

This section describes how you define the individual objects that you want to display in the 

overview. 

3. Define fields 

This section describes how you choose fields and define the overview layout. 

4. You can transport your settings by selecting Table view -> Transport. 

26.1.4.2.6 Define Overview Variants for Where-Used Lists 

In this step, you can use your own overviews for where-used lists and mass replacement of work centers 

and reference operation sets. 

These individual overviews are marked as variable lists. 

You create an overview variant for each overview. The variant specifies: 

- which objects are displayed, such as operations or sequences 

- which fields are displayed for each object, such as standard values or lot size 

Standard settings 

Overviews and overview variants are included in the standard delivery. 

Activities 

Proceed as follows to create your own overviews: 

1. Create overview variants 

This section describes how to create overview variants. 

2. Specify objects 

This section describes how to specify the individual objects you want to display in the overview. 

3. Specify fields 

This section describes how to choose fields and the layout of the overview. 

4. You can transport your settings. To do this, select the menu options Table view -> Transport. 



 

 

Further notes 

You define the overview for where-used lists and mass replacement of production resources/tools in the 

step Define overview variants for PRT where-used lists. 

26.1.4.3 Operation Data 

In this section, you can make settings for operations. 

26.1.4.3.1 Define Control Key 

In this step, you define the control key of an operation. The 

control key specifies: 

- The business functions you want to carry out with an operation 

- How the SAP System processes an operation The most important functions are: 

- Scheduling 

If you set this indicator, the operation is scheduled. 

- Capacity planning 

If you set this indicator, capacity requirements records are written when the operation is scheduled. 

- Time tickets 

If you set this indicator, time tickets are printed for this operation. 

- Rework 

With this indicator you specify that an operation is designated for rework. Make sure that this 

indicator disables the Automatic goods receipt indicator. You must post the goods receipt 

manually for the rework quantity. 

- Costing 

If you set this indicator, the operation is taken into account in costing. 

- Confirmation 

You set this indicator to specify whether and how an operation is confirmed. 

- External processing 

With this indicator you can specify whether an operation is internally or externally processed or 

both. 

- WIP batches 

You can control the use of WIP batches for an operation. 

You can control the use of WIP batches for an operation. If you allow the use of WIP batches, yu 

can enter WIP batches for an operation in the subcontracting confirmation Furthermore, you can 

control the goods receipt for WIP batches. You process the goods receipt of WIP batches in the 

confirmation using the Goods Receipt indicator: 

- If the goods receipt is allowed, but not mandatory, in the standard system the indicator is not preset 

but can be set if desired. 

- If the goods receipt is mandatory, the indicator is set and cannot be unset. 

- If the goods receipt is expected but not mandatory, in the standard system the indicator is preset but 

can be unset. 
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- If the goods receipt is not allowed, the indicator is not preset and cannot be set. Note 

With individual-batch-valuated materials, you can only post the goods receipt of a WIP batch to a 

certain operation. You cannot post the GR of a WIP batch to several different operations. For this 

reason, it may not be possible to post a GR for a WIP batch because a GR for this batch has already 

been posted to a previous operation. 

Note 

If you subsequently change these specifications, data is usually also changed. 

Actions 

1. Check the existing control keys. 

2. Create new control keys if required. 

3. If necessary, create a new long text for the control key. To do so, choose Call Up Long Text. 

26.1.4.3.2 Define Reduction Strategy 

In this step, you specify the reduction strategy to be used when the reduction measures are carried out on 

operations. Scheduling reduces the lead_time automatically if the basic dates given are not adhered to, 

that is if the scheduled dates lie outside the basic dates. 

In this work step, you also define the reduction levels. The reduction takes place level by level no further 

than the level that you have specified in the control parameters. 

You can specify a reduction strategy in every operation. 

- Reduction strategies 

You use the reduction strategies to determine how the operation lead time can be reduced step by 

step. You can enter a reduction strategy in every operation. 

- Reduction levels 

You can define up to six reduction levels for each reduction strategy. For every reduction level you 

can enter what is to be reduced and by how much. 

The SAP system carried out reduction step by step no further than the reduction level specified 

in the scheduling parameters. 

Note 

The order/network is rescheduled after every reduction level. To improve performance we recommend 

that you keep the number of reduction steps to a minimum. 

Standard settings 

The reduction levels are predefined in the SAP standard package. 

Activities 

1. You should define the reduction strategies. 



 

 

2. You should define the reduction levels for all the reduction strategies. 

26.1.4.3.3 Define Setup Type and Setup Group 

In this step, you define setup. 

Setup includes: 

- Setup type key 

You define the setup type according to plant by using the setup type key. You can print out setup 

type with shop floor papers. In sequencing, the optimum sequences for setup are determined with 

the setup type key. 

- Setup group category 

The setup group category classifies the setup groups. Setup group categories are plant-dependent. 

- Setup group 

The setup group combines operations with the same or similar setup conditions. In capacity 

leveling, you can optimize the sequence using the setup group. 

Actions 

1. Define your setup type keys for each plant. 

2. Maintain the setup group categories. 

3. Maintain the setup groups within the setup group categories. 

26.1.4.3.4 Define Wage Group 

In this step you define wage groups for operations and work centers. 

By assigning an operation or a work center to a wage group you can evaluate the work to be performed in 

the operation from a job evaluation point of view (for instance suitable for unskilled  labor or requiring 

special training). When you confirm the operation, you enter the wage group that was actually used. 

In the standard system the wage group does not affect payroll accounting in the ERP system. 

Note: 

A SAP enhancement is available for the interface between production planning and incentive wages (see, 

IMG for incentive wages, Integration with Logistics) You can use this enhancement to adapt the 

interface so that the wage group is transferred to the time ticket as the pay scale groups that are generated 

in incentive wages with reference to an order or a confirmation. Please note however that, 

- Wage groups and pay scale groups are maintained in different tables 

- Wage groups have three figures, pay scale groups eight 

- Wage groups depend on the plant, pay scale groups depend on the pay scale area, the pay scale type 

etc. 

In this case you yourself must make sure that the data is consistent. 

Activities 

Define the wage groups that you want to use in your plant. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 68 

26.1.4.3.5 Define Suitability 

In this menu option, you can define the suitability required in a plant for carrying out certain tasks. In 

addition, you can determine whether suitability is copied or used as a reference. 

Example 

Suitability for a task can be: 

- Certificates 

- Courses of study 

- Short-term training 

Actions 

1. Enter the plant for which you want to define the suitability. 

2. Define the suitability. 

26.1.4.3.6 Define Type of Standard Value Determination 

The type of standard value calculation specifies how the standard values of an operation are 

calculated (for example, using CAPP). You define the types of standard value calculation for each plant. 

Actions 

Define the types of standard value calculation for each plant. 

26.1.4.3.7 Define User-Defined Fields 

In this step, you create user-defined fields for the operation detail screen. 

You enter field names (key words) for each field key (key word ID). 

Make sure your entries are complete if you maintain field keys in several languages. When you press 

possible entries (F4) on the operation detail screen, you can choose all field keys regardless of the logon 

language. However, if the field key is not maintained in the logon language, no short text appears. 

Actions 

Define the field keys and field names. 

26.1.4.3.8 Define Overview Variants for Scheduling 

In this step you can create your own lists for object overviews in the following areas: 

- Routing 

- Reference operation set 



 

 

- Rate routing 

- Reference rate routing 

You use a technology called "variable lists" to create the lists. 

For each list that you create, you define a so-called overview variant. You determine for this overview 

variant: 

- Which objects on the list the system should display, for example activities or sequences. 

- Which fields per object the system should display, for example dates and quantities. 

Standard settings 

Lists and overview variants are delivered with the SAP standard package. 

Activities 

You can read about the procedure to create your own list in the following sections. 

1. Create overview variants 

This section describes how to create overview variants. 

2. Define objects 

This section describes how you determine the individual objects which you want display on the list. 

3. Define fields 

This section describes how you select fields and determine the layout of the list. 

4. You can transport your settings. To do this, select Table view -> Transport. 

Creating Overview Variants 

You use an overview variant to make display settings in overviews. 

1. Select New entries and enter a key and a description for the overview variant. 

2. Specify the width of the key column for each overview variant. The key column does not move 

when you scroll. 

Note: The width of the key column is only used for object overviews. 

3. Define the maximum line length for each overview variant. 

4. Save your settings. 

Specify objects displayed in the overview 

Notes 

The sequence in which the individual objects appear in the overview is predefined by the application. 

Activities 

1. Choose an overview variant from the variant list and press Objects. 

2. Choose a line category, for example, New header. 

For each line category, you can choose different objects for the overview variant, such as activities. 

These objects are preset by the system and cannot be changed or influenced. 

3. Choose the objects and press Continue. 
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4. Specify whether the object line can be scrolled or not with the fixed indicator. Header lines should 

not be scrollable but column headers and item lines should be scrollable. 

5. Define the display attributes for the line category for each object: 

If you have specified the width of the key column, all fields within this width are displayed as 

standard with other display attributes, such as color and intensity. 

The values you specify are valid for the line background and are used as the standard settings when 

displayed in the overview. 

- You can choose between a wide variety of standard color and intensity combinations. 

- As an alternative, you can specify display attributes for key fields and other fields. 

6. Save your settings. 

Specify fields and layout 

Specify view to work with 

1. Select a line type and click on Fields. 

2. Specify the view with which you want to work.  You can select from the following: 

- Selection -> only field lines  

Only the lines occupied with fields are displayed.  You can use this view for the final 

inspection of the layout. 

- Selection -> Field lines + objects 

In addition to the field lines, the object names are displayed.  You can see the lines on which 

an object is displayed. 

- Selection -> Line + Obj. + Blank 

A blank line is displayed along with the object.  This may be helpful if you want to create new 

overview variants. 

Specify layout for object lines 

The following layouts are possible: 

- insert horizontal lines with a specific length 

- insert vertical lines 

- insert blank spaces with a specific length and color 

- select fields 

- change length of the field 

- move, copy and delete blocks of entries 

- change characteristics and output attributes 

- generate a heading for the line item 

- copy the layout of an object from another overview variant 

Inserting horizontal lines 

 1. Place the cursor at the desired position in the overview. 



 

 

The system takes you to a dialog box where you can specify the length. 

Inserting vertical lines 

1. Place the cursor at the desired position in the overview. 

2. Select the function key with the vertical line. 

Inserting blanks 

1. Place the cursor at the desired position in the overview. 

2. Select the function key with the blank. 

The system takes you to a detail screen where you can specify the length and standard attributes. 

Selecting fields 

1. Place the cursor at the desired position in the overview. 

2. Select Fields. 

The system displays a dialog box where you can specify the field type for the fields you want to 

insert. 

3. If you want to select several fields at the same time, you can use the indicator with vert. lines to 

specify whether a vertical line should be inserted between the fields. 

4. Select the desired fields and choose close. 

5. To move the fields in their order, 

- double click on the field and position the cursor where the field is to be moved 

- select move 

The field is inserted above the cursor. 

6. To delete fields in the selection list, 

- place the cursor on the corresponding field 

- select delete 

7. When you double click on table, you see a table with all of the fields you selected for the overview 

variant. Here, you can also maintain fields. 

Changing the length of fields 

1. To shorten or lengthen the fields, place the cursor where the field should end. 

2. Select change length. 

Moving, copying or deleting blocks of entries 

1. Place the cursor on the corresponding field. 

2. Press select block. 

3. If necessary, place the cursor on another field and press select block. 

4. Position the cursor to where you want the object moved and select move. 

Changing characteristics and output attributes 
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1. Place the cursor on the desired entry and select menu options Goto -> Details. You reach a 

dialog box where you can change characteristics and output attributes for an object. 

Generating a heading for a line item 

1. Place the cursor on the desired line item and select menu options Tools -> Create heading. 

Copying the layout of an object from another overview variant 

1. Place the cursor on the desired line and select menu options Tools -> Copy object. 

2. In the dialog box, enter the overview variant from which you want to copy the line item. 

26.1.4.3.9 Define Relevancy to Costing 

With relevancy to costing, you can define price factors for the indicator "relevancy to costing" depending 

on the valuation variant. Using these factors, the costs incurred for the bill of material item and the 

operation in the routing are modified and taken over into costing. 

The price factors are ignored in the following calculations: 

- standard cost estimate 

- calculation of the production order in the task list 

- calculation of the production order for the actual data. The indicator "Relevancy to costing" is then 

always interpreted with the factor 100%. 

Note 

With the "Relevancy to costing" key "x", the system always uses the price factor 100%. 

Actions 

1. If the price factors you want to define for the "Relevancy to costing" indicator are to be valid for all 

valuation variants, enter "+++". Otherwise, enter a relevant valuation variant. 

2. Enter an indicator for relevancy to costing. 

3. Assign price factors for fixed and variable costs to the indicator. 

26.1.4.3.10 Define (Standard) Trigger Point Usage 

In this step you define the usage for  standard trigger points or trigger points. 

With usage, you can combine (standard) trigger points randomly. 

A well-planned grouping of (standard) trigger points with usage offers the following advantages: 

- You create more clearly arranged trigger points. 

If you enter the usage when creating a trigger point, the system lists all of the standard trigger 

points with this usage. 

- You can recognize sooner which functionality a trigger point causes. You can combine, for 

example, all of the (standard) trigger points that cause similar functions by using usage. 

Activities 



 

 

Define the corresponding usages. 

26.1.4.3.11 Define Group for Standard Trigger Points 

You can combine several standard trigger points under one common term as a trigger point group. In 

addition, you can combine trigger point functions that are often carried out at the same time by using a 

trigger point group in order to minimize entries. 

Activities 

Define trigger point groups according to your needs. 

26.1.4.4 Routing Selection 

In this section, you determine the criteria used to select task lists (alternative task lists) in Production 

Planning and Control. 

You select a task list 

- when you create a task list using the copy function 

- when you create an order 

- in scheduling 

- in costing 

26.1.4.4.1 Define User Selection 

In this menu option, you can allow the selection of task lists by the the user. 

You can define your own ABAP/4 routines for each of the following parameters: 

- Task list application 

- Task list type 

- Selection ID 

These parameters are then processed automatically when task lists or alternative task lists are selected. 

Actions 

Determine the task lists the user can select. 

26.1.4.4.2 Select Automatically 

In this menu option, you can define selection IDs which identify selection criteria for the automatic 

selection of routings. 

You can define several selection priorities for each selection ID. You assign the selection criteria to these 

priorities. 
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In the automatic selection of routings the system searches for a routing that corresponds to the selection 

criteria. 

The selection criteria are: 

- routing type 

- routing usage 

- routing 

status 

If it cannot find a routing matching the criteria with the highest priority, it will continue to search using 

the criteria with the next highest priority and so on. 

Actions 

Define the selection criteria and their priorities for the desired selection ID. 

26.1.4.5 Assignment of Production Resources/Tools 

In this section, you make the appropriate settings in the system to assign production resources/tools. 

You can assign production resources or tools to individual operations in task lists and work 

orders. These assignments are described by a number of attributes. You can define default values for 

these attributes in the production resource/tool master data file. 

26.1.4.5.1 Define PRT Control Keys 

The PRT control key determines whether PRTs that are allocated to a task list or an order are included in 

the following business functions: 

- scheduling 

- costing 

- printing production orders 

- completion confirmation 

Actions 

Define your PRT control keys. 

26.1.4.5.2 Formulas 

In production resources/tools maintenance, formula parameters and formulas are used to calculate the 

total quantity or total usage value of a PRT required in an operation. 

When you use formulas to calculate the total quantity or usage value of a PRT, you can take the order lot 

size into account, for example. 



 

 

26.1.4.5.2.1 Define Formula Parameters 

Formula parameters are used in formulas for capacity planning, scheduling, costing, PRT management 

and determining standard values using CAPP. 

A formula parameter is identifeied by a parameter ID. Every formula parameter is linked with a 

particualr field either in Customizing, the routing or the work center. When the formula is evaluated the 

parameter takes the value of the field. 

Origin of Formula Parameters 

The assignment of a formula parameter to a data field is defined in the origin. You can refer to the data 

field in the work center or the routing via the parameter-ID or the key word that is assigned to every 

formula parameter and is displayed next to the the data field in the routing or work center. Formula 

parameters can have the following origins: 

- Standard Value 

Using the standard value key you provide the work center, and thus the routing, with up to six 

formula parameters that you assign values to in the routing operation. 

- Work Center Constant 

In the work center you can assign up to six work center constants a value and an unit. 

- General Formula Constants 

You can assign  general formuula constants a value and an unit in Customizing formula parameters. 

- General Operation Value 

The formula parameter is assigned to a data field in the general operation data, for instance the lot 

size or the base quantity. In this case you have to explicitly enter the field name. 

- User-Defined Field from Operation 

The formula parameter is assigned to an user-defined field in the operation. In this case the the 

assignment of the formula parameter is controlled by user-defined field key, that you define in 

Customizing the work center. The key words that describe the data fields are not defined in the 

formula parameters, but in the user-defined field key. 

- Value from PRT Allocation 

 You assign  the formula parameter to a field in the PRT alloaction, for instance the PRT quantity. 

- PRT constant 

You assign the formula parameter a fixed value in the PRT master record.This formula parameter 

can only be used for PRT management. 

Note: 

You enter the meaning of the fields in the key words for work centers and routings and not in the field 

names. 

Please note that this step is the prerequisite for the step Define rounding categories and additional values 

key in Customizing for CAPP standard value calculation. 

If you want to use the parameters in formulas you should use descriptive parameter IDs. 

- The value that you enter in the std. value field is only used to check the syntax of the formula 

(apart from general formula constants). The system does this automatically when you create a 

formula in Customizing. You should maintain this field, specially if a formula parameter is used as 

a divisor in a formula. Similiarly the Standard value unit field is only used for checking 

purposes. 

Actions 
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1. Define your formula parameters. 

2. Check the assignment of the formula parameters to the standard value keys. 

3. Check the use of the formula parameters in formula definitions. 

26.1.4.5.2.2 Define Formulas 

In PRT maintenance, formulas are used to calculate the usage value and the quantity required of 

a PRT. 

Note 

Formulas are also used in capacity planning, scheduling and costing to calculate capacity requirements, 

lead times and costs. 

Actions 

Define the formulas used in your company. 

26.1.4.6 Data Transfer Workbench: Routing 

Step 1: Generate tranfer structure 

In this step you generate the transfer structure (source desription of the table structure), which you can 

write in a sequential dataset. You can use this datset for data declaration in the transfer program. 

You use the tranfer program to write the required routing data from the present data processing system to 

a sequential file, from which batch input sessions are generated for data transfer. 

The SAP System generates the transfer structure in the following programming languages as desired: 

- "COBOL" 

- "C" 

- "PL/1" 

- "ASSEMBLER" 

The source desription has the following table structure: 

Record class  Structure name       Explanation 00            BI000             

Session record, contains information                                 about 

the session to be created 01            BIMPL             Material - 

routing assignment 

03 BIPKO             Header 

04 BIPTX             Long text - header 

05 BIPFL             Sequence 

06 BIPTX             Long text - sequence 

09 BIPPO             Operation 

10 BIPTX             Long text - operation 11            

BIPFH             Production resources/tools 



 

 

assignment 12            BIPTX             

Long text - PRT assignment 

13            BIPMZ             Material components 

assignment 99            BI001             Header records per 

tranaction, contains                                 the 

transaction code for the transaction                                 

to be carried out                                 "CA01" - 

Create routing 

                                "CA11" Create reference operation set 

Note 

Please refer to the documentation on report RCPTRA01. 

Activities 

If necessary generate source decriptions of the table structures for the transfer program. 

Step 2: Transferring Data 

In this step the data is transferred. 

Prerequisites 

You must have already created a sequential file containing the routing data from your present DP system 

and have made this file available to the SAP System. 

Activities 

1. Enter the name of the sequential file, that contains the routing data from the present system. 

The entry must be in the following form: 

/Path/Name of the sequential file 

2. Create the batch input sessions by executing the program. 

3. Run the batch input sesions. 

4. Test the transferred data. 

26.1.4.7 Define Matchcode for Routing 

In this menu option, you can define matchcodes for routings and assign any routing field to them. When 

you search for routings using a matchcode, you can limit the number of data records selected by entering 

data in these fields. 

You cannot use the transport functionality for matchcodes. 

Default settings 

SAP delivers various matchcodes in the standard system. 

Recommendation 

Generating a new matchcode for many data records slows down system performance. Therefore, you 

should generate matchcodes at a time when the system workload is low. 

Action 
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 1. Check the existing matchcodes. 

If necessary, define additional matchcodes for routings. 

26.1.4.8 Archiving: Create Enhancement for Usage Check 

You can use the following SAP Enhancement to archive and delete routings: 

   CPRE0001   customer-specific enhancement for usage check when                     

archiving routings 

You can use this enhancement to define individual criteria to select routings which will not be archived 

or deleted. 

Enhancement CPRE0001 contains the following enhancement component: 

   EXIT_SAPLCPRE_001 

Activities 

1. Create the enhancement. 

Either create a new project or use an existing one. 

2. Edit the enhancement component: 

Insert function exit EXIT_SAPLCPRE_001 to the program coding. This exit takes the data from the 

SAP standard program to your individual program portion and later transfers the changed data back 

to the SAP standard program. 

To do this, call the function module and double-click on the include line. Create the include 

module. 

3. Activate the project. 

Your enhancement is effective once the project is active. 

Further notes 

In contrast to modifications, enhancements are generally not affected by release since they are not in the 

SAP Standard package but are reserved for customers for specific applications. 

26.1.5 Line Design 

In this step, you define the settings for printing operational method sheets. 

26.1.5.1 Operational Method Sheet 

In this IMG activity, you define templates (layouts) with which you can print exact operational method 

sheets for one or more operations of a rate routing, standard routing or inspection plan. You can print an 

operational overview cover sheet with one or more pages per operation, in which you can include the 

following data: 



 

 

- tables containing operation data, component allocations, production resources/tools or inspection 

characteristics 

- graphics displaying the work flow procedure, for example 

- data on the individual fields from the rate routing, such as the description of a processing station or 

data from the task list header. 

In order to set up for printing, define a layout in the SAP system that specifies the data to be included in 

the printout. In this layout you can define one or more tables and set the number of graphics that you 

want to in appear in the printout. 

To print an OMS, you need to use Microsoft Word 97. You generate a document in which you create and 

format the tables defined in Customizing for the OMS.  In addition you can insert links to the graphics 

and to the individual fields in the document. 

On printing, the SAP system sends the data to Microsoft Word and thereby fills the tables, inserts the 

graphics and then prints the document. 

Before you begin printing, you can define the routings and line segments, for which you want to print an 

OMS, using extensive selection criteria. For example, you can print an OMS for all materials that are 

produced on the production line or on a specific line segment. You can also only print an OMS for 

several materials if the operations in the routing do not differ for these materials. 

These detailed operational methods allow you to plan your personnel capacity flexibly using job rotation, 

as your employees can learn new activities quickly, using the OMS directly at the production line. 

Requirements 

Setting up the word processing system 

To ensure smooth interaction between the SAP system and the word processing system, set the Options 

in Word 97, proceeding as follows: 

1. Choose Tools -> Options. 

The dialog box Options appears. 

2. Choose the tab page General, and de-select the indicators Update automatic links at Open and 

Macro virus protection. 

3. Choose the tab page Print and de-select the indicator Update links. 

4. Choose OK and exit Word. 

Creating graphics in the system 

Create the graphics in the system, which you want to print.  You can use graphics with the graphic 

formats BMP, GIF and JPG. 

1. First of all check in Customizing for the document administration system whether the workstation 

applications are defined for the appropriate graphic formats. Pay attention to the following in the 

detail view: 

a) If you want to print bitmaps, you must have the file suffix BMP and MIME type image/x-ms-

bmp . 

b) If you want to print GIF files, you must have the file suffix GIF and MIME type image/gif. 

c) If you want to print JPEG files, you must have the file suffix JPG and MIME type 

image/jpeg. 

2. Create the graphic as a document in the SAP Document management system.  In the group 

Original, enter the work station application that is defined in Customizing and then choose the 

storage data of the graphic. Finally release the document. 
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3. Afterwards create this document as a production resource/tool and assign it to the corresponding 

operation in the rate routing. For the production resource/tool number enter only a number from a 

specific number area (e.g. 800-900) in order to differentiate between the graphics and other 

documents, which you have also created as production resources/tools. You must enter this area 

later, when you create a layout in the SAP system. 

Recommendation 

- As a rule, operational method sheets have the same layout enterprise- wide.  Therefore you 

should first of all create a layout as template, in which you can enter general data, such as the 

company logo or page format settings. You can then copy this template for all other layouts 

that you want to create. 

- If you want to print several operations in one step, you can create an additional layout that you 

use for printing a cover sheet. 

Activities 

You must carry out the following steps to print an OMS: 

Creating layout in the SAP system 

- First of all create a new template in the work step Header data template, by 

- selecting New entries 

- entering the name and the description of the template 

- entering the maximum number of graphics that you want to print per operation 

- entering the number area of the production resources/tools, in which you have placed the 

graphics 

- Save your entries. 

- In the work step Table assignment define the tables that you would like to print for each 

operation. Enter the following data: 

- a key for the table (freely definable) 

- the table, which sends the data to MS Word.  You can, for example, choose the table OPR 

(operation data) 

- the current Table number in the Word document 

- whether the system is to  automatically adjust the number of lines in the table in the 

Word document 

- which row is the First row of data in the Word document table - Save your entries. 

- In the work step Field assignment, assign the field name of an table in the SAP system to 

each column of the Word table. On printing, this field provides the data to Microsoft Word. 

- Save the layout so that you can edit the document in MS Word. 

Creating a document in Microsoft Word 97 



 

 

Select a template and then the function key Template to begin Microsoft Word. The system 

automatically opens an empty document template in Microsoft Word, which contains the macros 

necessary for printing.  Therefore you should always begin Word from Customizing for OMS. 

Create the following objects in the Word document: 

For each table that you have already defined in Customizing, create a table in Word.  Note that Word 

numbers the tables in columns from top to bottom and from left to right. You must insert the tables in 

such a way that the table number corresponds to the number which you have entered in the template in 

the SAP system. 

If you subsequently insert a table into a Word document, Word renumbers all following documents and 

you must update the layout in the SAP system. 

1. Insert links (placeholder) in the document for the graphics that you would like to print. 

a) To do so, select the function key Link and then select the desired graphic from the selection 

list.  Whilst doing so, keep Microsoft Word constantly open in the background. 

The graphics have the key 'PS_PICTURE' followed by a two figure number. 

b) Choose Copy to clipboard.  The system inserts the links onto the clipboard. 

c) Change to Microsoft Word and place the cursor on the place in the document in which you 

would like to insert the link. 

d) Then choose Edit -> Insert contents. A dialogue box appears. 

e) Choose  Links. 

f) Choose OK. 

You have inserted the link. 

g) As well as links to graphics, you can also insert links to individual fields of a table in the SAP 

system. To do so, proceed as for inserting graphics. The selection list contains all fields of the 

tables of operation data OPR and task list header data TSK. 

You can insert all fields with a name beginning with OPR- or with TSK-. You should 

only insert operation data with templates for printing operations, since with cover sheets there 

is no operation assignment and the system cannot fill the field with data. 

You should only insert task list header data if you are printing an OMS for one material or from one 

routing only. Otherwise the system cannot assign the task list header data clearly. Instead, insert a 

table in the template if you would like to work with several materials and various routings. 

h) After you have inserted all objects and the data has been received from the SAP system, you 

can format the tables and if necessary insert further objects such as your company logo, for 

example. Word then prints these objects with every operation. 

2. You can save the layout and the document simultaneously in Microsoft Word by choosing Save. 

26.1.6 Engineering Workbench 

In this section you define the settings for the component Engineering Workbench. 

26.1.6.1 Edit Working Areas 

In this work step you define for the working environments in the Engineering Workbench, 
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- Which usage area is envisaged (for example general production) 

- Which Focus is used 

The focus determines, which object type are referred to by the selection criteria that the user enters. 

- Which object types should be included in the working area 

Only those object types that are included in the working area can be displayed and edited in the 

Engineering Workbench. A tab page is available for these object types on the selection criteria 

screen. 

- Whether and which default values should be proposed 

In doing this the default values are summarized by a profile 

Requirements 

Profiles that you want to use already have to exist in the system. 

Activities 

1. When you are creating the working area: enter its usage area. 

2. If default values should be proposed to the users of the working area: enter a profile. 

3. Select the focus. 

4. Select the object types that should be included in the working area. 

In doing this you should note that the object hierarchy forces particular combinations. For example: 

If you want to include the operation object type in the working area, you also have to include the 

sequence and task list header object types (see also: "further notes") 

5. Save the working area. 

Further notes 

The following rules apply for including object types in the working area: 

- You have to include at least one of the task list header and BOM header object types in the 

working area. 

- If an object type in a routing (for example: operation) is included in the working area, the 

hierarchically superior object types in a routing (for example: sequence) must also be included in 

the working area. The same correspondingly applies for an object type in a bill of material. 

- If both the task list header and BOM header object types are included in the working area, the 

material-routing allocation object type must be included in the working area (and vice versa). 

- If both the operation and item object types are included in the working area, the component 

assignment object type must be included in the working area (and vice versa). 



 

 

26.1.6.2 Edit Layouts for Printing with MS Word 

In this IMG activity, you define templates (layouts) with which you can print header and operation data 

via Microsoft Word 97. 

Depending on the layout, one or more pages can be printed per header or operation, which you select in 

the Engineering Workbench. A layout can include the following data: 

- Individual header or operation data, such as description of the work center 

- Tables, operation data, component assignments, production resources/tools or inspection 

characteristics 

- Graphics 

You proceed as follows: 

1. You define a layout in the ERP system. 

2. You define one or more tables. 

3. You set the number of graphics you want to appear in each printout. 

4. You create a Word document. 

5. You create the tables defined in the layout and format them. 

6. You create links to the graphics and individual fields. 

Then you can begin printing from the Engineering Workbench. The ERP system sends the data to 

Microsoft Word and thereby fills the tables, inserts the graphics and then prints the document. 

Requirements 

Setting up Word 97 

To ensure smooth interaction between the ERP system and Microsoft Word 97, set the Options in Word 

97, proceeding as follows: 

1. Choose Extras -> Options. 

The Options dialog box appears. 

2. Choose the tab page General, and de-select the indicators Update links automatically and 

Display macro warning. 

3. Choose the tab page Print and deselect the Update links check box. 

4. Choose OK and exit Word. 

Creating graphics in the ERP system 

Create the graphics that you want to print in the ERP system. You can use graphics with the graphic 

formats BMP, GIF and JPG. 

1. First of all check in Customizing for the document management system whether the workstation 

applications are defined for the appropriate graphic formats. Pay attention to the following in the 

detail view: 

a) If you want to print bitmaps, you must have the file suffix BMP and MIME type image/x-ms-

bmp . 

b) If you want to print GIF files, you must have the file suffix GIF and MIME type image/gif. 
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c) If you want to print JPEG files, you must have the file suffix JPG and MIME type image/jpeg. 

2. Create the graphic as a document in the ERP Document management system.  In the group 

Original, enter the work station application that is defined in Customizing and then choose the 

storage data of the graphic. Finally release the document. 

3. Afterwards create this document as a production resource/tool and assign it to the corresponding 

operation in the rate routing.   For the production resource/tool number enter only a number from a 

specific number area (e.g. 800-900) in order to differentiate between the graphics and other 

documents, which you have also created as production resources/tools. You must enter this area 

later, when you create a layout in the ERP system. 

Recommendation 

If you want certain printouts, such as operational method sheets, to have the same layout enterprise-wide, 

you should first of all create a layout as template, in which you can enter general data, such as the 

company logo or page format settings. You can then copy this template for all other layouts that you 

want to create. 

If you want to print several operations in one step, you can create an additional layout that you use for 

printing a cover sheet. 

Activities 

To print header or operation data via Microsoft Word 97 you first create a layout in the ERP system and 

then a Word document. Proceed as follows: 

Creating a Layout in the ERP System 

1. First of all create a new template in the work step Header data template, by 

a) Choosing New entries 

b) entering the name and the description of the template 

c) entering the maximum number of graphics that you want to print per operation 

d) entering the number area of the production resources/tools, in which you have placed the 

graphics 

e) Save your entries. 

2. In the work step Table assignment define the tables that you would like to print for each 

operation. Enter the following data: 

a) a key for the table (freely definable) 

b) the ERP table that sends the data to Word. 

You can, for example, choose the table OPR (operation data) 

c) the current Table number in the Word document 

You should also enter 

d) whether the system is to automatically adjust the number of lines in the table in the Word 

document 

e) which row is the First row of data in the Word document table 

3. Save your entries. 

4. In the work step Field assignment, assign the field name of an ERP table to each column of the 

Word table. On printing, this field provides the data to Microsoft Word. 



 

 

5. Save the layout so that you can edit the document in MS Word. 

Creating a document in Microsoft Word 97 

6. Select a template and then the function key Template to begin Microsoft Word. The system 

automatically opens an empty document template in Microsoft Word, which contains the macros 

necessary for printing.  Therefore you should always begin Word from Customizing for OMS. 

7. Create the following objects in the Word document: For each table that you have already defined in 

Customizing, create a table in Word. 

Note that Word numbers the tables in columns from top to bottom and from left to right. You must 

insert the tables in such a way that the table number corresponds to the number which you have 

entered in the template in the ERP system. 

If you subsequently insert a table into a Word document, Word renumbers all following documents 

and you must update the layout in the ERP system. 

8. Insert links (placeholder) in the document for the graphics that you would like to print. 

a) To do so, select the function key Link and then select the desired graphic from the selection 

list. Whilst doing so, keep Microsoft Word constantly open in the background. 

The graphics have the key 'PS_PICTURE' followed by a two figure number. 

b) Choose Copy to clipboard.  The system inserts the links onto the clipboard. 

c) Change to Microsoft Word and place the cursor on the place in the document in which you 

would like to insert the link. 

d) Then choose Edit -> Insert contents. 

A dialog box appears. 

e) Choose Links. 

f) Choose OK. 

You have inserted the link. 

9. As well as links to graphics, you can also insert links to individual fields of an ERP table. To do so, 

proceed as for inserting graphics. The selection list contains all fields of the tables of operation data 

OPR and task list header data TSK.  You can insert all fields with a name beginning with OPR- or 

with TSK-. 

10. After you have inserted all objects and the data has been received from the ERP system you can 

format the tables and if necessary insert further objects such as your company logo, for example. 

Word then prints these objects with every operation. 

11. You can save the layout and the document simultaneously in Microsoft Word by choosing Save. 

26.1.6.3 Define Field Selection for the Engineering Workbench 

In this work step, you can carry out the field selection for the Engineering Workbench. 

Modifiable and influencing fields are defined for each screen group: 

- For modifiable fields, you use an indicator to determine how the individual fields appear on 

the screen: 
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- The field is ready for input (default setting) 

- The field requires an entry (required entry) 

- The field is only for display 

- The field is hidden 

- The field is displayed brightly 

- For the influencing fields you determine, dependent on a value, how the modifiable field 

appears on the screen. 

Notes 

The setting for the field selection can be transported and are not affected by Release changes or upgrades. 

When you change an influencing field, a modified field becomes obligatory (a required entry), however, 

the system does not check whether this field is filled in all the existing objects. 

Required fields determined by the application can not be modified. 

Standard settings 

No default settings are delivered for the field selection. 

Further notes 

The modifiable and influencing fields are predefined for each screen group and can not be extended. 

Activities 

You can define a field selection in several ways. 

You maintain the indicator of a modifiable field, independent of an influencing value 

1. Choose Screen group. 

2. Place the cursor on the screen group. 

3. Select the function key Modifiable. 

All the fields that you can modify for this screen group appear on the screen. 

4. Maintain the indicator and save your entries. 

You maintain an influencing value for an influencing field and then the indicators for the 

modifiable fields 

1. Choose Screen groups. 

2. Place the cursor on the screen group. 

3. Select the function key Influencing. 

All the fields for which you can maintain influencing values appear on the screen. 

4. Double click to select the influencing field for which you want to maintain a value. 

All the fields, for which an influencing value can be modified, appear on the screen. 

5. Maintain a value in the field Influencing value and maintain the corresponding indicator for the 

modifiable field. 

6. Click Enter. 

The entries are copied. 



 

 

7. Maintain other values for the influencing field or use the function key Influencing to select other 

fields. 

8. Save your entries. 

You maintain an indicator for a modifiable field and determine the value of the influencing field 

aswell 

1. Choose Screen groups. 

2. Place the cursor on the screen group. 

3. Select the function key Modifiable. 

All the fields that you can modify for this screen group appear on the screen. 

4. Double click to select a modifable field for which you want to maintain influencing values. 

All influencing fields appear on the screen. 

5. Place the cursor on the influencing field for which you want to define a value and select New 

values. 

A dialog box appears on the screen. 

6. Maintain the value and indicator for the influencing field and select Continue. The values are 

copied. 

7. Save your entries. 

26.1.7 Integrated Product Engineering 

26.1.7.1 Connection to Collaboration Projects 

26.1.7.1.1 Determine RFC Destination with Systems Linked to iPPE 

Use 

In this work step, you create the connection between the iPPE system and other systems. 

Currently, you can only assign logical cProjects systems. 

Requirements 

You have defined the logical systems that you want to use as RFC destinations, under Tools -> 

Administration -> Administration -> Network -> RFC Destinations. 

Activities 

To assign a new system, proceed as follows: 

1. Choose New Entries. 

2. Specify the type of the logical system (for cProjects systems, this is CPRO). 

3. Specify the logical system and the RFC destination. 
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The logical system describes the RFC destination with which APIs in the source system of a linked 

object can be called via the SAP RFC interface. The logical system and the RFC destination are 

identical. If the cProjects application and the iPPE application are in the same logical system, you 

enter NONE as the RFC destination. 

4. Save your entries. 

26.1.7.1.2 Assignment of Object Link Types from cProjects to iPPE Object 

Types 

Use 

In this activity, you define additional assignments of cProjects object link types to iPPE node types and 

iPPE variant types. 

For every obect link type defined in cProjects, you determine which iPPE object types are valid for it. In 

addition, for every cProjects object link type, you specify the logical destination of the cProjects system 

in which this object link type was defined. 

To conduct automatic checks (such as existence, authorization, and consistency checks) from the iPPE 

system upon creation or deletion of a line, you use a shadow object link type. 

Requirements 

You have defined the logical system in Customizing under Production  -> Basic Data -> Integrated 

Product Engineering -> Connection to cProjects -> Determine RFC Destination with Systems 

Linked to iPPE. 

In the cProjects system, you have created and activated the object link types and shadow object link types 

that you want to use. 

Standard settings 

The standard system contains the cProjects object link types that are available as of PPIM 4.5 in 

cProjects, as well as an assignment of the iPPE object types that are valid for them. 

You can use the delivered cProjects object link types and the assigned iPPE object types to display the 

assignments between the cProjects tasks and cProjects checklist items to the following iPPE object 

types: 

- 0IPPECMPNODE (iPPE CMP node object types) 

Structure node, assembly group, focus structure node, and focus assembly group 

- 0IPPECMPVARIANT (iPPE CMP variant object types) 

Component variant, assembly header, assembly item, focus variant, focus assembly header, and 

focus assembly header item 

- 0IPPECONVARIANT (iPPE concept (CON) variant object type) 

Concept 

- 0IPPEFOCUS (iPPE focus object type) 

Focus 

You can also assign your own iPPE object types to these if they are derived from one of the iPPE object 

types specified. 

Activities 



 

 

To create a new link between a cProjects object link type and an iPPE object type, proceed as 

follows: 

1. Choose New Entries. 

2. Enter the technical name of the cProjects object link type. 

3. Enter the application that belongs to the iPPE object type that is to be assigned. 

4. Enter the iPPE object category (Node, Variant, or Focus). 

5. Enter the iPPE object type (iPPE node type or iPPE variant type). The value help offered for the 

specialized iPPE object type depends on the previously-specified application and on the iPPE object 

category. 

6. Enter the logical system in which the cProjects object link type is defined and which contains the 

cProjects tasks and checklist items that you want to assign. 

7. Enter the cProjects shadow object link type. 

8. Save your entries. 

To assign your own iPPE object types to the object link types contained in the standard system, proceed 

as follows: 

1. In the cProjects system, edit the activities in Customizing for cProjects under Collaboration 

Projects -> Connection to External Systems -> Object Links in SAP Systems. 

For more information, see the Installation Guide Collaboration Projects (cProjects): Guide for 

Implementing an Object Link on SAP Service Marketplace. 

2. Then proceed according the steps described above. 

Note 

The namespace 0 is reserved for the delivered cProjects object link types. Therefore, you cannot define 

any cProjects object link types whose names begin with 0. 

26.1.7.1.3 BAdI: Customer-Specific Options for iPPE-cProjects Object Link 

Use 

The Business Add-In (BAdI) IPPE_CPRO_EXT in the iPPE_CPRO enhancement spot is used in the 

Integrated Product and Process Engineering (iPPE) component. 

You can use this BAdI to enhance the displayed attributes of a linked cProjects object (task or checklist 

item) in iPPE Workbench. You can also conduct further authorization checks for the cProjects object. 

Requirements 

You have included the attributes to be displayed in the structure of the Customer Include 

CI_PPE_CPRO_TASK and/or CI_PPE_CPRO_CKLITEM. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 90 

- Note that the Business Add-In can be used more than once and therefore all active implementations 

are called and executed. 

- The Business Add-In is not filter-dependent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

This BAdI uses the IF_EX_IPPE_CPRO_EXT interface. For more information, display the interface in 

the Class Builder. 

26.1.7.2 General Settings 

26.1.7.2.1 Define General iPPE Customizing 

Use 

In Define General iPPE Customizing, you make one-off settings for Integrated Product and Process 

Engineering (iPPE). These settings should not be changed once the system is in operation. 

You can make settings for the following areas: 

- General iPPE Customizing: 

The settings you make here concern the way iPPE cooperates with other systems and functions. 

- Define PVS Parameter: 

The settings you make here concern the maintenance of variants in the product variant structure. 

You can define whether the class type 300 is to be used as the standard value in iPPE. If you enter a 

class type here, you cannot enter a class type in the iPPE Workbench when you create or edit iPPE 

objects; the system automatically proposes the class type 300. 

- Define Color Supplement Key: 

The settings you make here concern the maintenance of color nodes (color scheme) and color 

variants. 

When you make the settings for the color offset and the length of the color supplement 

key, You need to be aware that with the SAP Advanced Planner und Optimizer that - the 

material numbers of the colored materials ALWAYS have the same length. 

- the color neutral components always have the same length as the colored components, and that the 

component of the material number, which is filled via the color supplement key, appears as a 

phantom. 

This is necessary to prevent problems during transfer to the SAP APO System. 

- Define Start-Up Parameters: 

Start-up parameters control whether you can use a component variant with a change number and a 

future effectivity in an earlier phase of production. This is the case when a characteristic value 



 

 

defined in the classification system is also defined as an effectivity parameter in Engineering 

Change Management and is used in a change number. 

- Effectivity Parameter Description: 

The settings you make here control that the effectivity parameter used for effectivity type PVSECM 

in Engineering Change Management correspond to those used for the configuration simulation in 

the iPPE Workbench. The effectivity type PVSECM is provided as standard. 

- Events and Change Documents: 

The settings you make here control whether the corresponding functions are active or inactive. 

Do not change the settings once the system is in operation. 

When you want to transfer products to APO, you can assign these a key via the user exit APOCF005 that 

indicates from which system the product/ material comes from. 

Standard settings 

The following settings are provided as standard: 

- The field Explosion Type for Component Variants has the value History by Valid-From Date. 

- The field Class Use has the value Class Differentiation. 

- The field Color Offset has the value 15 and the length of Color Supplement Key is 3. 

Activities 

To make general settings: 

1. From the Cross-Application Components Customizing, choose Integrated Product and 

Process Engineering (iPPE) -> Define General iPPE Customizing. The screen General iPPE 

Customizing Display / Change will appear. 

2. Make the required settings. 

3. Save your entries. 

26.1.7.2.2 Enhanced Dependency Editor 

26.1.7.2.2.1 Activate Enhanced Dependency Editor 

Use 

This IMG activity activates the Enhanced Dependency Editor for creating and maintaining object 

dependencies. 

26.1.7.2.2.2 Create Schema for Extended Dependency Editor 
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Use 

In this IMG activity, you can create schemes to work with the Enhanced Dependency Editor. A scheme 

controls the appearance of the interface for the Enhanced Dependency Editor, and how syntax is 

displayed here. 

You have the following options: 

- You can determine if you want to use SAP syntax or your own syntax. 

- You can determine if you want to use the variance scheme and the information to help with 

completion. The variance scheme will only be displayed in the iPPE Workbench. 

- For the syntax, you can define 

- the sequence of characteristics if several characteristics are being used. 

- which characters the logical operators should be displayed with. 

- the sequence of the values if several values are used. 

- For the interface, you can determine how the object dependency will be displayed and input on the 

interface. 

Requirements 

You are working with the Enhanced Dependency Editor and have activated the Editor in the processing 

step Activate Enhanced Dependency Editor. 

Standard settings 

The following schemes are included in the SAP standard system: 

- S_GEN_CUS: 

Scheme for the maintenance of object dependencies in the form of customer syntax for all 

applications outside the iPPE Workbench. 

- S_GEN_SAP: 

Scheme for the maintenance of object dependencies in the form of SAP syntax for all applications 

outside the iPPE Workbench. 

- S_IPPE_CUS : 

Scheme for the maintenance of object dependencies in the form of customer syntax in the iPPE 

Workbench. 

- S_IPPE_SAP: 

Scheme for the maintenance of object dependencies in the form of SAP syntax in the iPPE 

Workbench. 

Please use the standard schemes provided by SAP. 

Further notes 

To use the variance scheme and the information to help with completion in the iPPE Workbench 

- Variance Scheme: 

In a variance scheme, you determine which characteristics and which values are used at the variants 

of a structure node in the object dependency. 



 

 

The variance scheme can only be viewed in the iPPE Workbench. If you set this indicator in a 

scheme that you are using for another application, you will not be able to view the variance scheme. 

- Information to Help With Completion: 

With the information to help with completion, you can check if all the values of characteristics 

available in the variance scheme of the node are actually being used in the object dependencies. 

Information to help with completion will verify if any errors appear in the list. 

26.1.7.2.2.3 Assign Schema 

Use 

In this IMG activity, you define which schema of the extended dependency editor is active for the iPPE 

workbench and for all other applications. 

Requirements 

- You are working with the extended dependency editor and have activated it in the following 

activity: Activate Extended Dependency Editor. 

- You have defined a schema in the following activity: Create Schema. 

Further notes 

Note that a maximum of two schemas can be active in the system: one schema for the iPPE workbench 

and one schema for other applications. 

26.1.7.2.3 Define Settings for Access Object 

Use 

In this activity you define which usage can be combined with which access type. The usage controls the 

way the product structure is exploded. 

In iPPE there are two types of access; simulative (engineering accesses) and production (productive or 

operative accesses). 

The usage ENG allows you to create accesses with or without a material and maintain concept accesses. 

You can explode structures for these accesses for simulation purposes. 

The usage PRD represents accesses that are required for production. You can use accesses that have the 

usage PRD in production versions. 

Standard settings 

Two access usages are included in the standard system: 

- ENG (Engineering/Design) 

The system automatically proposes this usage for each variant on the Accesses tab page. 
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- PRD (Production) 

You can select this usage on the Accesses tab page. This usage is for simulating productive 

explosions. 

You can change the standard usages, but you cannot extend their properties beyond those provided as 

standard. 

Activities 

1. In the SAP Implementation Guide, choose Production -> Basic Data -> Integrated 

Product and Process Engineering -> iPPE Product Structure Administration -> 

Maintain Setting for Access Object. 

2. The screen Change View "Settings for Access Object": Overview appears. 

26.1.7.2.4 Define Status 

Use 

In this section, you define which iPPE objects are subject to status management. In status management, 

you define certain states that an object must reach before the next business processes can begin. You can 

shape the status management for each object individually. 

Activities 

You define a status in the following way: 

1. In the SAP Reference IMG, choose Cross-Application Components -> Integrated Product and 

Process Engineering -> General Settings -> Define Settings for Status Management. 

The screen Change View "Status IDs": Overview appears. 

2. Select New Entries. 

3. Enter a key and a description for the status and save your entries. 

4. Select the status and choose Status Values. 

The screen Change View "Status Values": Overview appears. 

5. Select New Entries. 

6. Enter the keys, meanings, and if required, icons and descriptions for the values that your status can 

have. 

7. Choose Status Preconditions if you wish to define preconditions. 

8. Select New Entries. 

9. Enter a key and a description for each precondition and state whether it must be fulfilled or not. 

10. Select Status Object Types. 

11. State the iPPE objects to which this status is to apply. 



 

 

12. Select Status Predecessors if your status builds on other statuses that must be fulfilled first. 

13. Enter the preceding status and state whether it has to be fulfilled. 

14. Save your entries. 

Note 

If you create a status for an assembly item or component variant that is assigned above the superior node 

of a product class, the system always creates the same number of status graphs as the number of classes 

that exist in the associated product class hierarchy. 

For example, node C1 has the class CL1 (of class type 300). Class C1 is assigned two subclasses, CL11 

and CL12, in the class hierarchy. For variant V1 of the node C1, the system then assigns three status 

graphs for the classes CL1, CL12, and CL13. 

Example 

Status 0001 (released for construction) for component variants: 

Status 0001 can have the following values: 001 for initial and 002 for successful. This shows that a 

component variant is either released or not released for construction. 

The precondition 001 (DMU data available) must be fulfilled before the status 0001 can be set to 002 

(successful). You can specify whether this precondition must be fulfilled (cannot be overridden) or may 

be fulfilled (can be overriden with warning). In the latter case, the status can achieve the value 

'successful' even if the precondition has not been fulfilled. 

Status 0001 is valid for component variants (S_CSMPST), and is automatically used for all component 

variants created in the system. 

If the component variants have to reach various different statuses and be released, you can state whether 

the status has preceding statuses that must be fulfilled. 

26.1.7.3 iPPE Object Administration 

26.1.7.3.1 Define General iPPE Node Types 

Use 

In this activity, you can define additional iPPE node types. You define the characteristics that a certain 

iPPE node type is to have, and the name of iPPE nodes of this type. 

Standard settings 

The standard system includes the superset of possible iPPE node types. You cannot change the attributes 

of the standard node types. You use the standard node types to represent master data in all the iPPE 

applications (product variant structure, process structure, and factory layout). The standard iPPE node 

types are: 

Product Variant Structure Variant Assembly   Joint Production 

Access Node            Assembly Node      Header (Joint Production) 
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View Node                

Production) 

Structure Node 

Color Scheme 

VA Structure Node  Item Group Joint 

Process Struct. (Shop Floor) (SNP/CTM) 

Process Struct. (Line) Process Struct. 

Routing Header         Routing (Line)      SNP Routing Header 

Grouping Activity    Subrouting (Line)  SNP Activity 

Operation               Operation (Line) 

Activity               Activity (Line) 

Line Design 

Line Network 

Line 

Group of Alternative Lines 

Line Area 

Line Segment 

Buffer 

Work Area 

Intermediate Buffer 

When you create a new node type, you must use one of the SAP standard nodes as a template. However, 

you cannot create new node types that would change the attributes of existing node types. 

The namespace S is reserved for the standard iPPE node types. This means you cannot create node types 

with technical names that begin with the letter S. 

Recommendation 

Use the standard iPPE node types. 

Activities 

To create a new iPPE node type: 

1. Choose Customizing for Cross-Application Components  -> Integrated Product and Process 

Engineering (iPPE) -> Administration for iPPE Objects -> Define iPPE Node Types -> 

Define iPPE Node Types . 

The screen Change iPPE Node Types: Overview appears. 

2. Choose New Entries. 

The screen New Entries: Details of Added Entries appears. 

3. Enter the technical names for the new node type. 

4. Enter the node type whose attributes you wish to copy to the new node type, and choose Enter. 

The attributes of the reference node type are displayed for the new node type. The fields you can 

change are ready for input. 

5. Enter data as required and save your entries. 



 

 

Further notes 

You can also create new node types by selecting existing nodes and choosing @2U@ Copy As. 

If nodes of an iPPE node type have been created in the system, you cannot delete the iPPE node type. If 

the node type is used in iPPE, you cannot change the attributes. 

For structure nodes from the PVS, it is possible that relationships point from this node type directly to 

lower-level structure nodes, or from alternatives of the structure node to lower-level structure nodes. 

You can make settings for both possibilities in Customizing. However, if you create an alternative for an 

existing structure node, which already has relationships to lower-level structure nodes, the system 

automatically reassigns all such relationships to the alternative. 

26.1.7.3.2 Define iPPE Variant Types 

Use 

In this step, you can define the variant types for the node types that you have already defined in step 

Define General Node Types. 

You can use a variant to document if a node can have various concrete characteristics. When you 

maintain data in the iPPE Workbench, the variant that belongs to the node is automatically selected. 

Standard settings 

The variant types included in standard Customizing allow you to build the structures for all applications 

in iPPE. The following variant types are included in the standard Customizing: 

- Product Structure 

- Access Variant 

- Item Variant 

- Assembly Header 

- Assembly Item 

- Color Variant 

- Focus 

- Focus Access Variant 

- Focus Variant 

- Focus Assembly Header 

- Focus Assembly Item 

- Focus Color Variant 

Activities 

You create new variant types as follows: 
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1. In the Customizing of Cross-Application Components, choose Integrated Product and 

Process Engineering (iPPE) -> Administration iPPE Objects -> Define iPPE Variant Types. 

The screen Change iPPE Variant Types appears. 

2. Select New Entries to create a new entry. The screen New Entries: Details appears. 

3. Enter the necessary data. 

4. Save your entries. 

26.1.7.3.3 Define iPPE Alternative Types 

Use 

In this step, you define alternatives for the nodes that you have defined in step Define General Node 

Types. 

An alternative documents, for example, that a node and its structure can be assembled differently in 

different plants. When you maintain data in the iPPE Workbench, the system automatically selects the 

relevant alternative for the node. 

Standard settings 

The alternative types that are included as standard allow you to build structures for all iPPE applications. 

The following alternative types are included as standard: 

- Product Structure: 

- PVS Access Alternative Segment (Access Node) 

- PVS Structure Alternative Segment (Structure Node) 

- Variant Assembly Alternative 

- Assembly Alternative 

- Focus Product Structure: 

- Focus Variant Assembly Alternative 

- Focus Assembly Alternative - Process Structure: 

- Mode Process Structure (Line) (Technical Name: S_ACTSTM) - Mode Process 

Structure (Workshop) (Technical Name: S_PPMSTM) - Line Structure: 

- Alternative Line 

- Alternative Work Center 

- Part of Line Network 

Use the alternative types provided by SAP. 

Activities 



 

 

To create new types of alternatives, proceed as follows: 

1. In the Customizing of Cross-Application Components, choose Integrated Product and 

Process Engineering (iPPE) -> Administration iPPE Objects -> Define iPPE Alternative 

Types. 

The screen Change View "iPPE Alternative Types" appears. 

2. To make a new entry, choose New Entries. The screen  New Entries: Details appears. 

3. Enter the required data. 

4. Save your entries. 

26.1.7.3.4 Define General iPPE Relationship Types 

Use 

You define iPPE relationships in this activity. You use relationships to link objects that you created in the 

activities Define General iPPE Node Types, Define iPPE Variant Types, and Define iPPE 

Alternative Types. You link objects to build up the complete structure for Integrated Product and 

Process Engineering (iPPE). 

As soon as you link two nodes to one another in the iPPE Workbench, the system automatically assigns 

the appropriate iPPE relationship type. 

You cannot delete iPPE relationship types that are already being used. 

Standard settings 

The relationship types provided as standard by SAP enable you to set up all structures in Integrated 

Product and Process Engineering (iPPE). 

Use the standard relationship types. 

Activities 

To create new relationship types, proceed as follows: 

1. In Customizing, choose Cross-Application Components -> Integrated Product and Process 

Engineering -> iPPE Object Administration -> Define iPPE Relationship Types. 

The screen Change iPPE Relationship Types appears. 

2. To create a new relationship type, choose New Entries. The screen New Entries: Detail appears. 

3. Enter the necessary data. 

4. Save your entries. 

26.1.7.3.5 Create Model Assignments 
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Use 

In this activity, you can define which node types can have variants and alternatives. 

Standard settings 

- The model assignments provided as standard represent the superset of possible model assignments. 

Together with the nodes types, variant types, and alternative types, they can be used to build the 

entire structure for Integrated Product and Process Engineering (iPPE). 

- When you create a node and maintain variants and alternatives in the iPPE Workbench, the system 

automatically uses the appropriate model assignment. 

- Use the provided model assignments. 

Activities 

To create new model assignments, please proceed as follows: 

1. In the Customizing of Cross-Application Components, choose Integrated Product and 

Process Engineering (iPPE) -> Administration of iPPE Objects -> Define iPPE Model 

Assignments. 

The screen iPPE Model Assignments: Change appears. 

2. To create a new entry, choose New Entries. The screen New Entries: Details appears. 

3. Enter the required data. 

4. Save your entries. 

26.1.7.4 iPPE User Interface Administration 

26.1.7.4.1 iPPE Filter User Interface Administration 

26.1.7.4.1.1 Determine Tab Page Titles for Attribute Filter 

Use 

In this Customizing activity, you create additional tab pages for the attribute filter in the iPPE 

Workbench Professional. You assign fields that you wish to use to filter the data in the iPPE Workbench 

Professional to these tab pages. 

Activities 

You must specify the following data: 

- Define the titles for the tab page. 



 

 

- Choose the icon and the language-dependent ID that is to be displayed on the tab page under 

Attribute in the filter. 

- Enter a description. 

26.1.7.4.1.2 Assign Attribute Fields to Tab Page 

Use 

In this process step, you assign the fields you wish to use to filter the data in the iPPE Workbench to the 

tab pages you defined in the process step Determine Tab Page Titles for Attribute Filter. 

Standard settings 

You can use the fields in the structure PPEGIFCAT and those in the field catalog in the iPPE Workbench 

Professional. 

26.1.7.4.1.3 Generate Attribute Value Filter 

Use 

In this process step, you generate the tab pages that you defined in the process step Determine Tab Page 

Titles for Attribute Filter, and to which you assigned fields in the process step Assign Attribute Fields to 

Tab Page. 

You must generate these tab pages to display these in the filter on the Attribute tab page. 

Requirements 

The system normally generates the language-dependent IDs for the fields on the filter interface. The 

translations for the fields must available in all installed languages. If this is not the case, the system 

cancels the generation. 

26.1.7.4.2 Define iPPE User Profiles 

Use 

The user profile controls which data is displayed and can be maintained by the user in the 

iPPE Workbench Professional. 

You can change the iPPE user profiles defined by SAP in this IMG activity by changing, copying, 

renaming, or creating new user profiles. 
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Standard settings 

The SAP standard system includes the following user profiles: 

- S_PPEALL (Total Display) 

This profile includes all the settings you need to work with the iPPE Workbench Professional. 

- S_ASTACT (Process Structure) 

Part of the S_PPEALL profile; calls up a process structure as an application tree in the detail area of 

the iPPE Workbench Professional. 

- S_ASTCMP (Product Structure) 

Part of the S_PPEALL profile; calls up a product structure as an application tree in the detail area of 

the iPPE Workbench Professional. 

- S_ASTFLO (Factory Layout) 

Part of the S_PPEALL profile; calls up a line structure as an application tree in the detail area of the 

iPPE Workbench Professional. 

Activities 

You can change, copy, and rename the profiles or create new profiles. You can define settings for the 

following areas: 

- Relationships: 

Here you can define if sequences, assignments, or hierarchies are visible between objects and how 

they are displayed. 

- Model Definitions: 

Here you define how the model definitions between the objects are displayed in the navigation area. 

- Environment: 

Here you define how objects from the Product Lifecycle Management environment are displayed 

in the navigation area of the iPPE Workbench Professional. and how these objects are connected to 

iPPE objects. 

- Reports: 

Here you define which reports will be available for this profile in the iPPE Workbench 

Professional. 

You can only choose reports that you have already defined in the activity Define Reports for the 

Reporting Tree . 

Further notes 

In the activity Define Tab Pages for the Detail Area of the iPPE Workbench Professional, you need to 

assign the layouts that exist for the individual objects to the profile. If the profile is not assigned any 

layouts, the system will not display any data for the selected object in the detail area of the iPPE 

Workbench Professional. 

26.1.7.4.3 Define Reports for the Report Tree 

Use 



 

 

In this activity, you can see the reports that are provided in the evaluations of the iPPE Workbench. You 

can see whether the reports are also visible in the context menu for specific objects, and if they can be 

selected there. 

You can create new reports, which become available for use in the iPPE Workbench when you enter 

them in this activity. 

Requirements 

If you redefine function modules and enter them in this activity, they must correspond to the interface 

PPEUIREP_EXAMPLE in the function group PPEUIREP. 

Standard settings 

The following reports are included in the standard system and are displayed in the menu of the iPPE 

Workbench under Evaluations -> Reports: 

- Activities to Line Balance 

- Components to Line Balance 

- Production Resources to Line Balance 

- Status Cockpit 

26.1.7.4.4 Define Tab Pages for iPPE Workbench Detail Area 

Use 

In this step, you can specify the number of tab pages and their layout, and also state which objects are to 

be visible on the tab pages in the iPPE Workbench. The layout for the tab pages, which consists of a 

definition and the corresponding screens, is linked to the user profile and the individual iPPE objects. 

You create user profiles in the activity Define iPPE User Profiles. 

Example 

Tab page for the overview of component variants. 

Screen Definition: 

Screen Name    Program Name Screen No. Screen No.  Description 

S_CMP_VARIANTS SAPLPVSUICMP 1301      1300       Overview of 

CMPVar 

Screens 1301 and 1300 from program SAPLPVSUICMP  are identified by the screen 

name S_CMP_VARIANTS. 

Tab Title Definition: 

 Tab Page             Tab Title          Description 
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S_CMPN_VARIANTS      Variants               

The tab page for variants is identified by the key S_CMPN_VARIANTS. 

Tab Title - Screen Assignment: 

Tab Page: S_CMPN_VARIANTS 

 Screen                   Screen Position 

 S_CMP_VARIANTS           1 

Screen S_CMP_VARIANTS will be displayed on the tab page S_CMPN_VARIANTS in the first 

position. 

Layout Definition: 

 Layout                  Description 

 S_CMPN_ST               Structure Node 

The layout for the structure node is identified by the key  S_CMPN_ST . 

Layout - Tab Title Assignment: 

Layout: S_CMPN_ST 

 Tab Page                Position 

 S_CMPN_VARIANTS               3 

The layout for the structure node S_CMPN_ST (structure node) is displayed in the third position on 

the tab page  S_CMPN_VARIANTS for variants. 

Layout - Object Type Assignment: 

S_CMPN_ST 

 Profile           Object Type               Object Type 

 S_PPEALL          S_ST                    Node 

The layout S_CMPN_ST is used in profile S_PPEALL for the node S_ST (structure node). 

Requirements 

Before you define tab pages and their layouts, you must define the profiles and object types that you 

wish to use. 

Standard settings 

All tab page definitions and settings that you need for using the iPPE Workbench are included in the 

standard Customizing. 

Recommendation 

Use the standard Customizing included in the Release. 

Activities 



 

 

Screen Definition: 

All iPPE screens and their corresponding programs are recorded in the screen definition section, 

each with a screen name.  You assign these screens to layouts and tab pages. In certain cases, 2 

screen numbers are specified for the same data. This is because the screens are available in 2 sizes. 

The option Navigation View in the iPPE Workbench allows you to select the large or small 

screen. 

- Tab Page Definition: 

The individual tab pages available in the iPPE Workbench are recorded in this section. A tab page 

is identified by a key, the tab title, which appears in the iPPE Workbench, and a description. You 

can see the description in the iPPE Workbench as quick info. You can also define an icon for each 

tab page. 

- Tab Title - Screen Assignment: 

In this section, the screens and tab pages are managed as one unit. You specify which screens from 

the screen definition section are to appear on which tab page from the tab page definition section. If 

there are several screens on one tab page, you can state the order in which they are to be arranged. 

- Layout Definition: 

The keys and descriptions for the layouts are recorded in this section. 

- Layout - Tab Title Assignment: 

In this section, you specify which tab pages belong to which layout. 

- Layout - Object Type Assignment: 

In this section, you state the profile from the iPPE Workbench (such as S_PPEALL) and the object 

type  (such as S_CMPST alternative at structure node), for which the layout is to be active. 

- Layout - Tabstrip Assignment: 

In this section, you specify whether another set of tab pages can be displayed on a tab page. Up to 

three sets of tab pages (tabstrips) can be displayed on a tab page. This function is already used 

internally. Contact your SAP consultant if you wish to use this function. 

26.1.7.4.5 Set Relationships in iPPE Workbench 

Use 

In this section, you can specific whether existing relationships, which have been defined in the 

processing step  Define iPPE Relationship Types and go in a specific direction, can also point in the 

opposite direction. This enable you to assign objects in the Workbench using Drag & Drop, regardless of 

whether the objects are in the navigation tree or on a tab page for the assignment. 

Requirements 

The SAP standard system includes additional settings for all relationships of the following types: 

- S_ACTIOC (Material Assignments) 

- S_FLOACT (Line Balances) 

- S_FOCIPO (Focus Structure) 

- S_RESFLO (Resource Capacities) 
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26.1.7.5 iPPE Product Structure Administration 

26.1.7.5.1 Geometric Instances 

26.1.7.5.1.1 Define Geometric Instance Types 

Use 

In this activity, you define geometric instance types. These characterize geometric instances, which 

contain geometric data for item variants or assembly items. 

The geometric instance type is part of the external key of geometric instances. You must therefore define 

at least one type to be able to create geometric instances. 

Standard settings 

SAP delivers the STANDARD geometric instance type.  This type is part of the 

EA_IPPE_401_INST_DM business configuration set. 

Activities 

Specify a geometric instance type and a name for the geometric instance type. The geometric instance 

type must not begin with the letter "S", since the namespace for geometric instance types beginning with 

"S" is reserved for SAP. 

Example 

You want to use a further geometric instance type, EXTREME, in addition to the STANDARD 

geometric instance type delivered by SAP. Geometric instances that contain the geometric data for an 

extreme situation (such as a door that is wide open, contrary to the standard geometric instance, in 

which the door is closed), is to receive the geometric instance type EXTREME. Specify the geometric 

instance type EXTREME and the name "Extreme Situation". You can then create geometric instances 

that have the type EXTREME. 

26.1.7.5.1.2 BAdI: Couple Change States with Higher-Level Object 

Use 

Appication Component: AP-PPE. 

Package: CPPEINST 

You use the Business Add-In (BAdI) IPPE_INST_ECM_SWITCH to define whether the change states 

for geometric instances are coupled with the change states of the higher-level iPPE object (item variant 

or assembly item) or not. 

For more information about the coupling of change states, see Coupling of Change States. 

Standard settings 

- The Business Add-In is not filter-dependent. 



 

 

- The Business Add-In cannot exist at several positions. 

- In the standard system, there is no activated BAdI implementation. 

In the standard, the CL_EX_IPPE_INST_ECM_SWITCH_EXT fallback class is executed. This 

class determines that change states for geometric instances are coupled with change states of the 

higher-level object. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Example 

For an example implementation, see the 

IF_EX_IPPE_INST_ECM_SWITCH~INST_PARENT_ECM_COUPLED_CHK method in the 

CL_EX_IPPE_INST_ECM_SWITCH_EXT class. 

26.1.7.5.1.3 BAdI: Fill Customer-Specific Fields for Change State 
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Use 

Appication Component: AP-PPE. 

Package: CPPEINST 

The Business Add-In (BAdI) IPPE_INST_BAPI_MAINT is used in the PPEHI_PVINS_MAINTAIN 

function module. 

The BAdI fills the customer-specific fields after the geometric instances have been defined and locked 

and the associated change numbers have been defined and checked for validity. 

The system first checks the transferred data for changes (delta) and copies the transferred delta data. 

Standard settings 

- The Business Add-In is not filter-dependent. 

- The BAdI is designed for multiple use. 

- In the standard system, there is no activated BAdI implementation. No default coding is executed. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 



 

 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

26.1.7.5.1.4 BAdI: Define Additional Fields 

Use 

Appication Component: AP-PPE. 

Package: CPPEINST 

You can use the Business Add-In (BAdI) IPPE_INST_ALV_GUI to define whether or how customer-

specific fields in the CI_INSTCMPD structure, which extends the INSTCMPD database table, are 

displayed in iPPE Workbench Professional. 

In addition, you can change the type of display for certain standard fields. For example, you can make the 

field containing the name of the geometric instrance, which cannot be edited in the standard system, 

editable. 

The BAdI is called when geometric instances are displayed in iPPE Workbench Professional. 

You use the BUILD_FIELD_CATALOG method to define the field catalog for customer-specific fields. 

You use the FILL_CELLSTYLE method to make customer-specific fields and certain standard fields 

editable. 

Standard settings 

- The Business Add-In is not filter-dependent. 

- The BAdI is designed for multiple use. 

- In the standard system, there is no activated BAdI implementation. No default coding is executed. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 
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6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Example 

For an example implementation, see the CL_EXAMPLE_IPPE_INST_ALV_GUI class. 

26.1.7.5.1.5 BAdI: Use Own Logic While Reading Geometric Instances 

Use 

Appication Component: AP-PPE. 

Package: CPPEINST 

You can use the Business Add-In (BAdI) IPPE_INST_READ_BY_OBJECT to filter geometric instances 

according to your own criteria. The filter criteria and all geometric instances to the higher-level objects 

(unfiltered) are available as importing parameters. The geometric instances whose validity and object 

dependencies correspond to the returned parameters are returned as changing parameters in the BAdI. 

You can remove or add further data records. 

The BAdI is called when geometric instances for higher-level iPPE objects are read and possibly filtered 

according to further criteria, such as whether the geometric instances are displayed in iPPE Workbench 

Professional, order if the PPEHI_PVINS_GET_INST_BY_OBJECT function module is executed. 

The IS_CUSTOMER_FIELDS parameter is only filled if the corresponding parameter was filled in the 

PPEHI_PVINS_GET_INST_BY_OBJECT function module and the BAdI was then executed; the 

parameter is empty if SAP applications (for example, iPPE Workbench Professional) read the geometric 

instances for an object. 

Standard settings 



 

 

- The Business Add-In is not filter-dependent. 

- The BAdI is designed for multiple use. 

- In the standard system, there is no activated BAdI implementation. No default coding is executed. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -

> Business Add-Ins -> Implementing a Business Add-In. 

26.1.7.5.1.6 BAdI: Influence Reading of Data for Consistency Check 

Use 

Appication Component: AP-PPE. 
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Package: CPPEINST 

You can use the Business Add-In (BAdI) IPPE_INST_CONSISTENCY_CHK to filter geometric 

instances for the consistency check. 

The BAdI is called when the consistency check is triggered in iPPE Workbench Professional or when the 

PPEHI_PVINS_CHECK_CONSISTENCY function module is called. 

The geometric instances filtered by the system and additional filter criteria are available as importing 

parameters, which are to be considered during the check. The change states of the geometric instances 

whose validity and object dependencies correspond to the parameters indicated, are returned in the BAdI 

as changing parameters. As a result, you can remove or add data records. 

The IS_CUSTOMER_FIELDS parameter is only filled if the corresponding parameter was filled in the 

PPEHI_PVINS_CHECK_CONSISTENCY function module and the BAdI was then executed; the 

parameter is empty if SAP applications (for example, iPPE Workbench Professional) check the 

geometric instances for consistency. 

Standard settings 

- The Business Add-In is not filter-dependent. 

- The BAdI is designed for multiple use. 

- In the standard system, there is no activated BAdI implementation. No default coding is executed. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 



 

 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

26.1.7.5.1.7 BAdI: Notify About Changed Geometric Instances 

Use 

Appication Component: AP-PPE. 

Package: CPPEINST 

You can use the Business Add-In (BAdI) IPPE_INST_AFTER_SAVE to carry out further steps that are 

necessary as a result of changes to geometric instances. In particular, you can inform an external system 

about changes. 

The BAdI is called while saving changed geometric instances, immediately before these geometric 

instances are written to the database. 

The BAdI method PUBLISH_CHANGED_INST provides the following data for newly created, 

changed, or deleted geometric instances that are to be written to the database table upon saving: 

- Data records for the geometric instance in database table INSTANCEID 

- Data records for the geometric instance in database table INSTHIST 

- Data records for the geometric instance in database table INSTHISTTX 

- Data records for the geometric instance in database table INSTCMPD The SRC_CHNGD_FLG 

checkbox in this data record indicates whether an object dependency was changed. 

- In addition, each of these data records contains the DBOP field, which determines if the data record 

is newly created ('I'), changed ('U'), or deleted ('D'). 

You cannot change the data. 

Standard settings 

- The Business Add-In is not filter-dependent. 

- The BAdI is designed for multiple use. 

- In the standard system, there is no activated BAdI implementation. No default coding is executed. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 
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2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

26.1.7.5.2 Maintain Variable-Size Item Formulas 

Use 

Here you maintain formulas for calculating the quantity of a variable-size item from the size. 

26.1.7.5.3 Define Object-Dependent Settings for Status Management 

Use 

In this Customizing activity, you define the interaction between the status on assembly item or 

component variant and change management. You can make the following settings: 



 

 

- If you set the Lock indicator for a status, the change state of the component variant (or assembly 

item), upon reaching this status, is automatically locked against further processing with respect to 

the same change number. 

- If you set the Close indicator for a status, and work with the Change Request / Change Order 

function in change management, the change order for the processed object, upon reaching this 

status, is automatically set to Closed. In this way the object is locked against further processing with 

respect to this change order. 

26.1.7.5.4 Extract: Activate and Define Settings 

Use 

In this step, you activate the extraction function and determine how the system describes the extractions. 

Standard settings 

This function is not active. 

26.1.7.6 Business Add-Ins for Integrated Product and Process Engineering 

26.1.7.6.1 BAdI for the Product Designer 

Use 

You can use Business Add-In (BAdI) PDCNV to influence the selection and extraction of the iPPE 

model and the conversion to a bill of material. 

For example, you can define default settings for iPPE extraction and conversion. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 
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1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The 

system displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI provides the following methods: 

Determine Documents for an Item 

Change Conversion Options 

Additional Attributes in the iPPE Extraction 

Revision of the Extraction Result 

Fill Customer Fields in BOM Items 

26.1.7.6.2 BAdI: Check / Change of Objects of the iPPE Product Structure 

Use 

Appication Component: AP-PPE. 

The Business Add-In (BAdI) iPPE_CMP_CHECK_EXT allows you to maintain the following objects of 

the iPPE process structure: 

- Nodes 

- Alternatives 

- Variants 



 

 

You can 

- create 

- change 

- delete 

the specified objects. 

If you are using ECM, you can maintain the following objects when swapping change numbers: 

- Component variants 

- Color variants 

- Assembly items 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In is not filter-dependent. 

- The Business Add-In cannot exist at several positions. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 118 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

26.1.7.6.3 BAdI for Reports in PVS 

Use 

Appication Component: AP-PPE. 

Package: CPPEOM. 

The Business-Add-In (BAdI) IPPE_CMP_REP provides methods for the selection function in the object 

search of the product structure. The selection function is used in the following areas: 

- Enhanced PVS load area 

- PVS-CMPID report for overview of item and assembly variants The BAdI IPPE_CMP_REP 

contains the following methods: 

- You can use method ADJUST_WHERE_CLAUSE to adjust the WHERE clauses of the 

generated SELECT statement for the selection function according to customer specifications. This 

refines the search. 

- You can use method ADJUST_SELECT_OPTIONS to adjust the contents of the selection screens 

that are used for specifying parameters. This method also allows you to filter and change the 

attributes used according to customer specifications. 

The BAdI IPPE_CMP_REP defines two screen enhancements that can be used to enhance the selection 

screens used with customer-specific attributes. These attributes allow you to further adjust the selection 

function according to customer requirements. 

- Screen Enhancement: Selection for Enhanced PVS Load Area 

- Screen Enhancement: Selection for the PVS-CMPID Report 

Requirements 

None 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 



 

 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Example 

Example: Add Customer-Specific Fields in the Load Area of the iPPE Workbench 

- Implement the BAdI. 

- On the 'Subscreens' tab page, define a screen for the 'Enhancements: Selection for Load Area' row 

with which the iPPE Load dialog box is to be enhanced. 
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- The selection fields on the defined screen are displayed below the available selection fields. 

- For the customer-specific area of the Load dialog box, use a screen that is defined via the 'selection-

screen' statement in a report or module pool. See the example below: 

selection-screen begin of screen 0002 as subscreen. select-

options: 

  so_fld1     for pvcmpd-zzfield1,   

so_fld2     for pvcmpd-zzfield2,   

so_fld3     for pvcmpd-zzfield3. 

parameters: p_param1 type xfeld. 

selection-screen end of screen 0002. 

- You can use additional language elements for creating the selection screens. 

- You do not need to carry out any additional implementations for customer-specific fields that were 

added using customer includes in order for the entries to be used in the selection 

(this includes the fields pvcmpd-zzfield1, pvcmpd-zzfield2, pvcmpd-

zzfield3). 

- You can enhance the selection screen via additional parameters. You can evaluate the parameter 

value by implementing the methods ADJUST_WHERE_CLAUSE and 

ADJUST_SELECT_OPTIONS. 

Example: Using Method IPPE_CMP_REP~ADJUST_SELECT_OPTIONS 

- The method provides the following information: 

- IT_DDIC_FIELDS: Contains information about the DDIC reference for the fields used. 

- CT_SO_INFO: Contains the values specified by the user on the selection screen, which can be 

revised in this method. 

- In method ADJUST_SELECT_OPTIONS, you can change the values for the selection options, if, 

for example, values are dependent on one another because of customer-specific logic. 

- In the example above, you may not want to include the entries in the selection option so_fld3 when 

the parameter p_param1 is set. These can be deleted from the table CT_SO_INFO. 

Example: Using Method IPPE_CMP_REP~ADJUST_WHERE_CLAUSE 

- The method provides the following information: 

- IT_SO_INFO: Contains the data from the selection options as well as the parameters of the 

selection screen used. 

- IT_DDIC_FIELDS: Contains DDIC information about the iPPE fields used in the 

selection. 

- CT_COND: Contains the dynamic WHERE clause that is used to find iPPE objects in the 

subsequent SELECT statement in the database. 

- You can revise the table CT_COND in order to exclude certain fields from the selection, for 

example. To do so, you must adjust the texts contained in the table. 



 

 

26.1.7.6.4 BAdI: Sort Product Structure Data (CMP/COL) 

Use 

Appication Component: AP-PPE. 

With this BAdI, you can define in what sequence objects in the iPPE Workbench should be sorted. 

Standard settings 

- The Business Add-In is active in the standard system. The default coding is executed automatically. 

Sorting occurs as described in the individual BAdI methods. 

- The Business Add-In is not filter-dependent. 

- The Business Add-In cannot exist at several positions. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 
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12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can also call the documentation on the BAdI method via the menu, by carrying out the following 

steps: 

13. Choose the tab page Interface. 

14. Double-click on the relevant method. 

15. Click on the right mouse button and choose Component documentation. 

Further notes 

The BAdI provides the following methods: 

PACMP_SORT 

PRPVR_SORT 

PVCMP_SORT 

PVCOL_SORT 

26.1.7.6.5 BAdI for Consistency Check of Variants 

Use 

Appication Component: AP-PPE. 

Package: CPPEVS. 

The Business Add-In (BAdI) IPPE_CONS provides methods for the consistency check of variants. 

- With the method RESTRICTIONS_SELECT, you can determine the constraints and restrictions 

relevant for the consistency check from the configuration profile of the configurable material that 

was transferred. 

Standard settings 

- Das Business Add-In ist nicht filterabhängig. 

- The Business Add-In cannot exist at several positions. 



 

 

- In the standard system, there is no activated BAdI implementation. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -

> Business Add-Ins -> Implementing a Business Add-In. 

Example 

Further notes 

Documentation for BAdI Methods: 

RESTRICTIONS_SELECT 
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26.1.7.6.6 BAdI: Adjust Object Dependency When Copying with Class Changes 

Use 

Appication Component: AP-PPE. 

You can use this BAdI to adjust the object dependency when copying a node. This is necessary if the 

node class changes when the node is copied, and you wish to use customer-specific logic for making the 

object dependency adjustments. 

The BAdI contains the method CLASS_CHANGE. The method is described below. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 



 

 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI provides the following methods: 

Adjust Object Dependency When Copying with Class Changes CLASS_CHANGE 

26.1.7.6.7 BAdI: Adjust Variance Scheme When Copying or Changing Classes 

Use 

Appication Component: AP-PPE. 

You can use this BAdI to adjust the variance scheme when copying a node. This is especially useful if 

the node class changes when the node is copied, and you wish to implement customer-specific logic for 

adjusting the variance scheme. 

The BAdI contains the method CLASS_CHANGE, which is described below: 

Standard settings 

- The Business Add-In is active in the standard system. The default coding is executed automatically. 

- The Business Add-In is not filter-dependent. 

- The Business Add-In cannot exist at several positions. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 
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2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can also call the documentation on the BAdI method via the menu, by carrying out the following 

steps: 

13. Choose the tab page Interface. 

14. Double-click on the relevant method. 

15. Click on the right mouse button and choose Component documentation. 

Example 

See the default implementation in class CL_DEF_IM_IPPE_COPY_VS. 

Further notes 

The BAdI provides the following methods: 

Adjust Variance Scheme 

26.1.7.6.8 BAdI: Extensions for Checking External Name 

Use 



 

 

Appication Component: AP-PPE. 

This Business Add-In (BAdI) provides methods with which you can execute your own checks for the 

external description of nodes, variants, alternatives, and relationships. 

You can, for example, define customer-specific naming conventions and use the BAdI to check if these 

are being complied with. The BAdI is always called up when a node, variant, alternative, or relationship 

is created or renamed by the user. The check is carried out before all other checks take place (also before 

the existence check). 

Documentation for BAdI methods: 

- PNODID_EXT_NAME_CHECK 

- POSVID_EXT_NAME_CHECK - PALTID_EXT_NAME_CHECK 

- PRELID_EXT_NAME_cHeCK 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 
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9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Example 

You can specify, for example, if the external names of all nodes should begin with the ID XX_. In this 

case, the system will not allow the user to create a node using the ID XY_. 

Further notes 

You can also call the documentation on the BAdI method via the menu, by carrying out the following 

steps: 

13. Choose the tab page Interface. 

14. Double-click on the relevant method. 

15. Click on the right mouse button and choose Component documentation. 

26.1.7.6.9 BAdI: Additional Tab Pages in the iPPE Load Dialog Box 

Use 

Appication Component: AP-PPE. 

Function Group: PPEUILOAD. 

The Business-Add In (BAdI) IPPE_ENG_GUI_LOAD_EX allows the iPPE Load dialog box and an 

additional tab page for customer data in this dialog box to communicate with one another. There are 

methods to activate and deactivate standard and customer tab pages and to import and export data to and 

from the customer screen. 

The BAdI is always called up when the dialog box to load objects in the iPPE Workbench is called up. 

Requirements 

The external BAdI must have been implemented. In addition to the implementation of the interface 

methods, there must also be a function group with a subscreen containing the corresponding flow logic. 

The subscreen corresponds to the customer screen. The flow logic of the subscreen calls up the interface 



 

 

methods to transport data between the iPPE popup and the function group of the subscreen; see 

documentation for interfaces. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 
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Further notes 

Documentation for the BAdI interface: 

IF_EX_IPPE_ENG_GUI_LOAD_EX 

26.1.7.6.10 BAdI: Customer-Specific Sort Order for iPPE Relationships 

Use 

Appication Component: AP-PPE. 

The BAdI IPPE_ENG_SORT contains a method you can use to implement a special master data sort in 

the navigation area or detail area within the iPPE Workbench. 

The following method is available to sort the following object: 

- Relationships: 

The BAdI is called up when objects are displayed using relationships in the navigation area or in 

the detail area of the iPPE Workbench. 

Standard settings 

- The Business Add-In is active in the standard system. The default coding is executed automatically. 

The default implementation defines that the target object of the relationships are sorted alphanumerically. 

Please note that the sequence relationships are sorted according to their predecessor- successor 

relationships, which will override the alphanumerical sort. 

- The Business Add-In is not filter-dependent. 

- The Business Add-In cannot exist at several positions. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 



 

 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can also call the documentation on the BAdI method via the menu, by carrying out the following 

steps: 

13. Choose the tab page Interface. 

14. Double-click on the relevant method. 

15. Click on the right mouse button and choose Component documentation. 

Further notes 

The BAdI provides the following methods: 

PRELID_SORT 

Example 

See default implementation. 

26.1.7.6.11 BAdI: Customer-Specific Evaluations During Explosion 

Use 
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Appication Component: AP-PPE. 

The Business Add-In (BAdI) IPPE_EXPL_EVAL_EXT contains two methods to replace the standard 

filter function in the iPPE Workbench Professional. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI provides the following methods: 



 

 

Evaluation of Change Statuses Within Date Interval 

Evaluation of Last 'N' Change Statuses 

26.1.7.6.12 BAdI: Customer-Specific Options for Filter 

Use 

Appication Component: AP-PPE. 

You can use the Business Add-In (BAdI) iPPE_FILTER_EXT to influence how the attribute filter 

handles evaluations in the iPPE Workbench Professional. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- Note that the Business Add-In can be used more than once and therefore all active implementations 

are called and executed. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 
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9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI provides the following methods: 

Change Object and Attribute Correlation 

Filters Node by Filter Settings 

26.1.7.6.13 BAdI: Matching Algorithm for Comparison 

Use 

Appication Component: AP-PPE. 

Function Group: PPEUISOP2 

You can use the BAdI IPPE_STRUCT_MATCH (BAdI: Options for Configuration Comparison) to 

define which objects are to be compared in the iPPE configuration comparison. In the algorithms 

contained in the BAdI methods, you define the objects to be compared as well as the object attributes 

that determine when the objects are identical. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In cannot exist at several positions. 



 

 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -

> Business Add-Ins -> Implementing a Business Add-In. 

Example 

If object ABC in structure 1 is to be compared with object XYZ in structure 2, then the field 

PGUID_MATCH at object ABC in structure 1 must contain the value XYZ; the field PGUID_MATCH 

at object XYZ in structure 2 must contain the value ABC. 

The comparison pairs are always in a 1:1 ratio. This means that an object can only be compared with one 

other object in the other structure. 

You can view a matching algorithm example in the SAP default type function module, function group 

PPEUISOP2, FORM matching_build_mat. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 136 

26.1.7.6.14 BAdI for Enhanced Dependency Editor 

Use 

Appication Component: AP-PPE. 

Package: CPPEOM. 

The Business Add-In (BAdI) OM_EDITOR provides methods for the Enhanced Dependency Editor. 

- With the method CUST_SYNTAX_CHECK, you can execute a customer- specific syntax check for 

the maintained object dependencies. 

- With the method AFTER_CHANGE, you can process additional data for all variants, at which 

object dependencies were changed. 

Requirements 

You have activated the enhanced dependency editor in the iPPE Customizing. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- Das Business Add-In ist nicht filterabhängig. 

- Note that the Business Add-In can be used more than once and therefore all active implementations 

are called and executed. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 



 

 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components 

-> SAP Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard 
(BC) -> Business Add-Ins -> Implementing a Business Add-In. 

Example 

Further notes 

Documentation for the BAdI Methods: 

CUST_SYNTAX_CHECK 

AFTER_CHANGE 

26.1.7.6.15 BAdI: Field Catalog and Navigation Area in iPPE Workbench 

Use 

Appication Component: AP-PPE. 

With this BAdI, you can enhance the field catalog of the iPPE Workbench (PPEGI_FCAT) by customer 

fields. 

When starting the iPPE Workbench, the system checks if an active implementation of this BAdI exists in 

the GI Engine. This BAdI is called up when an object is displayed or changed in the navigation area of 

the iPPE Workbench. 

If the customer fields are filled at runtime by the BAdI implementation, they are then transferred to the 

field catalog by the iPPE Workbench. 

In order to view the contents of the customer fields in the navigation area, the fields must also be 

included in the current display variant. 
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Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In is not filter-dependent. 

- The Business Add-In cannot exist at several positions. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 



 

 

Further notes 

The BAdI provides the following methods: 

FIELDCAT_FILL 

26.1.7.6.16 BAdI: Status Checks/Enhancements at GEN Node 

Use 

Appication Component: AP-PPE. 

With this BAdI, you can execute customer-specific checks and preassign values to the status fields for a 

GEN node. 

The methods of this BAdI are called up in the class CL_PPELISGENN_CNTL. You have the following 

options: 

- You can preassign values to the status fields of a GEN node. These values will appear in the status 

when a status for a GEN node is created. 

- You can execute you own check before changing a status or a precondition for a status. If the 

customer-specific check results in errors, the status and the precondition for the status are not 

changed. 

Requirements 

You must provide an active implementation of the BAdI PPELISGENN. You must also implement the 

interface IF_EX_PPELISGENN for the class CL_PPELISGENN_CNTL. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 
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- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can also call the documentation on the BAdI method via the menu, by carrying out the following 

steps: 

13. Choose the tab page Interface. 

14. Double-click on the relevant method. 

15. Click on the right mouse button and choose Component documentation. 

Further notes 



 

 

The BAdI provides the following methods: 

PRECOND_CHECK 

STATUS_CHECK 

STATUS_CREATE 

26.1.7.6.17 BAdI: Status Checks/Enhancements at CMP Variants 

Use 

Appication Component: AP-PPE. 

With this BAdI, you can execute your own checks and preassign fields for the status management for 

variants of the product structure. 

The methods of this BAdI are called up in the class CL_PPELISCMPV_CNTL. You have the following 

options: 

- You can preassign values to the status fields. If a status for a variant of a product structure is 

created, the values are entered here. 

- You can execute customer-specific checks before changing a status or changing a precondition for a 

status. If an error occurs during a customer-specific check, the status and the precondition for the 

status are not changed. 

 Requirements 

You must provide an active implementation of the BAdI PPELISCMPV. You must also implement the 

interface IF_EX_PPELISCMPV for the class CL_PPELISCMPV_CNTL. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 
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If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI provides the following methods: 

PRECOND_CHECK 

STATUS_CHECK 

STATUS_CREATE 

26.1.7.6.18 BAdI: Adjustment of Field Catalog in the Tabular Maintenance 

Use 

Appication Component: AP-PPE. 



 

 

With this BAdI, you can adjust the column display in the tabular maintenance in the iPPE Workbench 

and in the configuration mode to meet your requirements. 

Requirements 

- You are using the iPPE Workbench (transaction PPE) or the configuration mode (transaction 

PPETI). 

- The user must be authorized to display the table fields and columns (authorization object 

C_PVS_GRID) in order to display the settings that are controlled by the BAdI. 

Standard settings 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

- The Business Add-In is active in the standard system. The default coding is executed automatically. 

In the standard system, the column headers of the configurations in the configuration mode are assigned a 

prefix, for example, "3 : ..." as the configuration number. The column grouping in the configuration 

mode is valid for all objects of the product structure. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 
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During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI provides the following methods: 

SET_FIELD_ATTRIBUTES 

SET_EDITABLE_FIELDS_PNOD 

SET_EDITABLE_FIELDS_POSV 

SET_COLUMN_CAPTIONS 

SET_COLUMN_GROUPS 

26.1.7.6.19 BAdI for Displaying Set Assignments for Product Structure 

Use 

Appication Component: AP-PPE. 

You can use the Business Add-In (BAdI) PPEUISET_DISPLAY to implement a customer-specific 

display for the set assignments for the iPPE product structure. The system then processes this 

implementation instead of the standard display. 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 



 

 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI provides the following methods: 

Display the Set Assignment (SET_DISPLAY) 

26.1.7.6.20 BAdI: iPPE Connection to Project System 

Use 

Appication Component: AP-PPE. 
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You can use the Business Add-In (BAdI) iPPE_CMP_CHECK_EXT to influence the maintenance 

processes for the following objects in the iPPE product structure: 

- Nodes 

- Alternatives 

- Variants 

The maintenance processes include the following: 

- Create 

- Change 

- Delete 

If you are using change management, you can make changes in the following objects when switching the 

change number: 

- Component variants 

- Color variants 

- Assembly items 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In is not filter-dependent. 

- The Business Add-In cannot exist at several positions. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 



 

 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -

> Business Add-Ins -> Implementing a Business Add-In. 

26.1.8 Integrated Product and Process Engineering (iPPE) 

26.1.8.1 iPPE Object Administration 

26.1.8.1.1 Define iPPE Production Resources 

Use 

In this activity, you can define node types to represent production resources within the factory layout in 

iPPE. 

Standard settings 

The following node types are provided as standard: 

- Workers 

- Operating Facilities 

- Planning Resources 

You cannot change the properties of the available node types. You can use the available node 

types as a template for new node types. 

Activities 
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To create a new production resource, please proceed as follows: 

1. In the Customizing of Cross-Application Components, choose Integrated Product and 

Process Engineering (iPPE) -> Administration of iPPE Objects -> Define iPPE Node Types 

-> Define iPPE Production Resources. 

2. Create and save the new entry. 

26.1.8.1.2 Define Line-Specific Relationship Types 

Use 

In this step, you can define Relationship Subtypes for line design. 

It is only necessary to define your own relationship subtypes if you have previously created new entries 

for the relationship types S_ACTFLO and S_FLOPLN in step Define iPPE Relationship Types. 

26.1.8.2 iPPE Process Structure Administration 

26.1.8.2.1 Define Standard Value Determination Type 

Use 

In this activity, you can specify the possible ways in which the standard values can be determined. 

Activities 

Create the possible ways in which the standard values can be determined. On the detail screen for the 

mode of an activity, your entries will be offered in the standard value determination field for you to 

select the way the values are to be determined. 

Example 

The standard values could be determined, for example, using a time analysis tool, or on the basis of times 

calculated by REFA (a work study organization). 

26.1.8.3 iPPE Line Structure Administration 

26.1.8.3.1 Define Types of Reporting Point 



 

 

Use 

In this IMG activity, you define reporting point types. 

In line design, you can define reporting points at a production line or a line segment. If you want to use 

an action point as a reporting point for backflush, you need to assign a reporting point to each of these 

action points. The reporting point type determines whether, in the reporting point backflush: 

- capacity is reduced. 

- the components are backflushed. 

- goods receipt is posted. 

- all previous reporting points  (Predecessor Reporting Points) of this type are backflushed 

automatically. 

Further notes 

Reporting points with a type that specifies capacity reduction can only be defined at a production line. 

Only a production line has an allocated line resource, from which capacity can be reduced. 

You can define two reporting points per line segment, one at the start and one at the end. 

26.1.8.4 Define Settings for Consistency Check 

Use 

You can use the consistency check for iPPE data to check if the master data that was maintained in iPPE 

for one or more products are complete and consistent in SAP APO. 

The consistency check consists of several checks for the areas of the product structure, process structure, 

and line structure. In this IMG activity, you determine which checks will be available in the system. 

Standard settings 

All consistency checks are active in the standard delivery. 

Activities 

Activate and deactivate the desired checks. Here, you determine which checks will be available in the 

consistency check. 

When the checks are active, they will be displayed on the corresponding consistency check tab page and 

can also be activated and deactivated here. 

You can use the LS>BAdI for Customer-Specific Consistency Checks to implement additional checks. 

You must also activate using this IMG activity if these checks are to be available on the consistency 

check tab page. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 150 

26.1.8.5 Business Add-Ins for Integrated Product and Process Engineering 

26.1.8.5.1 BAdI for Customer-Specific Consistency Checks 

Use 

Appication Component: AP-PPE. 

The Business Add-In (BAdI) IPPE_CHK_EXT and its method CONSISTENCY_CHECK can be used to 

implement customer-specific checks for the iPPE consistency check that is used for production versions 

and the product structures, process structures, factory layouts, and line balances assigned to them. 

The BAdI provides the following methods: 

- CONSISTENCY_CHECK 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- Note that the Business Add-In can be used more than once and therefore all active implementations 

are called and executed. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 



 

 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

You can also call the documentation on the BAdI method via the menu, by carrying out the following 

steps: 

13. Choose the tab page Interface. 

14. Double-click on the relevant method. 

15. Click on the right mouse button and choose Component documentation. 

26.1.8.5.2 Customer Check for CI in the iPPE Process Structure 

Use 

Appication Component: AP-PPE. 

This Business Add-In (BAdI) contains check methods that you can implement to execute a special check 

for master data in the process structure when creating, changing, or deleting. You can also check 

customer-specific includes. 

The BAdI methods support the check of the following objects of the iPPE process structure: 

- Modes 

Standard settings 

- In the standard system, there is no activated BAdI implementation. 

- The Business Add-In cannot exist at several positions. 
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- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. 

Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI provides the following methods: 

PAMOD_MAINT_CHECK 

PAMOD_DELETE_CHECK 

26.1.8.5.3 Sort Data of the iPPE Process Structure (ACT) 



 

 

Use 

Appication Component: AP-PPE. 

The BAdI IPPE_ACT_SORT contains sorting methods, which you can implement to sort master data in 

the navigation tree or in the detail overviews within the iPPE Workbench. 

The following methods can be used to sort the following objects of the iPPE process structure: 

- Modes 

The BAdI is called up when the data for modes in the navigation tree or in the detail area of the 

iPPE Workbench are displayed. 

Standard settings 

- The Business Add-In is active in the standard system. The default coding is executed automatically. 

The default implementation defines that the system sorts the modes of an activity by mode number 

first and then by the alphabetical sequence of the change numbers used. Secondary resources are 

sorted in the sequence in which they were entered. 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 
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10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -

> Business Add-Ins -> Implementing a Business Add-In. 

Example 

See default implementation. 

Further notes 

The BAdI provides the following methods: 

PAMOD_SORT 

26.1.8.5.4 Saving and Reusing Results of Model Mix Explosion 

Use 

Appication Component: AP-PPE. 

You use this BAdI so that the result of the model mix explosion can be saved and so that the display 

structure of the line balance relationship can be reused with the weighted duration. 

Standard settings 

- This Business Add-In is not active in the standard delivery. No default coding is available. 

- The Business Add-In cannot exist at several positions. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate the Business Add-In, you have to create an active implementation. 

1. To do so, choose the IMG activity by double-clicking @15@. Or 



 

 

2. To do so, choose the following menu in the SAP Easy Access Menu  Tools -> ABAP Workbench 

-> Utilities -> Business Add-Ins -> Implementation. 

If implementations already exist for the selected BAdI, the system braches to a dialog box 

displaying a list of the existing implementations. 

3. In this dialog box, choose Create. 

The system branches to the dialog box BAdI Builder: Create Implementation. 

4. Enter an implementation name and choose Continue. 

The screen Business Add-In Builder: Change Implementation appears. 

5. In the field Implementation Short Text enter a short desctiption. 

6. Select the tab page Interface. 

In this tab page, the field Name of implementing class is filled automatically as the system 

assigns the class name using the name of the implementation. 

7. Save your entries and assign the implementation to a package. 

8. Position the cursor on one of the methods. Access the class builder with a double click. 

9. Enter the coding for the implementation between the instructions method <Interface-Name>~ 

<Method nAME>.and endmethod. 

10. Save and activate your coding and return to the screen Change Implementation. 

11. Save your data again. 

Note: It is possible to create an implementation for a BAdI and activate it later. In this case, you 

should exit processing here. 

12. Choose Aktivate. 

During the execution of the application program, the system now runs through the coding you saved in 

the method. 

You can find additional information in the SAP Library under SAP NetWeaver Components -> SAP 

Web Application Server -> ABAP Workbench (BC-DWB)-> Changing the SAP Standard (BC) -
> Business Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI provides the following methods: 

COUNT_WEIGHT_DURATION 

26.1.9 Rough-cut Planning Profile 

In this section you define the number ranges for rough-cut planning profiles. 

26.1.9.1 Define number range for rough-cut planning profile 

In this step you define the number range for the rough-cut planning profile. 

To create a rough-cut planning profile the system requires an unambiguous internal number. The internal 

number lies within the number range that you define in this work step. 
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Note 

Make sure that the number range for the internal number range is large enough. 

Activities 

Maintain the number ranges for the internal number assignment. 

Note 

In this step you can also create external number ranges. You should note that external number ranges 

have no significance for rough-cut planning profiles because you cannot assign an external number for a 

rough-cut planning profile. 

Notes for transport 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.1.10 Production Resources/Tools 

This section contains all the information you need to implement master data maintenance of production 

resources/tools in your company. 

PRTs can be maintained according to their characteristics with various master record types: 

- material PRTs 

- document PRTs 

- miscellaneous PRTs (that is, PRTs with their own PRT master record) 

Note 

Various settings are relevant for certain PRT categories.  If your company doesn't have all of the PRT 

categories, then you don't have to make all the settings. 

There are tips in the appropriate sections. 

26.1.10.1 General Data 

In this section, you specify the central control parameters which are responsible for the following: 

- Category and usage in master data management 

- Processes in master data management 

- Operational usage in production resources/tools (PRTs) 

Note 



 

 

Depending on which PRT master record category you choose, different strategies are possible. Therefore, 

you should decide carefully. 

26.1.10.1.1 Define PRT authorization group 

With the help of the authorization group, you protect the production resource master records against 

changes by individual user groups. 

The authorization group is a part of the PRT master record. 

The SAP System checks the authorization in the user master record when you 

- create 

- change - display - delete 

Note 

The PRT status is only relevant for the production resource master record (miscellaneous PRT). 

Actions 

Define the PRT authorization groups used in your company. 

26.1.10.1.2 Define PRT status 

In this menu option, you define the PRT status. This status controls the usage of production 

resources/tools. 

Depending on its status, a production resource/tool can be released for various tasks in PRT maintenance. 

Note 

The PRT status is only relevant for PRTs with material master records (material PRTs) For each 

status, you can specify the following attributes: 

- PRT can be used in planning 

- PRT can be used in production 

Actions 

Define the PRT statuses used in your company. 

26.1.10.1.3 Define Task List Usage Keys 

In this menu option, you can specify the task list in which a work center or production resource/tool may 

be used. 

This way, you can categorize PRTs according to their relevance and their usage, for example, into 

maintenance routings or inspection plans. 
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You can also allow production resources/tools to be used in any combination of task list types. 

Note 

The PRT usage key is relevant for the following PRT categories: 

- PRTs with material master records (material PRTs) 

- PRTs with PRT master records (miscellaneous PRTs) 

Actions 

1. Define the PRT usage key. 

2. Assign task list types to the usage key. 

26.1.10.1.4 Define PRT group key 

In this menu option, you define production resource/tool group keys. With this key, you can combine 

production resources/tools into groups. You can use the PRT group key to set up matchcodes or use it for 

informational purposes in printing. 

The group key is only relevant for the following PRT categories: 

- PRTs with material master records (material PRTs) 

- PRTs with PRT master records (miscellaneous PRTs) 

Note 

The PRT group key does not have as large a range of functional uses as the PRT category. 

Actions 

Define the production resource/tool group keys used in your company. 

26.1.10.1.5 Define overview variants for PRT where-used lists 

In this step, you can create your own overviews for where-used lists and replacement of production 

resources/tools. 

These overviews are called variable lists. 

You create an overview variant for each overview. The variant specifies: 

- which objects are displayed, such as operations or sequences 

- which fields are displayed for each object, such as standard values or lot sizes 

Standard settings 

The standard system contains overviews and overview variants. 

Activities 



 

 

Proceed as follows to create your own overviews: 

1. Create overview variants 

This section describes how to create overview variants. 

2. Specify objects 

This section describes how to specify the individual objects you want to display in the overview. 

3. Specify fields 

This section describes how to choose the fields and specify the layout of the overview. 

4. You can transport your settings by selecting the menu options Table view -> Transport. 

26.1.10.2 Assignment of Production Resources/Tools 

In this section, you make the appropriate settings in the system to assign production resources/tools. 

You can assign production resources or tools to individual operations in task lists and work orders. These 

assignments are described by a number of attributes. You can define default values for these attributes in 

the production resource/tool master data file. 

26.1.10.2.1 Define PRT control keys 

The PRT control key determines whether PRTs that are allocated to a task list or an order are included in 

the following business functions: 

- scheduling 

- costing 

- printing production order printing 

- completion confirmation 

Actions 

Define the PRT control keys that are used in your company. 

26.1.10.2.2 Formulas 

In production resource/tool management formula parameters and formulas are used to calculate the total 

quantity or total usage value of a PRT required in an operation. 

When you use formulas to calculate total quantity or total usage value, you can take the lot size of the 

order into account, for example. 

26.1.10.2.2.1 Define formula parameters 

Formula parameters are used in formulas for capacity planning, scheduling, costing, PRT management 

and determining standard values using CAPP. 
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A formula parameter is identifeied by a parameter ID. Every formula parameter is linked with a 

particualr field either in Customizing, the routing or the work center. When the formula is evaluated the 

parameter takes the value of the field. 

Origin of Formula Parameters 

The assignment of a formula parameter to a data field is defined in the origin. You can refer to the data 

field in the work center or the routing via the parameter-ID or the key word that is assigned to every 

formula parameter and is displayed next to the the data field in the routing or work center. Formula 

parameters can have the following origins: 

- Standard Value 

Using the standard value key you provide the work center, and thus the routing, with up to six 

formula parameters that you assign values to in the routing operation. 

- Work Center Constant 

In the work center you can assign up to six work center constants a value and an unit. 

- General Formula Constants 

You can assign  general formuula constants a value and an unit in Customizing formula parameters. 

- General Operation Value 

The formula parameter is assigned to a data field in the general operation data, for instance the lot 

size or the base quantity. In this case you have to explicitly enter the field name. 

- User-Defined Field from Operation 

The formula parameter is assigned to an user-defined field in the operation. In this case the the 

assignment of the formula parameter is controlled by user-defined field key, that you define in 

Customizing the work center. The key words that describe the data fields are not defined in the 

formula parameters, but in the user-defined field key. 

- Value from PRT Allocation 

 You assign  the formula parameter to a field in the PRT alloaction, for instance the PRT quantity. 

- PRT constant 

You assign the formula parameter a fixed value in the PRT master record.This formula parameter 

can only be used for PRT management. 

Note: 

You enter the meaning of the fields in the key words for work centers and routings and not in the field 

names. 

Please note that this step is the prerequisite for the step Define rounding categories and additional values 

key in Customizing for CAPP standard value calculation. 

If you want to use the parameters in formulas you should use descriptive parameter IDs. 

- The value that you enter in the std. value field is only used to check the syntax of the formula 

(apart from general formula constants). The system does this automatically when you create a 

formula in Customizing. You should maintain this field, specially if a formula parameter is used as 

a divisor in a formula. Similiarly the Standard value unit field is only used for checking 

purposes. 

Actions 

1. Define your formula parameters. 

2. Check the assignment of the formula parameters to the standard value keys. 



 

 

3. Check the use of the formula parameters in formula definitions. 

26.1.10.2.2.2 Define formulas 

In production resource/tool management, formulas are used to calculate the required total quantity or 

total usage value of a PRT. 

Note 

These formulas are used in capacity planning, scheduling and costing to calculate capacity requirements, 

lead times and costs. 

Actions 

Define the formulas used in your company. 

26.1.10.3 Define PRT matchcode 

In this menu option you allocate any field from the PRT master record to a matchcode. Using these 

allocated fields you limit the PRT you search for. 

Note 

You cannot use the transport functionality here. 

Standard settings 

Various matchcodes are pre-defined in the standard system. 

Recommendation 

The utility can overload the system if you want to make a matchcode for a lot of PRTs. 

Therefore you should choose to generate a matchcode at a time when the system is not being 

used so much. 

Actions 

1. Check the matchcodes which are in the standard system. 

2. If necessary define new matchcodes. 

26.1.11 Set Authorizations 

This section introduces you to the authorization objects that are defined for the individual functions of 

this application in the standard system. You can maintain authorizations for these objects in the SAP 

system. 

Authorization objects 

The list below shows the authorization objects that are checked in the individual application functions. 
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Functions for... 

BOM 

Authorization object 

Create, change  C_STUE_BER Bill of material 

BOM C_STUE_WRK Plant 

C_STUE_NOH Without history 

Change BOM C_STUE_MAS Mass changes 

Archive and C_STUE_BER Bill of material 

reorganize BOM C_STUE_WRK Plant 

S_ARCHIVE Archiving authorization 

Display BOM,  C_STUE_BER Bill of material 

BOM group 

and plant allocation 

C_STUE_WRK Plant 

BOM explosion,  

Where-used list for materials 

C_STUE_BER Bill of material 

Display change documents S_SCD0 Change documents 

Variable lists C_VARLIST Objects for variable lists 

Engineering change management 

Create, change, display C_AENR_BGR Authorization group 

Change master record (extended 

check) 

C_AENR_ERW Change master record 

Create, change revision 

level 

C_AENR_RV1 Revision level 

Display change documents 

Work centers 

S_SCD0 Change documents 

Create, change, display  work 

centers, capacities, hierarchies 

C_ARPL_WRK Work centers 

Limit access to work center via 

work center category 

C_ARPL_ART Work center category 



 

 

Update work centers in the 

Human Resources System 

(HR active) 

Task lists 

PLOG HR: Human Resources 

Create, change, display routings 

and 

reference operation sets 

C_ROUT Routings 

Archive and delete S_PROGRAM ABAP: Program flow checks 

routings C_ROUT Routings 

Display where-used lists, mass 

replace function 

Production resources/tools 

C_ROUT Routings 

Create, change, display 

production resources/tools with 

PRT master records 

C_CRFH_BRG Production resources/ tools 

For information on 

authorization objects for 

production resources/tools 

with material master records 

and document info records, 

refer to the relevant 

application. 

Calculation of standard values with CAPP 

Create, change, display formulas, 

methods, processes 

C_CAPV_STA CAPP: Master data 

Calculate standard values C_CAPV_ANW CAPP: Application 

Standard Settings 

In the standard system, authorizations are provided for all authorization objects in the application. 

You will find both maintenance authorizations and display authorizations for authorization objects. 

The standard authorizations apply to all organization units. 

Activities 

1. Check whether the authorizations that come with the standard system cover 

your needs. Proceed as follows: 

a) Choose the object class of the application. 

A list of the authorization objects in this class is now displayed. 

b) Choose an object. 
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A list of the authorizations for this object is now displayed. 

2. If necessary, create new authorizations to meet your requirements. Proceed as 

follows: 

a) Choose Authorization -> Create. 

b) Enter the authorization and a short text. 

c) Maintain the values of each field one by one. 

d) Save your entries. 

e) Activate the new authorization. 

Note 

The profile generator lets you create authorizations and profiles. 

This function makes it much easier for you to customize your authorizations. You should use this 

function if you are working in a new installation. 

The individual configuration steps for the profile generator are described in Customizing underBasis 

Components - System Administration - Users and Authorizations - Maintain authorizations and profiles 

using profile generator.  



 

 

Description of the authorization objects 

Object: C_STUE_BER Bill of material 

Definition 

This authorization object allows you to restrict maintenance of bills of material. 

The system checks this authorization when you call a transaction for maintaining bills of material. If the 

authorization group is changed while the BOM is being maintained, the system checks the authorization 

again. 

Defined fields 

The table below shows the fields and values of the authorization object. 

Fields Possible 

entries 

Description 

ACTVT 01 Create 

(Activity) 02 Change 

 03 Display 

 06 Delete 

 24 Create archive file 

 41 Delete from database 

STLTY M Material BOM 

(BOM category) E Equipment BOM 

 D Document structure 

 K Sales order BOM 

 S Standard BOM 

 T Functional location BOM 

STLAN 

Customizing. 

(BOM usage) 

 These values are defined in 

BEGRU 0000-ZZZZ Used to make additional 

(Authorization  restrictions on authorizations 

group)  for maintaining individual BOMs 

(BOM header). 

Object: C_STUE_WRK Plant 

Definition 

This authorization object allows you to protect the allocation of a BOM to a plant. 

Defined fields 

The table below shows the fields and values of this authorization object. 

Fields Possible 

entries 

Meaning 

ACTVT 01 Create 

(Activity) 02 Change 
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 03 Display 

CSWRK 
 

Here, you enter the BOM plant 

(BOM plant)  in which the user is allowed to 

carry out the activity. 

  



 

 

Object: C_STUE_NOH Without history 

Definition 

This authorization object allows you to maintain a BOM that has a history requirement without using a 

change number. 

Defined fields 

For this authorization object, you maintain the field NOHIS. If you 

want to assign this authorization, enter "X".  
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Object: C_AENR_BGR Change master record 

Definition 

This authorization object allows you to protect a change master record, together with all object types and 

object management records belonging to it. 

The system checks your authorization: 

- when you edit a change master record 

If the authorization group is changed while you maintain the master record, the system makes 

another check. 

- when you change master data with reference to the change number 

Defined fields 

The table below shows the fields and values covered by this authorization object. 

Fields Possible 

entries 

Meaning 

ACTVT 01 Create 

(Activity) 02 Change 

 03 Display 

 06 Delete (change master) 

 22 Enter (change number in object) 

 81 Set dates (for change number) 

BEGRU 0000-ZZZZ Used to make additional 

(Authorization  restrictions on access to 

group)  individual change master records 

(change header). 

Object: S_SCD0 Change documents 

Definition 

Authorization for access to change objects and change documents. 

Defined fields 

- ACTVT activity - 06 delete change documents. 

- 08 display change documents. 

- 12 maintain change document objects.  



 

 

Objekt: C_ARPL_WRK Work centers 

Definition 

With this authorization object, you can restrict 

- the maintenance of work centers/resources, work center/resourcer hierarchies, and capacities to 

certain actions (e.g. change or display) in certain plants. 

- the maintenance of downtimes, independent of plant 

Defined fields 

The system checks the following fields: 

Fields Possible entries Meaning 

ACTVT 01 

and hierarchies 
User may create work centers/resources 

02 centers/resources 

and hierarchies 

User may change work 

03 centers/resources 

and hierarchies 

User may display work 

05 

and hierarchies 

User may lock work centers/resources 

06 

and hierarchies 

User may delete work centers/resources 

07 User may enter downtimes 

WERKS Enter the plants for which the user 

may edit work centers/resources and hierarchies. When downtimes are entered, the plant is not 

checked. 

Objekt: PLOG HR: Human Resources 

Definition 

The present object is used by the authorization check for PD data. Defined 

fields 

- Plan version 

- This field defines which plan version(s) the user may access. 

- Object type 

- This field defines which object types the user may access. 

- Infotype 

- This field defines, which infotypes, that is, attributes, of an object the users (generally) may access. 

- Subtype 

- This field determines which subtypes the user may access for given infotypes. Relationships are 

special subtypes for infotype 1001. Consequently, the relationships for which a user should have 

access authorization can also be limited in this field. 

- Planning status 
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- This field determines in which planning status the user may access information. 

- Function code 

- This field defines for which type of information processing (Display, Change...) the user is 

authorized. 

The possible values are defined in table T77FC. 

This protection against unauthorized access is extended by the structural authorization check. Two types 

of function codes are distinguished in HR management. By marking the processing method 

Maintenance in table T77FC the function codes are indicated, with which objects may be maintained 

within the structure; Otherwise, only Display is allowed. 

The function code has effects in connection with the structural authorization. In table T77PR, 

authorization profiles can be indicated which are to have maintenance authorization for the structure. 

Without this authorization, you can only display structures. Consequently, the overall authorization 

results from the intersection between basis authorization and structural authorization. 

Object: C_ROUT Routings and reference operation sets 

Definition 

This authorization object controls authorizations in 

- routings 

- reference operation sets 

- rate routings 

- reference rate routings 

- master recipes 

Defined fields 

The following fields are checked: 

Fields Possible entries 

Values 

Meaning 

ACTVT 01 You may create data. 

(Action) 02 You may change data. 

 03 You may display data. 

 06 Logically delete task list, sequence, operation/phase 

    Change deletion flag 

 24 You can generate an archive file. 

 41 You can delete from the database. 

PLNTY N 
You have authorization for 

routings. 

(TL type) S You have authorization for 

reference operation sets. 

 R You have authorization for 

rate routings. 



 

 

 M You have authorization for 

reference rate routings. 

 2 You have authorization for 

master recipes. 

WERKS Enter the plants for which 

(Plant) data may be edited. The system 

will check the plant details of 

material, header, operation and 

sub-operation. 

STATU Enter the status for which 

(Status) data may be edited. The system 

will check the status details in the 

header. 

VERWE Enter the usages for which 

(Usage) data may be edited. The system 

will check the usage in the header. 

Authorization for displaying usages and for mass replacement are linked with the ACTVT field. If you 

are authorized to display data, you automatically have authorization to display usages. If you are 

authorized to change data, you also have authorization to mass replace. 

Authorization for calling up the print list and task list changes is linked to the ACTVT field. In the 

evaluation results only those task lists are displayed that the user is authorized to display. 

Authoritzation for the field in the header and operations that are relevant to QM, is linked to 

Q_PLN_FEAT authorization object (authorization for maintaining inspection characteistics in task lists).  
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Object: S_PROGRAM ABAP: Program flow checks 

Definition 

Authorization to execute ABAP/4 programs by program group. 

You can assign authorizations by program group for the following activities: 

- Starting a program 

- Scheduling a program to run as a background job 

- Editing variants 

Defined fields 

The object consists of two fields: 

- Authorization Group ABAP/4 Program: Name of the program group for which a user is 

authorized. 

Programs that are not assigned to any class can be started and edited by any user. Generic names 

are not supported. 

- User Action ABAP/4 Program: Permitted operations. Possible values: 

- SUBMIT: Executes programs 

- BTCSUBMIT: Schedules programs for background processing 

- VARIANT: Edit variants 

(The EDIT activity is obsolete as of Release 3.0. Authorizations for attributes, text elements, and 

ABAP/4 help functions are checked using the object S_DEVELOP.) 

Example 

This authorization allows a user to execute programs in the MMDLMAT authorization group. 

 Field Value 

 Authorization Group ABAP/4 Program MMDLMAT 

 User Action ABAP/4 Program SUBMIT 

Object: C_CRFH_BGR Production resources/tools  



 

 

Object: C_CAPV_STA CAPP: Application 

Definition 

Authorization for the maintenance of CAP master data 

This object controls whether a user is authorized to edit the master data of the CAP calculation of 

standard values (formulas, methods, and procedures). 

Defined fields 

Fields Possible entries Meaning 

ACTVT 01 User may create data. 

 02 User may change data. 

 03 User may display data. 

 06 User may delete data. 
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Object: C_CAPV_ANW CAPP: Master data maintenance 

Definition 

Authorization for performing the computer-aided planning (CAP) calculation of standard values 

This object controls whether the user is authorized to perform a CAP calculation of standard values. 

Defined fields 

Fields Possible entries Meaning 

ACTVT 16 User may perform the CAP calculation 

of standard values.  



 

 

26.2 Sales & Operations Planning (SOP) 

This implementation guide tells you how to configure Sales & Operations Planning (SOP). 

The application allows planning at any level of aggregation: for example, high-level planning of planning 

hierarchies and/or product groups or detailed planning of finished products. 

Not only can users create sales and production plans, they can also plan other items of information such 

as key figures from an information structure. 

Moreover, resource leveling can be performed for work center capacities, materials, production 

resources/tools, and costs to ensure that resources are sufficient to meet targets. 

Planning is carried out in an easy-to-use planning table like a spreadsheet, in which macros and events 

can be defined and actual data compared with planned data. 

26.2.1 Master Data 

In this section, you configure the following master data for Sales & Operations Planning: 

- planning parameters for information structures 

- planning parameters for key figures 

- number range intervals for combinations of characteristics 

- number range intervals for events 

26.2.1.1 Assignment of Validation Rules to Key Figures 

Documentation for the following IMG activities will be available in Release 4.0B. 

26.2.1.1.1 Maintain Checking Groups for Availability Check 

Documentation for this IMG activity will be available in Release 4.0B. 

26.2.1.1.2 Maintain Checking Rules for Availability Check 

Documentation for this IMG activity will be available in Release 4.0B. 

26.2.1.1.3 Assign MRP elements to a key figure 

Documentation for this IMG activity will be available in Release 4.0B. 

26.2.1.2 Set parameters for info structures and key figures 

In this step, you set the planning parameters of information structures and their key figures for use in 

Sales & Operations Planning. These parameters are as follows: 
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Information Structures 

- Table 

This is the number of the information structure. 

- Number of rolling versions 

At any one time, the system can manage one active planning version and a number of historical 

versions for an information structure. You specify here the number of historical versions which you 

want to be stored in the system. 

- Planning method 

- Consistent planning 

- Level-by-level planning 

- Delta planning 

In consistent planning, planning levels are interdependent. The user plans at any characteristic level, 

and the data is then aggregated and disaggregated automatically up and down the planning 

hierarchy. The sum of the details always gives the planning value at the aggregate level. In contrast 

to level-by-level planning, the system stores the data at the most detailed hierarchy level only. 

In level-by-level planning, planning data is saved for every characteristic value of an information 

structure. The planning levels are independent of each other, unless they are aggregated and/or 

disaggregated by manual intervention from the user. In order to aggregate, you need to write a 

macro (see SOP: Planning Types and Macros). You perform disaggregation for a key figure using 

the planning table function Edit -> Disaggregate line; the system then bases disaggregation on the 

proportional factors in the planning hierarchy master record. 

In delta planning, aggregation is performed automatically, but not disaggregation. 

- planning plant 

The plant you enter here is used in resource leveling. Resource leveling is always carried out with 

reference to a plant, even if no plant has been specified in the rough-cut planning profile. For more 

information, see Define scheduling levels, Define routing selection, and Set planning plant for SOP. 

- storage periodicity 

The storage periodicity gives the time unit in which planning versions of the information structure 

are stored. The default storage periodicity is the update period defined in Customizing for the 

Logistics Information System. 

If the planning method is consistent planning or delta planning, this entry is mandatory. 

If the planning method is level-by-level planning, this entry is optional. If you do not define a 

storage periodicity, the data is saved as it is displayed in the planning table. 

- fiscal year variant 

If the storage periodicity is "posting period", you must specify a fiscal year variant. 

- factory calendar 

Make an entry here if you want to be able to disaggregate one or more key figures in this 

information structure with regard to time (see "time-based disaggregation" below). 

- exchange rate type 

You define here whether, for example, an average rate, a buying rate, or a selling rate is to be used 

for currency conversion. 

- statistics currency 

This is the currency in which you want to plan value key figures from this information structure. It 

will apply throughout the planning hierarchy. 

- base unit of measure 



 

 

If the planning method is consistent planning, this is the default unit in which you plan quantity 

key figures from this information structure. The unit can be overwritten in the planning table 

provided that conversion is possible either via the SI system (e.g. 1 tonne = 1000 kg) or via 

conversion factors defined in the material master. 

If the planning method is level-by-level planning, this is the default unit in which you plan quantity 

key figures from this information structure. This unit can be changed in the planning hierarchy for 

characteristic values above the material level provided that conversion is possible via the SI system 

(e.g. 1 tonne = 1000 kg). Key figure quantities are shown in the planning table in the unit of 

measure maintained for that characteristic value in the planning hierarchy. The unit can also be 

overwritten in the planning table provided that conversion is possible either via the SI system or via 

conversion factors defined in the material master. 

When data is transferred from SOP to Demand Management, planned independent requirements are 

created in Demand Management in the base units of measure of the materials. This is not 

necessarily the same as the base unit you maintain here. If you plan a material in SOP in a unit 

other than its base unit, the necessary conversion factor between the two units needs to have been 

defined in the material master record. Otherwise, you cannot pass on this material's data to Demand 

Management. 

- zero values to MRP 

You set this indicator if you want key figure values of zero to be transferred to Demand 

Management. 

Note 

When you perform this transfer, any planned independent requirements that already exist in 

Demand Management are overwritten with the SOP data. 

- capacity allowed 

Enter a "1" here to allow the capacity situation to be displayed for this information structure. You 

will then be able to carry out resource leveling for the following resources: 

- work center capacities 

- materials 

- production resources and tools 

- costs 

- capacity key figure 

If you want to carry out capacity planning in flexible planning on the basis of routings, enter here 

the field name of the key figure to which the capacity load is to be attached. 

- no unit conversion 

Enter an "X" here to disallow units conversion for this information structure. 

- no user exits 

Enter an "X" here to disallow the incorporation of non-SAP data into your sales and operations 

plans. 

- no 0 column usage 

Enter an "X" here to disallow the setting of values (for example, opening stock) in the 0 column of 

the planning table. 

- no event usage 

Enter an "X" here to disallow the use of events for this information structure. 

Key Figures 
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- forecast 

You specify whether or not it will be possible to run a forecast for this key figure in this 

information structure. 

- time-based disaggregation 

You specify whether or not, in the case of period splitting to a smaller period (e.g. 

months to weeks), you wish to disaggregate on a proportional basis. 

You use the "factory calendar" setting (see above) in conjunction with this parameter. 

Example 

The key figure is stock level and you wish to maintain a constant stock level of 100 tonnes. 

Therefore, you do not disaggregate (that is, you do not set this indicator); when you change the 

period split from months to weeks, the stock level stays at 100 tonnes. 

Example 

The key figure is planned production order quantity. You wish to view it first in months and second 

in weeks. In this case, you do disaggregate. The system works out the key figure values in each of 

the periods with reference to the factor calendar. 

 - aggregation type 

This parameter is designed for use with the consistent planning method. In consistent planning, data 

is aggregated and disaggregated automatically to every level in the planning hierarchy. For each 

key figure, you choose one of three options: 

1. Average calculated 

If you are in Create mode and enter or overwrite data at the aggregate level, this data is copied to 

the detailed level. 

If you are in Change mode and overwrite data at the aggregate level, the values at the 

detailed level change so that each one represents the same proportion of the aggregate value as 

before. 

If you create or change data at the detailed level, the new value at the aggregate level is calculated 

as the mean average of the values at the detailed level. 

This option is designed for key figures that represent prices (for example, sales price) or 

percentages (for example, percentage of purchasing budget already released). 

2. Total created 

This is the default setting for planned key figures. 

The system performs aggregation by totaling the key figure values at the detailed level and writing 

the total to the aggregate level. 

The system performs disaggregation using the proportional factors. In consistent planning, the 

proportional factors can be determined in four ways: 

- You can have the system calculate them on the basis of existing (normally actual) data (the 

menu option Master data -> Calculate proportions -> Using actual data). This calculation 

gives generic proportional factors that will be valid for all key figures, characteristic values, 

and periods unless they are overridden. 

- You can have the system calculate them on the basis of proportional factors already entered 

for adjacent levels in the planning hierarchy (the menu option Master data -> Calculate 

proportions -> Using planning hierarchy). This calculation gives generic proportional 

factors that will be valid for all key figures, characteristic values, and periods unless they are 

overridden. 



 

 

Note 

If you have calculated the proportional factors in one of the two ways just described and then 

change the values of a key figure in the planning table, you override the predefined 

proportional factors of this key figure in this period. This means that the next time 

disaggregation of this key figure for this period takes place, the system uses the new 

(temporary) proportions that it derives from the changed data at the detailed level. However, 

you can still apply the predefined proportional factors to this key figure. To do so, place the 

cursor on it and select Edit -> Disaggregate line. 

- You have not calculated the proportional factors and no planning data has yet been entered in 

this version of the information structure. The data is distributed evenly, that is, the 

proportional factor of each of the details is the same. 

- You have not calculated the proportional factors and data has already been entered for this 

version of the information structure. The system distributes the data according to the 

proportions which it derives from the key figure values at the detailed level. 

Therefore, the following situations may arise: 

If you create a version and enter data for the first time, the system performs disaggregation in one 

of two ways: 

- the data is distributed using the predefined proportional factors (see above) 

This is the case if you have predefined the proportional factors. The data is disaggregated 

automatically to the detailed level when the planning table is regenerated, that is, when you select 

ENTER or switches to the detailed level with Goto -> Details. 

- the data is distributed evenly 

This is the case if you have not predefined the proportional factors. The data is disaggregated 

automatically to the detailed level as soon as the screen is regenerated, that is, when you select 

ENTER or switch to the detailed level with Goto -> Details. 

If you create a planning version and overwrite data which has just been entered, or if you change a 

planning version, the system performs disaggregation in one of two ways: 

- the data is distributed in accordance with the proportions it derives from the existing planning 

data 

This is the case either if you have not predefined the proportional factors, or if you have changed 

the key figure values at the detailed level in certain periods, thus overriding the predefined 

proportional factors. The data is disaggregated to the detailed level as soon as the screen is 

regenerated, that is, when you select ENTER or switch to the detailed level with Goto -> Details. 

- the data is distributed using the predefined proportional factors (see above) This is the case if 

you have predefined the proportional factors. However, if you have changed the key figure 

values at the detailed level in certain periods, thus overriding the predefined proportional 

factors in those periods, you must also select Edit -> Disaggregate line for this key figure. 

Otherwise, the system will disaggregate the key figure in these periods on the basis of the new 

proportions that it derives from the altered planning data. 

 3. No aggregation 

Neither aggregation nor disaggregation is performed. This option is designed for key figures which 

do not need to be aggregated or disaggregated, such as text lines or auxiliary lines. 

This is the default for actual data. 
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Requirements 

You create, change, and display information structures in Customizing for the Logistics Information 

System (the step Maintain self-defined information structures). 

Actions 

1. Select the information structure whose parameters you want to set, if necessary, using the 

pushbutton Position. 

2. Select Goto -> Details. 

3. Set the parameters of this information structure. 

4. Select Table view -> Save. 

5. Select Goto -> Back. 

6. In the Navigation group box at the top of the screen, click on the navigation icon for Key Figure 

Parameters. 

7. Select the key figure whose parameters whose want to set, if necessary, using the pushbutton 

Position. 

8. Select Goto -> Details. 

9. Set the parameters of this key figure. 

10. Select Table view -> Save. 

11. Select Goto -> Back. 

26.2.1.3 Set planning plant for SOP 

In this step, you specify which plant is to be used for resource planning in SOP in cases where no other 

plant can be identified. 

When you carry out resource planning in SOP, the system reads the resource requirements from a routing 

or a rough-cut planning profile. Precisely which routing or rough-cut planning profile is read depends on 

the selection ID set in Customizing and on the priorities defined for this selection ID (see Define 

scheduling levels and Define routing selection). The system identifies the selection ID with reference to 

several selection criteria, in particular, the criterion "plant". If plant is not a characteristic of the planned 

information structure, or if the planned characteristic values combination includes more than one plant, 

no plant is uniquely identifiable. The system then checks to see whether a planning plant has been set for 

this information structure in the Customizing step Set parameters for info structures and key figures. If 

no entry is found here, the selection ID is identified via the plant marked as the planning plant in this 

step. 

Actions 

1. Enter an 'X' by the plant you want to function as your planning plant in SOP. 

2. Select Table view -> Save. 

Further notes 

Only one plant can be marked as the SOP plant. 



 

 

26.2.1.4 Define number range for combined characteristics 

In this step, you define the number range intervals of characteristic value combinations in Sales & 

Operations Planning (SOP). 

The system uses these numbers internally; they do not appear in the application. 

Example 

You may find it useful to define different intervals for test data and production data. 

Actions 

1. Maintain the number range intervals of your characteristic value combinations as required. 

2. Make sure that no number intervals overlap. 

3. Save your changes. 

Transport Notes 

To transport number range objects, select Interval -> Transport on the initial screen. 

In the target system, all intervals of the chosen number range object are deleted first so that only the 

exported intervals exist after the import. The number statuses are imported with the value that they had 

when exported. 

Dependent tables are not transported or converted. 

26.2.1.5 Define number range for events 

In this step, you define the number range intervals of events in Sales & Operations Planning (SOP). 

The system uses these numbers internally; they do not appear in the application. 

Example 

You may find it useful to define different intervals for test data and production data. 

Actions 

1. Maintain the number range intervals of your events as required. 

2. Make sure that no number intervals overlap. 

3. Save your changes. 

Transport Notes 

To transport number range objects, select Interval -> Transport on the initial screen. 

In the target system, all intervals of the chosen number range object are deleted first so that only the 

exported intervals exist after the import. The number statuses are imported with the value that they had 

when exported. 

Dependent tables are not transported or converted. 
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26.2.1.6 Create characteristics for remainder allocations 

In this step, you maintain a block allocation for characteristic values for which no specific allocation is 

defined. SAP recommends you carry out this step if you intend to plan product allocation quantities. 

The system then adds the characteristic value '#' to every level of the planning hierarchy except the top 

one. This top level is represented by the characteristic "product allocation object". Thus, it acts as a 

container for all characteristic values that are not specified by name in the planning hierarchy. 

You quantify the allocations by defining proportional factors in the planning hierarchy. 

When the system carries out allocations checking, it works from the bottom of the planning hierarchy 

upwards. With information structure S140, it checks whether an allocation has been maintained for the 

sold-to party for which the order has been taken. If not, it moves up one level and checks to see whether 

the customer belongs to a customer group for which an allocation has been maintained. If no allocation 

has been maintained for characteristic values at the lower levels, the system arrives at the "product 

allocation object" characteristic value at the top of the planning hierarchy and derives the allocation from 

the proportional factor from the appropriate container. If a valid combination of characteristic values is 

found but the allocation has already been used up, then the container is not used. 

Thus you can assign allocations to only the most important customers without having to create separate 

master records for each of the less important characteristic values (i.e. customers). 

Activities 

1. Enter the information structure on which your product allocation planning is based. 

The standard information structure provided by SAP for product allocation is S140. 

2. If you want the results to be saved on the database, select Change database. 

3. Select Program -> Execute. 

26.2.2 Functions 

In this section, you configure the following planning functions for Sales & Operations Planning (SOP): 

- proportional distribution of data across plants 

- resources planning 

- forecasting 

- mass processing 

- Application Link Enabling (ALE) 

26.2.2.1 Define proportional distribution across plants 

In this step, you configure the proportional distribution across different plants of material values that the 

user copies from one information structure to another. The source information structure does not contain 

the characteristic "plant", but the target information structure does contain it. 

Example 



 

 

You want to create sales plans in standard SOP by transferring the sales quantities already planned in the 

Sales Information System (SIS). However, the sales quantities in SIS are not planned with reference to 

plants, while product groups and materials in SOP are defined in terms of their plant. 

Product group PGTB contains two members: the material MTB "touring bike" in plant 1 and plant 2. The 

system treats them as the same planning object in the Sales Information System and as separate planning 

objects in standard SOP. For standard SOP, you define the proportion of this material's sales in plant 1 as 

0.7 and the proportion of sales in plant 2 as 0.3. 

Actions 

1. Enter your plants. 

2. Specify the proportions of these plants, for example, 0.75 and 0.25. 

3. Enter materials to which these proportions do not apply, including materials which are managed in 

only one plant. 

You enter a material as many times as it has plants. 

4. For each material, enter the plants in which it is managed. 

5. Specify the proportions of your materials in each plant. 

If a material is managed in only one plant, the proportion for this plant will be 1. 

Further notes 

You do not have to enter proportions for each material separately, but only for materials to which the 

usual distribution does not apply. To specify the usual distribution, you enter the proportions of your 

plants leaving the material column blank. 

If you do not enter any proportions here, the system will distribute the data evenly across all plants in 

which the material is managed. 

26.2.2.2 Resource Planning 

In this section you configure resources planning for Sales and Operations Planning (SOP). You define 

the following: 

- Scheduling parameters 

- Routing selection 

- Number range intervals (number areas) for SOP orders 

26.2.2.2.1 Configure scheduling parameters 

In this step you specify for each plant and production scheduler the parameters for scheduling 

SOP orders. This comprises the maintenance of 

- scheduling control for detailed scheduling 

- reduction 

The parameters are described in more detail in what follows: 

- In detailed scheduling you specify: 
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- how the production dates are calculated 

- whether capacity requirements are generated 

- In scheduling control for detailed scheduling you define the control parameters for detailed 

scheduling, among other things 

- scheduling type 

Here you specify the scheduling direction. You can also specify that a scheduling run is only 

used to generate capacity requirements. 

- Start date in the past 

Here you specify how many days an order can be in the past before today scheduling is 

automatically triggered. 

- Automatically display log 

Here you specify whether the log is automatically displayed after scheduling. 

- In reduction you specify 

- up to what maximum reduction level the reduction can take place 

- to what percentage the floats before and after production in every reduction level should be reduced. 

Actions 

Define the scheduling parameters for SOP orders. 

26.2.2.2.2 Define routing selection 

In this step, you define the selection IDs which identify the criteria for the automatic selection of 

routings. 

The selection criteria are: 

- routing type 

- routing usage - routing status 

You can assign several combinations of these selection criteria to every selection ID, and specify a 

selection priority for each combination. 

When selecting routings, the system searches for a routing which matches the selection criteria. If it 

cannot find a routing matching the criteria with the highest priority, it will continue to search using the 

criteria with the next highest priority, and so on. 

Actions 

1. Define the selection criteria and their priorities for the desired selection ID. 

2. Save your routing selection criteria. 

Further notes 

When computing resources, the system determines the selection ID according to the following criteria: 

- plant 



 

 

- order group 

- order type 

- production scheduler 

See also Define scheduling levels. 

However, flexible planning in SOP may be carried out on a combination of characteristic values for 

which a plant cannot be uniquely identified. Possible reasons for this are: 

- "plant" is not a characteristic of the information structure 

- you are planning at an aggregate level across multiple plants 

Example 

You plant all materials that belong to sales organization CENTRAL. These materials are managed 

in several different plants. You now wish to carry out resource leveling for this characteristic values 

combination. 

If no one plant can be identified, the plant which the system uses to determine the selection ID is the 

plant defined in the Customizing step Set parameters for info structures and key figures. If no plant has 

been defined here, the selection ID is determined using the SOP plant defined in the Customizing step 

Set planning plant for SOP. 

The system determines the selection ID by searching in the following order for these criteria: 

First Choice 

 Plant see above 

Order group 1 

Order type [space] 

Production scheduler 

Second Choice 

[space] or entry as in material master 

Plant see above 

Order group 1 

Order type [space] 

Production scheduler 

Third Choice 

* 

Plant see above 

Order group 1 

Order type * 

Production scheduler 

Fourth Choice 

[space] or entry as in material master 

Plant see above 

Order group 1 

Order type * 

Production scheduler * 

26.2.2.2.3 Define number range for SOP orders 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 186 

In this step, you maintain the number range intervals of SOP orders. The quantities and dates of 

requirements planned in Sales & Operations Planning are stored in SOP orders. The system creates SOP 

orders in the background. SOP orders are used in resource leveling. 

Example 

You may find it useful to define different intervals for test and production data. 

Actions 

1. Check the number range intervals of your SOP orders to ensure there is no danger of overflow. 

2. Make sure that no number intervals overlap. 

3. Make any necessary changes. 

4. Save these changes. 

Transport Notes 

To transport number range objects, select Interval -> Transport on the initial screen. 

In the target system, all intervals of the chosen number range object are deleted first so that only the 

exported intervals exist after the import. The number statuses are imported with the value that they had 

when exported. 

Dependent tables are not transported or converted. 

26.2.2.3 Forecasting 

In this section you configure the forecast for Sales and Operations Planning (SOP). You define the 

following: 

- Forecast profiles 

- Number range intervals (number areas) for forecast parameters -

 Number range intervals (number areas) for forecast values 

26.2.2.3.1 Maintain forecast profiles 

In this step, you configure forecast profiles. The automatic forecast is one way to create sales plans in 

Sales & Operations Planning. 

Forecast profiles combine forecast parameters which are often used together. Thus, they facilitate data 

entry since the user does not have to make the same settings every time he/she runs a forecast, but can 

simply choose a forecast profile. 

Standard settings 

Release 3.0 of the R/3 System comes with the standard forecast profile SAP. You can add your own 

profiles as necessary. 

Actions 



 

 

1. Maintain the name and description of your forecast profile. 

2. Maintain its forecast parameters. 

3. Save your entries. 

26.2.2.3.2 Define number range for forecast parameters 

In this step, you configure the internal number range intervals of your forecast parameters. 

Example 

You may find it useful to define different intervals for test and production data. 

Actions 

1. Check the number range intervals of your forecast parameters to ensure there is no danger of 

overflow. 

2. Make sure that no number intervals overlap. 

3. Make any necessary changes. 

4. Save these changes. 

Transport Notes 

To transport number range objects, select Interval -> Transport on the initial screen. 

In the target system, all intervals of the chosen number range object are deleted first so that only the 

exported intervals exist after the import. The number statuses are imported with the value that they had 

when exported. 

Dependent tables are not transported or converted. 

26.2.2.3.3 Define number range for forecast values 

In this step, you configure the internal number range intervals of your forecast values. 

Example 

You may find it useful to define different intervals for test and production data. 

Actions 

1. Check the number range intervals of your forecast values to ensure there is no danger of overflow. 

2. Make sure that no number intervals overlap. 

3. Make any necessary changes. 

4. Save these changes. 

Transport Notes 

To transport number range objects, select Interval -> Transport on the initial screen. 
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In the target system, all intervals of the chosen number range object are deleted first so that only the 

exported intervals exist after the import. The number statuses are imported with the value that they had 

when exported. 

Dependent tables are not transported or converted. 

26.2.2.4 Mass Processing 

In this section, you configure the processing of large volumes of data in Sales & Operations Planning 

(SOP) for actions which require a planning activity. 

The following actions require a planning activity for mass processing: 

- forecasting 

You create a forecast profile in Maintain forecast profiles. You 

define an activity for forecasting in this section. 

- copying key figures from one information structure to another You create a key figure assignment 

profile and a copy profile in this section. You define an activity for copying in this section. 

- transferring data to Demand Management 

You create a transfer profile in this section. 

You define an activity for the transfer in this section. 

- executing macros 

You write a macro for a planning type in Maintain planning types. You 

define an activity for the macro in this section. 

For full information on the various steps required to carry out each of these actions, see the online guide 

"PP Sales & Operations Planning". 

26.2.2.4.1 Define activities 

In this step, you make the general configurations necessary for SOP activities. Background jobs can then 

be created and scheduled for these activities. An SOP activity includes one or more of the following: 

- a macro as defined in a planning type 

- a transfer of data to Demand Management 

- the copying of key figure values between versions of different information structures 

- the forecast 

For each activity, you specify: 

- a key 

This represents the activity that will be performed when the background job is run. 

- a sequence number 

One activity can comprise several actions. This number determines the sequence in which these 

actions are performed when the background job (that is, the activity) is carried out. 

- a planning type 



 

 

In this field, you specify the planning type to which the activity refers. You must make an entry in 

this field. 

If you are copying between information structures, you enter a planning type of the target 

information structure. 

- an action 

In this field, you specify whether the action is a macro, a transfer to Demand Management, the 

copying between versions of information structures, or the forecast. 

- macro 

If the action is a macro, you specify the macro name here. 

- transfer profile 

If the action is the transfer of planning data to Demand Management, you specify a transfer profile 

here. 

- copy profile 

If the action is the copying of data from one information structure to another, you specify a copy 

profile here. 

- forecast profile 

If the action is the forecast, you specify a forecast profile here. 

- table 

If the action is the forecast, you enter here the information structure of the key figure for which the 

forecast will be run. 

- field name 

If the action is the forecast, you enter here the key figure for which the forecast will be run. 

Requirements 

Before you carry out this step, you need to have defined the planning type. 

You also need to have defined the action: 

- a macro 

- a transfer profile 

- a key figure assignment profile and a copy profile , or 

- a forecast profile 

Actions 

1. Make or change your entries. 

2. Save them. 

Further notes 

You do not need to create an activity if the following conditions are met: 

- the planning method of both your source and your target information structures is consistent 

planning 

- you require a high-level copy with subsequent distribution 

In this case, you create a key figure assignment profile and then carry out the function Planning -> 

Mass processing -> Copy/delete version -> High-level copy. 
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For more information, see Copy key figures between info structures. 

26.2.2.4.2 Copying Key Figures Between Info Structures 

In this section, you configure the copying of key figures from one information structure to another. 

The copying method you use depends on the planning methods of the source and target information 

structures and on the characteristics in each one. Sales & Operations Planning comes with standard 

copying methods for three combinations of planning methods: 

- consistent -> consistent 

- consistent -> level-by-level 

- delta -> level-by-level 

Otherwise, you can write your own copying method and define it in the Customizing step Define user 

methods. 

The standard copying methods are as follows: 

Consistent -> Consistent 

The system copies key figures to the detailed level of the target information structure in one of two ways: 

1. The system attempts to match planning objects with identical characteristic values in the source and 

target information structures. It then copies key figures to the target information structure for each 

planning object in the source information structure in which the characteristic value can be found. 

Example 

Source Information Structure 

Region       01   01   02   03 

Division     01   02   01   02 

Material     A    A    A     A 

Key figure   10   10   20   20 

The sum of the key figures at the detailed level is 60. 

Target Information Structure 

SalesOrg   0001 0001 0002 0002 

DistChnl     01   02   01   02 

Material      A    A    A    A 

Plant         1    1    1    1 

Key figure   60   60   60   60 

The key figure has been copied to the four planning objects which contain material A. 

2. The system attempts to match planning objects with identical characteristic values in the source and 

target information structures. It copies a key figure once only for each characteristic value. This key 

figure is then distributed among the planning objects which contain this characteristic value. The 

key figure is distributed either equally or in accordance with the proportional factors. 



 

 

If you are copying online, the characteristic values for which key figures are copied depend on the 

characteristics for which you specified values when calling up the planning screen. If you use 

background processing, key figures are copied for all planning objects with identical characteristic 

values in the source and target information structures. 

If you desire an aggregate copy with subsequent distribution (see example below), you must 

perform one of two actions depending on whether you will be copying data online or in the 

background: 

- online processing 

You set the Aggregate copy indicator in the second dialog box that appears after you have 

selected Edit -> Copy data in the planning table. 

- background processing 

You carry out the function Planning -> Mass processing -> Delete/Copy -> High-level 

copy in the flexible planning menu. 

Example 

Source Information Structure 

Region       01   01   02   03  1 

Division     01   02   01   02  1 

Material      A    A    A    A  B 

Key figure   10   10   20   20 10 

The sum of the key figures at the detailed level for material A is 60. 

Target Information Structure 

SalesOrg   0001 0001 0002 0002 0001 

DistChnl     01   02   01   02   01 

Material      A    A    A    A    B 

 Plant         1    1    1    1    1 

 Key figure   15   15   15   15   -- 

The key figure has been copied to material A and then distributed among the planning objects which 

contain this material. Only material A was specified when the planning screen was called, not material B. 

Consistent -> Level-By-Level 

The target information structure can be either the standard information structure S076 or an information 

structure you have created yourself. The level to which the key figures are copied depends on the 

characteristics. When planning online, you specify these when calling up the planning table. When 

planning in the background, you specify the characteristics in the variant. 

If the target information structure is S076, you need to have run the Actual Data Generator in standard 

SOP before you copy data. 

If plant is a specified characteristic of the target information structure but is not contained in the source 

information structure, the system distributes the key figure quantities across the different plants of each 

material provided that two conditions are fulfilled: 

- the target information structure is S076 or a similar information structure with the same 

characteristic fields 

- the proportions by which the key figure is to be distributed have been defined in the Customizing 

step Define proportional distribution across plants 
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Delta -> Level-By-Level 

This method is used when you create sales plans in standard SOP by copying data from the Sales 

Information System in which one of the standard information structures for sales has been planned. 

You need to have run the Actual Data Generator in standard SOP before you copy data. 

26.2.2.4.2.1 Maintain copy profiles 

In this step, you configure copy profiles. Copy profiles allow you to copy data in the background from 

one version to another version of different information structures. 

Copy profiles facilitate data entry since you do not have to make the necessary settings every time you 

want to copy data from one information structure to another; instead, you simply choose a copy profile. 

Note 

You do not need to create a copy profile if the following conditions are met: 

- the planning method of both your source and your target information structures is consistent 

planning 

- you require a high-level copy with subsequent distribution 

In this case, you create a key figure assignment profile and then carry out the function 

Planning -> Mass processing -> Copy/delete version -> High-level copy. For more 

information, see Copy key figures between info structures. 

You make the settings for the copying process in two steps: 

1. You create a key figure assignment profile. 

2. You create a copy profile. 

The second of these steps is described below. 

Copy profiles specify: 

- the name of the copy profile (this is a speaking name of your own choice) 

- the version of the information structure from which data is copied 

- the version of the information structure to which data is copied 

- the first and last dates of the period for which you want data to be copied 

- the assignment key which you defined in the step "Assign key figures to copy profile" 

Example 

Your company uses one information structure to plan sales and another information structure to plan 

production. 

You can use the combination of a copy profile and a key figure assignment profile to define that the key 

figures for "planned sales quantities" are copied from the first information structure to the key figures for 

"planned producion quantities" in the second information structure. 

Requirements 



 

 

You need to create a key figure assignment profile before carrying out this step. 

Actions 

1. Create or change your entries. 

2. Save them. 

26.2.2.4.2.2 Maintain key figure assignment profiles 

In this step, you maintain key figure assignment profiles. 

In SOP, you can copy data from one information structure to another in the background. You make the 

settings for this process in two steps: 

1. You create a key figure assignment profile. 

2. You create a copy profile. 

The first of these steps is described below. 

Key figure assignment profiles facilitate data entry, since you can use them in conjunction with as many 

copy profiles as you like. 

Example 

Your company uses one information structure to plan sales and another information structure to plan 

production. 

You can use the combination of a copy profile and a key figure assignment profile to define that the key 

figures for "planned sales quantities" are copied from the first information structure to the key figures for 

"planned production quantities" in the second information structure. 

Actions 

To create a key figure assignment profile: 

1. Enter a key figure assignment key. 

This key uniquely identifies your key figure assignment profile and provides the link to the copy 

profile. 

2. Enter a counter. 

The counter serves to differentiate key figure assignments within a key figure assignment profile. 

For example, you can store the copying of several key figures in one profile. The default counter is 

0. 

3. In the first Table name field, enter the source information structure, that is, the information 

structure from which you want to copy data. 

4. In the second Table name field, enter the target information structure, that is, the information 

structure to which you want to copy data. 

5. In the first Field name field, enter the field name of the source key figure, that is, the key figure 

whose values you want to be copied. 

6. In the second Field name field, enter the field name of the target key figure, that is, the key figure 

to which you want values to be copied. 

7. Save your entry. 
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Further notes 

You can save several key figures under the same assignment key in the event that you want several key 

figures to be copied together. See the description of the field Counter above. 

26.2.2.4.3 Maintain transfer profiles 

In this step, you configure transfer profiles for the transfer of SOP data to Demand Management where it 

is processed further. 

Transfer profiles facilitate data entry since you do not have to make the necessary settings 

every time you transfer planning data to Demand Management; instead, you simply choose a transfer 

profile. 

In a transfer profile, you specify 

- the name of the transfer profile (this can be any speaking name of your choice) 

- the transfer strategy 

- You transfer the planning data of a material direct from the sales plan (created in the standard 

planning table). 

- You transfer the planning data of a material from the sales plan (created in the standard 

planning table) as a proportion of the product group of which it is a member. 

- You transfer the planning data of a material direct from the production plan (created in the 

standard planning table). 

- You transfer the planning data of a material from the production plan (created in the standard 

planning table) as a proportion of the product group of which it is a member. 

- You transfer the planning data of a material from an information structure (either a planned 

information structure or a planning type based on an information structure). 

- the information structure (table name) that the material data is to be transferred from 

- the information structure from which you want material data to be transferred 

- You make this setting in conjunction with the strategy for transferring from an information 

structure. 

- the key figure (field name) which you want to be transferred 

- You make this setting in conjunction with the strategy for transferring from an information 

structure. 

- the requirements type 

- An entry in this field is optional. If you do not make an entry, the system will determine the 

requirements type automatically. 

- version number for independent requirements 

- active/inactive indicator 

- This specifies whether or not the version is active and therefore relevant for MRP. 

Actions 



 

 

1. Create or change your entries. 

2. Save them. 

26.2.2.4.4 Transfer LIS / CO-PA 

In this IMG activity, you set up the interface for the transfer of data between LIS information structures 

and CO-PA operating concerns. 

This interface enables you to exchange the following data: 

- Planning data 

- Planning data with SOP information structure 

- Statistical key figures 

The activity consists of three functions: 

- In the characteristics assignment, you assign exactly one characteristic of an operating concern to 

a characteristic of an information structure. 

- In the key figure assignment, you assign exactly one value and quantity field  of an operating 

concern to a key figure of an information structure. 

In this assignment, only fields of the same type can be assigned to each other, i.e. quantity field to 

quantity field, value field to value field. 

- In the assignment of information structure to operating concern, you basically have to specify 

the operating concern you wish to use, the corresponding information structure, along with the 

characteristics and key figure assignment. 

Further notes 

In the transfer of planning data with SOP information structure, the characteristics assignment does not 

take place, because this is already understood for information structure S076 (Sales and Operations 

Planning) 

The assignment is defined as follows: 

- COPA   ->   LIS 

- WERKS  ->   WENUX 

- ARTNR  ->   PMNUX 

- WWxxx  ->   PMNUX 

The field WWxxx stands for a freely definable characteristic whose contents correspond to the product 

group in SOP. In the transfer of data from SOP (Sales and Operations Planning) to CO-PA, the system 

determines whether the current characteristic value of the field PMNUX refers to an article or a product 

group. If it is a product group,the corresponding field in CO-PA is taken from the master data of the 

respective product group. 

In the case of information structures that are copied from S076, data can only be transferred at the level 

of article / product group and plant. Any other characteristics that may exist are aggregated. 

26.2.2.5 Generate message type 

In this step, you configure information structures for use in Application Link Enabling (ALE). 

ALE is the technique by which data is exchanged between a central application and distributed 

applications running on different logical computer systems, sometimes in different countries, in a 

communications network. 
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Communication between applications is carried out via the medium of the IDOC (intermediate 

document). The configuration of all information structures is based on one central reference IDOC. An 

IDOC used for SOP has ten segments for key figures, one segment for characteristic values, and one 

segment for the planning version. 

You maintain a distribution model for the IDOC of each information structure, in which you define the 

reference as the sender and the client as the receiver. You can then set up this distribution model such 

that organizational units (characteristic values) receive only data (key figures) which is relevant to them. 

For example, you specify that sales organization Florida is to be sent its own target sales quantities but 

not the target sales quantities of sales organization Texas, and not the total target sales quantities for all 

sales organizations. You configure distribution models in Customizing for Application Link Enabling. 

In order to be able to send the data of a particular information structure, you must have the system 

generate a message type for it (please see "Activities" below). This ensures that an IDOC containing 

planning data is transmitted to the receiver whenever the data of this information structure is saved. This 

may be a sales plan, a production plan, or any planning data saved in an information structure. Previous 

planning data at the receiver location is overwritten in this process. Thus, if the user wishes to resend 

data for any reason, he or she must call up the planning data and save it. All message types generated for 

Sales & Operations Planning have the format "LIPxxx" (xxx stands for the three figures after the leading 

"S" in the name of the information structure). 

At the receiving end, the Workflow Management module records the arrival of an IDOC, checks its 

date, and ensures that the most recent data is saved. If subsequently it is decided that the older data is 

needed after all, it has to be sent again. 

It is possible to define a line in the planning table such that it is not ready for input, for example, such 

that the planning figures set centrally cannot be changed decentrally. 

Example 

1. Sales plans are created decentrally by the company's sales organizations and passed to head office. 

Head office creates an overall production plan based on the cumulated sales plans and then 

distributes production quotas to individual plants. These, in turn, report their ability to meet these 

targets back to head office, which adjusts the production quotas accordingly. Reasons why 

production plants might not be able to meet the central targets include machine failure or a staff 

shortage. The planning table might contain a line showing the difference between the quotas set by 

head office and those set decentrally. Because the criteria which determine a sales plan are very 

different from the criteria which determine a production plan, there is no need for the sales planner 

and the production planner to communicate directly with each other. 

2. Alternatively, or in addition, head office may adjust the sales targets set by the individual 

sales organizations. 

Requirements 

The information structure must be present both centrally and decentrally so that characteristic values can 

be recognized on both sides. 

Actions 

To configure an information structure for use in Application Link Enabling: 

1. Specify the information structure. 



 

 

2. If you want any existing message type for this information structure to be overwritten by a new 

message type, set the update indicator. If you want a message type to be created for this information 

structure only on condition that none existed before, do not set the update indicator. 

3. Select Enter. 

The system now creates a message type for this information structure. 

Further notes 

To use ALE for Sales & Operations Planning, you must also make a number of settings centrally. For 

further information, see the Implementation Guide for Application Link Enabling. 

Transport Notes 

When you execute this transaction, you are required to enter a change request number. This will enable 

your ALE setting to be transported via a transport request. 

26.2.3 Tools 

In this section you configure the following tools for Sales and Operations Planning (SOP): 

- Planning types and user-specific macros 

- Self-defined procedure (user methods) 

- Generation time stamp 

- User parameters 

26.2.3.1 Maintain planning types 

In this step, you maintain planning types. A planning type is a customized view on the planning table; for 

example, you might have one view for the sales planner and another view for the production planner. A 

planning type defines the content and layout of the lines in the planning table as well as the mathematical 

operations, in the form of macros, which can be performed 

on these lines. 

A planning type is based on any information structure of your choice (either a standard information 

structure or a self-defined information structure). You therefore have almost infinite possibilities with 

regard to the information you can plan. 

If you intend to use the consistent planning method, you must create your own information structure. The 

different planning methods are explained in the online guide "PP Sales & Operations Planning". 

For more information on information structures, see the "Implementation Guide for the Logistics 

Information System" and the online guide "LO Logistics Information System". 

Requirements 

Each planning type is based on an information structure. A suitable information structure must therefore 

exist before you can create a planning type. You create, change, and display information structures in 

Maintain self-defined information structures of Customizing for the Logistics Information System. 
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You configure your information structure for use in Sales & Operations Planning in Set parameters for 

info structures and key figures. 

Actions 

The actions you perform to create a planning type are as follows: 

- making the initial specifications for a planning type 

- creating planning type info 

- assigning a key figure to a line 

- creating lines in the planning table 

- defining line attributes 

- defining a macro 

- using special operators to define macros for stock balance, production, days' supply, and historical 

totals 

- translating planning type, freely defined line, and macro texts 

- viewing a planning type in different formats Each of these actions is described below. 

Making the Initial Specifications for a Planning Type 

To make the initial specifications for your planning type: 

1. Select Create planning type. 

The initial screen for creating a planning type appears. 

2. Enter the name of your new planning type in the first Planning type field. It must begin with the 

letter Y or Z and may be up to 11 characters long. 

3. If you want to base your planning type on an existing planning type, enter the existing planning 

type's name in the Copy from box. 

4. To copy the line layout of the reference planning type, select the Line layout checkbox. 

5. To copy the macros of the reference planning type, select the Macros checkbox. 

Note 

If you copy the macros of the reference planning type, you must also copy its line layout. This is 

because the system needs to know to which lines it should apply the macros. 

6. Select Enter. 

If you have specified a reference planning type, the Define Planning Type screen appears. 

Proceed to the section "Assigning a Key Figure to a Line". 

If you have not specified a reference planning type, a window appears asking you to enter an 

information structure. 

7. Enter the name of the information structure on which you want to base your planning type and 

select Enter. 

The Define Planning Type dialog box appears. 

Creating Planning Type Info 

If you have specified a reference planning type, the system will have copied its planning type info to the 

new planning type. Proceed to the section "Assigning a Key Figure to a Line". 



 

 

To create planning type info for a planning type without a reference: 

1. In the Text field, enter a text up to 60 characters long to describe your planning type. 

2. If you want to plan owner data only, select the radio button for Single-level planning. If you want 

to plan owner and member data, select the radio button for Dual-level planning. 

Note 

If consistent planning or delta planning has been defined for the information structure on which this 

planning type is based, only dual-level planning is possible. 

3. You determine when planning is to start in one of two ways. 

- In the Planning start field, you enter the date on which you want plans of this planning type 

to begin. 

- In the Period offset field, you enter the number of periods into the future that you want plans 

of this planning type to begin. 

The time unit of your chosen information structure as defined in Set parameters of info structures 

and key figures determines whether the period is month, week, day, or posting period. 

4. In the Future periods field, specify the number of future periods that you want to plan in plans of 

this planning type. 

5. In the Historical periods field, specify the number of historical periods that you want to be 

displayed in plans of this planning type. 

The days between the current date and your planning start date count as "historical" and cannot be 

overwritten unless you select the Ready for input checkbox. 

6. If you want to be able to overwrite the data in historical periods, select the Ready for input 

checkbox. For example, you may want to correct past planning data or revise planning data in the 

periods between the current date and planning start start. 

7. In the Default macro field, enter the name you want to give to your default macro. This entry is 

optional. 

A default macro is a macro which the system runs every time the planning screen is 

regenerated, for example, when the user selects Enter. You define macros on the next 

screen. 

8. In the Final macro field, enter the name you want to give to the macro which is run before the 

planning data is stored. This entry is optional. 

9. In the Initial macros field, enter the name you want to give to the macro which is run when the 

planning data is read in. This entry is optional. 10. In the Initial display box, specify whether you 

want 

- both owner and member data (Disaggregation) or 

- just owner data data (Charac.) to be displayed initially when you call up a plan of this 

planning type. The user can change this setting interactively. 

Note 

You can only make this setting if dual-level planning was set in step 2 above, and level-by-level 

planning has been defined for the informaton structure. 

 11. To continue, select Enter. 

The Define Planning Type screen appears. 

The initial planning table contains ten blank lines. You can assign key figures and some other types of 

data to these lines. 
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Note 

If your planning type is dual-level and level-by-level planning is defined for the information 

structure, you create lines, define line attributes, assign key figures, and define macros at both 

owner and member level. 

Assigning a Key Figure to a Line 

To assign a key figure from the information structure to a line: 

1. Place your cursor on the line. 

2. Select Edit -> Assign structure. 

A dialog box appears inviting you to choose a key figure. 

3. Select the key figure you want to be displayed in this line. 

4. To continue, select Enter. 

The selected key figure now appears in the planning table. 

5. Repeat this procedure until you have assigned all the key figures you require in this planning type. 

Creating Lines in the Planning Table 

You can add extra lines in several ways. 

Note 

Only key figures are saved in the information structure; other data is calculated or read into the 

planning table at runtime. 

- You select Edit -> Add line. 

A blank line appears at the bottom of the planning table. 

- You select Edit -> Insert line. 

A blank line appears at the point in the planning table where you positioned your cursor. 

- You select Edit -> Propose lines. 

This causes lines to appear containing all key figures from the information structure.  You can 

delete any lines you do not need. 

- You place your cursor on a key figure line and select Edit -> Actual data. 

A line is inserted below the current line. In the planning table, the actual values of this key figure 

will be displayed here, that is, the values from version 000. You cannot enter or overwrite the 

values on this line. 

This line is useful for comparing planned data with actual data. In retail, for example, you can use it 

to track open-to-buy. 

- You place your cursor on a key figure line and select Edit -> Actual data, previous year. 

A line is inserted below the current line. In the planning table, the actual values of this key figure 

from the previous year will be displayed here. You cannot enter or overwrite values on this line. 

This line is useful for comparing planned data with actual data from the previous year. 

- You place your cursor on a key figure line and select Edit -> User exit data. A line for external 

data is inserted below the current line. You can write your own coding for function module 

EXIT_SAPMMCP6_001 to display data - for example, auxiliary data on this line. The function 

module will be called when you create or change a plan of this planning type. See also Develop 

functional enhancement to read non-SAP data. 



 

 

- You place your cursor on a key figure and select Edit -> Insert event. Lines to show the values of 

events for this key figure are inserted. For more information on events, see the online guide "PP 

Sales & Operations Planning". 

Defining Line Attributes 

Each line has certain attributes that define how its contents are processed and displayed in the planning 

table. The system proposes values for these attributes which you can change as necessary. 

To maintain the attributes of a line: 

1. Place the cursor on the line and select Edit -> Line attributes. The Line Attributes dialog box 

appears. 

2. In the Line text field, enter the text that you want to be displayed on this line if it is different from 

the standard text. You can also enter your own line in the main planning type screen. 

3. Specify a text type: 

- Standard text indicates that the text comes from the key figure in the information structure. 

- Freely defined text indicates that the text is entered by the user (see step 2 above). 

- Planning object indicates any characteristic value, such as a material number or a work 

center capacity. 

4. Specify the Ready for input status: 

- Planning line indicates that you want to be able to plan, that is, overwrite the figures in this 

line. 

- Output line indicates that you want to be able to see, but not enter or change, values in this 

line. 

- Text line indicates that the line contains a text but no numerical values. 

- Auxiliary line indicates that the line acts, for example, as an intermediate step, but is displayed 

only in Definition mode (Goto -> Format -> Definition) and not in Layout mode (Goto -> 

Format -> Layout). 

5. Check and, if necessary, change the Aggregation type (see Set parameters for info structures and 

key figures). 

6. Select Continue. Defining a Macro 

A macro is a mathematical operation made up of a given sequence of instructions. It is useful to define 

macros for often-used, sometimes complicated, series of instructions. Macros save time and eliminate the 

possibility of typing errors during the planning process. The user executes a macro with a single 

keystroke or mouse-click. 

The definition of macros is optional. 

Note 

In the case of consistent planning, the macros for aggregation and disaggregation of characteristic 

data come predefined with the system. You do not have to write them yourself. 

You can define macro in one of two ways: 

- with the Record function 

The Record function allows you to define a macro directly in the planning screen. It is therefore 

quicker than the Create function. The operands can be either texts from lines in the planning table 

or numerical values. The operators are displayed in the application toolbar. Standard operators are 
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provided for the calculation of stock balance, production, days' supply, and historical totals  (see 

"Macros for Stock Balance, Production, Days' Supply, and Historical Totals" below). 

- with the Create function 

The Create function allows you to define a macro in a separate window. You therefore see exactly 

how each macro is calculated. You also set two indicators that control how the macro is handled in 

the planning table. The operands can be either texts from lines in the planning table or numerical 

values. 

Note 

You can also write your own coding for function module EXIT_SAPMMCP6_002 to define a 

highly complicated macro. For more information, see Develop functional enhancement to calculate 

a macro. 

To define a macro using the Record function: 

1. Select Macro -> Record. 

The Define Macro dialog box appears. 

2. Enter here the name and description of your macro. To continue, select Enter. 

3. Choose the first line, that is, the first operand for your macro (place the cursor on it and select 

Choose or double-click with the mouse). 

4. From the application toolbar, choose the operation you wish to perform. 

5. Define the second operand for your macro (either choose a line or enter a value using the 

pushbutton Enter value). 

6. Choose the line in which you want the results of the operation to be displayed. 

7. To save your macro, select Macro -> Save. 

8. To exit Record mode, select Macro -> Exit macro. 

9. You can now try out your macro by entering values in the appropriate lines and selecting Macro -> 

Execute. 

To define a macro for stock balances, production, days' supply, or historical totals using the Record 

function: 

1. Select Macro -> Record. 

The Define Macro dialog box appears. 

2. Enter here the name and description of your macro. To continue, select ENTER. 

3. Select the pushbutton Special operation. 

See also "Macros for Stock Balance, Production, Days' Supply, and Historical Totals" below. 

4. Choose the desired operation and select ENTER. 

5. Choose the lines to be included in the calculation by following the instructions at the bottom of the 

screen (to choose a line, place the cursor on it and select Choose or double-click with the mouse). 

The mathematical operations to be performed by this operator are recorded internally. 

6. When the message Choose first line reappears, either specify further calculations or save the 

macro with Macro -> Save. 

7. To exit Record mode, select Macro -> Exit macro. 



 

 

8. You can now try out your macro by entering values in the appropriate lines and selecting Macro -> 

Execute. 

Note 

You cannot try out macros for production or days' supply in the planning type. This is because these 

macros depend on the number of workdays in a period and the period type is not specified in the 

planning type. 

To define a macro using the Create function: 

1. Select Macro -> Create. 

The Define Macro dialog box appears. 

2. Enter here the name and description of your macro. To continue, select Enter. 

3. In the first Operand field, enter the first operand for your macro. This operand must be a line text 

from the planning table. 

4. Choose an operation. 

5. In the second Operand field, enter the second operand for your macro. This operand can either be a 

line text from the planning table, or a number, or a blank. 

You leave the field blank if, for example, you want to aggregate members (first Operand) to owner 

level (Result). 

6. In the Result field, enter the text of the line on which you want the macro result to appear. 

7. If your macro requires more than one line for its calculation, repeat steps 3 to 6 until your macro is 

complete. 

8. Set or not, as required, the Display and Disregard selection indicators. 

9. Select Macro -> Save. 

10. To return to the main definition screen, select Goto -> Back. 

11. You can now try out your macro by entering values in the appropriate lines and selecting Macro -> 

Execute. 

Macros for Stock Balance, Production, Days' Supply, and Historical Totals 

The following operators are provided for the calculation of stock levels, goods receipts, goods issues, and 

days' supply: 

 Operator Description 

 L0       Stock balance 

 L1       Target stock/receipts 

 L2       Receipts 

L3       Issues 

L4       Target stock/issues 

PR       Target supply/production 

RW       Days' supply 

ZS       Historical totals 

The operations performed by these operators are defined internally as described below. All you need to 

do is specify which lines in the planning type are to represent which operands in the macro (see 
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"Defining a Macro" above); for example, you might define the sales line as goods issues and the 

production line as goods receipts. 

- stock balance 

The operator L0 Stock balance calculates stock levels. As the basis for this calculation, you 

specify goods receipts, goods issues, and (if required) an opening stock level. 

For every period (i): stock level (i) = receipts (i) + stock level (i - 1) - issues 

(i) where stock level (i - 1) is the closing stock from the previous period 

- receipts based on target stock 

The operator L1 Target stock/receipts calculates goods receipts and stock levels. You specify 

target stock levels, goods issues, and (if required) an opening stock level as the basis for this 

calculation. 

For every period (i): receipts (i) = target stock (i) + issues (i) - 

stock (i - 1) if receipts (i) < 0, then receipts (i) = 0 stock (i) = 

receipts (i) + stock (i - 1) - issues (i) 

- receipts 

The operator L2 Receipts calculates goods receipts. You specify goods issues, stock levels and (if 

required) an opening stock level as the basis for this calculation. 

For every period (i): receipts (i) = stock (i) + issues (i) - 

stock (i - 1) 

- issues 

The operator L3 Issues calculates goods issues. You specify goods receipts. stock levels, and (if 

required) an opening stock level as the basis for this calculation. 

For every period (i): issues (i) = receipts (i) + stock (i - 

1) - stock (i) 

- issues based on target stock 

The operator  L4 Target stock/issues calculates goods issues and stock levels. You specify target 

stock levels, goods receipts, and (if required) an opening stock level as the basis for this calculation. 

For every period (i): issues (i) = receipts (i) + stock (i - 1) - 

target stock (i) if issues (i) < 0, then issues (i) = 0 stock (i) = 

receipts (i) + stock (i - 1) - issues (i) 

- production based on target days' supply 

The operator PR Target supply/production calculates goods receipts. As the basis for this 

calculation, you specify goods issues, target days' supply, and (if required) an opening 

stock level. The lines which represent goods issues and goods receipts are recorded in the macro, 

normally goods issues is the sales line and goods receipts is the production line. The system works 

out for each period the quantity that will need to be received (that is, produced) in order to cover 

both sales in the current period and the target days' supply, where one day's supply is the quantity 

sold in the next period divided by the number of workdays in that period. 

Example 

Key figure            0 Column Month 1   Month 2  Month 3 

Workdays in month          -      20         19        - 

Issues (sales)             -       -        190      230 

Target days' supply        -      15         15        - 

Opening stock level      100       -          -        - 

Receipts (production)      -      50        190       80 

- days' supply 



 

 

The operator RW Days' supply calculates days' supply. As the basis for this calculation, you 

specify stock levels and goods issues. The line which represents goods issues is recorded in the 

macro; normally goods issues is the sales line. The system works out the days' supply in a period 

according to the closing stock level in that period and the goods issues (that is, sales) in the 

following periods. 

Example 

Key figure       Month 1 Month 2 Month 3 Month 4 

Workdays in month    20      19      23      22 

Issues (sales)       200     190     230     220 

Stock                 0     100     200     ... 

Days' supply          0      10      20     ... 

- historical total 

The operator ZS Historical total calculates the sum of all the historical values of a chosen key 

figure, and displays the result in the first future period of either the same or a different key figure. 

You use this operator to calculate a backlog such as open orders. 

Note 

In this context, historical periods are historical periods that have not been defined as ready for input 

in the planning type. 

Translating Planning Type, Freely Defined Line, and Macro Texts 

If you want more than one language group to be able to use a planning type, you need to translate the 

planning type text as well as any freely defined line texts and macro texts so that they are available in 

systems with different logon languages. 

Example 

You implement Application Link Enabling (ALE) in order to carry out sales and operations 

planning in distributed systems around the world. 

To translate planning type, freely defined line, and macro texts: 

1. Select Goto -> Translation. 

A window appears showing the planning type text(s) in the top half of the screen and any freely 

defined line texts in the bottom half of the screen. 

2. In the To language field, enter your target language. 

The source language (your logon language) is displayed in the field above. 

3. Select Continue. 

The fields for the planning type and freely defined texts in the target language are ready for input. 

4. Enter your translations. 

5. Select Macro texts. 

The bottom half of the screen now shows the macros defined for this planning type. 

6. Enter your translations of the macro texts on the bottom right of the screen. 

7. To flag your translations of all texts for saving and return to the planning table, select Adopt texts. 

The translations will be saved when you save the planning type. 

Viewing a Planning Type in Different Formats 

You can view a planning type in 

- either Definition mode (Goto -> Format -> Definition) 
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- or Layout mode (Goto -> Format -> Layout). 

In Definition mode, you see all the lines that have been defined. In Layout mode, you see the lines 

that will be visible during planning; these do not include auxiliary lines. 

In addition, there are a number of formats that apply only to the level-by-level planning method in dual-

level planning types: 

- owner data only  (Goto -> Format -> Owner) 

- member data only (Goto -> Format -> Member) 

- owner data and all members at the lower level (Goto -> Format -> Dual-level -> All members) 

- owner data and just one member at the lower level (Goto -> Format -> Dual-level -> One 

member) 

26.2.3.2 Define user methods 

In this step, you create one or more user methods. A user method is a program or programs 

written by your company to perform a clearly defined, highly specific task when certain conditions are 

fulfilled. For example, a method allows you to perform complex transformations on statistical data. It 

consists of administrative information and an ABAP/4 FORM routine which you write yourself. 

In Sales & Operations Planning, you can define methods for the following situations: 

- the setting of initial stock values (B) 

For full information on the different possibilities for setting opening stock levels, see the online 

guide "PP Sales & Operations Planning" (SOP). 

- the copying of planned key figure values from one information structure to another (Y) If the 

combination of planning methods from and to which you want to copy is not defined in the R/3 

System, you create a copying method. For information on the standard copying methods supplied 

with the R/3 System, see the online guide "PP Sales & Operations Planning" (SOP). 

- the reduction in the number of fully qualified records from an information structure, determined by 

the Actual Data Generator, to those records relevant for planning (P) For information on the Actual 

Data Generator, see the online guide "PP Sales & Operations Planning" (SOP). 

In a method, you maintain the following: 

- method usage (B, Y, or P) 

- method 

This is a four-character key of your choice which denotes the method. 

- source table 

This is the source information structure. 

- target table 

This is the target information structure. If the method usage is 'B' or 'P', you enter the same 

information structure for both the source and the target table. 

- program 

This is the program in which you create the FORM routine for the transformation. 

- subroutine 

This is the FORM routine with which the data transformation is carried out. 



 

 

- description 

This is a description of the method. 

Actions 

1. Enter the method usage (B, Y, or P) and press Enter. 

2. Select Methods maintenance -> Maintain methods. 

3. Maintain your entries. 

To branch into the editor for program or subroutine maintenance, double-click on the field 

Program or Subroutine. 

4. Save your entries. 

Further Notes 

To see an example of a particular method, place your cursor on the scenario and click the pushbuttons 

Documentation and Reference. 

You can also create a method to plan characteristic values that are not updated from the operative 

applications. For an example, see Copy Management in Customizing for the Logistics Information 

System. 

26.2.3.3 Reset Generation Time Stamp 

In this IMG activity, object types are regenerated for information structures that are used in Sales and 

Operations Planning (SOP). 

When an information structure is planned for the first time, the planning screens and programs required 

for the planning of this information structure are generated in the background. Each time the coding of 

these programs is changed (for example, when a program is corrected), it is necessary to regenerate these 

objects. 

Note 

In order to ensure that the regeneration runs in background processing mode, you need to specify a 

variant. 

Activities 

1. Select the object types that need to be regenerated. 

2. Save your entries. 

3. Choose Program -> Execute. 

Notes for Transport 

These settings cannot be transported. You should therefore make them in the client(s) of the system in 

which you want to use them. 

26.2.3.4 Set user parameters 

In this step, you make user-specific settings for Sales & Operations Plannning. 
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All entries shown here are default values which the user can overwrite in the application in the Settings 

menu. 

- Date and time specifications for the planning table 

- The date which you enter as the planning start determines the time split (for example, month 

or week) of the planning period. The system uses it to work out the first 

column of the planning table. If you do not enter a date, the current date is adopted. 

- You also have the option of specifying the number of time splits (periods) you want to plan. If 

this field is left blank, the planning horizon is unlimited. 

- Parameters for copying planning quantities from either the Sales Information System (SIS) or 

Profitability Analysis (CO/PA). You specify the following: 

- the information structure 

- the planning version of the information structure 

- which key figure is to be adopted (for example, incoming orders quantity or invoiced quantity) 

- Disaggregation 

You specify here whether 

- automatic disaggregation is to be carried out or not 

- the sales plan or the production plan of the product group is to be used for disaggregation into 

its members 

Note 

The period specifications are copied from the material master. 

Actions 

1. Make your settings. 

2. Save them. 

26.2.4 Functional Enhancements 

The SAP enhancement concept allows you to enhance individual functions of Sales & Operations 

Planning (SOP) that cannot be adapted by standard Customizing or application functions, and tailor them 

to meet your requirements. 

An SAP enhancement consists of at least one component. A distinction is made between the different 

kinds of components (for example, function exits, screen areas, menu entries). 

In contrast to modifications, enhancements are basically compatible with all release levels, as they are 

not incorporated in the original SAP R/3 System, but exist in a name range that is reserved for customers. 

The Customizing activities below describe how you compile the SAP enhancements relevant to your 

business in enhancement projects, edit the enhancement components, and finally activate the 

enhancement projects. An enhancement is not visible until its project has been activated. 

Note 



 

 

Once an SAP enhancement has been allocated to a project, you can no longer use it in another project. 

Activities 

1. First check the functionality of the standard functions. 

2. If the functionalities necessary for your business are not covered by the Customizing functions, you 

can then use the transaction CMOD to develop the functional enhancements. To do this, proceed as 

follows: 

a) In the field Project, specify a name for your enhancement project. 

b) Select Project -> Create. 

c) Enter a short description for your project. 

d) Save the attributes (maintenance info) for the project using Attributes -> Save. 

e) Select the function Goto -> SAP enhancements. 

f) Enter the name of the SAP enhancement that you would like to edit in the field 

Enhancement. 

You can find the names of the SAP enhancements in the corresponding documentation in the 

Implementation Guide. 

You can combine several SAP enhancements to make an enhancement project. To display the 

SAP documentation on an SAP enhancement, place the cursor on the name of this SAP 

enhancement and select the function SAP enhancements -> SAP documentation. 

g) Save your entries. 

h) Go back to the initial screen. 

i) Select the sub-object Enhancement components. 

j) Choose Change. 

The system now displays the SAP enhancements you specified along with their components. 

k) Place the cursor on the name of the component (for example, EXIT_SAPMMCP6_001) that 

you wish to edit and choose Edit -> Component. 

You now branch to the ABAP/4-Editor (function module display). 

l) When you double-click on the INCLUDE line, the system will ask you to create the object 

INCLUDE. 

If you have already created this object, then double-click to branch directly to the ABAP/4-

Editor (program display). 

This is where you can store your own coding. 

m) If you have not yet created the object, you first need to specify the program attributes. 

n) Save the program attributes. 

o) Choose Goto -> Source text. 

You branch to the ABAP/4-Editor. 

p) Enter the coding for your program. 

q) Save the program. 

r) Go back to the initial screen. 

s) Activate the project via Project -> Activate project. 

Your enhancement only takes effect once it has been activated. 

Further notes 
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For more information, select Utilities -> Online manual from the initial CMOD screen. 

26.2.4.1 Import external data to the planning table 

In this step, you can create a user exit to read non-SAP data into the planning table of SOP. To program 

this user exit, use the following enhancement: 

 - MCP20001   User exit to read external data into the planning table 

Actions 

1. Create the functional enhancement. 

For this purpose, you either create a new project or use an existing one. 

2. Activate the project. 

Your enhancement will not take effect until you have activated it. 

Further notes 

Unlike modifications, enhancements can be used with different release levels. This is because they are 

stored in a name range that is reserved for SAP customers, and not in the original SAP name range. 

To find out how to create an enhancement, see the documentation in the functional enhancements 

transaction (CMOD) under Utilities -> Online manual. 

In addition, each enhancement comes with its own documentation. To view this documentation, select 

the pushbutton Display SAP doc. in the enhancements transaction (CMOD). 

26.2.4.2 Calculate complex macros 

In this step, you can create a user exit to calculate a macro in the planning table. To program this user 

exit, use the following enhancement: 

 - MCP20002   User exit to calculate a macro in SOP 

Actions 

1. Create the functional enhancement. 

For this purpose, you either create a new project or use an existing one. 

2. Activate the project. 

Your enhancement will not take effect until you have activated it. 

Further notes 

Unlike modifications, enhancements can be used with different release levels. This is because they are 

stored in a name range that is reserved for SAP customers, and not in the original SAP name range. 

To find out how to create an enhancement, see the documentation in the functional enhancements 

transaction (CMOD) under Utilities -> Online manual. 



 

 

In addition, each enhancement comes with its own documentation. To view this documentation, select 

the pushbutton Display SAP doc. in the enhancements transaction (CMOD). 

26.2.4.3 Define own function codes 

In this step, you can define your own function codes for the planning table. To program this user exit, use 

the following enhancement: 

 - MCP20003  User exit to define a function code 

Actions 

1. Create the functional enhancement. 

For this purpose, you either create a new project or use an existing one. 

2. Activate the project. 

Your enhancement will not take effect until you have activated it. 

Further notes 

Unlike modifications, enhancements can be used with different release levels. This is because they are 

stored in a name range that is reserved for SAP customers, and not in the original SAP name range. 

To find out how to create an enhancement, see the documentation in the functional enhancements 

transaction (CMOD) under Utilities -> Online manual. 

In addition, each enhancement comes with its own documentation. To view this documentation, select 

the pushbutton Display SAP doc. in the enhancements transaction (CMOD). 

26.2.4.4 Create own header information for planning table 

In this step, you can design your own header information for the planning table of flexible planning. To 

program this user exit, use the following enhancement: 

 - MCP20004 User exit to design header screens 

Actions 

1. Create the functional enhancement. 

For this purpose, you either create a new project or use an existing one. 

2. Activate the project. 

Your enhancement will not take effect until you have activated it. 

Further notes 

Unlike modifications, enhancements can be used with different release levels. This is because they are 

stored in a name range that is reserved for SAP customers, and not in the original SAP name range. 

To find out how to create an enhancement, see the documentation in the functional enhancements 

transaction (CMOD) under Utilities -> Online manual. 

In addition, each enhancement comes with its own documentation. To view this documentation, select 

the pushbutton Display SAP doc. in the enhancements transaction (CMOD). 
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26.2.4.5 Define additional authorization checks 

This IMG activity enables you to define authorization checks that a performed in addition to the standard 

checks for planning. You can use the following enhancement to program this user exit: 

 MCP20005   User exit for enhancing authorization checks 

Activities 

1. Create the functional enhancement. 

Either create a new project or use an existing project. 

2. Activate the project. 

You enhancement will not take effect until after activation. 

Additional information 

As opposed zo modifications, enhancements are release-insensitive, because they are not created in the 

original SAP system, but rather in a name range that is reserved for customers. 

You can find information about creating enhancements in the documentation for transaction CMOD 

under Utilities -> Online maunal. 

Each enhancement has its own documentation. You can access this in transaction CMOD using Disaply 

SAP documentation. 

26.2.4.6 Edit Excel header (exported for planning table) 

This IMG activity enables you to process header data in Excel format that is exported from the planning 

table. You can use the following enhancement to program this user exit: 

 MCP20006   User exit for editing Excel header information 

Activities 

1. Create the functional enhancement. 

Either create a new project or use an existing project. 

2. Activate the project. 

You enhancement will not take effect until after activation. 

Additional information 

As opposed zo modifications, enhancements are release-insensitive, because they are not created in the 

original SAP system, but rather in a name range that is reserved for customers. 

You can find information about creating enhancements in the documentation for transaction CMOD 

under Utilities -> Online maunal. 

Each enhancement has its own documentation. You can access this in transaction CMOD using Disaply 

SAP documentation. 



 

 

26.2.4.7 Create F4-Help for self-defined characteristics 

This IMG activity enables you to create a possible entries help (F4) for self-defined characteristics. You 

can use the following enhancement to program this user exit: 

MCP20007   User exit for defining possible entries help (F4) for            self-

defined characteristics 

Activities 

1. Create the functional enhancement. 

Either create a new project or use an existing project. 

2. Activate the project. 

You enhancement will not take effect until after activation. 

Additional information 

As opposed zo modifications, enhancements are release-insensitive, because they are not created in the 

original SAP system, but rather in a name range that is reserved for customers. 

You can find information about creating enhancements in the documentation for transaction CMOD 

under Utilities -> Online maunal. 

Each enhancement has its own documentation. You can access this in transaction CMOD using Disaply 

SAP documentation. 

26.2.5 Business Add-Ins 

26.2.5.1 Postprocessing of forecast errors and exception messages 

Use 

If the update indicator is not selected in the mass forecast, the forecast results (forecast values, forecast 

errors and exception messages) are not stored. 

Accordingly, you have the option of checking the forecast errors with transaction MP33 and then 

correcting them. 

Since the mass forecast can only be carried out once for a period without initialization indicator, it would 

make sense to first only save the forecast error for test purposes, and then to check the incorrect forecast 

using transaction MP33. After all errors have been corrected, the mass forecasts with a selected update 

indicator will start. 

This method allows the forecast values and forecast errors to be stored separately from each other. If the 

'FLG_PRON' flag in the Include 'ZXFCSU01' is set to True ( FLG_PRON = 'X'. ), forecast errors and 

exception messages are nevertheless stored, even though the update indicator was not selected. 

Standard settings 

The BAdI is not active in the standard system. 
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The BAdI is not filter-dependent. 

The BAdI is not for multiple use. 

Example 

Sample coding exists for this method. 

Further notes 

You will find more information on the procedure in the SAP Library under Basis Components -> ABAP 

Workbench -> Changing the SAP Standard -> Business Add-Ins -> Implementing Business Add-Ins. 

26.2.6 Authorization Management 

In this section, you assign authorizations to users according to the areas in which they work. 

26.2.6.1 Sales and Operation Planning 

In this IMG activity, you create authorizations for the authorization objects of individual functions in 

Sales & Operations Planning. 

To create an authorization, you assign values to the fields in the authorization object. When checking 

whether or not a user is authorized to carry out a particular transaction, the system checks the values of 

these fields in the appropriate user profile of the user master record against the field values SAP has 

predefined for the transaction in table TSTC. If the values do not match, the user is not allowed to 

process that particular object. 

Authorization Objects 

The list below shows which authorization objects are checked for which application functions in Sales & 

Operations Planning (SOP). 

 Functions for...                                    Authorization object 

In the object class "Production Planning": 

Sales & Operations Planning for applications       C_APPL_SOP Sales & 

Operations Planning for versions           C_PLAN_SOP 

In the object class "Logistics Information System": 

 Planning: information structure/version            M_INFO_MCD 

In the object class "MM: Master Data": 

 Material master: maintenance status                M_MATE_STA 

 Material master: plant                            M_MATE_WRK 



 

 

Standard Settings 

In the standard system, authorizations are provided for all authorization objects in the application. 

You will find both maintenance authorizations and display authorizations for authorization objects. 

The standard authorizations apply to all organization units. 

Activities 

1. Check whether the authorizations that come with the standard system cover 

your needs. Proceed as follows: 

a) Choose the object class of the application. 

A list of the authorization objects in this class is now displayed. 

b) Choose an object. 

A list of the authorizations for this object is now displayed. 

2. If necessary, create new authorizations to meet your requirements. Proceed as 

follows: 

a) Choose Authorization -> Create. 

b) Enter the authorization and a short text. 

c) Maintain the values of each field one by one. 

d) Save your entries. 

e) Activate the new authorization. 

Note 

The profile generator lets you create authorizations and profiles. 

This function makes it much easier for you to customize your authorizations. You should use this 

function if you are working in a new installation. 

The individual configuration steps for the profile generator are described in Customizing underBasis 

Components - System Administration - Users and Authorizations - Maintain authorizations and profiles 

using profile generator. 

Description of the authorization objects 

Object: C_APPL_SOP Sales & Operations Planning for Applications 

Definition 

You use this authorization object to define and, if necessary, restrict a user's authorization to maintain 

data in different areas of Sales & Operations Planning (SOP). 

Defined fields 

The authorization object comprises two fields: 

- action 

Determines which actions the user may carry out in Sales & Operations Planning (SOP). 

- SOP application area 

Determines which areas of Sales & Operations Planning (SOP) the user may maintain. 
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Thus, the authorizations for this object specify the actions with which different functional areas in Sales 

& Operations Planning (SOP) may be processed. 

The following field combinations are possible: 

Application area Action Meaning 

AS 01 Create product group/pl.hierarchy 

AS 02 Change product group/pl.hierarchy 

AS 03 Display product group/pl.hierarchy 

PM 01 Create plan for material 

PM 02 Change plan for material 

PM 03 Display plan for material 

PP 01 Create plan for product group 

PP 02 Change plan for product group 

PP 03 Display plan for product group 

DP 01 Create product group disaggregation 

DP 02 Change product group disaggregation 

DP 03 Display product group disaggregation 

LI 16 Display lists 

DM 02 Transfer to Demand Management 

Example 

User A may create, change, and display in all areas of SOP. Relevant authorization: 

- Action "1-3" 

- Application area "*" 

User B, by contrast, may only display product group and planning hierarchy structures. Relevant 

authorization: 

- Action "3" - Application area "AS"  



 

 

Object: C_PLAN_SOP Sales & Operations planning for Versions 

Definition 

You can use this authorization object to define and, if necessary, restrict a user's authorization to 

maintain planning versions in Sales & Operations Planning (SOP). 

In this way, authorizations can be assigned such as to underline the importance of planning versions in 

organizational terms. For example, planning version A00 is always the active version and therefore only 

certain employees should be allowed to change it. 

Defined fields 

The authorization object contains two fields: 

- action 

Determines which actions (create 01, change 02, display 03) the user may carry out. 

- version 

- Determines which planning versions a user may maintain. 

Therefore, by means of the various authorizations for this object, you determine which actions a user is 

allowed to carry out on which planning versions. 

Example 

User A may create, change, and display all planning versions. Relevant authorization: 

- Action   "1-3" 

- Version  "*" 

User B, by contrast, may only display versions 020-060. Relevant authorization: 

- Action   "3" 

- Version  "020-060" 

Object: M_MATE_STA Material Master Records: Maintenance Status 

Definition 

Maintenance status authorization for material master records 

The data contained in a material master record is divided into user departments or views (Purchasing, 

MRP, and so on). The maintenance status is a single-character key for the relevant user department or 

view. 

This object determines which user departments or views a user is authorized to process; that is, which 

data he or she may process from this view. 

Note 

To use material master functions, a user needs the authorization for at least one user department. 

Defined fields 

Fields Possible values Meaning 

ACTVT 01 User may create data. 

 02 User may change data. 

 03 User may display data. 
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 06 User may flag data for 

deletion. 

 08 User may display change 

documents. 

STATM  Here, you specify the 

maintenance status for which 

the user is authorized. 

The maintenance statuses possible are as follows: 

User department Maintenance status 

Work scheduling A 

Accounting B 

Classification C 

MRP D 

Purchasing E 

Production resources/tools F 

Costing G 

Basic data K 

Storage L 

Forecasting P 

Quality management Q 

Warehouse management S 

 Sales V 

 Plant stocks X 

 Storage location stocks Z 

Notes 

This authorization object also determines: 

- Whether a user may flag a material master record for deletion. In this case, 06 must be entered in 

field ACTVT; the maintenance status is irrelevant here. 

- Whether a user may change the material type. In this case, 02 must be entered in field ACTVT; the 

maintenance status is irrelevant here. 

- Whether a user may process an MRP profile or forecast profile. In this case, the following values 

must be entered in field ACTVT: 

- 01 to create 

- 02 to change or delete 

- 03 to display 

The maintenance status must be D for the MRP profile or P for the forecast profile. 

- Whether a user may create an overview of all extendable materials. In this case, 01 must be entered 

in field ACTVT; the maintenance status is irrelevant here. 

- Whether a user may call up the materials list. In this case, 03 must be entered in field ACTVT; the 

maintenance status is irrelevant here. 

- Whether a user may create or change production versions from task lists. In this case, 02 must be 

entered in field ACTVT, and A in field STATM. 



 

 

Object: M_MATE_WRK Material Master: Plants 

Definition 

This object determines whether a user is authorized to process material master data at plant level. 

The following data is mostly at plant level: 

- MRP data 

- Forecasting data 

- Work scheduling data 

- Shipping data 

- Accounting data (depending on your system configuration) 

If a user has this authorization, he or she is also authorized to process material master data at all 

dependent levels of the plant(s), for example, at storage location level and at special stock level. 

Defined fields 

Fields Possible values Meaning 

ACTVT 01 User may create data. 

 02 User may change data. 

 03 User may display data. 

 06 User may change deletion flags. 

 08 User may display change 

documents. 

WERKS  Here, you must specify the plants 

for which data may be processed. 

Notes 

This authorization object also determines whether a user is authorized to create or to change production 

versions from standard task lists. In this case, 02 must be entered in field ACTVT. 

Transport Notes 

To transport authorizations: 

1. Call up the list of object classes for authorizations. 

2. Choose the relevant object class. 

3. Select Authorization -> Transport. 

4. Check the boxes of the authorizations that you want to transport. 

5. Confirm your entries with ENTER, specify the correction number, and select Continue. 

26.2.6.2 Define profiles 

In this step, you define authorization profiles. 

An authorization profile groups together authorizations for specific work areas. 

You define a user's authorizations by entering one or more authorization profiles in the user master 

record. 
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Standard Settings 

The R/3 System comes with the following standard profiles: 

- C_SOP_ALL 

This profile covers all functions in Sales & Operations Planning. 

- C_SOP_ANZ 

This profile covers all display functions in Sales & Operations Planning. 

- M_LIS_ALL 

This profile covers all functions in the Logistics Information System including planning. This 

profile allows you to call a standard analysis from within Sales & Operations Planning. 

The authorizations in standard profiles are valid for all organizational units. 

Activities 

To create a single profile: 

1. Check the standard profiles: 

a) Select the pushbutton Create work area. A list of all existing profiles appears. 

b) Double-click on a profile to see the authorizations it contains. 

To read the documentation on an authorization object, place your cursor on the authorization 

and select Utilities -> Object documentation. 

2. If the existing profiles do not cover your needs, create new profiles: 

a) Select Profile -> Create. 

b) Enter a name and a short text for the profile, and select Single profiles. 

c) Select Edit -> Insert authorization. 

d) Choose an object class. 

e) Check the boxes of the authorizations you want to include in this profile. 

f) Select Authorization -> Add authorization. 

g) Select Profile -> Save. 

h) Select Profile -> Activate. 

The implementation screen appears. 

i) Select Profile -> Activate. 

To create a composite profile: 

1. Check the standard profiles: 

a) Select the pushbutton Create work area. A list of all existing profiles appears. 

b) Double-click on a profile to see the authorizations it contains. 

To read the documentation on an authorization object, place your cursor on the authorization 

and select Utilities -> Object documentation. 

2. If the existing profiles do not cover your needs, create new profiles: 

a) Select Profile -> Create. 



 

 

b) Enter a name and a short text for the profile, and select Composite profiles. 

c) Select Edit -> Add profile. 

d) Check the boxes of the profiles you want to include in this composite profile. 

e) Select Profile -> Add profile. 

f) Select Profile -> Save. 

g) Select Profile -> Activate. 

The implementation screen appears. 

h) Select Profile -> Activate. 

Transport Notes 

To transport profiles: 

1. Call up the initial profiles screen. 

2. Select the pushbutton Generate work area. 

3. Select Profile -> Transport. 

4. Check the boxes of the profiles you want to transport. 

5. Confirm your entries with ENTER, specify the correction number, and select Continue. 

6. Specify whether or not you want to transport dependent profiles and authorizations too. 

26.3 Production Planning 

This section covers the implementation of Master Planning. 

26.3.1 Demand Management 

In this section, you make the necessary configurations for demand management. 

26.3.1.1 Planned Independent Requirements 

In this step, you specify the control parameters for maintaining planned independent requirements. 

26.3.1.1.1 Define number ranges for planned independent 

requirements 

In this step, you maintain the number range and the interval for demand management. 

In demand management, number ranges are only used internally within the system for counting per 

planned independent requirements item. The number of the planned independent requirements is not 

displayed. 
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Standard settings 

The number ranges are preset from 1 to 999999999999. 

Recommendation 

SAP recommends that you work with the standard system. In this case, you need not carry out any 

actions. 

26.3.1.1.2 Maintain number range for requirements plan number 

This IMG activity will be documented in Release 4.0B. 

26.3.1.1.3 Requirements Types/Requirements Classes 

In this step, you maintain the settings required for requirements types and requirements classes. 

Requirements classes control the creation of planned independent requirements or sales orders and 

customer requirements. The following is determined by the requirements class, for example; 

- the consumption of independent requirements by sales orders 

- how warehouse stock is taken into account (net or gross requirements planning) 

- inventory management and cost allocation (make-to-order or make-to-stock production) 

- the release of the planned order (planning without final assembly) 

- requirements distribution (configuration) 

The control parameters for requirements class are defined by demand management and cannot be 

changed. 

The requirements type is a language-dependent key that can be given a short text. When maintaining 

independent requirements, the system only displays the requirements type. 

Several requirement types can be assigned to a requirements class. 

26.3.1.1.3.1 Define requirements types and allocate requirements class 

In this step, you allocate requirements types to a requirements class. 

Requirements classes control the creation of planned independent requirements or sales orders and 

customer requirements. The following is determined via the requirements type: - consumption of 

independent requirements and customer requirements 

- how warehouse stock is taken into account (net or gross requirements planning) 

- inventory management and cost consumption (make-to-order or make-to-stock) 



 

 

- if the planned order can be released (planning without final assembly) 

- requirements distribution (configuation) 

The control parameters for the requirements class are stipulated in demand management and cannot be 

changed. 

The requirements type is a language-dependent key that can be given a short text. When maintaining 

planned independent requirements, only the requirements type is displayed. 

A requirements class can be allocated several requirements types. 

Note 

You can define a default requirements type for maintaining independent requirements if several 

requirements types exist per class. 

If no requirements type is selected as a default value, the system selects the last entry. 

Default settings 

In the SAP standard system, the following requirements types are preset: 

       BSF:   gross requirements planning 

       LSF:   make-to-stock production/net requirements planning 

       VSF:   planning with final assembly 

       VSE:   planning without final assembly 

       VSEV:  planning with planning material 

       VSFB:  planning at assembly level 

Actions 

Define the requirements types and allocate them to the requirements classes. 

26.3.1.1.3.2 Maintain requirements classes 

This IMG activity will be documented in Release 4.0B. 

26.3.1.1.3.3 Check indep.reqmts/consumption of requirements classes 

In this step, you check the following control parameters for the requirements classes of the planned 

independent requirements: 

- Planning indicator 

- net requirements planning 

- gross requirements planning 

- Single-item planning 

- Consumption indicator 
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- Consumption - planning with final assembly - Consumption - planning without final 

assembly 

- Consumption - planning with planning material, etc. 

Default settings 

In the SAP standard delivery, control parameters are preset for the requirements classes. 

Recommendation 

SAP recommends that you use the standard settings. When making changes you must make sure that the 

consumption indicator matches the assignment indicator in the sales order if consumption is to be carried 

out. 

Further notes 

You maintain the indicator for the requirements classes of the sales order in Customizing for sales and 

distribution. 

You assign the requirements classes/requirements types to the planning strategy in the step entitled, 

"Define strategy". Here, you also receive an overview of all the control parameters of the strategy or of 

the requirements classes assigned. 

26.3.1.1.4 Planning Strategy 

In this step, you specify the possible planning strategies for demand management and sales order 

management. Here, you also allocate strategies to strategy groups and in a third step, you allocate the 

strategy groups to an MRP group. 

The planning strategy represents a procedure for planning a material and is technically controlled via the 

requirements types. With the help of the planning strategy, the material is automatically assigned the 

correct requirements type in demand management and in sales order management. 

- Strategy 

The planning strategy represents a planning procedure for planning a material. It is 

defined by one of the following: 

- a requirements type from demand management 

- a requirements type from sales order management 

- a combination of both that makes sense 

The strategies available for creating the master plan can be seen in step "Define strategy". 

- Strategy group 

You use the strategy group to group together all the valid planning strategies. Thus, more than one 

planning strategy can be allowed for a material. 

- Allocating a strategy group to an MRP group You can allocate a strategy group to an MRP 

group. 



 

 

Two possibilitites exist for finding the correct requirements type in demand management and sales 

order management: 

1. You allocate the strategy group to an MRP group and enter this MRP group in the 

material master record of the appropriate materials. In so doing, you are not only 

allocating the planning strategy to the material but other additional control parameters for 

MRP. 

2. You can enter the strategy group for the material directly in the material master record. 

Actions 

1. Check the planning strategies. 

2. Allocate the strategy(ies) to the strategy group. 

3. If necessary, allocated the strategy group to an MRP group. 

26.3.1.1.4.1 Define Strategy 

The planning strategy represents an appropriate procedure to be used for planning and produced a 

material. 

The planning strategy is defined by: 

- a requirements type from demand management 

- a requirements type from sales order management 

- a combination of both that makes sense 

In this section, you also see various control indicators for each planning strategy on the overview screen, 

for example: 

- consumption indicator (determines whether the requirements type in planned independent 

requirements and the requirements type in sales order management are consumed or whether sales 

orders increase the master plan, and so on). 

- availability check (determines whether the check is to be carried out according to ATP logic or as a 

check with planned independent requirements) 

- assembly type (determines whether an assembly order is created for the sales order and whether the 

assembly order is created as a planned order or as a production order in the system) 

- configuration (determines whether configuration is allowed), and so on 

Standard settings 

In the SAP standard system planning strategies are preset. 

Recommendation 

You should use the planning strategies that are contained in the standard system. 

Actions 

If necessary, enter new planning strategies. 

26.3.1.1.4.2 Define Strategy Group 
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In this step, you group strategies together into a strategy group. You can determine a main strategy as 

well as up to seven alternative strategies. 

Note 

The main strategy is proposed in demand management or in sales order management and can be 

overwritten by another planning strategy defined in the strategy group. 

You can allocate the strategy groups to the materials directly in the material master record, or you can 

allocate the strategy groups to an MRP group and then in a second step allocate the MRP group to the 

material in the material master record. 

Default Settings 

Strategy groups are preset in the SAP system. 

Actions 

1. Change the strategy groups contained in the SAP system according to your requirements. 

2. Create new strategy groups, if necessary. 

26.3.1.1.4.3 Assign MRP Group to Strategy Group 

In this step, you assign a strategy group to the MRP group. 

If an MRP group is maintained for a material, the strategies specified in the strategy group are allowed 

for this material. 

In order to find the correct requirements type in demand management and in sales order management, 

you have to: 

Assign the strategy groups to the MRP groups, and 

Assign the MRP groups to every material to be planned in the material master record. or 

Enter the strategy group directly in the material master record of the material to be planned 

Actions 

Maintain the allocation of strategy groups to MRP groups. 

26.3.1.1.5 Define version numbers 

In this step, you define versions to be able to: 

- differentiate between different planned independent requirements 

- indicate the transfer of requirements from previous planning levels (for example, the sales plan 

from SOP) 

- simulate requirements planning in long-term planning 

Note 

You can either create the versions in Customizing or interactively when maintaining planned independent 

requirements. 



 

 

Actions 

Define the versions. 

26.3.1.1.6 Automatic Split 

With the function "automatic splitting", planned independent requirements created using a reference are 

split automatically according to a period split that you define. 

Here, you define a period split that has to be assigned to either the reference type or the MRP group. 

The following is valid: if a period split is only assigned to one reference type, then the system uses the 

entry from this reference type. If the period split is also assigned to an MRP group and the material has 

been assigned this MRP group, then the system uses the entry from the MRP group. 

26.3.1.1.6.1 Distribution Function for Automatic Split 

In this step, you maintain the distribution function and the distribution strategy for automatic distribution. This 

means that you can split the schedule lines according to a certain function. 

First, define the distribution function(s) and then assign this function(s) to the plants. 

26.3.1.1.6.1.1 Define distribution function 

In this workstep, you define the distribution function. You specify the percentage of the quantities that 

are to be produced within a certain percentage of the production time. 

Actions 

Define the distribution function. 

26.3.1.1.6.1.2 Define distribution strategy 

In this step, you can define the distribution strategy depending on the plant. The distribution strategy 

comprises the distribution function and the distribution type. 

- Distribution function 

Define the percentage of the quantity that is to be produced after a certain percentage of the total 

production time. 
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- Distribution type 

Defines whether the requirement is distributed exactly according to the points defined in the 

function or over the time axis according to the distribution function. 

Warning 

The distribution type can only be used to distribute requirements over the time axis in demand 

management. 

Actions 

1. Define the distribution function. 

2. Define the distribution type. 

Further notes 

Please note that the period split for automatic splitting is maintained irrespective of the plant. 

The distribution strategy, on the other hand, is maintained per plant. If you want to control automatic 

splitting using the MRP group, the distribution strategy and the MRP group must both be valid for the 

same plant. 

26.3.1.1.6.2 Define period split for automatic split 

The period split determines the type of period split for automatically splitting the planned independent 

requirements. Automatic splitting is only possible if the planned independent requirements were created 

using a reference. 

You must make sure that the following three steps have been carried out before you can automatically 

split the independent requirements: 

1. Maintain the period split for the automatic splitting. 

2. Assign period split to reference type or to MRP group (in the workstep "Assign version and split for 

automatically splitting the reference" or "Assign period split to MRP group"). 

3. Create planned independent requirements using a reference that has been allocated a period split in 

the above step. 

The system proceeds as follows when automatically splitting planned independent requirements: 

Weekly requirementsare automatically split, whereby the system first reads the entry in the column "W 

in T". The number of weeks entered in this field is split into daily quantities. Thus, the system creates 

daily quantities. 

Monthly requirements are automatically split, where the system first reads the entry in column "W in 

D". The number of weeks entered in this field is split into daily quantities. Then the system reads the 

entry in the column "No.of weeks" and creates the number of weekly quantities entered here. 



 

 

Moreover, you can assign a distribution function. This means that you can define the percentage of the 

quantity that is to be produced according to a certain percentage of the production time depending on the 

period to be split. 

Activities 

Maintain the period split for the automatic split. 

Further notes 

The allocation of the reference type is mafe in step "Allocate version and split for automatic split of the 

reference". 

Note that the period split for automatic splitting is maintained independently of the plant. The 

distribution strategy in the period split, on the other hand is plant-specific. If you want to control the 

automatic split using the MRP group, the distribution strategy and the MRP group must both be valid in 

the same plant. 

26.3.1.1.6.3 Assign period split of MRP group 

In this IMG activity, you assign the period split to the MRP group. 

Warning 

If the entry in the MRP group is to be valid for a material, the appropriate MRP group in the material 

master record must be maintained. 

Requirements 

Please take note of the following: 

- If a period split is only assigned to a reference type then the system uses the entry from the 

reference type. If the period split is also assigned to an MRP group, and the material has also been 

assigned this MRP group then the system uses the entry from the MRP group. 

- The period split for automatic splitting is maintained independently of the plant. The distribution 

strategy in the period split, on the other hand is plant-specific. If you want to control the automatic 

split using the MRP group, the distribution strategy and the MRP group must both be valid in the 

same plant. 

26.3.1.1.7 Allocate version and split for autom. splitting to reference 
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In this step, you assign a version number to a reference type (sales plan, production plan, and so on) and 

you also assign a period split for automatically splitting planned independent requirements, if necessary. 

With the default value for the version, a planned independent requirement, that was created using a 

certain reference type, is automatically assigned the version number defined here. 

With the period split, the planned independent requirement items that are created using the selected 

reference type, are automatically split according to the period split entered here. 

Note 

In the step, "Define default values per transaction", the default values are allocated via the requirements 

class of the transaction. 

Actions 

1. Determine the default values for the versions per reference type. 

2. Enter the period split if you want the system to carry out an automatic requirements split for certain 

reference types. 

26.3.1.1.8 Maintain consumption mode and period of adjustment 

In this step, you define the control parameters for the consumption of planned independent requirements 

and customer requirements/sales orders as well as the period of adjustment per plant and MRP group. 

Consumption parameters 

The consumption parameters affect all planning strategies in which consumption is carried out. 

The parameters maintained per plant and MRP group are only used if no material-specific consumption 

mode or periods have been maintained. 

- Consumption mode 

The consumption mode specifies the direction on the time axis in which the requirements are 

consumed. 

If you leave the field, consumption mode blank, the system will only consume the independent 

requirements in the past, that is, customer requirements will only consume planned independent 

requirements that lie before the customer requirements. 

- Consumption period (forward/backward) 

The consumption period defines an interval within which consumption should take place. This 

interval is maintained in workdays. 

If no consumption period has been maintained, customer requirements can only consume planned 

independent requirements that are planned on exactly the same date. 

Period of adjustment an adjustment indicator 

You use the adjustment function to define that only customer requirements are relevant for the planning 

run in a predefined period (that is the period of adjustment). The system creates no order proposals in the 

planning run for planned independent requirements that lie within the period of adjustment and for which 

no firmed receipts and no firmed order proposals have been planned. The period of adjustment is 

maintained in workdays. 



 

 

You can use the adjustment indicator to define whether the number of days are to be calculated from the 

current date in the past or in the future. Or, whether the period of adjustment is valid for planned 

independent requirements of all planning strategies or only for those in which consumption takes place. 

Note 

The period of adjustment is only valid if the adjustment indicator has been maintained as well. 

Actions 

Define the consumption mode as well as the consumption interval at plant level. If necessary, maintain 

the period of adjustment and the adjustment interval. 

26.3.1.1.9 Organization tip: reorganizing planned independent reqmts 

Using the reorganization function, you can delete planned independent 

requirements that are out of date and for which there are no customer 

requirements. You can also delete the histories of the independent 

requirements from the database. The reorganization function is started online 

from the main menu of demand management by selecting Environment -> 

Indep. reqmts: reorg.. 

The reorganization is carried out in three steps: 

1. Adjusting requirements 

When adjusting requirements, the system checks whether customer requirements exist for active 

planned independent requirements that lie before the key date and the quantity of customer 

requirements that are assigned. The planned independent requirement quantities that are not 

assigned are set to zero and are flagged for reorganization. In this step, you can also set the system 

so that it deletes all inactive planned indepenent requirements. 

2. Reorganization 

The system checks which planned independent requirements were set to zero - either by reduction 

or consumption or by "requirements adjustment". Requirements records that lie before the key date 

and that have the quantity zero are deleted from the database. 

3. Deleting histories 

Once the system has completed the reorganization process, the histories can also be deleted for the 

same period. The key date for deleting histories can differ from the key date of reorganization. 

Note 

The reorganization can also be carried out in background mode. To do this, create the appropriate 

variants of the reorganization program and define the background processing in the ABAP/4 reporting. 

For more information on reporting and background processing, please refer to the documentation,  BC 

ABAP/4: User Manual. It is recommended that you reorganize out-of-date planned independent 

requirements once a month. 

26.3.1.1.10 Default Values and Presettings 

In this step, you define the default values and the settings for planned independent requirements. 

The following default values and settings are defined per transaction: 

- Single-line or double-line display of the item screen 
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- Period totals or period split display of the schedule line screen 

- Versions and active indicators 

- Reference types and allocation of versions and period split for automatic splitting of planned 

independent requirements 

- Period for values display in item screen 

These default values are allocated to a requirements class. In the IMG activity "Assign default values and 

presettings to transaction", the requirements class is allocated to the transaction. The requirements class 

is only used as a medium for allocating the default values, it creates a link between the transaction and 

settings. It does not represent any preallocations for the planning strategy or the requirements type. 

The following presettings are determined via the planning strategy: 

- Consumption indicator 

- Creation of history 

Here, the default value is determined via the planning strategy that contains the requirements type 

(technically speaking, the requirements class). This means that the presettings are not allocated to the 

transaction. Instead, for these two settings, the system determines the planning strategy per material and 

it finds the default value from Customizing via the requirements class contained in the planning strategy. 

The requirements type is only preset via the allocated requirements class for standard independent 

requirements. 

26.3.1.1.10.1 Define default values for consumption type per reqmts class 

In this step, you define a default value for the consumption indicator per requirements class. This means 

that the consumption indicator is proposed for every planned independent requirement that has been 

assigned the corresponding requirements class/requirements type (via the planning strategy, for 

example). 

You use the consumption indicator to control whether planned independent requirements are to be 

consumed with the following requirements elements: 

- sales orders 

- reservations and dependent requirements 

- sales orders, reservations and dependent requirements 

Consumption with customer requirements makes sense when dealing with a finished product. The 

consumption with dependent requirements or reservations makes sense when the consumption takes 

place at assembly level, that is, the material is a part of a bill of material. 

Default settings 

The following requirements classes are preset for the following consumption types: 

Make-to-stock production               no consumption 

Gross requirements planning            no consumption 

Planning with final assembly           consumed by customer reqmts 

Planning w/o final assembly            consumed by customer reqmts 



 

 

Planning with planning material        consumed by customer reqmts 

Planning at assembly level             consumed by customer                                        

reqmts, reservations and                                        dependent reqmts 

Note 

The system finds the default values via the planning strategy and the requirements type entered here. 

Consumption indicators are not allocated or determined per transaction. 

Actions 

Check the default values for consumption. 

26.3.1.1.10.2 Assign default values and presettings to transaction 

In this step, you define the various default values and settings for maintaining planned independent 

requirements for each of the three transactions: 

- You use the indicator Item screen to preset whether the item screen is to be displayed with single 

or double-lines. 

The setting that you select here can be converted either in the maintenance screen of the planned 

independent requirements via the requirements parameters, or directly in the item screen. 

- You use the indicatorDispl.sched.line to determine whether the schedule lines in the maintenance 

of independent requirements are displayed as period totals values or as period splits. 

The setting that you select here can be reconverted either in the maintenance screen of the planned 

independent requirements or via the requirements parameters. 

- The version number you enter here is proposed as a default value for the selected transaction. 

- You can also define whether the active indicator is to be preset in the selected transaction. Only 

active versions are included in MRP. 

Actions 

Define the default values and the presettings per transaction. 

26.3.1.1.10.3 Define Internal Number Assignment per Reqmts Class 

Documentation for this IMG activity will be available in Release 4.0B. 

26.3.1.2 Demand management 

In this section, you learn which authorization objects are defined for the individual application functions 

in the SAP system. In the SAP system you can define authorizations for these objects. 

Authorization objects 

The list below shows the authorization objects that are checked in the individual application functions. 
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Functions for... 

Demand management 

(Maintain planned indep reqmts, 

Authorization object 

customer requirement) 

Planned independent requirements, customer 

requirements 

C_PPBD Demand management 

Display total requirements 

Reorganization of 

C_PPBD Demand management 

indep.req.records C_PPBD_REODemand management 

Standard Settings 

In the standard system, authorizations are provided for all authorization objects in the application. 

You will find both maintenance authorizations and display authorizations for authorization objects. 

The standard authorizations apply to all organization units. 

Activities 

 1. Check whether the authorizations that come with the standard system cover your needs. 

Proceed as follows: 

a) Choose the object class of the application. 

A list of the authorization objects in this class is now displayed. 

b) Choose an object. 

A list of the authorizations for this object is now displayed. 

2. If necessary, create new authorizations to meet your requirements. Proceed as 

follows: 

a) Choose Authorization -> Create. 

b) Enter the authorization and a short text. 

c) Maintain the values of each field one by one. 

d) Save your entries. 

e) Activate the new authorization. 

Note 

The profile generator lets you create authorizations and profiles. 

This function makes it much easier for you to customize your authorizations. You should use this 

function if you are working in a new installation. 

The individual configuration steps for the profile generator are described in Customizing underBasis 

Components - System Administration - Users and Authorizations - Maintain authorizations and profiles 

using profile generator. 

Description of the authorization objects 



 

 

Objekt: C_PPBD Authorizations for demand management 

Definition 

Authorization for maintaining planned independent requirements (Demand Management). 

The authorization check for this authorization object is carried out on accessing the planned independent 

requirements function. 

Defined fields 

The authorization object contains two fields: 

- Activity category of the transaction (Field: AKTTYP) 

Possible values:         'H': Create 

                         'V': Change 

                         'A': Display 

                         '* : All activity categories 

- Plant (Field: WERKS) 

Here you must enter all the plants in which the planned independent requirements can be 

maintained.  
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Objekt: C_PPBD_REO Demand management - reorg.activities 

Definition 

Authorization for reorganizing planned independent requirements records 

You use this authorization object to control whether a user is allowed to carry out the reorganization 

functions for one or several plants. 

Defined fields 

The authorization object contains two fields: 

- Activity category of the transaction 

Possible values:      'A' : Adjusting requirements 

                      'B' : Reorganizing schedule lines 

                      'C' : Delete history 

                      'T' : Test mode for reorganization 

- '*' : All activity categories 

- Plant 

Here, you must enter all the plants where reorganization of the planned independent requirements 

records is allowed.  



 

 

26.3.1.3 Tools 

In this section, a description is given of the execution of the data transfer from the old system. 

26.3.1.3.1 Data Transfer Workbench: Planned Independent Requirements 

In this IMG activity, you define the way in which the system performs the transfer of master data from 

other systems (i.e. from your legacy systems) 

Recommendation 

You should use the direct input procedure for the automatic transfer. 

This means that you use all internal sytem checks. In addition, this method guarantees that only correct 

data is transferred. 

Indentifying Relevant Fields 

1. Compare your legacy data with the data fields of the SAP System. 

2. Find out which fields can be transferred directly from the legacy data to the SAP System. 

3. In the case of fields that cannot be directly supplied with data from the legacy data, you need to 

create rules in order for it still to be possible to fill the SAP system fields with data. 

4. Decide whether you want to transfer your legacy data automatically or manually. 

Processing the Transfer Structure 

1. Extract the data to be transferred from the source system by means of a self-defined program, and 

write the data to a sequential file. 

2. In order to use the SAP data structure definitions in your legacy system, you can run a record layout 

generator. 

This generates an Include in one of the programming languages of your choice: COBOL, C, PL/1, 

or ASSEMBLER. 

Record Layout Description 

The following table structures are used for the record layout description 

- BGR00  Session record 

- B60BL  Item data 

- B60ET  Schedule line data - B60C1  Characteristic data The following types of data can be transferred: 

- Item data 

 Structure Meaning 
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 E60BL Planned indep. requirements item data: 

Contains material number, plant, 

requirements type, active ind., 

information structure/key figure (SIS) 

(not relevant for MRP) 

- Schedule line data 

 

 Structure Meaning 

 E60ET Planned indep. reqmts schedule line data: 

Contains period indicator see table TPRG 

(e.g. M for month, date and quantity) 

BOM explosion number, production version 

- Characteristic data 

 

 Structure Meaning 

 B60C1 Planned indep. reqmts char. values: 

Contains date, number of the forecasting table, 

item in the forecasting table, usage probability (in 

character format) usage quantity (according to the 

flag 'X'=qty,'W'=probability) Fixing indicator (fix 

usage qty or usage probability) Transfer of fixed 

objects 

Processing the Transfer File 

You can use the program RM60INEX to generate a sample file. 

Use the material master maintenance transactions to create a material. You can use this to generate an 

input file. This helps you to recognize what fields are filled with what values. 

Performing the Transfer 

The data transfer is performed with the help of the direct input procedure. 

You can speed up the transfer by first deactivating the setup of administration data and setting up this 

data retrospectively (i.e. once the data transfer has been successfully completed). 

26.3.2 Master Production Scheduling 

In this step, you make the settings required to carry out master production scheduling. 

In master production scheduling, those parts or produccts which greatly influence company profits or 

which take up critical resources are flagged as master schedule items and are planned with extra 



 

 

attention. A series of functions are supported for MPS to make it possible to plan master schedule items 

carefully and, therefore, more precisely: 

- Separate planning run 

In MPS, only master schedule items are planned, and the rest of the BOM is not exploded. 

Dependent requirements are only created for the BOM level directly below the planning level. This 

means that you can make changes to the master plan at master schedule item level and check the 

effects of the changes avoiding immediate initiation of procurement of the dependent parts. In a 

second step, once you are satisfied with the master plan for the master schedule items, the system 

plans the complete BOM structure. 

- Planning time fence 

You use the planning time fence to define a period in which the MRP result is to be protected from 

automatic changes. Depending on the fixing type defined in the MRP type, no order proposlas are 

created or changed automatically within this period. Thus, the MRP controller can check the dates 

and capacities of the planned orders in this period before the planning result affects the lower BOM 

levels. 

- Interactive planning 

The functions of interactive planning are used to reprocess the results of MPS. You can change the 

order proposals created automatically and you can adjust capacities for the planned orders. You can 

check the changes immediately in a simulative planning run. 

- Special MPS evaluation layout 

In MPS, special evaluations exist which have been developed according to MRPII standards. 

Furthermore, you can define user-specific evaluation layouts. 

26.3.2.1 Master Data 

In this step, you maintain the system parameters required for MPS which have master data status. 

26.3.2.1.1 Define MRP Controllers 

In this step, you define a number that is allocated to the MRP controller. 

All materials are allocated to an MRP controller or a group of MRP controllers who(that) is(are) 

responsible for monitoring material availability. You can use the number entered here, for example, to 

select the individual planning results per MRP controller. The MRP controller can either be one person 

or a group of persons. 

Every material that is relevant to the planning run must be allocated an MRP controller number in the 

material master record. 

You can also define a "special person" for backorder processing who is notified by mail if a goods 

receipt was posted for a missing part. You must enter the mail name of this person in the receiver name 

field. 

Actions 

Enter the MRP controllers and is necessary maintain the mail receivers. 

26.3.2.1.2 Check MRP Types 
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You use MRP types for master production scheduling (MPS) to control which procedure is to be used for 

planning master schedule items. 

The MRP type is assigned to the material in the material master record. 

The following MRP type parameters are relevant in master production scheduling: 

- MRP procedure 

The MRP procedure determines which of the following planning types is to be used: 

- master production scheduling (MPS) 

- material requirements planning (MRP) 

- consumption-based planning 

- Firming type indicator 

You use this indicator to define how order proposals are to be treated for master schedule items if 

you work with a planning time fence, that is, the manner in which order proposals are firmed 

within the planning time fence and scheduled. You can use the planning time fence to exclude a 

particular planning interval from automatic planning. Depending on the firming type, only manual 

changes are made in this period. The system does not create any order proposals in this period. 

- Roll forward indicator 

To adapt the firmed master plan to a changed requirements situation, you can maintain an indicator 

for deleting obsolete planned orders. 

This indicator causes the system to delete firmed order proposals that lie before the 

so-called roll forward period in the planning run and to create new, scheduled planned orders (or, 

depending on the fixing type, to shift them to the end of the planning time fence). 

You can determine the roll forward period in the step entitled "Define planning time fence". 

For more information on this topic, please refer to the chapter entitled "Define planning time fence 

and roll forward period". 

- Plan regularly indicator 

This indicator determines that materials having this MRP type are to be included in planning at 

regular intervals, even if no change relevant to the planning run has been made. 

For materials that are to be planned regularly, you must also maintain the maximum interval at 

which the material is again to be included in planning. You do so via the MRP group. 

Please also refer to the chapter entitled "Define maximum MRP interval". 

- Forecast indicator 

You use this indicator to determine whether a forecast is to be carried out. 

- Forecast consumption indicator 

You use this indicator to define the consumption values that are to be used for the forecast. 

- MRP indicator of the forecast 

You use this indicator to determine the requirements values that are to be included in the planning 

run. 

- MRP list: extended header 



 

 

The screen sequence key controls the display of the extended header in analyses in requirements 

planning, that is, you use this key to determine which screens are displayed in the extended header 

and the sequence in which they appear. 

For more information on this topic, please refer to the chapter entitled "Screen sequence for 

extended header (MRP list + stock/reqmts list)" 

Default settings 

In the SAP system, MRP types for master production scheduling are preset with different fixing types. 

Actions 

1. Check the MRP types that come with the SAP system. 

The MRP procedure for master production scheduling must be "M". 

2. If necessary, change the parameters. 

3. Create new MRP types to suit your requirements. 

26.3.2.1.3 Define Planning Time Fence and Roll Forward Period 

In this step, you define the planning time fence and the roll forward period. 

- Planning time fence 

You use the planning time fence to define the period that the MRP result is to be protected from any 

automatic changes. In this period, depending on the firming type maintained in the MRP type, no 

order proposals are changed or created automatically. Thus, the MRP controller can the check the 

dates and capacities of the planned orders before the planning result has any efect on the lower-

level BOM. 

- Roll forward period 

- To update the master plan automatically, you can set the system so that out-of-date and firmed 

planned orders that lie before the roll forward period are deleted during the planning run. With this 

function, the system deletes all the planned orders for which there are no longer any requirements. 

Note on roll forward period 

In the step, "Check MRP types", you can maitain the indicator, "Delete out-of-date planned orders" 

with which order proposals that lie before the roll forward period are deleted and new re-scheduled 

planned orders are created (or depending on the planning time fence, they are displaced to the end 

of the planning time fence). 

Actions 

1. Define the planning time fence per plant and MRP group. 

2. Define the roll forward period. 

26.3.2.2 Evaluation 

In this step, you can design evaluations for MPS. You can either design the evaluations for master 

schedule items according to your own requirements or you can use the evaluation that is preset in the 

system for master schedule items. 
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You specify the composition and structure of the evaluation in an evaluation profile. There are two layout 

elements available for creating the evaluation profile: 

- Hierarchy elements: 

The hierarchy elements determine the structure of the evaluation. You use the hierarchy elements to 

determine the order and the headings according to which the MRP results are to displayed. 

- MRP elements: 

The MRP elements contain the MRP data. 

Note 

You can maintain the texts for the MRP elements in the menu option "Evaluations -> MRP list -> MRP 

element texts". 

Default Settings 

MPS evaluations are preset in the system. 

26.3.2.2.1 Define Hierarchy Elements 

In this step, you specify the possible hierarchy elements and the texts to the hierarchy elements. The texts 

of the hierarchy elements are displayed in the evaluation as headings of the MRP items. 

Note 

With the texts of the hierarchy elements you can maintain precise headings per MRP item. If you want to 

distinguish, for example, between fixed and unfixed planned orders, you maintain two hierarchy 

elements with different texts. 

Actions 

1. Change existing texts according to your requirements. 

2. Specify new hierarchy elements, if necessary. 

26.3.2.2.2 Define Evaluation Profiles 

In this step, you specify a hierarchy for the hierarchy elements and link this hierarchy to the MRP 

elements. 

Analysis profiles can be created for analyses of a single material or of a product group. 

Note 

A hierarchy element to which an MRP element is allocated cannot be exploded further. 

Example 

Below, is an example of a hierarchical structure: 

                    _____________RECEIPTS______________ 



 

 

                   |                                   | 

           In-house production                  External procurement 

          |                   |                |                    | 

        Planned          Production         Purchase 

Purchase 

       __orders__          orders           requisition          order 

      |          |     

Firm        Non    

planned     firm     

orders      planned                 

orders 

Actions 

1. Specify a three-character profile name and a short description to identify the evaluation profile. 

2. Specify the hierarchy elements and the hierarchical levels for the evaluation and allocate the 

appropriate MRP elements. 

3. 

- with "Explode", you create further hierarchical levels 

- with "Insert", you can display several hierarchy elements on the same level or allocate several 

MRP elements to one hierarchy element 

- you can add blank lines or you can draw lines to optically differentiate between the individual 

levels 

- with the +/- sign, you can display the MRP elements in an addition or subtraction relationship 

- you can also display the following special functions by selecting "Special functions": 

* available quantity 

* ATP quantity 

* accumulated ATP quantity 

Note 

The special functions are displayed only if in addition to the entry as a hierarchy element the 

special function was selected and flagged. 

The following elements of SOP can also be displayed as special functions: 

* sales plan 

* warehouse stock 

* target warehouse stock 

- select the function "Field contents", if you want to specify the MRP elements 

The field contents are divided into details for external procurement and details for in-house 

production. 

26.3.2.2.3 Define Layout 
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In this step, you allocate a certain layout, that is, a certain display format to an evaluation profile. 

Note 

You have to allocate at least one layout to every profile because the MPS evaluation is accessed using 

the name of the layout. 

Actions 

1. Specify a layout name and a short description of the layout. 

2. Specify the layout usage. 

3. Allocate the layout to the appropriate evaluation profile. 

4. Specify whether the layout should be protected against changes by users. 

5. Allocate an individual period split to the layout, if necessary. 

26.3.2.3 Authorization Management 

In this step, you allocate profiles and authorizations to the users for their particular work areas. 

Authorization objects define the authorization by the entry of fields that are required for carrying out a 

particular activity. For example, the fields User group and Actions. 

The authorization specifies the authorization object. For example, for the field User group you can 

define "MRP controller" and for the field Actions yoiu can define "Dispaly planned order". 

Profiles group together individual authorizations into a group. 

26.3.2.3.1 Master production scheduling 

In this section, you learn which authorization objects are defined for the individual functions of the 

application in the standard system. In the SAP System, you can maintain authorizations for these objects. 

Authorization objects 

The following lists shows which authorization objects are checked for the individual functions of the 

application. 

 Functions for... authorization objects 

 Single-item MPS M_MTDI_ORG Material requirements planning 

(Class: Materials management: MRP) 

 Multi-level MPS M_MTDI_ORG Material requirements planning 

(Class: Materials management: MRP) 

 Interactive MPS M_MTDI_ORG Material requirements planning 

(Class: Materials management: MRP) 

 Total planning, MPS M_MTDI_ORG Material requirements planning 

(Class: Materials management: MRP) 



 

 

Master schedule items - Evaluation 

(MRP list, 

 Stock/requirements list) M_MTDI_ORG  Material requirments planning 

(Class: Materials management: MRP) 

 Process planned order M_PLAF_ORG Processing planned orders 

(Class: Materials management: MRP) 

 Display planned order M_PLAF_ORG Processing planned orders 

Processing planned orders 

(Class: Materials management: MRP) 

 Planned order list display M_PLAF_ORG Processing planned orders 

(Class: Materials management: MRP) 

 Convert planned order M_PLAF_ORG Processing planned orders 

(Class: Materials management: MRP) 

 Firming planned orders M_PLAF_ORG Processing planned orders 

(Class: Materials management: MRP) 

 Backorder processing M_MIPA_ORG Backorder processing 

(Class: materials management: MRP) 

Standard Settings 

In the standard system, authorizations are provided for all authorization objects in the application. 

You will find both maintenance authorizations and display authorizations for authorization objects. 

The standard authorizations apply to all organization units. 

Activities 

1. Check whether the authorizations that come with the standard system cover 

your needs. Proceed as follows: 

a) Choose the object class of the application. 

A list of the authorization objects in this class is now displayed. 

b) Choose an object. 

A list of the authorizations for this object is now displayed. 

2. If necessary, create new authorizations to meet your requirements. Proceed as 

follows: 

a) Choose Authorization -> Create. 

b) Enter the authorization and a short text. 

c) Maintain the values of each field one by one. 

d) Save your entries. 

e) Activate the new authorization. 

Note 

The profile generator lets you create authorizations and profiles. 

This function makes it much easier for you to customize your authorizations. You should use this 

function if you are working in a new installation. 
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The individual configuration steps for the profile generator are described in Customizing underBasis 

Components - System Administration - Users and Authorizations - Maintain authorizations and profiles 

using profile generator.  



 

 

Description of the authorization objects 

Object: M_MTDI_ORG Organization levels for material requirements planning 

Definition 

Organizational authorizations for material requirements planning 

This authorization object controls whether an MRP controller is authorized to carry out the planning run 

for one or more plants or which specific activities the MRP controller is authorized to execute. 

Defined fields 

The authorization contains three fields: 

- Activity categories in MRP (Field MDAKT) 

Possible values: 

BMRP: Total planning 

EMRP: Single-item planning 

 O MRP: Project planning 

 M MRP: Sales order planning 

 A MRP: Stock/requirements list 

LMRP: MRP list, individual display 

S MRP: MRP list, collective display / planned order, collective conversion 

RMRP: Current materials overview 

H MRP: Create planned order 

 V MRP: Change planned order 

FMRP: Firm planned order 

 U MRP: Planned order, individual conversion 

PMRP: Generate planning file entries 

 W MRP: Stock value display in the collective display graphic 

1 Long-term planning: Total planning 

2 Long-term planning: Single-item, multi-level planning 

3 Long-term planning: Single-item, single-level planning 

4 Long-term planning: Display stock/requirements list 

5 Long-term planning: Display MRP list 

J Long-term planning: Sales order planning 

KLong-term planning: Project planning 

 Y Multi-level MPS 

ZSingle-level MPS 

I Interactive MPS 

CMPS, total planning 

- Plant (Field WERKS) 

Here, you must enter all the plants for which materials planning can be carried out. 

- MRP controller (Field DISPO) 

Here, you must enter the MRP controller(s), who are authorized to carry out the activities. 

Object: M_PLAF_ORG Organization levels for processing planned orders 

Definition 

Organization authorization for processing planned orders 

This object controls which options the MRP controller has for processing planned orders and in which 

plants. 
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Defined fields 

The authorization object contains three fields: 

- Activity categories of materials planning Possible values:         'H': Create 

                         'V': Change 

                         'A': Display 

                         'L': List display 

                         'S': Collective conversion 

                         'U': Individual conversion 

                         'F': Fixing 

(For the conversion of planned orders into production orders only the values 'S' and 'U' are of relevance.) 

- Plant 

Here, you must enter all the plants for which planned order processing can be carried out. 

- MRP controller 

Here, you must enter the MRP controller(s) who are authorized to process planned orders. 

26.3.2.3.2 Define Profiles 

Profiles contain authorization objects for distinct working areas. 

Requirements 

You must have defined the authorizations. 

Default Settings 

Profiles are predefined in the SAP system. 

Actions 

1. Change the profiles that are contained in the SAP system to suit to your requirements. 

2. Create new profiles, if necessary, by allocating objects and authorizations to every profile. 

26.4 Capacity Requirements Planning 

This section contains all information on implementing capacity planning in production planning. 

You make settings in the following sections: 

- Available capacity 

- Capacity requirements 

- Scheduling 

- Capacity evaluation - Capacity leveling 

26.4.1 Master data 



 

 

In this section, you define the following master data used in capacity planning: 

- time units 

- capacity categories 

- work center data 

- standard value keys 

- move time matrix 

- control key for routing 

- setup parameters Note: 

If you have already entered the master data for the work center and routing, you do not have to process 

this section. 

26.4.1.1 Define time units 

In this step you define the units necessary for scheduling with the dimension "time" (for example, 

second, minute, decade and so on). 

Note 

To maintain the time units you must set the dimension "time" in the field next to the function key "units 

of measure" on the initial screen, before you press the function key. 

Actions 

Define new time units, if necessary. 

26.4.1.2 Capacity data 

In this section you enter essential data for capacity maintenance. In the section capacity category you can 

define capacity categories. Every capacity that you create directly or via the work center has to be 

allocated to a capacity category. You can enter default values for every capacity category. These default 

values can be transferred to the capacity category when the capacity is created. 

You also set up the capacity planner in this section. 

26.4.1.2.1 Define Capacity Category 

In this step you can assign several capacities belonging to different categories to one work center. 

Capacity categories can be, for example: 

- machine 

- labor 

- setup crew 

- emissions 
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You must maintain the available capacity for every capacity category (for example, shift start, shift end, 

calendar, etc). You can maintain default values for this data per plant and capacity category. 

Actions 

Define which capacity categories are to be available. 

26.4.1.2.2 Set up capacity planner 

In this menu option, you specify the person/group of people responsible for planning capacities. 

Actions 

Specify the capacity planners. 

26.4.1.3 Work center data 

In this section, you specify work center data for scheduling. 

26.4.1.3.1 Standard value 

In this section, you define parameters and allocate them to the standard value keys. 

26.4.1.3.1.1 Define parameters 

In this menu option, you define the parameters. You allocate these parameters to the standard value keys. 

You can assign any meaning to these standard values. The most common standard values are setup time 

or machine time per unit ("tr" or "te" after REFA). Under certain circumstances, you also have to make 

further standard values such as labor times or cleanout times available for planning. 

In addition, you need the parameters in the formula definitions and for the definition of formulas and 

methods for the CAP calculation of standard values. 

Note 

Please keep in mind that the meaning of the fields is specified by the key words. 

Recommendation 

You should select mnemonic identification codes if you later want to use the parameters in the formula 

definition. 

Actions 

Set up the parameters. 



 

 

26.4.1.3.1.2 Define standard value keys 

In this step you define standard value keys. The standard value key determines the meaning of the six 

standard values in the operation. The SAP System assigns a parameter ID to the standard values of the 

operation and the work in network activities. 

The parameter ID in turn determines: 

- the key word displayed for the standard value on the screen, for example, setup, machine, labor, 

teardown etc. 

- the dimension (for example, time, quantity, volume) of the standard value 

At the same time, the parameter IDs are the names used for the standard values in formulas for the 

calculation of 

- execution time - capacity requirements - costs. 

Note 

A parameter which is to be used in a standard value key must have the origin "2". 

If you use capacity leveling, SAP recommends that you always enter the parameter key for the setup 

standard values in the same position (for example, in the first column) in all standard value keys. 

Actions 

Define the standard value keys. 

26.4.1.3.2 Define move time matrix 

In this menu option, you can define the location group and the move time  matrix. The system uses the 

move time matrix in scheduling to calculate  the move time between work centers. You must enter the  

move time from one location group to another in a matrix for the calculation. 

Recommendation 

To prevent the matrix from getting too large, you should combine work centers located in the same area 

into one location group. 

Actions 

1. Define your location groups. 

2. Maintain the matrix for the move time. 

26.4.1.4 Routing data 

You specify the following routing data in this section: 

- Control keys 

- Setup parameters 

- Setup matrix 
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26.4.1.4.1 Define setup matrix 

In this step you define the setup matrix. 

In the setup matrix you store values and units for the setup standard values of operations depending on 

the setup state of the work center. 

Various dispatching functions on the capacity planning table for capacity leveling (for example, setup 

time optimization) take into account that the setup time for an operation depends on which operation was 

previously processed at the work center, that is in what setup state the work center is. These functions do 

not use the value for the setup standard value from the operation but instead the value from the setup 

matrix. 

Note 

For capacity leveling in the process industry (PP-PI), that is, for the capacity leveling of process 

orders and planned orders referring to master recipes, the functions which consider and adjust the 

setup times are not available. This applies to the manual adjustment of setup time as well as the 

functions that are based on the evaluation of a setup matrix. The setup matrix for PP-PI is therefore 

not relevant. 

The setup state of a work center is characterized in the setup matrix by the setup group category and the 

setup group key that are saved in the operation to be processed. 

A transition between two setup states is identified by the setup group categories and the setup group keys 

of two operations that are processed at the work center one after the other. The value for the setup 

standard value that you store in a transition is assigned to the successor operation. 

You can specify for every individual setup transition which standard value is regarded as the setup 

standard value in the following operation. If a setup transition is not maintained in the setup matrix then 

you should specify in the control profile which standard value is to be interpreted as the setup standard 

value. 

The standard value "1" is predefined internally both in the control profile and for a setup transition in the 

setup matrix. 

You define a transition in the setup matrix as follows 

Enter for the 

Predecessor group        the setup group category of predecessor 

Predecessor subgroup   the setup group key of predecessor 

Successor group       the setup group category of successor 

Successor subgroup  the setup group key of successor 

In the setup matrix you can also define whether a transition is permitted or forbidden. For example, this 

is taken into account in setup time optimization when forming a sequence of operations where the setup 

time is minimized. 

You can use the wildcard character * for the setup group key in the setup matrix as described in the 

following example: For example, the system searches in the setup matrix for an entry with the setup 

group key ABC for the predecessor. If it does not find a key ABC it looks for the key AB*, then for a 

key A* etc until it finds one of them. 

Initial setup states 

The setup state of the work center is not defined for the case where an operation does not have a 

predecessor in the evaluation period. You can define the setup state of the work center by entering an 

initial setup state in the strategy profile. To calculate the setup time of this first operation at the work 

center the system can use the setup standard value that is assigned in the setup matrix to the transition 



 

 

between the initial setup state and the setup state for processing the operation. An initial setup state 

can only occur in the setup matrix as a predecessor for a transition. You can only use a key that is a 

maximum of three characters long for the predecessor group for the initial setup state. You cannot 

make any entry for the predecessor subgroup. 

Activities 

Define the setup matrix. 

Further notes 

The setup group key and the setup group category are not checked in the setup matrix. 

26.4.1.4.2 Define control key 

In this step you define the control key for the operation. 

By means of the control key for the operation, you specify 

- which business functions you want to carry out 

- how an operation is to be dealt with The most important alternatives are: 

- scheduling 

You use this indicator to determine that the operation or sub-operation is scheduled. 

- Capacity planning 

You use his indicator to ensure that when the operation is scheduled capacity requirements records 

are written. 

- Costing 

You use this indicator to ensure that the operation is taken into account during costing. 

- External processing  

You use this indicator to specify that the operation is processed externally. 

- Confirmation 

You use this indicator to determine: 

- that the operation is confirmed 

- how the operation is confirmed 

- Printing of time tickets 

You use this indicator to ensure that time tickets are printed for the operation. 

Note 

A later change to the reference generally causes the data to be changed afterwards. 

Actions 

Check the existing control keys. 

26.4.1.4.3 Define setup parameters 
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In this step, you define setup. 

Setup includes: 

- Setup type key 

You define the setup type according to plant by using the setup type key. You can print out setup 

type with shop floor papers. In sequencing, the optimum sequences for setup are determined with 

the setup type key. 

- Setup group category 

The setup group category classifies the setup groups. Setup group categories are plant-dependent. 

- Setup group 

The setup group combines operations with the same or similar setup conditions. In capacity 

leveling, you can optimize the sequence using the setup group. 

Actions 

1. Define your setup type keys for each plant. 

2. Maintain the setup group categories. 

3. Maintain the setup groups within the setup group categories. 

26.4.2 Operations 

In this section you define the parameters for the operations that are relevant to finite scheduling. 

This concerns how available capacity is defined and determined, scheduling and the calculation of 

capacity requirements. 

26.4.2.1 Available capacity 

In this section, you can carry out adjustments to the available capacity. 

26.4.2.1.1 Define shift sequences 

In this step you define the following: 

- Grouping 

Using the grouping you can create shift sequences and shift definitions for special areas (for 

example, different plants or different areas of a plant) and when maintaining the available capacity 

choose from between work centers. 

- Work break schedule 

Here you define parameters that describe the individual work break schedules in more detail, as for 

example: 

- Start 

- Finish 

- Break times 



 

 

- Shift definition 

Here you define the parameters common to several work centers that describe the individual shifts 

in more detail, for example: 

- Start 

- Finish 

- Break times 

- Validity period of a shift 

In Logistics (LO) you can reference daily work schedules from the personnel system (HR). If you 

reference a daily work schedule in LO from HR and this is changed in HR then this change has a 

direct effect on changes in LO. 

- Shift sequences 

You can assign the shift sequence of a capacity category as the available capacity at the work 

center. 

You define a sequence of shifts per weekday. The shift sequence represents a collection of shift 

definitions. 

In capacity planning the system uses the predefined values from the shift definition to determine the 

available capacity of a work center. 

The system calculates the following values: 

- the capacity 

- the actual operating time for the capacity 

Standard settings 

The SAP standard package contains settings for various shift sequences. 

Activities 

You should define the following: 

1. groupings 

2. shift sequences 

3. shift definitions 

4. work break schedules 

26.4.2.1.2 Define key for performance efficiency rate 

In this menu option, you  define performance efficiency rates. In the SAP System, performance 

efficiency rates are used in costing and in scheduling. The system uses the performance efficiency rate to 

correct standard values in the operation to correspond with the actual expected costs. 

In every performance efficiciency rate key you enter a performance efficiency rate for costing and 

scheduling.You can define time-dependent performance efficiency rate keys, that is you can enter 

different values for the performance efficency rate for different validity  periods. 
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Actions 

1. Define the performance efficiency rate keys. 

2. Define the performance efficiency rate keys and their validity periods 

26.4.2.1.3 Formulas 

In this section, you create the formulas with which the following data is calculated in capacity planning, 

scheduling and costing (general(: 

- capacity requirements 

- lead times 

- costs 

26.4.2.1.3.1 Define formula parameters 

Formula parameters are used in formulas for capacity planning, scheduling, costing, PRT management 

and determining standard values using CAPP. 

A formula parameter is identifeied by a parameter ID. Every formula parameter is linked with a 

particualr field either in Customizing, the routing or the work center. When the formula is evaluated the 

parameter takes the value of the field. 

Origin of Formula Parameters 

The assignment of a formula parameter to a data field is defined in the origin. You can refer to the data 

field in the work center or the routing via the parameter-ID or the key word that is assigned to every 

formula parameter and is displayed next to the the data field in the routing or work center. Formula 

parameters can have the following origins: 

- Standard Value 

Using the standard value key you provide the work center, and thus the routing, with up to six 

formula parameters that you assign values to in the routing operation. 

- Work Center Constant 

In the work center you can assign up to six work center constants a value and an unit. 

- General Formula Constants 

You can assign  general formuula constants a value and an unit in Customizing formula parameters. 

- General Operation Value 

The formula parameter is assigned to a data field in the general operation data, for instance the lot 

size or the base quantity. In this case you have to explicitly enter the field name. 

- User-Defined Field from Operation 

The formula parameter is assigned to an user-defined field in the operation. In this case the the 

assignment of the formula parameter is controlled by user-defined field key, that you define in 

Customizing the work center. The key words that describe the data fields are not defined in the 

formula parameters, but in the user-defined field key. 

- Value from PRT Allocation 



 

 

 You assign  the formula parameter to a field in the PRT alloaction, for instance the PRT quantity. 

- PRT constant 

You assign the formula parameter a fixed value in the PRT master record.This formula parameter 

can only be used for PRT management. 

Note: 

You enter the meaning of the fields in the key words for work centers and routings and not in the field 

names. 

Please note that this step is the prerequisite for the step Define rounding categories and additional values 

key in Customizing for CAPP standard value calculation. 

If you want to use the parameters in formulas you should use descriptive parameter IDs. 

- The value that you enter in the std. value field is only used to check the syntax of the formula 

(apart from general formula constants). The system does this automatically when you create a 

formula in Customizing. You should maintain this field, specially if a formula parameter is used as 

a divisor in a formula. Similiarly the Standard value unit field is only used for checking 

purposes. 

Actions 

1. Define your formula parameters. 

2. Check the assignment of the formula parameters to the standard value keys. 

3. Check the use of the formula parameters in formula definitions. 

26.4.2.1.3.2 Set up formula definitions 

In this menu option, you define formulas which are used for calculations in the following areas: 

- capacity planning 

- scheduling 

- costing 

The formula parameters which you want to use in your formulas must be predefined in the section 

"Define formula parameters". Formula parameters can be linked in the formulas using the following 

operators: 

- addition => + 

- subtraction => - multiplication => * 

- division => / 

Actions 

1. Check the available formula parameters. 

2. Define the formulas needed in your company. 

26.4.2.2 Scheduling 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 258 

In this menu option, you enter settings relevant to scheduling. 

26.4.2.2.1 Specify scheduling type 

In this step you define the scheduling type, which determines how the SAP System should carry out 

scheduling. There are the following options: 

- Forwards 

- Backwards 

- No scheduling 

- "Today" scheduling 

- Basic dates with times (only for process orders) 

You can save the scheduling type in the control data for scheduling depending on the order type. It is 

then proposed by the SAP system when an order is created. 

Recommendation 

Scheduling types are predefined in the SAP standard package. We recommend that you work with these 

predefined scheduling types. 

26.4.2.2.2 Set up production scheduler group 

In this menu option, you assign the work scheduler groups for each plant. A work scheduler group 

defines responsibility within routing maintenance. 

You can assign the scheduler groups to a profile. 

Actions 

Create the work scheduler groups. 

26.4.2.2.3 Task list selection 

In this section you define the criteria according to which task lists/ task list alternatives are selected in 

PPC. 

The task list selection occurs 

- when you create a task list with a reference when you create an order 

- in scheduling 

- in costing 

26.4.2.2.3.1 Define user selection 

In this section you can enable the user to select task lists. 

You can define ABAP routines for each of the following parameters: 

- Task list application 



 

 

- Task list type 

- Selections ID 

These parameters are then run during the selection of task list alternatives. 

Actions 

You must specify which task lists the user can select. 

26.4.2.2.3.2 Select automatically 

In this step you use the selection ID to define the selection criteria for automatic selection of task list 

alternatives. 

You can define several selection priorities for the selection ID. You allocate the selection criteria to these 

priorities. 

During automatic alternative task list selection, the system looks for a task list alternative that 

corresponds to the selection criteria. 

Selection criteria include: 

- Task list type 

- Task list usage - Task list status 

If a task list alternative cannot be determined then the SAP system continues searching using the 

selection criteria with the next-highest selection priority. 

Automatic selection always takes precedence over user selection. 

Note 

In production control the selection ID is determined by the order category. 

Actions 

Define the following for every selection ID: 

- Selection priority 

- Task list type 

- Task list usage 

- Task list status 

26.4.2.2.4 Define Scheduling Parameters for Production Orders 

In this step you define for each plant, order type and production scheduler the parameters for scheduling 

production orders. This comprises maintaining 

- date adjustment when dates are exceeded 

- date control for detailed scheduling 

- reduction 
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The parameters are described in what follows in details: 

- In detailed scheduling you define: 

- how production dates are to be calculated 

- whether capacity requirements are generated 

- In date adjustment you specify whether and how the basic dates are adjusted to the production 

dates (for example, when deadlines are exceeded) and how dates for dependent requirements are to 

lie. 

- In Scheduling control for detailed scheduling you specify the control parameters for detailed 

scheduling, among other things the 

- scheduling type 

Here you specify in which direction scheduling is to be carried out and whether it is to be 

carried out to an exact time. Among other things you can specify that a scheduling run only be 

used to generate capacity requirements. 

- Start date in the past 

Here you specify how many days an order may lie in the past before today scheduling is 

triggered. 

- Calculate dates automatically 

Here you specify whether scheduling is carried out automatically on saving. 

- Display log automatically 

Here you specify whether the log is displayed automatically on scheduling. 

- Required date of material 

Here you specify where the required date of a component should be with respect to an 

operation. 

- Schedule exact to the break 

Here you specify that the exact time a break occurs must be taken into account. 

- Dates to be specified 

Here you specify that when you create or change an order the user must enter schedules dates 

(production dates) instead of basic dates. 

- Move order 

Here you specify whether the order can be moved if partially confirmed operations exist. 

- In reduction you specify 

- whether in the order or in the collective order all the operations are to be reduced or only those 

along the critical path. 

- Reduction along the critical path is only possible for networks, production orders and planned 

orders with parallel sequences and for collective orders that contain production orders or planned 

orders. 

- up to which maximum reduction level the reduction takes place 

- to what percentage the float before and after production in every reduction level is to be reduced. 

Actions 

Define the scheduling parameters for production orders. 



 

 

26.4.2.2.5 Define scheduling parameters for networks 

In this step you define control parameters for scheduling depending on the plant, the type of network and 

the production scheduler, for example: 

- whether basic dates are to be adjusted if the network is shifted within the earliest/latest dates 

- the scheduling type 

- whether or how many days the start date can be in the past 

- whether the dates are to be automatically recalculated on saving 

- whether the error log is automatically displayed if errors were calculated in scheduling 

- the number of days that the start date is in the past 

- the reduction type that defines whether all the operations should be reduced or only those on the 

critical path 

- maximum reduction level for reduction 

Standard settings 

Control parameters are saved for scheduling in the standard SAP package. 

Activities 

Define the control parameters. 

26.4.2.2.6 Define scheduling parameters for planned orders 

In this step you define the parameters for scheduling planned orders for each plant, order type and 

production scheduler. This comprises the following settings: 

- date adjustment when deadlines are exceeded 

- scheduling control for detailed scheduling 

- reduction 

The parameters are described in detail in what follows: 

- In detailed scheduling you define: 

- how production dates are determined - whether capacity requirement are generated - In 

Adjust Scheduling you specify: 

- that the takt time/rate-based scheduling determines sequencing for planned order dates. If you select 

this indicator, the dates determined by takt time-/rate-based scheduling are not overwritten by those 

determined in lead time scheduling. The basic dates are also not adjusted. Lead time scheduling is 

used to calculate capacity requirements and their dates. 

- whether and how basic dates are adjusted to production dates (for example, when exceeding dates) 

and what the dates for dependent requirements should be 

- In scheduling control for detailed scheduling you specify the control parameters for detailed 

scheduling, among other things 

- Scheduling type 

Here you specify the scheduling direction. You can also specify that a scheduling run should 

only be used to generate capacity requirements. 
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- Start date in the past 

Here you specify how many days an order may lie in the past before today scheduling  is 

automatically triggered. 

- Automatically calculate dates 

Here you specify whether scheduling is automatically carried out on saving 

- Display log automatically 

Here you specify whether the log is automatically displayed after scheduling. 

- Required date of material 

Here you specify where the required date for a component should be with respect to the 

operation. 

- Schedule exact to the break 

Here you specify that the break times should be taken into account exactly. 

- Under reduction you specify 

- whether in the order or in the collective order all the operations are reduced or only 

those on the critical path. Reduction along the critical path is only possible for production 

orders and planned orders with parallel sequences and for collective orders that contain 

production orders or planned orders. 

- up to which maximum reduction level the reduction is to take place 

- to what percentage the floats before and after production in every reduction level should be reduced. 

Actions 

Define the scheduling parameters for planned orders. 

26.4.2.2.7 Define scheduling parameters for maintenance orders 

In this step you can specify scheduling parameters for every PM order type and every PM plant. 

Besides the scheduling type you can specify further scheduling parameters: 

- automatic scheduling 

- display scheduling log after scheduling has taken place 

- maximum number of days for start in the past 

- automatic adjustment of basic dates 

- indicator move order 

Activities 

Maintain your scheduling parameters. 

26.4.2.2.8 Define scheduling parameters for process orders 



 

 

In this step you define the parameters for scheduling process orders for each plant, order type and 

production scheduler. It comprises maintenance of - date adjustment when deadlines are exceeded 

- scheduling control for detailed scheduling 

- reduction 

The parameters are described in more detail in what follows: 

- In detailed scheduling you specify: 

- how production dates are determined 

- whether capacity requirements are generated 

- In date adjustment you specify whether and how basic dates are adjusted to the production dates 

(for example, when deadlines are exceeded) and where the dates for the dependent requirements are 

meant to be. 

- In scheduling control for detailed scheduling you specify the control parameters for detailed 

scheduling, among others 

- scheduling type 

Here you specify the scheduling direction and whether scheduling is to be to specific points in 

time. You can also specify that a scheduling run is only to be used to generate capacity 

requirements. 

- Start date in the past 

Here you specify how many days an order may be in the past before today scheduling is 

automatically triggered. 

- Automatically calculate dates 

Here you can specify whether scheduling is automatically executed on saving if changes 

relevant to scheduling have occurred. 

- automatically save log 

Here you specify whether the log is automatically displayed after scheduling. 

- Required date of material 

Here you specify where the required date of a component is to be in relation to the operation. 

- Schedule taking breaks into account 

Here you specify that the times of a break are to be taken into account. 

- Dates to be specified 

Here you specify that when creating or changing an order the user must enter the scheduled 

dates (production dates) instead of the basic dates. 

- Move order 

Here you specify whether the order can be moved if partially-confirmed operations exist. 

- In reduction you specify 

- up to what maximum reduction level the reduction takes place 

- to what percent the floats before and after production in every reduction level are to be reduced. 

Actions 

Define the scheduling parameters for process orders. 

26.4.2.2.9 Reduction strategies 
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In this section you define the reduction strategy and the reduction levels for scheduling. 

If the scheduled dates that lie outside the basic dates entered, the SAP system tries to reduce the lead time 

of the following step by step: 

- planned orders 

- production orders 

- networks 

- process orders. 

26.4.2.2.9.1 Define reduction strategies planned-/production order 

In this step, you specify the reduction strategy to be used when the reduction measures are carried out on 

operations. Scheduling reduces the lead_time automatically if the basic dates given are not adhered to, 

that is if the scheduled dates lie outside the basic dates. 

In this work step, you also define the reduction levels. The reduction takes place level by level no further 

than the level that you have specified in the control parameters. 

You can specify a reduction strategy in every operation. 

- Reduction strategies 

You use the reduction strategies to determine how the operation lead time can be reduced step by 

step. You can enter a reduction strategy in every operation. 

- Reduction levels 

You can define up to six reduction levels for each reduction strategy. For every reduction level you 

can enter what is to be reduced and by how much. 

The SAP system carried out reduction step by step no further than the reduction level specified in the 

scheduling parameters. 

Note 

The order/network is rescheduled after every reduction level. To improve performance we recommend 

that you keep the number of reduction steps to a minimum. 

Standard settings 

The reduction levels are predefined in the SAP standard package. 

Activities 

1. You should define the reduction strategies. 

2. You should define the reduction levels for all the reduction strategies. 

26.4.2.2.9.2 Define reduction strategies for network/process order 



 

 

In this step you define the reduction strategy and the reduction steps for scheduling. 

If the scheduled dates lie outside the basic dates given, the SAP system tries, step-by-step to reduce the 

lead time of the network/process order. 

- Reduction strategies 

You use reduction strategies to control how the lead time of the operation can be reduced step-by-

step. You can enter a reduction strategy in every operation. 

- Reduction steps 

You can define as many as six reduction steps for each reduction strategy. For every reduction step 

you can specify what is to be reduced and by how much. 

Note 

The SAP system reduces step-by-step only as far as the reduction level that is stored in the scheduling 

parameters. 

Standard settings 

The reduction steps are defined in the SAP standard package. 

Activities 

1. Define the reduction strategies. 

2. Define the reduction levels for all the reduction strategies. 

26.4.2.3 Capacity requirements 

In this section, you enter settings for capacity requirements. 

26.4.2.3.1 Formulas 

In this section, you define the formulas used to calculate the following in capacity planning, scheduling 

and costing (general): 

- capacity requirements 

- lead times 

- costs 

26.4.2.3.1.1 Define formula parameters 

Formula parameters are used in formulas for capacity planning, scheduling, costing, PRT management 

and determining standard values using CAPP. 

A formula parameter is identifeied by a parameter ID. Every formula parameter is linked with a 

particualr field either in Customizing, the routing or the work center. When the formula is evaluated the 

parameter takes the value of the field. 

Origin of Formula Parameters 
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The assignment of a formula parameter to a data field is defined in the origin. You can refer to the data 

field in the work center or the routing via the parameter-ID or the key word that is assigned to every 

formula parameter and is displayed next to the the data field in the routing or work center. Formula 

parameters can have the following origins: 

- Standard Value 

Using the standard value key you provide the work center, and thus the routing, with up to six 

formula parameters that you assign values to in the routing operation. 

- Work Center Constant 

In the work center you can assign up to six work center constants a value and an unit. 

- General Formula Constants 

You can assign  general formuula constants a value and an unit in Customizing formula parameters. 

- General Operation Value 

The formula parameter is assigned to a data field in the general operation data, for instance the lot 

size or the base quantity. In this case you have to explicitly enter the field name. 

- User-Defined Field from Operation 

The formula parameter is assigned to an user-defined field in the operation. In this case the the 

assignment of the formula parameter is controlled by user-defined field key, that you define in 

Customizing the work center. The key words that describe the data fields are not defined in the 

formula parameters, but in the user-defined field key. 

- Value from PRT Allocation 

 You assign  the formula parameter to a field in the PRT alloaction, for instance the PRT quantity. 

- PRT constant 

You assign the formula parameter a fixed value in the PRT master record.This formula parameter 

can only be used for PRT management. 

Note: 

You enter the meaning of the fields in the key words for work centers and routings and not in the field 

names. 

Please note that this step is the prerequisite for the step Define rounding categories and additional values 

key in Customizing for CAPP standard value calculation. 

If you want to use the parameters in formulas you should use descriptive parameter IDs. 

- The value that you enter in the std. value field is only used to check the syntax of the formula 

(apart from general formula constants). The system does this automatically when you create a 

formula in Customizing. You should maintain this field, specially if a formula parameter is used as 

a divisor in a formula. Similiarly the Standard value unit field is only used for checking 

purposes. 

Actions 

1. Define your formula parameters. 

2. Check the assignment of the formula parameters to the standard value keys. 

3. Check the use of the formula parameters in formula definitions. 

26.4.2.3.1.2 Define formulas 



 

 

In this menu option, you define formulas which are used for calculations in the following areas: 

- capacity planning 

- scheduling 

- costing 

You can use formula parameters to which you have previously assigned values. You can then link these 

formula parameters mathematically, for example using the following operators: 

- addition => + 

- subtraction => - multiplication => * 

- division => / 

Actions 

1. Check the available formula parameters. 

2. Define the formulas needed in your company. 

26.4.2.3.2 Distribution 

In this step you define the distribution that spreads the capacity requirements over the duration of the 

operation. The requirements can be dispatched evenly or discretely to one or more points in time. 

You define the distribution by means of a distribution function and a distribution strategy: 

- Distribution function 

This function defines what percentage of the capacity is to be dispatched after a particular 

percentage of the operation duration has passed. 

- Distribution strategy 

This strategy defines whether 

- the requirements are to be dispatched at the earliest or latest start date 

- the requirements are to be distributed discretely at the points defined in the function or in a 

linear fashion according to the definition in the distribution function 

- whether the time basis is to be the gregorian calendar, the factory calendar or the operating 

time for the work center. 

26.4.2.3.2.1 Define distribution function 

In this menu option you define the distribution function. You specify what percentage of the capacity 

should be used after what percent of the operation's duration. 

Example 

- Equal distribution function 

       Percent duration:  20  40  60  80  100 

       Percent load:      20  40  60  80  100 

- Strategy: Point in time 
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Dispatch 20% of the capacity requirements after 20% of the operation's duration (20% at this 

point in time), another 20% of the capacity requirements after 40% of the operation's duration, 

etc. 

- Strategy: Function 

Continuous requirements distribution equally over the whole duration of the operation. You 

can achieve the same effect if you enter the value "100" for both the percentage duration and 

the percentage load. 

- Distribution with the maximum at the end 

First the capacity requirements rise only slightly, then rise sharply and level off at the end. 

   Percent duration:   20  40  60  80  100 

   Percent load:       10  20  40  90  100 

Actions 

1. Enter a description for the distribution function 

2. Define your distribution function. 

26.4.2.3.2.2 Define distribution strategy 

In this step, you define the distribution strategy. 

In doing so, you determine the following: 

- Earliest or latest dates of capacity requirements 

Dispatch of requirements at the earliest or latest dates of the operation 

- Distribution type 

Distribution of requirements at certain points in time or on the basis of a partially linear function 

whereby both distribution types use the distribution function definition. 

- Point in time 

Capacity load occurs only at those points in time which you have entered in the percentage 

operation duration and to the value given for the percentage load. 

- Function 

You define an interval using two related values of the percentage operation duration. Using 

the percentage capacity requirements the system determines a linear function for this interval. 

Capacity load occurs continually within this interval on the basis of this linear function. 

- Time basis 

You can use the following as a basis for the duration of the distribution function: 

- factory calendar 

- Gregorian calendar 

- operating time of the work center 

Actions 

Define your distribution strategy. 



 

 

26.4.2.3.2.3 Define distribution key 

In this menu option you define a requirements distribution in which you specify the distribution strategy 

and distribution function. 

Preconditions 

First you must have completed the menu options "Define function" and "Define strategy". 

Actions 

Define the distribution. 

26.4.3 Evaluation 

In this section, you can define the evaluations you need for capacity planning. 

You can define the following according to your requirements: 

- the selection screens 

- the lists that are generated 

- the graphics that are generated 

26.4.3.1 Selection set 

In this step you define the selection sets and the variables. Sets contain criteria for selecting specific 

capacity requirements information. They are required to define various selection screens. 

For example, if you want to define the Set to generate the selection screen, you must generate the 

following, if necessary: 

- variables for the criteria to be entered 

- basic sets for every selection criteria 

- multi set containing the basic set and that is now the actual object set from the selection profile 

- set values 

basic sets can contain fixed values or variables. If a set contains variables, then the user can enter 

values for the field on the selection screen, that belongs to the set. Default values from the 

variables can be overwritten. If a set contains fixed values these are not displayed on the 

selection screens and can therefore not be changed. 

You must define the following data when maintaining the variables: 

- default value 

You can enter a default value for the variable that the user can overwrite. If no 

value is proposed, enter the following: 
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- for a non-numerical field: * 

- for a numerical field:     0 

- description 

- parameter ID 

If the variable is to receive the SET/GET parameter that belongs to the field as a default value, then 

you must set the indicator here. 

Note 

If you want to use variables in a set, you must define them first. If you want to enter a variable in a basic 

set, you must enter a "&" before the name of the variable. 

Standard settings 

Selection sets and variables are predefined in the SAP standard setting. 

26.4.3.1.1 Define variables 

In this menu option, you can define the variables you can assign to a set.  If you assign a variable to 

a set, you can enter the value for the set when a capacity evaluation is carried out. 

For example, if you want to define a set for work center selection and you do not want to fix a specific 

work center in the set, you have to define a variable for the work center and assign this variable to the 

set. 

A variable always refers to a specific field (for example, the field "ARBPL" for work centers). When you 

create a variable, you have to enter the name of this field next to the name of the variable. 

When creating a variable, you must define the following data: 

- Default value 

You can specify a default value for the variable in an evaluation.  The default value can be 

overwritten by the user. 

If no default value is to be proposed, enter the following: 

- for a non-numeric field: * 

- for a numeric field:     0 

- Description 

When you carry out an evaluation, the description of the variable is displayed before the field in 

which you can enter a value for the variable, for example, on the initial screen. - Parameter 

ID 

If the SET/GET parameter for the field is to be used as a default value for the variable, you have to 

set the indicator here. You cannot use the transport functionality here. 

Actions 

RESET N1 

1. Create a variable. 

2. Change a variable. 



 

 

3. Display a variable. 

4. Delete a variable. 

26.4.3.1.2 Define sets 

In this step you define sets 

There are two types of sets: 

- Basic set 

A basic set contains the values for a specific field. You 

have two options when allocating values: 

- You can specify fixed values and/or fixed intervals. 

Fixed values are directly linked to the set. The user cannot change them when the set is used 

for a capacity evaluation. 

For example,if the capacity category "001" (plant) is to be displayed in an evaluation, you can 

create a basic set for the field "KAPAR" (capacity category), to which you allocate the value 

"001". 

- You can specify variable values and/or intervals. 

You can change variable values when the set is used for an evaluation. For example, if you 

want to enter the capacity category when the evaluation is carried out, you have to allocate a 

suitable variable to the field in the set. You always have to enter the variable in the set with a 

leading "&". You can enter the corresponding values when the set is used for an evaluation. 

For example, if the initial screen refers to a set with a variable, the system will display a 

screen on which the user can enter a value for the variable. 

- Multi set 

Using the multi set, you can group several basic sets into one set. Thus you can make selections 

using several fields. 

For example, you can define several fields with a fixed value or a variable value which can be 

entered in the initial screen for the evaluation. 

Note: 

You cannot create multi-sets by combining multi sets. 

Activities 

1. Create a set, if necessary. 

2. Change a set, if necessary. 

3. Display a set, if necessary. 

4. Delete a set, if necessary. 

26.4.3.2 Profiles 

In this section you define the profiles. It is in the profiles that the parameters are specified which control 

how a particular transaction runs. 
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26.4.3.2.1 Define selection profiles 

In this step you define selection profiles. 

A selection profile defines the sets to be used to generate the various selection screens. 

You can define the following sets: 

- The work center set defines the criteria to be taken into account in selecting a work center 

(application menu "Selection -> Work center...") 

- The order set contains the criteria to be taken into account in selecting orders (application menu 

"Selection" -> "Order..."). 

- The capacity set contains the criteria to be taken into account in selecting capacities (application 

menu "Selection" -> "Capacity cat..."). 

- The initial set contains the criteria to be taken into account when you access the capacity evaluation 

transaction. 

In the selection profile, you can also have to enter a time interval (start/finish) in the form of a counter. 

This refers to the current day. In this way you can specify that only capacity requirements can be 

processed that fall within this time interval. 

- define which capacity requirements are to be evaluated 

On the one hand the selection affects the order types, where you can select work orders and/or 

planned orders. On the other hand you define the capacity requirements of the scheduling level are 

to be processed. 

- Enter version of available capacity 

As a rule, the system uses the active version of the relevant capacity to display the available 

capacity. 

You can maintain new intervals in a particular version throughout 

work centers of interest and use them for simulation purposes. You can carry 

out capacity planning with this simulation version without switching off the 

active version. 

For example: 

A set, for example the initial set, specifies which selection is to be carried out when you access the 

transaction for the first time. If this set contains the plant "0001", for example, and a variable work 

center, the SAP System will display a field for entering a work center, but you can no longer change the 

plant. The plant "0001" will always be selected here. The selected plant will be displayed on the selection 

screen. 

In the above case we must be dealing with a Multi-Set, since two different fields are involved. 

Prerequisites: 

You must have maintained the menu item  "Define sets". 

Actions 

Define the selection profiles. 



 

 

26.4.3.2.2 Define options profiles 

In this step, you define the options profiles that determine some essential characteristics of the lists and 

graphics. 

In the option profile, you can specify the following parameters: 

- Display in cumulated or non-cumulated form 

- Capacity unit 

Unit in which the evaluations are to be carried out (for example, hours, minutes) 

- Unit of measure for capacity 

Indicator used to specify that capacity requirements and available capacities are displayed on the 

planning tables in the unit of measure that you maintained in the relevant capacities. 

- Requirements type, 

Key with which you specify whether the scheduled requirements or remaining requirements are to 

be displayed. 

- Minimum and maximum load 

In the standard overview, only the periods which are within these load limits are displayed. 

- Time interval 

You specify the time interval to be evaluated here. 

You specify the first and last day to be displayed using a day counter which itself refers to the 

current day. 

In addition, you must specify the period type in which the time interval is to be defined during the 

evaluation (for example "A" -> specification of the time interval in the form of calendar days). 

- Date for dispatching the backlog 

Using the date for dispatching the backlog, you specify to which date backlogs are to be allocated. 

The available capacity is taken into account as of this date. This date is also defined in the form of a 

day counter. 

- Period type 

Key with which you specify the category of the period (for example, days, weeks or months). 

If you have selected "MRP planning period" as the period type, then you must enter a planning 

calendar. 

Note 

You should note that the planning calendar is plant dependent. 

- Number 

The number of the periods specifies how many units of the period type the period should include. 

If you entered "week" for the period type and "4" for the number, for instance, the duration of the 

period is 4 weeks. 

- Distribution of capacity requirements 

Here, you define whether the distribution specified in the work center or operation is to be taken 

into account, or whether an alternative distribution is to be carried out. You can specify an 

alternative distribution specially for networks or maintenance orders and for all other orders. 

- Hierarchy cumulation 

Here, you specify 

- which hierarchy is to be used to cumulate 

- whether the available capacity is also to be calculated using the hierarchy during the evaluation 

- whether branches (for example, to the work center) are to be carried out in the display mode or 

change mode 
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- Branches 

Here you specify whether, on branching to the work center, the planned order and the production 

order, you get to display or change mode. 

Actions 

Define the options profiles. 

26.4.3.2.3 Define list profiles 

You define the list profiles in this menu option. 

In particular, you specify with a list profile how the detailed capacity list and the variable overview are to 

be set up. In addition, you define the parameters for data transfer to Microsoft EXCEL. 

You specify the following: 

- version of the detail list 

- version of the variable overview 

- type of data transfer to MS EXCEL 

In this case, the file names determine for 

- the standard overview 

- the detailed capacity list 

- the variable overview 

- the relevant path 

You determine whether these file names must be confirmed again when transferring. You can also 

predefine the version of the transferred detail list. 

Requirements 

You must have defined the relevant version of the detailed capacity list or the variable overview in the 

menu option "Define list versions". 

Action 

Define the list profile. 

26.4.3.2.4 Define graphic profiles 

You define the graphics profiles in this menu option. 

You can specify the following: 

- the structure of the graphic "operations per work center" 

Here, you determine 

- whether the operations are to be displayed with the earliest, the latest and/or the actual dates 



 

 

- whether the individual operation segments (setup, processing, teardown) are to be calculated 

individually 

- how the orders are to be sorted 

- the layout of the graphic "Standard overview" Here, you choose between the following displays: 

- bar display form 

- stacked bar form 

- line display form 

- the structure of the graphic "capacity detail" 

Here, you specify whether the display is to be in the form of percentages or absolute values. 

Actions 

Define the graphics profile. 

26.4.3.2.5 Define overall profiles 

In this menu item, you can define the overall profiles. 

An overall profile contains the following individual profiles: 

- Selection profile 

- Options profile 

- List profile 

- Graphics profile 

You can specify the type of evaluation you want to carry out using profiles. 

For example: 

You select an evalution for the work center load in the application. This means that the further processing 

of the transaction is controlled by the parameters of a particular overall profile. 

Prerequisites 

You must have defined the profiles in the following menu items: 

- "Define selection profiles"  

- "Define option profiles"  

- "Define list profiles" 

- "Define graphics profiles" 

Actions 

Define the overall profile. 

26.4.3.3 Selection 
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In this section, you specify how the selection of certain objects (for example, of work centers, orders etc) 

is to be carried out. 

You specify the category of the selection on the one hand using the selection profiles, and on the other 

hand, using the selection combinations. 

Recommendation 

You should have processed the menu options "Define sets" and "Define variables". 

26.4.3.3.1 Define selection profiles 

In this step you define selection profiles. 

A selection profile defines the sets to be used to generate the various selection screens. 

You can define the following sets: 

- The work center set defines the criteria to be taken into account in selecting a work center 

(application menu "Selection -> Work center...") 

- The order set contains the criteria to be taken into account in selecting orders (application menu 

"Selection" -> "Order..."). 

- The capacity set contains the criteria to be taken into account in selecting capacities (application 

menu "Selection" -> "Capacity cat..."). 

- The initial set contains the criteria to be taken into account when you access the capacity evaluation 

transaction. 

In the selection profile, you can also have to enter a time interval (start/finish) in the form of a counter. 

This refers to the current day. In this way you can specify that only capacity requirements can be 

processed that fall within this time interval. 

- define which capacity requirements are to be evaluated 

On the one hand the selection affects the order types, where you can select work orders and/or 

planned orders. On the other hand you define the capacity requirements of the scheduling level are 

to be processed.  

- Enter version of available capacity 

As a rule, the system uses the active version of the relevant capacity to display the available 

capacity. 

You can maintain new intervals in a particular version throughout work 

centers of interest and use them for simulation purposes. You can carry out 

capacity planning with this simulation version without switching off the 

active version. 

For example: 

A set, for example the initial set, specifies which selection is to be carried out when you access the 

transaction for the first time. If this set contains the plant "0001", for example, and a variable work 

center, the SAP System will display a field for entering a work center, but you can no longer change the 

plant. The plant "0001" will always be selected here. The selected plant will be displayed on the selection 

screen. 



 

 

In the above case we must be dealing with a Multi-Set, since two different fields are involved. 

Prerequisites: 

You must have maintained the menu item  "Define sets". 

Actions 

Define the selection profiles. 

26.4.3.3.2 Define selection combination 

In this menu option you can define a selection combination. A selection combination is a combination of 

sets forming the basis for a selection. 

This combination, for example, permits the simultaneous selection of specific 

- orders 

- work centers 

- capacity categories 

You can create a combination by doing the following: 

- Specify a name for the selection combination 

- Define the combination, that means, by specifying which sets are to be allocated to this 

combination. 

Example: 

For selected work centers, you have generated a list of capacity required and available for the category 

"labor".  In order to be able to control your orders in a timely and correct manner, you only want to 

consider released production orders for specific critical materials. You can define this additional 

selection combination in this menu option. 

Note 

The combination allows you to combine Multi-Sets. This is not possible when defining sets. 

Actions 

1. Give the combination a unique name. 

2. Define the combination. 

26.4.3.4 Lists 

In this section, you specify the contents and the layout of the following lists: 

- capacity detail 

- variable overview 
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26.4.3.4.1 Define list versions of detailed capacity list 

In this menu option you define the structure of the commitment list. 

In the section "Settings' you set the following default parameters (you can change them interactively.): 

- Percentage values: 

All the numerical values should be presented as percentage values 

- Sort in descending order: 

You should sort the lines in ascending or descending order according to the sort criteria. 

- Original width: 

All the columns should be displayed with the width of the fields that belong to them. 

- Column width: 

All the columns should be displayed in the predefined width 

You define the following default parameters in the section "Subprofiles" (you can change them 

interactively.): 

You define a profile by double-clicking, entering a profile name and selecting fields from a field list. 

- Fields displayed: 

A profile is specified that defines the fields to be displayed. 

- Sort criteria: 

You define a profile that defines the sort criteria. 

- User filter: 

The objects displayed in the list can also be filtered according to criteria which are freely 

defineable. 

In the section "Changes" you define whether the settings made in the profile interactively (from within 

the list) may be changed. 

- Protected: 

Only the last person to make changes may make further changes 

- not changeable: 

You cannot make changes from within the list. 

Activities 

Define the detailed list profiles if you want to create your own detail list profiles or if you want to protect 

or lock them. 

26.4.3.4.2 Variable overview 



 

 

You define a variable overview in this section. The variable overview is an evaluation in which you 

allocate any information from the following areas to individual planning periods: 

- capacity requirements 

- available capacity 

- capacity load 

The variable overview contains individual columns whose contents you can specify as you want. 

You can define several versions of the variable overview. These versions represent the list versions. 

The definition of a list version is carried out in the following steps: 

- definition of columns 

You specify a column name and the contents of these columns. You can specify, for example, that 

the requirements are to be listed for a certain capacity category or for a certain order in a column. 

- definition of a list version 

Using the list version, you can specify the following: 

- which columns are to be displayed 

- column line in the list version 

- column width 

- column heading 

You can set up, for example, a list version that contains two columns for the capacity requirements 

of an order. 

26.4.3.4.2.1 Define columns 

In this step, you define columns by specifying the values according to which the columns are to 

be calculated. 

The definition is carried out by means of values that are linked to each other by operators. 

A value can, for example, be the requirements of order 4711, which is linked by "+" to a second value, 

for example, the requirements of order 4712. In the column, the total capacity requirements of the orders 

4711 and 4712 is calculated in this case. 

The following value types are distinguished: 

 - value type "1A" 

In this case, the value is the capacity requirements for a set. As a value, you enter the name of a set 

for the definition of the column. With the calculation of the value, all capacity requirements which 

meet the selection criteria of the set are calculated and summed up. 

Example of such a column definition: 
   Value type  Value  Operator 

------------------------------- 

     1A         SET1      + 

If the column does not contain any other values, the capacity requirements which meet the 

selection criteria of set "SETX1" would be calculated in the column. If the set "SETX1" refers to 

the field "work center" and has the value "R0815", the requirements for the work center "R0815" 

would be calculated. The result is calculated with a + sign. 
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 - value type "1B" 

With this value type, you enter a set not to be taken into account. You can use this category 

only together with the category "1A". Example of such a column definition: 
   Value type  Value  Operator 

------------------------------- 

    1A          SET1     + 

    1B          SET2 

The requirements which meet the criteria of the set "SET1" are determined here, but the 

requirements of the set "SET2" are not taken into account. This way you can, for instance, 

calculate the requirements of all orders at a work center, where all planned orders are to be 

ignored, however. For this, set "SET1" must contain the name of the required work center, while 

set "SET2" contains the order category "planned orders". If you specify a sequence of sets in a 

column, the requirements that correspond to the terms of all sets are calculated. You can only 

specify an operator for the first set. 

- value type "2A" 

With this value type, you refer to the value of another column. Example of 

such a column definition: 
   Value type  Value  Operator 

------------------------------- 

     2A         SP1       + 

     2A         SP2       + 

This way, you add the calculated results of the columns "SP1" and "SP2". 

- value type "2B" 

With this value type, you calculate the available capacity for a column. Example of 

such a column definition: 
   Value type  Value  Operator 

     2B         SP3      + 

If you determine the requirements for the capacity category machine in the column "SP3", you 

calculate the appropriate available capacity. 

If you have not made out any restrictions in the reference column, that is to say in column "SP3", 

concerning the capacities to be considered, then the availability of all capacities selected with the 

current evaluation is calculated. 

- value type "3" 

With this value type, you specify an integral constant as a value. This way, you can calculate 

capacity loads, for example. Example of such a column definition: 

In column "SP4", requirements for the capacity category "machine" are determined. In column 

"SP5", the capacity load of the capacity category "machine" is to be calculated. 

You must define the following columns to do this: Column 

"SP4": 
   Value type  Value  Operator 

     1A         SET1     + 

SET1 contains the value "MAS" for machine for the field "capacity category". Column 

"SP5": 

   Value type  Value  Operator 

------------------------------- 

     2A         SP4      + 

     2B         SP4      / 



 

 

     3          100      * 

In column SP5, load is displayed in %. 

 - value type "4" 

With this value type, you allocate characters to a column. This way, you can, for instance, include 

the character "%" in a list. 

Actions 

1. Specify a name for the columns. 

2. Define the columns. 

26.4.3.4.2.2 Define list versions of variable overview 

In this step, you define the structure and contents of individual list versions. You allocate the previously 

defined columns to the list versions. 

You define the list version by specifying the following: 

- which columns are to appear in a list version 

- column line in the list version 

This way, you determine in which column of the list version a previously defined column is to 

appear. 

- column heading 

- column width 

- if necessary, the requirements type 

If you want to compare scheduled requirements and remaining requirements, you can specify per 

list version column whether scheduled requirements or remaining requirements are to be displayed. 

If you do not make any specification, scheduled requirements or remaining requirements are 

displayed in accordance with the general configuration. 

- whether the selection values are to appear in the heading 

You can specify for each column whether the selection values of a set are to appear in column 

heading. 

If you allocate the requirements for order 4711 to a column, for example, you can write this 

selection value as a heading over the column. 

Thus, a set which has the value "4711" for the field order number is allocated to the column. The 

value of set "4711" is the selection value. 

A list version can contain any number of columns. The only limit is given by the width of the screen or 

the printer. 

Example 

You want to create a list version which compares the requirements of the capacity category "labor" with 

the requirements of the capacity category "machine". The list version is to be defined as follows: 
Column  Column name   Heading         Width      Req.sel.values 

1 SP1     Requirements       10              1 

2 SP2     Requirements       10              1 

- column and width 
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The requirements for the previously defined column SP1 appear in column 1. The column is 10 

characters broad. 

The requirements for the previously defined column SP2 appear in column 2. The column is also 10 

characters wide. 

- column name 

The column SP1 is defined so that the requirements for the capacity category "machine" are 

calculated, that is, reference is made to a set which allocates the value "001" to the field "capacity 

category". 

The corresponding applies to the column SP2. 

- heading 

The headings of the columns read "requirements 001" or "requirements 002". 

You have specified the text "Requirements" as a heading for the list version definition. 

- requirements selection values 

Text "001" or "002" is taken over as a selection value from the set for the column SP1 or SP2 if the 

selection values are to be displayed (indicator "1"). 

Note: 

In the variable overview, only requirements you previously specified during capacity evaluation can be 

displayed. That is, you can only evaluate what corresponds to the selection criteria of the selection list. 

So if you have selected the work center "R0815" and only this work center is displayed on the selection 

list, no requirements for work center "R0888" can be displayed on the variable overview. 

Requirements 

You must have processed the menu option "Define columns". 

Actions 

1. Specify a name for the list versions. 

2. Define the list version. 

26.4.3.5 Specify maximum number of data records 

In this menu option, you specify the maximum number of data records to be read from the database. 

This specification prevents too much data being read from the database. This might overload the internal 

data memory and thus slow down the evaluation of the data considerably. 

The transport functionality cannot be used here. 

Actions 

Specify the maximum number of data records. 

26.4.4 Capacity leveling and extended evaluation 



 

 

In this section you make settings for the -

 capacity leveling function. 

- extended evaluation 

In the extended evaluation you can display the detailed capacity list and the standard overview, 

which are familiar from the capacity evaluation, with the following enhancements: 

- You can display the lists in the individual capacity view. 

- SOP requirements can also be displayed in the lists. 

These settings are combined into various sub-profiles. Sub-profiles can contain other sub-profiles. 

All sub-profiles on the first level are components of an overall profile that is always needed, when an 

application uses the functions of capacity leveling (for example, rough-cut production planning, 

interactive single-item planning, shop floor control). 

Depending on the application, some sub-profiles are not required. The corresponding entry in the overall 

profile remains empty. For example, interactive single-item planning uses its own presentations so that 

in this case neither type of planning table is required. 

The settings for capacity leveling include the following: 

- profiles mentioned above 

- sets and variables 

These are required both to set up selection screens and to group requirements on the planning 

tables. 

- Requirements groupings 

The are used on both types of planning table, for example to determine the capacity requirements 

that are displayed in the various sections of the planning table. 

- Layouts 

These determine how information on objects (work centers, orders, operations...) is laid out on the 

planning tables. 

- Settings for the planning table 

Hinweis 

Capacity leveling was divided into two sections. You should not change the settings in Customizing in 

the section "technical settings" without consulting SAP unless absolutely necessary. 

26.4.4.1 Define control profile 

In this step you define control profiles for capacity leveling and for the extended evaluation. 

In the control profile you define 

- The type of presentation and layout of the data 

- Locking properties of the system 
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- GUI-Status 

- Line sorting of the planning table 

- Range of planning for planning with the capacity planning table 

- Actions when leaving the planning table 

- Identification of the setup standard value 

In the screen section Presentation you use the presentation type and the layout type 

- the application, for example the capacity planning table (tabular form) 

- the layout of the data, for example display per period 

- the search for remaining available capacity when dispatching or carrying out the capacity 

availability check 

In the screen section locking properties you use the indicator change mode to specify whether changes 

are allowed on the planning table, or whether the planning table is called up in display mode. If you set 

the indicator the change status for the planning table is used that you have specified in the screen section 

GUI status. If you do not have authorization to make changes the change mode is automatically set to 

inactive. 

With the indicator Locking properties you control when orders are locked if you call up the planning 

table in change mode. Other users cannot change the orders you have locked. You can: 

- Lock orders only on changing 

The orders are only locked when you change them on the planning table, for example by 

dispatching an operation. 

- Only lock orders in pool 

The orders in the pool are already locked when reading. The orders dispatched are only locked 

when you change them. 

Note the following special case: If there is an operation in the pool and an operation that belongs to 

the same order is dispatched the order is not locked. 

- Lock all orders 

All orders are locked when they are read. 

Note that planned orders are only locked if you change them on the planning table. 

In the order view only those orders are locked that you have selected in the initial screen of capacity 

leveling. The orders that the system reads to calculate the load of the capacities affected and displays on 

the planning table are, however, not locked. 

If orders are locked by other users you cannot change the orders. If the data is changed by other users and 

released again then your changes are made on the basis of data that is now current. 

Capacities and work centers are only locked if you change them. 

In the section GUI status a GUI menu can be defined specially for the display and change mode. 

In the section Actions on saving the planning table you can determine that on leaving the planning 

table other actions are started automatically, for example mass dispatching. With the indicator Set trigger 

you define that when leaving the planning table the trigger CY_PLANNING_TABLE_END is set. Then 

the job is started that you have defined for this trigger and the parameter. 

With Restrict.plan. you define that the capacity planning table is called up in a mode in which you can 

temporarily save the results of your planning without thus automatically leaving the planning table. 



 

 

You can carry on working on the planning table during the saving procedure. Changes since the last start 

of saving are saved in the next saving operation. 

This planning table mode differs from the normal planning table mode in several respects: 

- Except during the saving procedure orders are locked neither while the capacity planning table 

is being generated nor during processing on the capacity planning table. Your specification in 

the control profile for locking properties is not taken into account. 

- The functions are restricted in the following ways: 

- You cannot dispatch operations to individual capacities. 

- Orders cannot be changed or displayed. 

- Sequence numbers of orders cannot be changed. 

- Capacities cannot be changed. 

- Operations cannot be displayed. You can only make limited changes in operations in orders. 

Here you can change the standard values. 

- When leaving the planning table you cannot automatically start an action with the event 

CY_PLANNING_TABLE_END 

If you want to call up the planning table in temporary saving mode and do not want to work with a 

standard profile then you must enter a change status for the GUI-status in which the change/display 

functions mentioned above are deactivated. Otherwise errors can arise. 

In the section "Identifying setup standard value" you specify which standard value is interpreted as the 

setup standard value in an operation. This information is used in capacity leveling on the capacity 

planning table. It is used by planning function that take into account the dependency of the setup 

standard value of an operation on the setup state of the work center. 

The dependency of a setup standard value on the setup state is represented in the setup matrix. For every 

setup transition in the setup matrix, that is, for every sequence of two operations, a value is assigned for 

the setup standard value to the following operation. In the setup matrix you can define the setup 

standard value in the subsequent operation for every individual setup transition. The standard value 

number that you specify in the control profile is only taken into account if setup transitions do not exist 

in the setup matrix. The standard value number "1" is predefined internally to the system both in the 

control profile and for a setup transition in the setup matrix. Hinweis 

For capacity leveling in the process industry (PP-PI), that is, for the capacity leveling of process 

orders and planned orders referring to master recipes, the functions which consider and adjust the 

setup times are not available. This applies to the manual adjustment of setup time as well as the 

functions that are based on the evaluation of a setup matrix. 

Note 

The control profiles in the SAP standard package cannot be changed or deleted. 

Standard settings 

In the SAP standard package control profiles are defined. 

Actions 

Define control profiles. 

26.4.4.2 Define selection profile 
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In this step you define selection profiles for capacity leveling and forthe extended evaluation. 

In a selection profile you define all the parameters for selecting and displaying object for which you want 

to see the capacity requirements and the available capacities. 

You can make the following individual settings in the selection profile: 

- The object set and the filter set define which selection criteria are grouped on the selection screens 

for capacity leveling and the extended evaluation. 

On these selection screens you select the objects when you access capacity leveling or the extended 

evaluation. 

The object set defines the selection criteria on the initial screen where you make the first selection 

of objects. The filter set defines the selection criteria on the filter screen where you can further 

restrict the selection made on the initial screen. 

- The requirements grouping defines all the the capacity requirements groups that are assigned to 

the planning table or the extended evaluation. 

A requirements group contains for example the capacity requirements for a work center or planned 

orders not yet dispatched and is assigned to a chart in the planning table. 

- The selection key defines the selection criteria used to select. mark or highlight operations online 

on the planning table. 

A selection key is created under the same menu option as a sort key: Define sort key. 

- The order categories define which capacity requirements are read from the database. These entries 

are only taken into account if you do not use the field TYPKZ (order type) as a selection field on a 

selection screen or if when you access capacity leveling or the extended evaluation you do not 

specify a value for this field on the selection screen. 

- In the screen section capacity requirements types you specify which capacity requirements types 

can appear in the capacity evaluation. If you do not select any of the capacity requirements types the 

system automatically displays the remaining capacity requirements in the extended evaluation. You 

cannot display other capacity requirements types. 

- In the screen section Selection of available capacities you specify: 

- that all the hierarchy work centers are automatically selected if you select a hierarchy work center 

on a selection screen 

- that in addition to the work centers and capacities all the individual capacities for each capacity 

(persons, individual machines) are automatically selected. 

Thus you can also plan individual capacities in capacity leveling or display them in the 

extended evaluation. 

- which version of available capacity forms the basis of capacity planning (for example, 

normal/maximum available capacity) 

Example of the selection of capacity requirements 

As object set you specify a set that contains the work center and plant as selection criteria. As filter set 

you use a set that contains the order number as selection criterion. 

To access capacity leveling you specify the following on the inital screen: work center PLATZ1 in plant 

0001 and then on the filter selection screen the order number 20002222 first of all those capacity 

requirements are selected that are in work center PLATZ1 in plant 0001. 

However, because of the filter criterion only those capacity requirements were display that belong to the 

order 20002222. 



 

 

Notes 

You can define set in Define sets 

Standard settings 

Selection profiles are predefined in the standard SAP package. 

You cannot delete the selection profiles in the standard SAP package. 

Actions 

If you need to you can define your own selection profiles. 

26.4.4.3 Define time profile 

In this step you define time profiles for capacity leveling and the extended evaluation. 

With the time profile, you specify various important time periods: 

- Database read period 

The database read period specifies the period in which capacity requirements are read from the 

database. All requirements are accessed which are partially or completely within the database read 

period. 

- Evaluation period 

The evaluation period specifies the period over which data is formatted and displayed. The 

evaluation period must lie within the database read period. 

- Planning period 

The planning period defines the period in which the SAP system can carry out planning. 

The planning period is smaller than or equal to the evaluation period. You cannot move 

operations outside the planning period. Equally, when automatic finite scheduling is carried out 

for an operation the system only searches for a new date within the planning period. 

Date for dispatching backlog 

The date for dispatching the backlog is of importance in period-related planning. You use the 

date for dispatching the backlog to determine the date backlogs are to be allocated. 

The following types of entry are available: 

- Actual date specifications 

These date specifications (for example, calendar day, calendar year) are only useful in the 

profiles in exceptional cases. 

- Relative date specifications 

These date specifications (for example, number of calendar days, number of calendar years) 

are always calculated from the current day. 

- For every period, you can specify in what form you want to enter the date by using the respective 

field "Type of entry". 
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Example 

Evaluation period 

Type of entry J (calendar month) 

Start date    0 

Finish date   2 

Current date: 06/09/1994 

In this case, the evaluation is carried out for the period from 6/1/1994 until 8/31/1994. 

Note 

- Specifications in posting periods and factory calendar days are not possible since a plant would 

have to be specified in this case. 

- You cannot delete the time profiles that are contained in the standard system. 

Standard settings 

Time profiles are predefined in the SAP standard package. 

Actions 

Define time profiles according to your requirements. 

26.4.4.4 Define evaluation profile 

In this step you define evaluation profiles for capacity leveling and for the extended evaluation. The 

evaluation profile is mainly of significance for period-related planning. 

You specify the following parameters in the evaluation profile: 

- Capacity unit 

This is the unit in which the evaluations are to be carried out (for example, hours, minutes, items). 

- Unit of measure from the capacity 

If you set the indicator "Unit of measure frm capacity" the unit of measure that is used in the 

display is not the one from the profile that is valid for all the capacities but the one given in the 

capacity in the field "Base unit of measure". 

- Available capacity of individual capacity 

The indicator determines that the available capacities are derived by cumulating the individual 

capacities that belong to them. 

- Hierarchy 

You can cumulate requirements and available capacity on hierarchy work centers using a hierarchy. 

To do this you must enter the name and plant for a hierarchy and specify whether both requirements 

and available capacity are to be cumulated. Available capacity and capacity requirements are 

cumulated according to your specifications when capacity planning is called up. If you do not 

cumulate available capacities then the available capacities of the hierarchy work centers are copied 

from whichever version of available capacity is active. 

- Distribution of the capacity requirements 



 

 

Here, you determine whether the distribution determined in the work center or operation (only for 

network orders and maintenance orders) is to be taken into account or whether an alternative 

distribution is to be carried out. 

You can specify an alternative distribution especially for networks or maintenance orders and for all 

remaining orders. 

Note 

You cannot delete the evaluation profiles that are contained in the standard system. 

Default Settings 

Evaluation profiles are predefined in the SAP standard setting. 

Actions 

Define evaluation profiles according to your requirements. 

26.4.4.5 Strategy 

In the following steps you specify which sequence-layout keys and which strategy profiles should be 

available to dispatch operations. 

Sequence-layout keys and strategy profiles are not relevant to the extended evaluation. 

26.4.4.5.1 Define sequence and layout keys 

In this step you define the sequence-layout keys. You use these to specify which fields from which 

structures (e.g. work centers, orders) are determine the sequence of dispatching in the planning table. 

You can use various functions to edit sequence-layout keys: 

- Maintaining sequence-layout keys 

You can maintain existing sequence-layout keys with this function or define new ones. The 

definition of a sequence-layout key consists of: 

- a name 

- a long text 

- Maintaining field selection 

Here you define which structures and fields are to be used for the sequence. 

If you have not yet maintained the field selection and not used a reference then you must first 

specify from which structures you want to select the fields. 

If you have already maintained the field selection then you can expand these using other structures. 

You should use the function "Structure of layout key" on the field selection screen. You can enter 

the structures here. 

If structures are allocated to the sequence-layout keys then you get a list of all the fields you can 

select from these structures. In this list you select the fields to be used to form the sequence. 
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- Maintaining the sequence 

Here you specify what priority the individual fields are to have in determining the sequence for 

dispatching. You have to select one field each time and shift it to the desired position. 
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Transfer reference 

If you have created a new sequence-layout key then you can use this function to copy the field 

selection of another layout key or sort- layout key and then adapt it to your requirements. 

Actions 

You should maintain the sequence-layout key. 

26.4.4.5.2 Define strategy profile 

In this menu option you define strategy profiles to control capacity leveling with the planning tables. 

Strategy profiles are not relevant for the extended evaluation. 

In the first section you define parameters to control scheduling, that is, the dispatching of individual 

operations. 

Parameters relevant to the capacity planning table are: 

- Finite scheduling 

It is only if you have set this indicator that the system takes account of competing requirements for 

the capacities. 

- Plan. direction forwards 

If you set this indicator, then when the system dispatches operations automatically it schedules them 

forwards towards the future. 

If the indicator is not set then the system schedules backwards. 

- Dispatch at earliest point in time 

You must set this indicator if an operation is to be dispatched at the earliest point in time in the 

planning period. The system does not take account of the earliest/latest dates of the operations. 

- Cancel dispatching due to error 

You can use this indicator to ensure that the system stops planning the current order if an error 

occurs because of an activated function (for example, material not available). 

- Dispatching sequence 

You use this indicator to define the sequence in which the operations displayed and selected are to 

be sorted and dispatched. Here you can enter a 

- Define sort/layout keys 

- a Define sort keys that can also contain several sort/layout keys. 
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Planning in non-work periods 

You use this indicator to specify that operations can be dispatched to non-work periods without 

you having to change the available capacities at the work centers. In dispatching, the calendars, 

operating times and available capacities at work centers are ignored and instead the following 

data is used: 

Operating time 00:00 to 24:00 

Efficiency rate 100% 

- Rescheduling with production version 

This indicator is only relevant for planned orders. You use it to specify that when rescheduling an 

operation the production version is copied to the planned order in which the new work center is 

entered as the production line. The planned order is scheduled with the new routing and dispatched 

to the new production line. The prerequisites for this are: 

- the old and the new work centers specified in the routings for these production versions are not 

assigned to more than one operation. 

If these prerequisites are not fulfilled then the system carries out scheduling using the formulas from 

the new work center but the old standard values and the operation is dispatched to the new work 

center. 

If, in addition to the indicator Reschedule with production version you have set the indicator 

Cancel rescheduling with production version then rescheduling is cancelled if one of the 

prerequisites mentioned above is not fulfilled. 

- Terminate when dispatching with production version 

This indicator is only effective if the indicator Rescheduling with production version has also 

been set. It specifies that rescheduling of a planned order to another work center is terminated if the 

new work center is not entered as the production line in a production version for the material. 

- Date entry when dispatching 

If you set this indicator then only manual as opposed to automatic dispatching is possible. That 

means that after the planning table function Dispatch has been triggered, a dialog box appears in 

which a desired time and/or a desired work center can be displayed. 

- Change planning direction 

If you set this indicator the system searches the whole planning period for remaining available 

capacity when dispatching operations. 

The system looks for remaining available capacity first in the planning direction. If it does not find 

any here then it searches in the opposite direction. direction specified in the strategy profile. 

The indicator Insert operation must not be set. If it is set then the system only searches in the 

planning direction specified in the strategy profile. 

Parameters relevant to theCapacity planning table and for the capacity planning table (tabular form) 

with  periodic-continuous display are: 

Insert operation 
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You must activate this indicator if one or more operations are to be dispatched at a particular point 

in time. Operations in an existing commitment are shifted according to the planning direction. Their 

sequence remains the same. 

- Close gaps 

With this indicator you can trigger actions to follow the deallocation of an operation. The gaps that 

arise when an operation is deallocated can be closed by shifting neighbouring commitments into the 

gap. 

- Dispatching to best point in time 

If you set this indicator then operations are dispatched to existing commitments in such a way as 

to increase the setup times at the work centers as little as possible. To adjust the setup times of the 

operations at the work centers and reschedule the operations accordingly you have to follow up 

by executing the function "Automatic adjustment of setup time". 

The functions Dispatch at best time for setup and automatic adjustment of setup time do not 

calculate the setup times using the setup times in the operations but instead the setup standard 

values stored in the setup matrix for the appropriate setup transitions. If you activate Dispatch at 

best time for setup then you also have to activate Insert operation. 

Note 

For capacity leveling in the process industry (PP-PI), that is, for the capacity leveling of process 

orders and planned orders referring to master recipes, the functions which consider and adjust the 

setup times are not available. This applies to the manual adjustment of setup time as well as the 

functions that are based on the evaluation of a setup matrix. 

- Initial setup status 

An initial setup status is the initial setup status of a work center. It is used in capacity leveling by 

the following functions: 

- Setup time adjustment 

- Dispatching operations in a sequence with minimum setup time (setup time optimization). 

- Dispatching an operation at the best setup time 

An initial setup status is identified by a key that has a maximum length of three characters. 

The following parameters are relevant for the capacity planning table (tabular form): 

- Finite scheduling 

- Planning direction 
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Overall capacity load 

You must set this indicator if overloads in individual periods are to be taken into account in the 

following periods. For example, a 200% load in one period prevents you from dispatching 

operations to the following period. 

- Dispatching at earliest point in time 

- Cancel dispatching on error 

- Date entry on dispatching 

- Rescheduling with production versions 

- Cancel on rescheduling with production version 

- Change planning direction 

In the second section you define parameters to control operation data: 

- Take op. floats into accnt., Use float bef. prod., Use float aft.prod. If you only want an operation 

to be dispatched within the float that is assigned to it in order scheduling then you should activate 

these indicators. 

If an operation is dispatched in such a way that a part of the float before production is used up, then 

the other operations in the order only have the rest of the float available. 

- Treatment of queue time and Reduction level 

If scheduling is to be carried out using a queue time that diverges from lead time scheduling, this 

can be controlled using these parameters. 

Note 

When carrying out finite scheduling for an individual operation, other reduction measures such as 

splitting are not taken into account. 

- The field "Dispatch internal production" serves to determine the date for dispatching 

operations/activities from networks and maintenance orders. 

If an operation from a network or maintenance order is to be dispatched on the planning table 

(tabular form), without entering a period, then the dispatching date is determined by the data in this 

field. 

In the third section you specify which functions are to be activated within dispatching. 
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The following functions are available: 

- Sorting of operations to be dispatched 

Consider operation sequence in the order 

- Operation date check 

- Change production version in event of an error 

- Midpoint scheduling 

You can find information on these functions in the F1 Help Action in the screen section "Dispatching 

functions". 

In the fourth section you enter a period pattern for dispatching and specify whether and how the period 

pattern for dispatching operations is to be taken into account. 

Note 

- You cannot delete the strategy profile that is in the SAP standard package. 

- You can define a user exit for the dispatching sequence in a strategy profile. This makes it possible 

for you to define the content of the sort criteria and the sequence of the operations to be dispatched. 

This function exit has the SAP extension "CYPP0001". 

Another prerequisite for using a user exit is that the dispatching function "Sort operations to be 

dispatched" is set to active. 

You can find additional information in the procedure "Define function exit". 

Standard settings 

Strategy profiles are predefined in the SAP standard package. 

Activities 

Define strategy profiles. 

26.4.4.6 Define period profile 

In this menu option you can define period profiles for capacity leveling and the extended evaluation. 

- You only have to have a period profile in your overall profile, if in the control profile you have 

chosen "Layout display per period" for the type of layout. 
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- You can define planning periods in the PPS planning calendar as you like. You can refer to these 

periods in capacity planning. 

With the period type and period duration you specify the period split your evaluation period (see 

time profile) is to be divided up in. 

- You can define planning periods as you like in the PPS planning calendar. You can refer to these 

periods in capacity planning. 

Example 

The result of entering the period type D and period duration 3 is that the evaluation period is laid out on a 

raster of a quarter of a month for each period. 

Note 

You cannot delete the period profiles which are in the standard package. 

Standard settings 

Period profiles are predefined in the SAP standard package. 

Actions 

Define new period profiles, if necessary. 

26.4.4.7 Capacity planning table (tabular form) 

In this menu option you maintain profiles for the planning table (tabular form) and the necessary layouts. 

You only need a profile for the planning table (tabular form) if you have selected the display "Planning 

table (tabular form)" in the control profile. 

You use layouts to define what information you wish to see in the various sections (work centers, 

operations,...) of the planning table. 

26.4.4.7.1 Layout 

You use this menu option to maintain layouts. Layouts determine the layout of information in the 

planning table (tabular form) and in the table section of the planning table. Layouts function in 

combination with the requirements grouping in the selection profile. 
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The layout determines the content of the planning table (tabular form). The planning table (tabular form) 

is in two sections. In the upper section (chart 1) you can see the requirements of the capacities displayed 

per period. In the lower section (chart 2) you see the orders that belong to it. 
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The layout specifies what "objects" (capacities, orders ...) are to be displayed on the planning table. You 

can also define the contents of text lines and how they are sorted. 

The layout refers to the groups in the requirements grouping. Each group is allocated either to the upper 

chart 1 or to the lower chart 2 in the planning table. The groups of capacities should be allocated to chart 

1 and the order groups to chart 2. 

For every group in the requirements grouping there must be a layout key with the layout used. 

You edit a layout in three steps: 

- Maintain layout key 

- Define a sort layout key and, if necessary, a sort key 

- Define a layout 

- Allocate a layout key to the layout 

26.4.4.7.1.1 Define layout keys 

In this menu option you define layout keys. Layout keys indicate which fields of which objects (e.g. work 

centers,orders) are to be displayed on the planning table (tabular form) and the planning table. Layout 

keys are combined to form layouts. 

You can use various functions when editing the layout key: 

- Maintain layout key 

You can use this function to maintain layout keys that already exist or to define new layout keys. 

The definition of a layout key consists of: 

- a name 

- the specification whether the columns for display should be separated or whether they should be 

linked together directly 

- the specification whether a separator is to be displayed between the columns 

- a long text 

You must also state the usage of the layout key. 

If you want to use the layout key for a layout you have to select "layout of field selection" since 

layout keys can also be used for sorting. 

- Maintain field selection 

Here you define which fields from which objects are to be displayed in what sequence. If you have 

not yet maintained the field selection and not used a reference then you must first of all specify 

from which structures or objects you want to display the fields. Use the function "structure of the 

layout key" on the field selection screen. You have to enter the structures here. If structures are 

allocated to the layout key you get a list of all the fields which you can display from these 
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structures along with the appropriate display length which you can change. You mark the fields in 

this list which you want to be displayed. 

With the structure USER you can take up user-specific fields. You can define the structure using 

the extension CYPP0002. The assigned table CYUSER_TAB is also filled with values in this 

enhancement. 

- Maintain sequence 

This is where you define the sequence in which the fields are to be displayed. You must select one 

field at a time and move it to the desired position. 

You can enter the column separator. You can also define the headings if the standard texts are not to 

be used. 

- Transfer reference 

When you have created a new layout key you can use this function to copy and then edit the field 

selection of another layout key. 

Actions 

You should maintain the layout key. 

26.4.4.7.1.2 Define sort/layout keys 

In this step you define sort/layout keys. You use it to specify which fields from which structures (e.g. 

work centers, orders) are critical for sorting in the planning table (tabular form) and in the planning table. 

Sort key/layout keys are combined to form layouts. 

You can use several functions when editing the sort and layout keys: 

- Maintain sort/layout key 

You can use this function to maintain existing ones or to define new ones. The 

definition of a sort/layout key consists of: 

- a name 

- a long text 

- maintain field selection 

Here you define which fields and structures are to be accessed for sorting. 

If you have not maintained the field selection or a used a reference yet then you must first specify 

from which structures you want to display the fields. 

If you have already maintained the field selection then you can enhance these using other structures. 

To do this you should use the function structure of the layout key on the field selection screen. You 

can enter the structures here. 

If structures are assigned to the sort/layout key then you get a list of all the fields you can select from 

these structures. Select the fields in this list which are to be accessed for the sort. 
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- Maintain sequence 

Here you can define the sequence to be used to sort the selected fields. You must select one field at 

a time and move it to the desired position. 

- Transfer reference 

If you have created a new sort/layout key then you can use this functionto copy the field selection of 

another layout key or sort/layout key and then adjust it to your needs. 

Activities 

You should maintain the sort/layout key. 

26.4.4.7.1.3 Define sort keys 

In this step you define sort keys. You use it to define how a chart is to be sorted. 

You allocate one or more sort-layout keys to a sort key (one sort- layout key for each requirements 

grouping). 

The sort-layout keys must be adapted to one another so that the chart is sorted in a meaningful fashion. 

Activities 

You should maintain the sort keys. 

26.4.4.7.1.4 Define layout 

In this menu option you define layouts. You define layouts in several steps. 

- Definition of charts 

In the capacity planning table (tabular form) you can define two charts, in the capacity planning 

table you can define eight charts. 

- Definition of groupings for charts 

- Specification of description 

- Assignment of groups to groupings (comparable to requirements groupings) 

- Assignment of layout keys to groupings (These define the content of text lines) 

- Definition of sorts for charts 

- Specification of description 
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- Allocation of sort keys to chart (comparable to requirements grouping) 

If all the objects in a chart are to be sorted together then the field group is not maintained 

(that means reference to all groups) and a sort key for all the groups is entered. In this way it is 

possible to sort different objects (planned orders and production orders) together. 

For example, if planned orders and production orders are to be sorted according to a particular date 

then a combined sort on the basis of different fields (PLAF-DATUM and AFKO-DATUM) is 

carried out. To do this two sort layout keys have to be defined and combined in one sort key. 

or 

- allocation of sort layout keys to chart and to group 

- You can carry out the sort within the groups for the chart. For example, if a chart contains two 

groups (planned orders and production orders) each group can be allocated its own sort layout key. 

So sorting takes place within groups. 

Actions 

Define the layouts. 

26.4.4.7.2 Define profile for capacity planning table (tabular form) 

In this step you maintain profiles for the planning table (tabular form). You only need a profile for this 

planning table if, in the control profile, you have selected the display "Planning table (tabular form). 

The data for the profile can be divided into two parts: 

Parameters which affect how the planning table looks are combined under "information layout". 

Parameters which affect how data is calculated or which are relevant for dispatching come under 

"Requirements and dispatching". 

- Layout 

Here you specify how information is displayed within the various requirements groupings on the 

planning table. For every group in the requirements grouping used the layout must contain a layout 

key. The layout key determines what information is shown for which objects (e.g. name of the 

work center for the object "work center" or order number for the object "order") within a group. 

This means that the entry in this field must be reconciled with that for the requirements grouping in 

the selection profile. 

- "Requirements to be displayed" 

Using the entry in this field, in the requirements section of the planning table, you can display the 

following requirements. 

- only dispatched requirements (1) 
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- only requirements not yet dispatched (2) 

- all requirements (3) 

- "Wide screen" 

You can set this indicator if you have a large screen or a screen with a high resolution. In this case 

the system generates a wider screen on which several periods can be displayed at the same time. 

- "Formula remaining available capacity" 

In this field you specify how the remaining available capacity at the work center is defined. Here it 

is a case of whether the requirements not yet dispatched are taken into account in calculating the 

remaining available capacity or not. 

- "Dispatching time" 

Exact time when an operation in a particular period in the planning table is dispatched. The time is 

of relevance if the dispatching period is not the scheduled period. 

Example 

In the SAP standard package for the planning table (tabular form) a requirements grouping is used which 

contains 3 groups in total. 

- Group 1 

comprises all dispatched operations for a work center and a capacity 

- Group 2 

comprises all the requirements not yet dispatched 

- Gruppe 3 

comprises all requirements which have been dispatched 

The relevant layout contains three layout keys. The first determines that in group1 the information on the 

work center and the capacity is displayed. 

The other two in this case are identical: They determine that in both groups (which form the pool in the 

planning table) information on the operations is to be displayed. 

Standard settings 

In the SAP standard package a planning table (tabular form) is preset. 

Actions 

Define the profiles for the planning table (tabular form). 

26.4.4.8 Capacity planning table 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 303 

In this step you define the profile for the planning table. This is a sub-profile in the overall profile for 

capacity leveling. 

Note 

The profile for the planning table is only active if you have selected "Planning table" as the display in the 

control profile. 

26.4.4.8.1 Define layout keys 

In this menu option you define layout keys. Layout keys indicate which fields of which objects (e.g. work 

centers,orders) are to be displayed on the planning table (tabular form) and the planning table. Layout 

keys are combined to form layouts. 

You can use various functions when editing the layout key: 

- Maintain layout key 

You can use this function to maintain layout keys that already exist or to define new layout keys. 

The definition of a layout key consists of: 

- a name 

- the specification whether the columns for display should be separated or whether they should 

be linked together directly 

- the specification whether a separator is to be displayed between the columns 

- a long text 

You must also state the usage of the layout key. 

If you want to use the layout key for a layout you have to select "layout of field selection" since 

layout keys can also be used for sorting. 

- Maintain field selection 

Here you define which fields from which objects are to be displayed in what sequence. If you have 

not yet maintained the field selection and not used a reference then you must first of all specify 

from which structures or objects you want to display the fields. Use the function "structure of the 

layout key" on the field selection screen. You have to enter the structures here. If structures are 

allocated to the layout key you get a list of all the fields which you can display from these 

structures along with the appropriate display length which you can change. You mark the fields in 

this list which you want to be displayed. 

With the structure USER you can take up user-specific fields. You can define the structure using 

the extension CYPP0002. The assigned table CYUSER_TAB is also filled with values in this 

enhancement. 

- Maintain sequence 

This is where you define the sequence in which the fields are to be displayed. You must select one 

field at a time and move it to the desired position. 
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You can enter the column separator. You can also define the headings if the standard texts 

are not to be used. 

- Transfer reference 

When you have created a new layout key you can use this function to copy and then edit the field 

selection of another layout key. 

Actions 

You should maintain the layout key. 

26.4.4.8.2 Table lines 

In the following steps you define how table lines can be displayed and select the type of display. You also 

define the criteria that should be available for sorting and select the desired sort key. 

26.4.4.8.2.1 Define sort/layout keys 

In this step you define sort/layout keys. You use it to specify which fields from which structures (e.g. 

work centers, orders) are critical for sorting in the planning table (tabular form) and in the planning table. 

Sort key/layout keys are combined to form layouts. 

You can use several functions when editing the sort and layout keys: 

- Maintain sort/layout key 

You can use this function to maintain existing ones or to define new ones. The 

definition of a sort/layout key consists of: 

- a name 

- a long text 

- maintain field selection 

Here you define which fields and structures are to be accessed for sorting. 

If you have not maintained the field selection or a used a reference yet then you must first specify 

from which structures you want to display the fields. 

If you have already maintained the field selection then you can enhance these using other structures. 

To do this you should use the function structure of the layout key on the field selection screen. You 

can enter the structures here. 

If structures are assigned to the sort/layout key then you get a list of all the fields you can select from 

these structures. Select the fields in this list which are to be accessed for the sort. 

- Maintain sequence 
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Here you can define the sequence to be used to sort the selected fields. You must select 

one field at a time and move it to the desired position. 

- Transfer reference 

If you have created a new sort/layout key then you can use this functionto copy the field selection of 

another layout key or sort/layout key and then adjust it to your needs. 

Activities 

You should maintain the sort/layout key. 

26.4.4.8.2.2 Define sort keys 

In this step you define sort keys. You use it to define how a chart is to be sorted. 

You allocate one or more sort-layout keys to a sort key (one sort- layout key for each requirements 

grouping). 

The sort-layout keys must be adapted to one another so that the chart is sorted in a meaningful fashion. 

Activities 

You should maintain the sort keys. 

26.4.4.8.3 Define layout 

In this menu option you define layouts. You define layouts in several steps. 

- Definition of charts 

In the capacity planning table (tabular form) you can define two charts, in the capacity planning 

table you can define eight charts. 

- Definition of groupings for charts 

- Specification of description 

- Assignment of groups to groupings (comparable to requirements groupings) 

- Assignment of layout keys to groupings (These define the content of text lines) 

- Definition of sorts for charts 

- Specification of description 

- Allocation of sort keys to chart (comparable to requirements grouping) 
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If all the objects in a chart are to be sorted together then the field group is not maintained 

(that means reference to all groups) and a sort key for all the groups is entered. In this 

way it is possible to sort different objects (planned orders and production orders) together. 

For example, if planned orders and production orders are to be sorted according to a particular date 

then a combined sort on the basis of different fields (PLAF-DATUM and AFKO-DATUM) is 

carried out. To do this two sort layout keys have to be defined and combined in one sort key. 

or 

- allocation of sort layout keys to chart and to group 

- You can carry out the sort within the groups for the chart. For example, if a chart contains two 

groups (planned orders and production orders) each group can be allocated its own sort layout 

key. So sorting takes place within groups. 

Actions 

Define the layouts. 

26.4.4.8.4 Define profile for capacity planning table 

In this step you define the profile for the capacity planning table. 

The capacity planning table is generated from various charts arranged one beneath the other. Every chart 

consists of a table section containing data on work centers and orders among other things and a diagram 

section with a horizontal time axis. The capacity requirements for objects are displayed in the diagram 

section according to their dates. All charts have the same time axis with the same scale. 

Along with the fixed charts on the planning table you can also hide and show a further chart with material 

stock curves for selected requirements. Customizing for the charts that can be shown is basically the same 

as for the fixed charts. For the chart that can be shown you have to set the indicator Use as histogram in 

Define chart sequence. The graphical characteristics for the curves and axes of the material stock curves 

are defined using the curve- and axis representation selection. 

In the profile for the capacity planning table you enter the key and profiles for the chart sequence and for 

the characteristics of the different sections of the charts (time axis, table section, diagram section). 

Notes 

Many properties of the planning table such as window size are defined in the options profile for the 

graphics profile. 

Standard settings 

In the standard SAP standard package profiles for the capacity planning table are predefined. 

Recommendation 
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You should copy the standard settings without changing them. 

Activities 

If necessary, create your own profiles for the capacity planning table. 

26.4.4.9 Lists 

In this step you define list profiles. You enter the profiles for the list versions of the following lists in the 

profiles. 

- capacity requirements list 

- standard overview 

- detailed capacity list 

26.4.4.9.1 Define overall detail list profile 

In this step you define the list versions for the capacity requirements list. 

In the section Settings you specify the following default parameters that you can also enter online: 

- Percentage values 

All numerical values should be expressed as percentages. 

- Sort. descending 

The lines should be sorted in ascending or descending order depending on the sort criteria. 

- Original width 

All columns should be displayed with the width of the fields that belong to them. 

- Column width 

All columns should be displayed in a predefined width. 

In the section Subprofiles you define the following default parameters that you can also change online: 

- Display fields 

Here you use a profile you specify which fields should be displayed. 

- Sort crit. 

Here you define the sort criteria using a profile. 
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- Grouping crit. 

Here you define the profile for the grouping. 

In the section Changes you specify whether the settings made in the profile can be changed online, that 

is from within the list: 

- Protected 

Only the last person to make changes can make more changes. 

- Cannot be changed 

No changes can be made from within the list. 

Standard settings 

Profiles have been created for the capacity requirements list in the SAP standard package. 

Activities 

If necessary, create your own list versions. 

26.4.4.9.2 Define list versions of standard overview 

In this step you define the list versions for the standard overview. 

In the section Settings you specify the following default parameters that you can also enter online: 

- Percentage values 

All numerical values should be expressed as percentages. 

- Sort. descending 

The lines should be sorted in ascending or descending order depending on the sort criteria. 

- Original width 

All columns should be displayed with the width of the fields that belong to them. 

- Column width 

All columns should be displayed in a predefined width. 

In the section Subprofiles you define the following default parameters that you can also change online: 

- Display fields 

Here you use a profile you specify which fields should be displayed. 
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- Sort crit. 

Here you define the sort criteria using a profile. 

- Grouping crit. 

Here you define the profile for the grouping. 

In the section Changes you specify whether the settings made in the profile can be changed online, that 

is from within the list: 

- Protected 

Only the last person to make changes can make more changes. 

- Cannot be changed 

No changes can be made from within the list. 

Standard settings 

Profiles are defined for the standard overview in the standard SAP package. 

Activities 

If necessary, define your own list versions. 

26.4.4.9.3 Define list versions of detailed capacity list 

In this step you define the list versions for the detailed capacity list. 

In the section Settings you specify the following default parameters that you can also enter online: 

- Percentage values 

All numerical values should be expressed as percentages. 

- Sort. descending 

The lines should be sorted in ascending or descending order depending on the sort criteria. 

- Original width 

All columns should be displayed with the width of the fields that belong to them. 

- Column width 

All columns should be displayed in a predefined width. 

In the section Subprofiles you define the following default parameters that you can also change online: 
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- Display fields 

Here you use a profile you specify which fields should be displayed. 

- Sort crit. 

Here you define the sort criteria using a profile. 

- Grouping crit. 

Here you define the profile for the grouping. 

In the section Changes you specify whether the settings made in the profile can be changed online, that 

is from within the list: 

- Protected 

Only the last person to make changes can make more changes. 

- Cannot be changed 

No changes can be made from within the list. 

Standard settings 

Profiles are defined for the detailed capacity list in the standard SAP package. 

Activities 

If necessary, define your own list versions. 

26.4.4.9.4 Define list profile 

In this step you define list profiles. 

A list profile comprises the profiles for the list versions of the 

- capacity requirements list 

- standard overview 

- detailed capacity list 

With default list you specify whether the standard overview or the detailed capacity list should be called 

up first. 

Note 

You need not maintain an overall profile for capacity leveling. In this case the following profiles are 

automatically copied: 

Detailed capacity list  SAP_D001 (capacity planning table) 
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                        SAP_D002 (capacity planning table (tab.form) 

Standard overview       SAPSFCEVS000 

Detailed capacity list  SAPSFCEVD000 

Standard settings 

The list profiles are predefined in the standard SAP package. 

Actions 

Define new list profiles if necessary. 

26.4.4.10 Define overall profile 

In this menu option, you define the overall profiles for capacity leveling and the extended evaluation. 

The system always uses an overall profile when starting capacity leveling. It specifies various parameters 

for carrying out capacity leveling using the sub-profiles it contains. 

An overall profile contains the following sub-profiles: 

- Selection profile 

- Control profile 

- Time profile 

- Evaluation profile 

- Period profile 

- Planning table profile 

- Planning table (tabular form) profile 

- List profile 

- Strategy profile 

Note 

The overall profiles are used as follows to control capacity planning: 

- If you select the menu options: Capacity planning -> Leveling -> Work center view -> Planning 

table, then the profile SAPSFCG001 is processed in the standard version. You can change the 

profile, but the SAP sub-profiles should remain unchanged as far as possible. 

- You can define your own profiles and allocate them to particular users by means of user parameters. 

(See user parameters CYA -> CYX) 
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For example, when you access the planning table enter using the application menu "Capacity 

planning" -> Leveling -> Work center view -> Planning table the user parameter "CYA" is 

operative. 

- You can select any overall profile you like by entering via the application menu "Capacity planning" 

-> Leveling -> Variable. 

Requirements 

To use the name of a subprofile in an overall profile, you must first have defined this subprofile. 

Standard settings 

Overall profiles are predefined in the SAP standard package. 

Actions 

Define overall profiles according to your requirements. 

Additional information 

In the documentation on capacity leveling you can find information on the standard profiles and 

parameters that are allocated to the individual menu options. 

26.4.4.11 Technical settings 

In this step you make the technical settings for the capacity leveling function. 

Hinweis 

You should use the settings provided by SAP in the standard package. 

If you want to change existing settings in this section or make new ones then you should consult SAP 

first. This section in Customizing is very critical with respect to incorrect entries. 

26.4.4.11.1 Selection 

In this step, you can define the following parameters for the selection in capacity leveling and in the 

extended evaluation: 

- Sets 

These are required both for the requirements groupings and to define the selection screens in 

capacity leveling. 

- Variables 
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Variables are used in sets to define the selection screens. 

- Requirements groupings 

Requirements groupings define how capacity requirements are grouped in the relevant planning 

tables. 

26.4.4.11.1.1 Define Selection Profiles 

In this menu option you define selection profiles that you can use to specify status combinations for 

selecting objects (for example, orders or operations). A selection profile is especially useful if you select 

a large number of objects repeatedly according to the same selection conditions (for example, orders for 

printing shop papers, for collective release, or for creating order valuations). 

Selection procedure 

The selection conditions are evaluated top-down. Here the following rule applies: 

- Several lines following one another that are linked by an OR are combined and evaluated together. 

From the block at least one selection condition must be fulfilled. 

- AND links blocks or individual conditions. All the blocks or individual conditions linked with AND 

must be fulfilled. An order is no longer part of the evaluation as soon as a block or individual 

condition is not fulfilled. That means that with every freshly inserted AND a bracket is inserted 

around the preceding expressions (conjunctive normal form). To select the desired status 

combinations a reforming of the selection conditions is necessary. 

- In general one can say that OR links more strongly than AND! 

Example 

You want to define a selection profile with which orders with the following status combinations 

are selected: 

- REL (released) 

- CRTD UND MACM (created and material committed) 

To do this formulate: 

REL OR (CRTD AND MACM) 

But the system interprets: 

(REL OR CRTD) AND MACM 

Orders with the following status combinations are selected: 

- REL AND MACM 

- CRTD AND MACM 

Thus the original formulation must be reformulated by "multiplying out" to: 

(REL OR CRTD) AND (REL OR MACM) 
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Status 'active', 'inactive', or 'never active' 

You can also define the state of a status according to which a selection is to be made: 

- If you set the state active the system searches for objects where the given status is presently active. 

- If you set the state inactive the system searches for objects where the status entered is presently 

inactive. 

- If you set the state never active the system searches for orders where the status entered was never 

active. 

Example 

The following is an example of a selection profile that should select all released orders that either have a 

missing material or a missing PRT. 

 link status state 

 REL (released) active 

 AND MMAT (missing material availability) active 

 OR MPRT (missing PRT availability) active 

The selection is carried out in two steps: 

- First, all released operations are selected (that is, orders with the active status 'REL'). 

- Out of this group the system selects all the orders with missing material or PRT availability (that is, 

orders with the active status 'MMAT' or 'MPRT'). All the orders are selected with the following 

status combinations: 

- RELEASED and MMAT 

- RELEASED and MPRT 

- RELEASED and MMAT and MPRT 

Indicator 'not' 

With this indicator you can reduce the effort required when maintaining selection conditions in particular 

cases. Many status conditions can be represented more simply by setting the indicator 'not'. 

Example 

Selection conditions without 'not' indicator: 

 link not state 

 <Status> _ inactive 

 OR <Status> _ never active 

Same selection condition with indicator 'not': 

 link not state 

 <Status> X inactive 

Recommendation 
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For performance reasons, conditions that limit the selection strictly should be placed at the start of the 

selection profile. 

System status/user status 

You can enter both system status and also user status in a selection profile. If you want to select objects 

according to user status, you must enter the appropriate status profile. 

If you have maintained a status profile in the status selection profile, you have to assign this status profile 

to all objects. Selection is restricted via the status selection profile only if you have assigned the status 

profile to the objects. If you enter a system status in addition to entering a status profile, the system will 

ignore it unless it has been assigned to the status profile. 

The status profile is assigned to the objects via 

- the project profile for the project definition and the WBS elements 

- the network type for the network header and the activities 

Language dependence of a selection profile 

If a selection profile has been created in a language then it can be used in all languages defined in the 

system. If user statuses are defined in a selection profile then you should make sure that the user statuses 

are translated in the corresponding status profile. If no translation exists then you must enter the user 

status in the language in which it was created. 

Action 

Define your own selection profiles if necessary. 

26.4.4.11.1.2 Selection set 

In this section you define selection sets and variables. Sets contain selection criteria for selecting specific 

objects and their capacity requirements. 

They are used 

- to generate the selection screens for capacity leveling and the extended evaluation 

- to define requirements groups that group capacity requirements according to specific selection 

criteria (for example, capacity requirements for work centers) 

The selection criteria always refer to system fields (e.g. "ARBPL" for work center): 

For example, if you want to define the set for generating the object selection screen, you may have to 

create the following: 

- variables for the criteria to be entered 

- basic sets for each selection criterion 
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- multi set containing the basic sets and which is actually now the object set from the selection profile 

- set values 

basic sets can contain fixed values or variables. If a set contains variables, then you can enter 

values on the selection screen for the field which belongs to the set. You can overwrite default 

values from variables. If a set contains fixed values these are not displayed on selection screens 

and can therefore not be changed. 

You must define the following data when maintaining variables: 

- Default value 

You can enter a default value for a variable and you can overwrite it. If the 

system does not propose a default value, enter the following: 

- for a non-numeric field: * 

- for a numeric field:       0 

- Description 

- Parameter ID 

If the variable is to be given the SET/GET parameter that belongs to the field as a default value, then 

you must set the indicator here. 

Note 

Basic sets that are used for the selection screens may not contain any until values (neither as variable, nor 

as fixed value). 

If you want to use variables in a set then you must first define them. If you want to enter a variable in a 

basic set then you must enter a "&" before the name of the variable 

Example 

In the standard SAP package the selection screen for the objects is defined using the multi-set "5KOBJ1". 

This set contains, for example, both basic sets "5KARBPLV" and "5KWERKSV". 

- The basic set "5KARBPLV" relates to the field "ARBPL" (work center) and contains a variable 

"5KEARBP". 

- The basic set "5KWERKSV" refers to the field "CRHDWERKS" (data in the plant in the work 

center) and contains the variable "5KEWERK". 

A variable enables the user to enter the value of a set at the time when capacity leveling takes place. If 

you want to define a set to select a work center without specifying the work center in the set, then you 

must define a variable for the work center. You then assign this variable to the set. 

A variable always refers to a specific field (e.g. the field work center  "ARBPL"). You must enter this 

field when creating a variable next to its description. 
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Standard settings 

Selection sets and variables are predefined in the SAP standard package. 

26.4.4.11.1.2.1 Define variables 

In this menu option, you can define the variables that you can assign to a set.  If you assign a variable to a 

set, you can enter the value for the set when a capacity evaluation is carried out. 

For example, if you want to define a set for work center selection and you do not want to specify a 

specific work center in the set, you have to define a variable for the work center and assign this variable 

to the set. 

A variable always refers to a specific field (for example, the field "ARBPL" for work centers). When you 

create a variable, you have to enter the name of this field next to the name of the variable. 

When creating a variable, you must define the following data: 

- Default value 

You can specify a default value for the variable in an evaluation.  The user can overwrite the default 

value. 

If no default value is to be proposed, enter the following: 

- for a non-numeric field: * 

- for a numeric field:     0 

- Description 

When you carry out an evaluation, the description of the variable is displayed before the field in 

which you can enter a value for the variable, for example, on the initial screen. 

- Parameter ID 

If the SET/GET parameter for the field is to be used as a default value for the variable, you have to 

set the indicator here. You cannot use the transport functionality here. 

Actions 

RESET N1 

1. Create a variable, if necessary. 

2. Change a variable, if necessary. 

3. Display a variable, if necessary. 

4. Delete a variable, if necessary. 

26.4.4.11.1.2.2 Define sets 
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In this step you define sets 

There are two types of set: 

- Basic sets 

A basic set contains the values for a specific field. 

You have two options when assigning these values: 

- You can specify fixed values and/or fixed intervals. 

Fixed values are directly linked to the set.  The user cannot change them when the set is used 

for a capacity evaluation. 

For example, if the capacity category "001" (plant) is to be displayed in an evaluation, you can 

create a basic set for the field "KAPAR" (capacity category), to which you allocate the value 

"001". 

- You can specify variable values and/or intervals. 

You can change variable values when the set is used for an evaluation. For example, if you 

want to enter the capacity category when the evaluation is carried out, you have to allocate a 

suitable variable to the field in the set. You always have to enter the variable in the set with a 

leading "&". You can enter the corresponding values when the set is used for an evaluation. 

For example, if the initial screen refers to a set with a variable, the system will display a screen 

on which the user can enter a value for the variable. 

- Multi sets 

Using the multi set, you can group several basic sets into one set. Thus you can make 

selections using several fields. 

For example, you can define several fields with a fixed value or a variable value which can be 

entered in the initial screen for the evaluation. 

Note 

You cannot create multi-sets by combining multi sets. 

Actions 

1. Create a set, if necessary. 

2. Change a set, if necessary. 

3. Display a set, if necessary. 

4. Delete a set, if necessary. 

26.4.4.11.1.3 Define grouping requirememts 

In this step you define the following for capacity leveling and the extended evaluation: 

- requirements grouping 
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A requirements grouping defines which objects appear with their capacity requirements in the 

planning table in capacity leveling or in the extended evaluation. Examples of objects are work 

centers or orders. You specify a requirements grouping in the selection profile. 

- requirements groups 

A requirements grouping can comprise several requirements groups. Every requirements group 

groups together certain objects and their capacity requirements and displays them line by line in a 

chart in the planning table, for example all dispatched capacity requirements for the work centers, 

that you have selected when accessing capacity leveling. Requirements groups are defined using 

multidimension sets. The individual requirements groups in the requirements grouping that you 

specify in the selection profile are assigned under Define layout to the various charts in the 

planning table. 

In the definition of the requirements group you also specify which material stock curves (if any) - 

for example, available quantity - can be displayed in the capacity planning table in capacity 

leveling. 

Example 

The following examples display step by step how you use a requirements grouping and its requirements 

groups to display objects and assigned capacity requirements in a planning table with two charts. 

1. Defining a requirements grouping 

The requirements grouping should contain two requirements groups. One requirements group is to group 

capacity requirements for all capacity categories in work centers, another requirements group the capacity 

requirements for orders: 

Requirements group   Object 

1 all capacity categories for the work centers 

2 orders 

2. Assign requirements groups of requirements grouping to charts in the planning 

table 

You assign the requirements groups of the requirements grouping to the charts in layout L1 under Define 

layout: 
Chart    requirements group  object 

1 1                all capacity categories of work centers 

2 2                orders 

In the first chart in the planning table the capacity requirements for all the capacity categories at the work 

centers are displayed, in the second chart the capacity requirements for the orders. 

3. Define requirements group (1) 

The requirements group defines which objects and assigned requirements are in the lines in the planning 

table screen. 

It is defined using a multidimension set that selects the objects and the assigned capacity requirements 

accordingly. A multidimension can comprise several basic sets each of which refers to a selection 

criterion. 
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In the example the capacity requirements for all the capacity categories at the work centers are displayed 

in the lines for chart 1 to which the requirements group 1 is assigned. 
Basic set    Object            Field        Value 

BS1          work center       ARBPL        R1 

BS2          capacity category KAPAR 

The basic set BS1 refers to the field ARBPL (work center). The value R1 is assigned to this field. Thus 

the work center R1 is selected. The basic set BS2 refers to the field KAPAR (capacity category). No 

value is assigned to this. 

With the requirements group 1 defined in this way the capacity requirements for all the capacity 

categories at work center R1 are displayed line by line in chart 1, thus 
Work center    capacity category 

R1             person 

R1             machine 

R1             energy 

etc. 

If you do not specify a value in the basic set BS1 for the field ARBPL the capacity categories for all work 

centers that you specify when accessing capacity leveling are selected using the requirements group 1. 

They are displayed line by line in the first chart of the planning table with the capacity requirements that 

belong to them. 

4. Define requirements group (2) 

If you only want to display the dispatched capacity requirements in chart 1 for all the capacity categories 

for the work centers you need an additional basic set with a selection criterion that contains the status 

information. Define the requirements group 1 and assign it to chart 1 with a multidimension set 

containing the following basic sets: BS1, BS2 and BS3: 
Basic set   object                           field     value 

BS1         work center                      ARBPL     R1 

BS2         capacity category                KAPAR 

BS3         status of capacity requirements  KBEDSELAV SAP001 

The basic set BS3 refers to the field KBEDSELAV, that is the status stored in the capacity requirements 

record. The value SAP001 is assigned to the field. It concerns a selection profile. A status profile allows 

the assignment of one or more statuses. The basic set BS3 has the effect that only those capacity 

requirements are selected whose status corresponds to the selection profile SAP001. With the status 

profile SAP001 defined by SAP only the dispatched capacity requirements are selected. 

Rules for the definition of requirements groups (multidimension sets) 

- Every requirements group (multidimension set) should contain a basic set to which not value is 

assigned. 

A basic set without a value has the effect that all the objects are selected to which the field belongs. 

The field ARBPL belongs to the object work center, so all the work centers are selected. The field 

name is not of significance. (The assignment of fields to objects is stored in the table TCY36). 

- All the basic sets that follow the last basic set without a value (in the example the set BS2) only 

serve to select capacity requirements. 

Note 
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- The capacity planning table can only display two charts. In the capacity planning table load sums are 

assigned to the lines instead of bars. So the capacity requirements assigned to a line are aggregated. 

The logic is as described above. 

- If possible restrict yourself to the requirements groups provided by SAP; the definition of new 

requirements groupings is time-consuming and problematic. 

Actions 

If necessary define new requirements groupings. 

26.4.4.11.2 Capacity planning table 

In this step you make settings for the profile for the planning table. This is one of the profiles in the 

overall profile in capacity leveling. 

26.4.4.11.2.1 Graphical object type attributes 

In this section you define the following for the capacity planning table: 

- Graphical object types 

- Graphical object type selection 

26.4.4.11.2.1.1 Define graphical object type 

In this section, you define the following for the graphic planning table: 

- application-specific object types 

- the corresponding object representations 

- the corresponding object representation selection 

1. Defining application-specific object types 

In this step you define the data from the application object needed for the graphic display. 

In this case the capacity requirements and the corresponding pegged requirements, such as operation, 

phase and work order are indicated as the application object. 

You can define several graphic object types for one application object. This is useful if the data needed 

for the graphic display is clearly different in different situations. 

Example 
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In the following example it is wise to define several graphics objects for one application object: 

- An operation from the "work order in pool" is displayed with 

- setup time 

- processing time 

- teardown time 

- wait time 

- An operation from the "work order in task list" is only displayed with 

- setup time 

- processing time 

- teardown time 

In the SAP standard package, several graphic object types are created for objects from the work order. 

Note 

- If various application objects are grouped in a planning table, such as work orders and planned 

orders, you also have to define the selection of the graphic object type. 

- The index 0 for every graphic object type is reserved for a text field that is displayed when the 

cursor is placed above the object. Select a text field which is as expressive as possible for this text 

field, such as the operation text. 

- You use the graphic object type selection to indirectly specify which graphic object types are used in 

a profile for the planning table. 

- The performance of the graphic decreases proportionately with the number of fields. So you should 

not use any fields that you do not need in the graphic object type. 

Standard settings 

Graphic object types are predefined in the standard SAP package. 

Recommendation 

You should use the standard SAP package without changing it. 

If necessary, you should define your own graphic object types. 

2. Defining the object representation 

In this step you define the graphic display for a graphic object type. This display arises through the 

combination of graphic elements e.g. bars, lines or symbols. 
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You can define several object representations for each graphic object type. This is useful if you want to 

mark application objects which have different properties using their display. 

That is why in the standard SAP package several object representations are created for different graphic 

object types. 

Note 

You can use the object representation selection indirectly to specify which object representations are used 

in a planning table profile. 

Example 

- A "dispatched operation" is represented by green bars for setup, processing and teardown. 

- A "released operation" is represented by bars for setup, processing and teardown. 

Standard settings 

Object representations are predefined in the standard package. 

Recommendation 

Copy the standard settings without changing them. 

Activities 

If necessary, create your own object representations. 

3. Specifying the object representation selection 

In this work step you define the decision steps that lead to the selection of the object representation. 

You can use the following for the selection: 

- every field of the capacity requirements 

- every field for the pegged requirements for the capacity requirements 

- a status profile that is defined for the application object 

The overall decision is divided into one or more decision states. Every decision state consists of one or 

more decision steps that are worked through according to the decision sequence. 

The decision starts with the decision status "0" and the smallest decision sequence (in the sequence "1"). 

In every decision step a statement is checked whether it is true or false: 

- If it is true and if an object representation has been entered then the overall decision has been 

successfully taken. 

- If it is true and if no object representation has been entered then the decision is continued with the 

smallest decision sequence in the "next decision state" given. 
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- If it is false then the decision is continued in the next largest decsion sequence in the same decision 

state. 

There are three sorts or statements: 

- Field comparison 

Here, the contents of the field in a structure is compared either with a comparison value or with the 

contents of a field. 

Various comparison operators are available for the field comparison, among others the operator CP 

("contains pattern"), that checks whether a character string is contained in another. You can find 

more information on comparison operators in the documentation BC-ABAP/4 user manual. 

A date field is compared with a date that is derived as follows from today's date: As a comparison value 

enter a positive or negative number that the system interprets as a number of days and adds to today's 

date. This date is the actual comparison value. In the following examples of logical relationships with a 

date field the statements in parentheses are the entries with which the statements on the object 

representation selection are defined: 

- < Date field > < GE > today date + < -10 > days 

This statement is true if the date in the date field is at the earliest 10 days in the future. 

- Status query 

Structure and object number denote the object for which the status profile is evaluated. You enter 

the status profile that is to be checked as the "comparison value". The comparison operator must be 

"ST". 

- True statement 

This statement is always true, that means that a false statement can never arise in a decision step. 

The comparison operator must be "DEF". 

Selected fields for comparisons 

Fields ERROR_MASK in structure KBED 

If an error arises with the following functions in capacity leveling then a 1 is written in the field 

ERROR_MASK. The place where the 1 is written depends on the function. 

 Function                        for error 1 in 

 Scheduling                      1st position 

ATP check                      2nd position 

 Taking setup time into A/C      3rd position 

 General selection function      4th position 

 Other                           5th position 

Note 

You can only use pegged requirments in the field "structure" that are read by the object set in the 

framework of the "selection" with the capacity requirements. 

Requirements 
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In order to be able to define the decision steps for the selection completely you must already have edited 

the work step "Define object representation". 

Activities 

Define the object representation selection. 

26.4.4.11.2.1.2 Define graphical object type selection 

In this step you define the following: 

- the graphical object type selection 

- the object representation profile 

1. Define graphical object type selection 

In this step you define the decision steps that lead to the selection of the graphical object type. 

You can use the following to make the selection: 

- every field for the capacity requirements 

- every field for the pegged requirements for the capacity requirements 

- a status profile defined for the application object 

The overall decision is divided into one or more decision states. Each decision state consists of one or 

more decision steps that are worked through according to the decision sequence. 

The decision starts with the decision status "0" and the smallest decision sequence (in the sequence "1"). 

At every decision step a statement is checked to see whether it is true or false: 

- If is is true and if a graphical object type is entered then the overall decision is made successfully. 

- If it is true and no graphical object type is entered then the decision is continued with the smallest 

decision sequence in the "next decision status" given. 

- If it is false then the decision is continued with the next-largest sequence in the same decision status. 

There are three types of statement: 

- Field comparison 

Structure and field are compared with the comparison value (comparison operator e.g. EQ = equal) 

- Status query 

Structure and object number denote the object for which the status profile is evaluated. You enter 

the status profile that is to be checked as the "comparison value". The comparison operator must be 

"ST". 

- "True statement" 
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This statement is always true, that means that a false statement can never occur in the decision step. 

The comparison operator must be "DEF". 

Note 

You can only use pegged requirements in the field "structure" that are read with the capacity requirements 

by the object-set in the context of the "selection". 

Requirements 

In order to be able to define the decision steps of the selection completely, you must already have 

processed the work step "Define graphical object type". 

Activities 

Define the graphical object type selection. 

2. Define object representation profiles 

In this step you define a profile for the graphical object selection. This profile defines the object 

representation selection for every graphical object type that exists in the graphical object type selection. 

In this way you determine the representation of all graphical objects in the planning table in one place. 

Example 

Requirements 

Standard settings 

Object representations are predefined in the standard SAP package. 

Recommendation 

You should take over the standard settings without changing them. 

Activities 

1. Define an object representation profile. 

2. Enter the object representation profile in the graphical object type selection. 

Further notes 

You must once again enter the profile to be defined here in the graphical object type selection. 
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26.4.4.11.2.2 Curve attributes 

In the capacity planning table you can display a chart with material stock curves for selected 

requirements, for example with the available stock. The stock data is shown over the time axis of the 

capacity planning table. 

In this section you use curve- and axis representations to define the graphical characteristics of curves and 

axes. 

You use the curve representation selection and the axis representation selection to define decision steps 

that lead to the selection of a curve- and axis representation. 

26.4.4.11.2.2.1 Define axis representation 

In this step you define the representations of the axes for the material stock curves. You use the axis 

representation to define the height of an axis and the color used to display it. 

Notes 

Which axis representation is used in a profile for the capacity planning table is defined using the axis 

representation selection. 

Standard settings 

In the standard SAP package the axis representations are predefined. 

Recommendation 

You should copy the standard settings without changing them. 

Activities 

If necessary, create your own axis representations. 

26.4.4.11.2.2.2 Define axis representation selection 

In this step you define decision steps that lead to the selection of an axis representation. 

The decision steps are processed according to the decision sequence starting with the lowest value for 

the decision sequence (generally "1"). In every decision step the assigned statement is checked to see 

whether it is true or false. If it is true then an axis representation is specified. 
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A statement category is available that is linked firmly by the comparison operator DEF. A linked 

statement DEF ("DEFAULT") is always true. 

Requirements 

You must always have processed the step Define axis representation 

Standard settings 

In the standard SAP package axis representation selections are predefined. 

Activities 

If necessary, define your own axis representation selection. 

26.4.4.11.2.2.3 Define curve representation 

In this step you define the curve representations of material stock curves. You use a curve representation 

to define the graphical features of a curve, for example the color and the thickness of lines. 

Notes 

You use the curve representation selection to define which curve representations are used in a profile for 

the capacity planning table. 

Standard settings 

In the standard SAP package curve representations are predefined. 

Recommendation 

You should copy the standard settings without changing them. 

Activities 

You can create your own curve representations. 

26.4.4.11.2.2.4 Define curve representation selection 

In this step you define the decision steps that lead to the selection of a curve representation. 

The decision steps are processed according to the decision sequence starting with the smallest value for 

the decision sequence (generally "1"). In every decision step the assigned statement is checked to see 

whether it is true or false. If it is true then a curve representation is specified. 
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There are two types of statements available that are linked by two different comparison operators: 

- One statement linked with DEF ("DEFAULT") is always true. 

- One statement linked with EQ ("EQUAL") is true if the values that are compared are the same. 

In the statements the comparison values are compared to the curve categories that you have entered 

under Define requirements grouping as fixed parameters for the requirements group. 

Requirements 

To be able to define the decision steps fully you must already have processed the step Define curve 

representation. 

Standard settings 

Curve representations should already have been defined in the standard SAP package. 

Activities 

If necessary, you should define your own representation selections. 

26.4.4.11.2.3 Define time scale 

In this step you define 

- the scale for the various segments on the time axis (see next section) 

- whether when the capacity planning table is called up the non-work times that are common to all 

capacities are hidden. 

Segments of the time scale: 

In the capacity planning table you see a segment of the (infinite) time scale. This segment is defined by 

the evaluation period in the time profile. You define the time scale of the time axis for the following 

segments: 

- Pre-evaluation period 

This represents the period between the start of the evaluations until the start of planning. 

- Planning period 

This represents the period between the start and the end of planning. 

- Post-evaluation period 

This represents the period between end of planning and end of evaluation. 

A scale is defined as the length per unit of time e.g. 40 mm per day. 

Note 
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The pre/post-evaluation period are not visible if the start of the evaluation period (or end of the planning 

period) and end of the evaluation period coincide. 

Standard settings 

In the standard SAP package there are predefined scales (e.g. daily period split, weekly period split). 

Recommendation 

You should leave the standard settings unchanged. 

Activities 

If necessary you should maintain your own scales and enter them in your profile for the planning table. 

Further notes 

You can find more information in the work step "Define profile for the planning table. 

26.4.4.11.2.4 Define chart sequence 

In this section you define the number and sequence of the charts in the plannning table. 

One or more requirements groups are allocated to each chart. For each chart you should create the 

following among other things: 

- Type 

- Height 

- Title 

- Table section 

- Diagram area 

You also define which functions are activated by dragging and dropping graphics objects. 

In the view "chart position" you can define that multiple commitments are automatically displayed in the 

capacity planning table. 

For a chart with material stock curves that can be flexibly hidden and shown in the capacity planning 

table you should set the indicator Use as histogram. 

Standard settings 

The following partial sequences are predefined in the standard SAP package. 

Recommendation 
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You should leave the standard settings unchanged. 

Activities 

If necessary you can create your own chart sequence. 

Further notes 

For more information see the section "Define requirements grouping". 

26.4.4.11.2.5 Define time scale profile 

In this work step you define the time scale profile. A time scale profile describes the properties of all 

possible scales using headings for the time axis (day scale, week scale etc.). 

The time fence is derived from the possible scales. 

Depending on the current scale the time scale is generated from one or more scales. 

There are scales with the following headings: 

- Yearly split 

- Quarterly split 

- Monthly split 

- Weekly split 

- Daily split 

- Hourly split - Minute split 

- Shift split 

To show the shift scale you have to select a capacity in the capacity planning table whose shift 

calendar determines the shift split. It you set the indicator Show shift then the shift calendar for the 

first capacity is displayed automatically in the capacity planning table. 

For every period pattern you have to define the following: 

- Minimum scale 

By defining a minimum scale for every period split enter the minimum limit above which a scale 

for this period split is displayed. 

Example 

The scale for the daily period split should exceed 5 mm/day, otherwise the texts for the headings 

(e.g. Monday, Tuesday...) cover one another. 

- Maximum scale 

When defining a maximum scale for every period pattern you should enter the upper limit up to 

which a scale should be displayed for this period pattern. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 332 

Example 

The scale for the daily period split should be less that 350 mm, otherwise the display for the day is 

so wide that the heading often lies outside the section that is visible. 

- Color category 

You use the color category to define the background color of a split. 

- Color category of time fence for split 

For the time fence that belongs to the shift split two color categories must be defined: for the line 

with the capacity, whose shift calendar is displayed and for the rest of the lines in the chart. 

- Major interval 

Here you can define the heading frequency. For example, every 8 hours => 0 hours, 8 hours, 16 

hours, 0 hours, etc. 

- Heading type 

For example, you can define January, February or January 1995, February 1995 as the heading. 

Note 

- By defining the scale as a unit of time the scales of all the period patterns are in a fixed relation to 

one another. 

Example 

With 5 mm/day, a week is displayed over 35 mm. 

- You can allocate each chart its own time scale profile in order to get a chart-specific heading. 

- In the chart type you can switch off the display of the time axis for a chart. Then the entries for the 

time axis in this chart are not active. 

Example 

The scale was defined as 40 mm per day. This corresponds to 280mm per week. 

In the time scale profile there is an area of 20-200 mm for the daily split and 50-500 mm for the weekly 

split. 

In this case there is both a daily and a weekly split heading for the time axis. 

Standard settings 

Time scale profiles are predefined in the standard SAP package. 

Recommendation 

You should use the standard settings. Do not change them. 
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Activities 

If necessary, you can define your own time profiles. 

Further notes 

You can get additional information in the work step "Define scale for time axis". 

26.4.4.11.2.6 Line attributes In this step you define how table lines can be 

represented and make a selection for a representation. You also define the 

criteria that should be available for sorting and choose the desired sort key. 

26.4.4.11.2.6.1 Define line representation 

In this section you define the graphic display for a line. This display arises through the combination of the 

form type and color category. 

You should define different line layouts if you want to emphasize various groups using their form or 

color. 

Note 

You define which line layouts are used in a profile for the planning table using the line layout selection. 

Example 

- A planned order in the pool of orders/operations is represented by a green line. 

- A production order in the pool or orders/operations is represented by a yellow line. 

Standard settings 

Line layouts are predefined in the SAP standard package. 

Recommendation 

You should copy the standard settings unchanged. 

Activities 

If necessary create your own line layouts. 

26.4.4.11.2.6.2 Define line layout selection 
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In this work step you define the decision steps that lead to the selection of the line layout. 

You can use the following to make the selection: 

- every field in a structure that is used for a grouping 

- a status profile defined for an application object of the grouping 

The overall decision is divided up into one or more decision states. Each decision state consists of one or 

more decision steps that are worked through according to the decision sequence. 

The decision starts with the decision status "0" and the smallest decision sequence (in the order "1"). 

In every decision step a statement is checked as to whether it is true or false: 

- If it is true and if a line layout has been entered then the overall decision has been successfully 

made. 

- If it is true and no line layout has been entered then the decision is continued with the smallest 

decision sequence in the given "next decision state". 

- If it is false then the decision is continued with the next-largest decision sequence in the same 

decision state. 

There are three types of statement: 

- Field comparison 

Here the structure and the field are compared with a comparison value (Comparison operator e.g. 

EQ = equal). 

- Status query 

Structure and object number denote the object for which the status object is evaluated. You enter the 

status profile that is to be tested as a "comparison value". The comparison operator must be "ST". 

- "True statement" 

This statement is always true, that means that a false statement can never arise in the decision step. 

The comparison operator must be "DEF". 

Note 

You can only use structures in the field "structure" that are read by the object set in the 

context of the grouping. 

Requirements 

In order to be be to define the decision steps for the selection completely you must already have 

processed the work step: "Define line layout". 

Activities 

Define the line layout selection. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 335 

26.4.4.11.2.7 Graphic 

In this section, you make the necessary graphics settings. When you call your graphic, the application 

automatically provides a graphic profile containing the required settings. 

26.4.4.11.2.7.1 Define color 

In this step you can define your own colors. The color definitions determine the color characteristics of an 

object such as: 

- Background color 

- Pattern 

- Connection color, etc. 

Note 

Color definitions can be used in different GANTT chart or network/hierarchy types. First check for 

possible dependencies before you change them. 

Standard settings 

There are colors already defined in the SAP standard delivery system. 

Recommendation 

Copy the standard settings without changing them. 

Activities 

Define your own colors if necessary. 

26.4.4.11.2.7.2 Define form 

In this step you can define your own shapes. shape definitions determine the shape of a graphical object. 

In the layout you define the allocation of the object into fields. 

Note 

Shape definitions can be used in different GANTT chart or network/hierarchy types. 

First check for possible dependencies before you change them. 

Standard settings 

There are defined shapes in the SAP standard delivery system. 

Recommendation 
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Copy the standard settings without changing them. 

Activities 

Define your own shapes if necessary. 

26.4.4.11.2.7.3 Define field 

In this step you define attributes for each field you specified when structuring the corresponding shape 

definition. 

Field attributes are: 

- Text specifications - Font specifications 

- Field characteristics 

- Symbol specifications (for example, your company logo or a different bit-map) 

Note 

Field definitions can be used in shape definitions of the GANTT chart or the network/hierarchy. First 

check for possible dependencies before you change them. 

Recommendation 

Copy the standard settings without changing them. 

Activities 

Specify your own field definitions if necessary. 

26.4.4.11.2.7.4 Assign colors 

In this step, you can define your own color types and use them in graphics profiles. 

Color types are combined into groups. 

Abstract color types which are used by the application are available for graphic objects such as rasters, 

time bars, table objects, diagram objects, and so forth. 

You must enter a color definition for every color type. 

Note 

A color group can be used in several graphics profiles. Therefore, first check for any possible 

dependencies before you make changes. 
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Requirements 

You should have already completed the "Determine color definition" step. 

Standard settings 

Color types have already been defined in the standard SAP R/3 System. 

Recommendation 

You should copy the standard settings without any changes. 

Activities 

Define your own color types, if necessary. 

26.4.4.11.2.7.5 Assign shapes 

In this step, you can define your own shape types and use them in graphics profiles. shape types are 

combined into groups. 

Abstract color types that are called by the application are available for graphic objects, such as table 

objects. 

You must enter a shape definition for every shape type. 

Requirements 

You should have already completed the "Determine shape definition" step. 

Standard settings shape types have already been defined in the standard 

SAP R/3 System. 

Recommendation 

You should copy the standard settings without any changes. 

Activities 

Define your own shape types, if necessary. 

26.4.4.11.2.7.6 Define options profile 

In this step you can define your own options profiles and use them in graphics profiles. 
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In the options profile you define: 

- Window 

specifications 

- Modes for editing -

 Colors, etc. 

Note 

An options profile can be used in several graphics profiles. First check for possible dependencies before 

changing it. 

Standard settings 

There are options profiles already defined in the SAP standard delivery system. 

Recommendation 

Copy the standard settings without changing them. 

Activities 

Define your own options profiles if necessary. 

26.4.4.11.2.7.7 Define chart 

In this step, you can define your own partial screen types and use them in graphics profiles. 

Partial screen types are combined into groups. The partial screen type determines the layout of the partial 

screens in a graphic. 

With a partial screen type, you determine which areas of the partial screen are displayed and how the 

color of these areas is designed. 

Note 

A partial screen modification group can be used in several graphics profiles. Therefore, first check for any 

possible dependencies before making changes. 

Requirements 

You should have already completed the "Determine color definition" step. 

Standard settings 

Partial screen types have already been defined in the standard SAP R/3 System. 

Recommendation 

You should copy the standard settings without any changes. 
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Activities 

Define your own partial screen types, if necessary. 

26.4.4.11.2.7.8 Define graphical element 

In this step, you can define your own graphic element types and use them in graphics profiles. 

Graphic element types are combined into groups. The graphic element type determines the layout of the 

graphic elements in the graphic. 

In a graphic element type, you determine which temporal area of a graphic object is displayed in the 

diagram and how. 

You must enter a color definition for the color design. You can control the text by means of a shape 

definition. 

Note 

A graphic element group can be used in several graphics profiles. Therefore, first check for any possible 

dependencies before you make changes. 

Requirements 

You should have already completed the following steps: 

- "Determine color definition" 

- "Determine shape definition" 

Standard settings 

Graphic element types have already been defined in the standard SAP R/3 System. 

Recommendation 

You should copy the standard settings without any changes. 

Activities 

Define your own graphic element types, if necessary. 

26.4.4.11.2.7.9 Define graphics profile 

In this step, you can define your own graphics profiles and then use them in the relevant application. The 

graphics profile determines the overall appearance of the graphic. 
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A graphics profile has the following components: 

- Partial screen modification group 

The partial screen types that are available to the application are grouped together in the partial 

screen modification group. 

- Graphic element group 

The graphic element types that are available to the application are grouped together in the graphic 

element group. 

- Color group 

The color types that are available to the application are grouped together in the color group. 

- shape group 

The shape types that are available to the application are grouped together in the shape group. 

- Option profile 

The option profile determines specifications for the window and modes for processing. 

Note 

A graphics profile can be used in several applications. Therefore, first check for any possible existing 

dependencies before making changes. 

Requirements 

You should have completed the following steps: 

- "Define partial screen" 

- "Define graphic element" 

- "Determine color definition" 

- "Determine shape definition" 

- "Define option profile" 

Standard settings 

Graphics profiles have already been defined in the standard SAP R/3 System. 

Recommendation 

You should copy the standard settings without any changes. 

Activities 

Create your own graphics profiles. 

26.4.4.11.3 Useful notes 
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In this step you are given instructions for the settings in capacity planning. 

On the planning table: 

Color of graphic objects 

Change display area 

26.4.4.11.3.1 Change display area 

You can change the display section of the capacity planning table: you can easily set the window on your 

monitor to the same size as that on a 21" monitor. 

Activities 

You can change the display section by clicking on the symbol showing the magnifying glass + (increase 

size) or - (decrease size) on the planning table. After every click the display section is changed by a given 

amount. You define this amount using the zoom factor. 

Proceed as follows: 

- In Customizing for capacity planning choose: Capacity leveling -> Technical settings -> Planning 

table -> Graphic -> Define options profile. 

- Select the options profile with which you call up the planning table and choose Goto -> Details. 

- Enter a factor in the screen section "window" in the field "zoom factor"The value 3000 is 

predefined. 

- If you enter factor 2000, then clicking once on the symbol for decreasing the size changes the 

original 21" window size to 17". 

26.4.4.11.3.2 Color of graphical objects 

In this step you find instructions for changing the color of graphical objects on the planning table. This is 

status-dependent. 

Graphical objects represent capacity requirements. For every graphical object there are one or more 

representations. A representation is the graphical depiction of a graphical object and is made up of several 

graphical elements. 

Example 

For example, you can represent a released order on the planning table in another color. In this way you 

get a better overview of the planning table. 
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Activities 

To change the color, depending on the status, you have to make several settings in Customizing: 

1. Analysis of profile used 

2. Define graphical object selection 

3. Define graphical representation 

4. Select graphical element 

5. Change graphical object representation 

6. Extend graphical object selection 

For 1: 

Before you change a graphical object you have to define which profiles and which representations are 

affected. 

Proceed as follows: 

- Call up the planning table. 

- Note the following profiles on the planning table: 

- Overall profile 

- Profile for the planning table 

- In Customizing for capacity planning choose: Capacity leveling -> Capacity planning table -> 

Define profile for capacity planning table. Make a note of the following profiles: 

- Graphical object type selection (diagram section) 

- Representation profile (diagram section) 

- Group (Graphical profile) 

- Name (Graphical profile) 

- In Customizing for capacity planning choose: Capacity leveling -> Technical settings -> Capacity 

planning table -> Graphics -> Define graphics profile. Select the appropriate group and make a 

note of the following settings: 

- Graphical element group 

- Color group 

For 2: 

In this step you specify which graphical object type you want to change.You do this using a decision 

table. 
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- In Customizing for capacity planning choose: Capacity leveling -> Technical settings -> Capacity 

planning table -> Define graphical object type selection. 

- Select the graphical object selection that you made a note of when analysing the profile. -

 Navigate to decision steps. 

- Analyse the decision table and make a note of the graphical object type that you want to change. By 

double-clicking on the appropriate line you go one level deeper. 

You now know the graphical object type that you want to change. 

For 3: 

Several representations belong to a graphical object. In this step you specify which of the graphical 

object´s representations gets changed. Here too the change takes place using a decision table. Proceed as 

follows: 

- In Customizing for capacity planning choose: Capacity leveling -> Technical settings -> Capacity 

planning table -> Define graphical object. 

- Choose the appropriate graphical object type from the table. 

- Navigate Object representation selection and Decision steps. Choose the object representation that 

you want to change. 

Now you know the graphical object type and the represenation selection that you want to change. 

For 4: 

To display the graphical object in another color, you have to change thegraphical element type. To do this 

you must establish which element types are used in the representation you have chosen, that means, what 

color they represent. Then you have to specify which element type is to be replaced. Proceed as follows: 

- In Customizing for capacity planning choose: Capacity leveling -> Technical settings -> Graphical 

planning table -> Define graphical object. 

- Select the appropriate graphical object type and navigate to fields. The meaning of the indexes is 

given in the table. 

- Make a note of the meaning of the indexes for which you want to change the display. 

- Go back to the object representation and choose graphical element type. All the graphical element 

types belonging to the object representation are given in the table. 

You now know the graphical element types that are assigned to the object representation and know what 

the indexes mean. Now you need to specify with which graphical elements you want to replace the 

previous ones. 

- In Customizing for capacity planning choose: Capacity leveling -> Technical settings -> Capacity 

planning table -> Graphics -> Define graphical element. 

- Place the cursor on the group that you have saved in the graphics profile. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 344 

- Find the element types used until now and choose the new ones. Make sure that the indexes match 

up with one another. 

For 5: 

In this step you create (by copying) a new graphical object type and a new object representation. When 

doing this change the graphical element types according to your selection in step 4. 

- In Customizing for capacity planning choose: Capacity leveling -> Technical settings -> Capacity 

planning table -> Define graphical object and select the graphical object type you have selected. 

- Choose Edit -> Copy as.... Also copy all the dependent entries. 

- Save the new graphical object type. 

- Select the graphical object type you have just created and choose object representation. 

- Choose Edit -> Copy as.... Copy all the dependent entries. 

- Save the new object representation. 

- Select the object representation that has been created and choose Edit -> New entries. 

- Enter the graphical element type you have chosen and confirm your entries with Enter. 

- Choose the graphical element type that you want to replace and select Edit -> Delete. 

- Save your entries. 

You have created a new object representation with different graphical element types. 

For 6: 

You have now created a new object representation of a graphical object. You now have to place a query 

in the decision table so that the new object representation is displayed under the new conditions. Proceed 

as follows: 

- In Customizing for capacity planning choose: Capacity leveling -> Technical settings -> Capacity 

planning table -> Define graphical object. 

- Select the "new" graphical object and navigate to Object representation selection. 

- Make the appropriate selection and choose decision steps. 

- Choose Edit -> New entries. 

- Enter a selection profile and a comparison value. For the object representation enter the one you 

created so that it is displayed under the given conditions. 

26.4.4.12 Enhancements for capacity leveling 

In the following steps you can enhance the SAP standard for capacity leveling. 
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26.4.4.12.1 Change operation data 

With the enhancement CY190001 you can change the operation data. 

Selected operations on the capacity planning table are transferred to the enhancement, where, for example 

standard values, work centers and dates are changed. The enhancement gives back both the changed 

operations and two of the functions: change, dispatch or deallocate that are to be carried out on the 

operations changed. 

26.4.4.12.2 Define dispatching sequence for operations 

With the enhancement CYPP0001 you can specify the sequence of operations to be dispatched. 

26.4.4.12.3 Display user data in table section of planning tables 

With the enhancement CYPP0002 you can fill the table section of the capacity planning tables with any 

user-specific data. In Customizing for capacity leveling in the layout key the structure CYUSER is made 

available. Its fields are empty when delivered. 

26.4.4.12.4 Fix time periods on capacity planning table 
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With the enhancement CY040001 you can define time intervals that are locked automatically when you 

call up the capacity planning table. You cannot change planning in the locked time periods. 

26.4.4.12.5 Change texts for graphical objects and status line 

With the enhancement PLAT0001 you can change or enhance the texts that are displayed for graphical 

objects in the status line of the capacity planning table. The enhancement contains the functions exit 

EXIT_SAPLPLAT_001. 

26.4.4.12.6 Change selection list for fields in sort-layout key 

You can use the enhancement CYPP0003 to reduce or extend the list of fields offered in Customizing for 

the sort-/layout key. 

26.4.4.12.7 Assign new values to fields in sort-layout key 

You can use the extension CYPP0004 to assign the fields in the sort- layout key new values and thus 

generate any sort sequences you like for your objects on the planning tables. 

Further notes 

It the sort-layout key itself you can only specify an ascending or descending sort for any field on the basis 

of the ASCII character set. 

26.4.5 Define authorizations 

Authorization objects 

The following list shows which authorization objects are checked for the individual application functions. 

Functions for... 

Capacity planning 

Authorization object 

Perform       evaluation 

C_KAPA_PLA Capacity planning 

Change, display quotation 

C_ARPL_WRK Work centers 

Pegged requirements C_AFKO_AWK Order types 

production order   C_AFKO_ATY Type/PP order 
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Pegged requirements I_TCODE Transact.Plant Maint. 

Maintenance       C_AFKO_AWK Order types 

order    I_IWERK Planning plant 

Pegged requirements C_AFKO_AWK Order types 

Network;  C_AFKO_DIS MRP controller 

Change, display network C_PROJ_TCD transact./application area 

 Pegged requirements M_PLAF_ORG Planned order 

Planned order; Change, 

display planned order  
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Description of the authorization objects 

Object: C_KAPA_PLA Capacity planning 

Definition 

Activity authorization for capacity planning 

This object controls whether or not a user is authorized to perform capacity planning analyses. 

Defined fields 

Fields Possible entries Meaning 

ACTVT 16 User may perform 

capacity planning analyses.  
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Object: C_ARPL_WRK Work centers 

Definition 

With this authorization object, you can restrict 

- the maintenance of work centers/resources, work center/resourcer hierarchies, and capacities to 

certain actions (e.g. change or display) in certain plants. 

- the maintenance of downtimes, independent of plant 

Defined fields 

The system checks the following fields: 

Fields Possible entries Meaning 

ACTVT 01 

and hierarchies 
User may create work centers/resources 

02 centers/resources 

and hierarchies 

User may change work 

03 centers/resources 

and hierarchies 

User may display work 

05 

and hierarchies 

User may lock work centers/resources 

06 

and hierarchies 

User may delete work centers/resources 

07 User may enter downtimes 

WERKS Enter the plants for which the user 

may edit work centers/resources and hierarchies. When downtimes are entered, the plant is not 

checked. 

Object: C_AFKO_AWK Order types 

Definition 

This authorization object can be used to limit the maintenance of production orders with respect to order 

type and plant. 

Defined fields 

The authorization object contains two fields: 

- AUFART: specifies the use of the order. The input help (F4) on this field in authorization 

maintenance displays the planned values. 

- WERKS: specifies the plant in which the order type may be processed. 

Example 

User A may maintain production orders with external number assignment in all plants. 
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- Order type "PP01: 

- Plant "*" 

User B may maintain production orders with internal number assignment in plant "0001" only. 

- Order type "PP02" 

- Plant "0001"  
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Object: C_AFKO_ATY Type/PP order 

Definition 

With this authorization object you can restrict the authorization of the order maintenance to specific order 

categories and actions. 

Defined fields 

The following fields are checked: 

Fields possible values meaning 

ACTVT 01 User can create orders 

 02 User can change orders 

 03 User can display orders 

 04 User can print orders 

 06 User can archive orders and 

also delete order logs archive 

for process orders 

AUTYP 10 production orders (PP-SFC) 

 40 process orders (PP-PI) 

Object: I_TCODE Transact. Plant Maintenance 

Definition 

Transaction code authorization in Plant Maintenance (PM) 

This authorization object determines which transactions a user may perform in the PM area. 

During sequential processing, the system checks the authorizations for the transaction codes of the master 

data. 

Defined fields 

The transaction code is assigned to the authorization object. 

Note: 

The authorization object is stored as test object in the table for transaction codes. 

The routing and work center areas are not controlled via the transaction code authorization. They 

have their own authorization objects.  
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Object: I_IWERK Planning plant 

Definition 

Planning plant authorization in Plant Maintenance (PM) 

Using this authorization object, you can control which users may edit PM data with which transactions in 

the planning plants. 

The system checks the authorization for the following functions: editing of 

master data, reports, orders, and maintenance plans 

Defined fields 

The following are assigned to this authorization object: 

- Transaction code 

- Planning plant  
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Object: C_AFKO_DIS MRP controller 

Definition 

With this authorization object, you can limit the maintenance of networks with regard to MRP controller 

and plant. 

Defined fields 

The authorization object contains three fields: 

- Plant: determines within which plant the MRP controller may maintain the network. 

- MRP controller: determines which MRP controllers may maintain the network. 

- Transaction type 

The following values are used for transaction type: 

- H: Create 

- V: Change - A: Display 

Examples 

User A in plant 0001 may display, but not edit, all networks that are assigned to the MRP controller XYZ. 

Relevant authorization: 

- MRP controller "XYZ" 

- Transaction type "A" 

- Plant "0001" 

Object: C_PROJ_TCD Transact./Application area 

Definition 

With this authorization object, you can restrict the call of most functions from the application menu of the 

project system. 

Defined fields 

The authorization object contains two fields: 

- Work area: determines for which area of the project a user can display or edit values, such as master 

data, actual costs, or PS texts. The input help (F4) on this field in authorization maintenance displays 

the allowed values. 

- Transaction type: determines whether and how these values may be processed (display, change, 

create). 

The values required for authorization to call a certain transaction in the project system are defined in 

transaction maintenance: Tools -> Case -> Development -> Transactions. 

Examples 
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User A may display, but not edit, all values in the project system. 

Relevant authorization: 

- Work area        "*" 

- Transaction type "A" 

User B may create and display confirmations but not cancel them. 

Relevant authorization: 

- Work area        "0203" 

- Transaction type "A" or "V"  
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26.5 Material Requirements Planning 

In this workstep, you make the necessary settings for material requirements planning. 

26.5.1 Plant Parameters 

In this step, you can maintain all the plant parameters. You can also maintain the reference plant for the 

common access of various plants to one master data table. 

26.5.1.1 Carry Out Overall Maintenance of Plant Parameters 

In this step, you can specify all plant parameters for the material requirements planning. 

In addition, you receive an overview of the maintenance statuses of the individual MRP parameters on 

plant level. 

When specifying the plant parameters, you have the following options: 

- creating the MRP parameters for a new plant 

- deleting the MRP parameters for a plant 

- maintaining individual MRP parameters 

- copying the MRP parameters of a plant already maintained into a new plant 

Note 

You must specify the MRP parameters in this menu option if the following requirements are met: 

- If you create the MRP parameters for a new plant for the first time 

- If you completely want to delete the MRP parameters for a plant 

Actions 

Specify the planning parameters. 

26.5.2 MRP Groups 

In this step, you can carry out the total maintenance of the MRP groups and you can allocate a material 

type to an MRP group. 

The MRP group is an organizational object that can be used to allocate special control parameters for 

planning to a group of materials. You can maintain MRP groups if planning control per plant is not 
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precise enough for your requirements and you want to allocate certain material groups different control 

parameters from the plant parameters. For this purpose, MRP groups are defined with these specific 

control parameters and are assigned to the material in the material master record (MRP 1 screen). 

For example, the following control parameters can be set for the total planning run: 

- the creation indicator for the planning run (creation of purchase requisitions, MRP lists, and so on) 

- the planning horizon 

- the consumption mode 

The following is valid for total planning and single-item planning: 

- for all materials without an MRP group, the system uses the plant parameters, or the entries in the 

initial screen of the planning run 

- for all materials with an MRP group, the system uses the parameters recorded in the MRP group 

26.5.2.1 Carry Out Overall Maintenance of MRP Groups 

In this step, you determine the MRP groups and you maintain the control parameters from a particular 

point of view. 

Warning 

If you want to work with an MRP group, you must first create the key of this MRP group in this step 

using the function Create. You can maintain the parameters of the MRP group either collectively in this 

step using the function Maintain or in the appropriate step of Customizing for MRP that refers to the 

MRP group. 

When creating the MRP groups, you have the following options: 

- Create the MRP groups for a new plant 

- Delete the MRP groups for a plant 

- Maintain individual MRP groups 

- Copy the MRP groups of a plant that has already been maintained to a new plant 

Note 

To activate the parameters of an MRP group for a particular material, you must assign the MRP group to 

the material in the material master record. 

Actions 

Define the MRP groups with the appropriate parameters. 
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26.5.2.2 Define MRP Group for Each Material Type 

In this workstep, you define MRP groups per material type. This method of maintaining the MRP group 

should be used if the control parameters or the planning strategies specially refer to material types. 

If MRP groups have been maintained that specifically refer to material types, the appropriate MRP type is 

automatically proposed in the material master record (MRP 1 screen). 

Actions 

Assign material types to MRP groups. 

26.5.3 Number Ranges 

In this step, you maintain the number ranges and intervals for the MRP documents. 

Here, you can create different number ranges for the following documents: 

- documents that are created during an automatic planning run 

- documents created during a manually controlled planning run 

26.5.3.1 Define Number Ranges for Planning Run 

In this step, you specify number ranges and intervals for the documents created during the planning run. 

These documents include: 

- planned orders for operative planning 

- planned orders for long-term planning (simulative planning) 

- dependent requirements and reservations 

- purchase requisitions 

- MRP lists 

Default Settings 

The following number ranges are preset in the SAP system: 

- planned orders 

internal number range 1 with interval from 1 to 19999999 

- MRP lists 

internal number range 1 with interval from 1 to 9999999999 

- reservations and dependent requirements internal number range 1 with interval from 1 to 

9999999999 
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- purchase requisitions internal number range 1 with interval from 10000000 to 19999999 

Recommendation 

You should work with the SAP system. In this case, you do not have to carry out any actions. 

Actions 

1. If necessary, specify at least one interval per document type. 

If you want to allow different number ranges for your plants, you have to specify different intervals. 

2. Allocate the intervals to the plant per document type. 

Note 

Only maintain your own intervals for the simulative planned orders, if you want to be able to recognize 

fro, the number of the planned order that it is a simulative planned order from long-term planning. 

If you do not want to make this differentiation, enter the same number range for simulative planned 

orders as you use for operative planned orders. 

26.5.3.2 Define Number Ranges for Manual Processing manually processing 

planned orders and purchase requisitions. 

Consequently, it is possible to differentiate the purchase requisitions that are created manually from the 

ones that are created automatically. 

Configuration 

In the SAP system, the following number ranges are preset: 

- for planned orders 

- internal number range 1 with interval from 1 to 19999999 

- external number range 2 with interval from 20000000 to 29999999 

- for purchase requisitions 

- internal number range 1 with interval from 10000000 to 19999999 

- external number range 2 with interval from 900000000 to 99999999 

Recommendation 

SAP recommends that you accept the settings defined in the standard system. In this case, no action is 

required on your part. 

Actions 

1. If necessary, define a new number range. 
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2. Assign a number range to each order type and document type. 

26.5.4 Master Data 

In this segment, you maintain the system parameters for material requirements planning which have 

master data status. 

26.5.4.1 Define MRP Controllers 

In this step, you define a number that is assigned to the MRP controller. 

The MRP controller is a person or a group of persons responsible for monitoring material availability. 

You can use the number entered here, for example, to select the planning results per MRP conroller. 

Every material that is relevant to the planning run must be assigned an MRP controller number in the 

material master record. 

You can also determine a special person for backorder processing who receives a mail if a goods receipt 

was posted for a missing part. You must enter the mail name of this person in the field entitled, recipient 

name. 

In addition, you can define a person or a group of persons, who are to informed if you send a mail from 

the MRP list or stock/requirements list to the MRP controller for the material displayed. 

Actions 

Enter the MRP controller and maintain the mail recipient, if necessary. 

26.5.4.2 Define Missing Parts MRP Controller 

In this step, you can specify MRP controllers for the processing of missing parts (backorder processing). 

Here, the system also displays which MRP controller was recorded as "mail receiver" if a goods receipt 

was posted for a missing part. 

Requirements 

You must already have processed the step, "Define MRP controller". 

Actions 

Create the missing parts MRP controller per plant. 
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26.5.4.3 Check MRP Types 

You use the MRP type to assign the procedure to be used to plan a material and to control which MRP 

parameters can be maintained for the material in the material master record. You enter the MRP type in 

the material master record. 

The following parameters of the MRP type are relevant for MRP: 

- MRP procedure 

The MRP procedure defines which of the following MRP types is to be used: 

- MRP 

- consumption-based planning (reorder point) 

- MPS 

- Indicator Firming type 

The firming type determines how order proposals are firmed and scheduled if 

you work with a planning time fence in the planning run. The following firming 

types exist: 

Firming type 0: Order proposals are not firmed automatically. 

With this firming type, no actual firming takes place. The materials only receive the indicator for MPS so 

that they can be planned using the special planning run for master production scheduling. This firming 

type only makes sense in combination with the MRP procedure MPS. 

Firming type 1: An order proposal that lies within the planning time fence is firmed automatically as soon 

as its date lies at least one day before the finish date of the planning time fence. The date of new order 

proposals that are actually created in the planning time fence are rescheduled out to the end of the 

planning time fence. Therefore, these new order proposals are not firmed. 

Firming type 2: An order proposal that lies within the planning time fence is automatically firmed as soon 

as its date lies at least one day before the end of the planning time fence. The system does not create any 

new order proposals within the planning time fence. That is, the shortage situation is not adjusted within 

the planning time fence. 

Firming type 3: Order proposals that lie within the planning time fence are not firmed automatically. The 

order proposals required to cover the requirements are moved to the end of the planning time fence. 

Firming type 4: Within the planning time fence, the system creates no order proposals automatically. That 

is, the shortage situation is not adjusted within the planning time fence. 

- Indicator: Planning time fence 

Using the planning time fence, you can exclude a certain period from the automatic planning run. In 

this period, only manual changes are made - depending on the firming type. The system will not 

create any order proposals within this period. 

For more information on the planning time fence, please refer to the IMG chapter entitled, "Master 

production scheduling". 
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- Indicator: Roll forward 

If you want to adjust the master plan to suit a changed requirements situation, you can do this by 

maintaining the indicator for deleting out-of-date planned orders. 

This indicator instructs the system to delete firmed order proposals that lie before the roll forward 

period during the planning run and to create new, correctly scheduled planned orders (or depending 

on the firming type they will be moved to the end of the planning time fence). 

You define the roll forward period in the workstep entitled, "Define planning time fence". For 

more information, please refer to the IMG chapter entitled, "Define planning time fence and roll 

forward period". Indicator: External requirements 

This indicator is only relevant for reorder point planning. It can be used to instruct the system to 

include customer requirements and manual reservationds in the MRP calculation for materails that 

are planned by reorder point. If a material is planned with this type of reorder point planning, then 

an entry is created in the planning file when creating or changing a sales order or a manual 

reservation. 

If you want to include requirements in the MRP calculation in addition to the customer 

requirements and manual reservations, select the following fields: - Requirements for materials 

to be provided in subcontracting 

- Dependent order reservations on the basis of production orders 

- Dependent order reservations on the basis of maintenance orders or networks 

- Release orders 

- Purchase requisition releases 

- Forecast delivery schedules Please note: 

The indicator Incl. external reqmts is only displayed if you selected the MRP procedure "reorder 

point planning". 

- Indicator: Plan regularly 

This indicator defines that materials with this MRP type are to be planned in regular intervals even 

if the material has not undergone a change relevant to planning. 

For materials that are to be planned regularly, you must also maintain the period in which the 

material is to be planned (at the latest). You do this via the MRP group. For more information, 

please refer to the IMG chapter entitled, "Define the maximum MRP period". 

- Forecast indicator 

You use this indicator to define whether the forecast is to be carried our or not. 

- Forecast consumption indicator 

You use this indicator to define which consumption values are to be used for the material forecast. 

- MRP indicator in forecast 

You use this indicator to define which requirements values are to be taken into consideration in the 

planning run. 
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- Calculate safety stock automatically 

You use this indicator to define whether the system is to calculate safety stock automatically. The 

safety stock can be calulated automatically for materials planned using MRP or using reorder point 

procedures if you have maintained a service level, if historical data exists and if the forecast has 

been carried out. 

- Calculate reorder point automatically 

You use this indicator to define whether the reorder point is calculated automatically. The reorder 

point is calculated for materials that are planned using reorder point if the procedure, "automatic 

reorder point planning" has been selected, if historical data exists, and if the forecast has been 

carried out. 

MRP list - extended header 

The screen sequence key controls the display of the extended header in the evaluations of MRP. 

That is, it controls which screens are to be displayed in the extended header and the sequence in 

which they are to be dispalyed. 

For more information, please refer to the IMG chapter entitled, "Screen sequence for ext. header 

(MRP list / stock/reqmts list): 

Default settings 

The following MRP types are defined in the SAP standard delivery: 

- ND => no MRP 

- PD => MRP 

- VB => manual reorder point planning 

- VM => automatic reorder point planning 

- V1 => Automatic reorder point planning including external requirements 

- V2 => Automatic reorder point planning without external requirements 

- VV => forecast-based planning 

Actions 

1. If necessary change the settings in the standard SAP syste. 

2. Add new MRP types to suit your requirements. 

26.5.4.4 Define Special Procurement Type 

In this step, you define the special procurement keys which as well as the procurement type control the 

procurement and storage of a material. The special procurement type always refers to a procurement type. 

You can now, also define how the system treats the material as a component during the BOM explosion 

using control indicators. 

Example 1 (special procurement keys without other indicators) 
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The procurement type "external procurement" is defined for raw materials. If a material is to be procured 

via a consignment order, you assign the special procurement type "consignment" to the material in the 

material master record. 

Example 2 (special procurement keys with other indicators) 

A material appears in several BOMs as a component because it is assembled in finished products in in-

house production. It is procured from an alternative plant if no dependent requirements exist for the 

material. 

The same material, on the other hand, is also sold from stock to customers, who need the material as a 

replacement part, for example. In this case, the material can be procured by stock transfer because with 

planned independent requirements (customer requirements, in this case), procurement you cannot use 

withdrawal from an alternative plant. 

You can do this by creating a special procurement key using the stock transfer special procurement type 

and by selecting the indicator for withdrawal from alternative plant. You assign this special procurement 

key to the appropriate material in the material master record. 

Default Settings 

The following special procurement types are defined in the SAP standard system: 

For the procurement type, "in-house production" 

- Phantom assembly 

A phantom assembly is a logical grouping of materials. These materials are grouped and managed 

together for a certain reason (for example, from the engineering point of view). However, a phantom 

assembly is not actually produced. Therefore, phantom assemblies pass the dependent requirements 

directly to the lower BOM level. 

- Production in another plant 

In this type of special procurement, material components are produced in a plant other than the 

planning plant. 

If you want to use this special procurement type, you must maintain a special procurement key by 

choosing 'planning plant -> production plant' for each relationship. 

- Withdrawal in alternative plant 

In this type of special procurement, the material components are withdrawn in a different plant to 

the planning plant. 

If you want to use this special procurement type, you must maintain a special procurement key per 

'planning plant -> withdrawal plant' relationship. 

This special procurement key is used to displace the stocking level of a BOM. If you use the 

planning strategy "planning without final assembly", the system only assemblies the assemblies that 

lie one BOM level below the finished product before any sales order has been received. If you want 

the stocking level to be even further down the BOM structure, the components receive the special 

procurement key "Phantom in planning". Assemblies with this special procurement key are not 

assemblies until sales orders at finished product level actually exist. 

For the procurement type "External procurement". 

- Consignment 
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You use this special procurement key to carry out consignment processing for a material. 

Consignment is a business process in which the vendor provides material at the customer. The costs 

are incurred by the vendor. 

- Subcontracting 

You use this special procurement type to carry out subcontracting with a material. In subcontracting, 

components are staged at an external vendor and are used to produce the required assemblies. 

- Stock transfer 

Here, materials are ordered from the receiving plant and are delivered by the delivering plant. The 

requirement is determined in the receiving plant. 

If you want to use this special procurement type, you must maintain a special procurement key per 

'receiving plant -> delivering plant' relationship. 

- Withdrawal in an alternative plant 

In this type of special procurement, material components are withdrawn from a different plant to the 

planning plant. 

If you want to use this special procurement type, you must maintain a special procurement key per 

"planning plant -> withdrawal plant" relationship. 

Actions 

Checking the special procurement key 

If you want to procure a material that is a BOM component in a way other than those in the standard 

special procurement types, you can define a special procurement type by selecting the following fields: 

- If you select Phantom item, the system uses a phantom assembly in the BOM explosion for a 

material that is used as a component in a BOM, regardless of which type of special procurement has 

been set. The phantom assembly characteristics can be combined with any other special procurement 

type. 

- If you select Direct production,the system uses direct productionin the planning run for a material 

that is used as a component in a BOM. Direct production can be combined with the special 

procurement type, production in an alternative plant. 

- If you select Withdrawal from an alternative plant, the system procures a material that is used as 

a component in a BOM by withdrawing it from an alternative plant. This only occurs if dependent 

requirements exist and is not dependent on the special procurement type defined. 

If you use storage location MRP and production or procurement is carried out directly for the storage 

location, you must create the following special procurement key: 

- in-house production (procurement type 'E', special procurement 'E') 

- external procurement (procurement type 'F', special procurement blank) 

Further notes 

The special procurement type is assigned in the material master record per material. 
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The procurement type is defined in Customizing for the material master record, in the material type. This 

means that every material is assigned the appropriate procurement type when creating its material master 

record. 

If you have selected the Phantom item field or direct production field for a special procurement key but 

you want to switch off this procurement type for a certain BOM item, select the appropriate key in the 

BOM item in the explosion type field. To maintain the explosion type in Customizing for the Bill of 

Material, choose Item Data -> Define explosion types. 

26.5.4.5 Maintain Planning Calendar 

In this section, you set the parameters that define a planning calendar. 

You use the planning calendar to define flexible period lengths for planning and procurement in demand 

management and in MRP. For this purpose, you can maintain period splits  of your choice (for example, 

Wednesday to Tuesday). If you work with the planning calendar, you can also display the period totals 

display in the MRP list or in the stock/requirements list according to your planning calendar periods. 

Example 

If, for example, a vendor always delivers his goods every second Wednesday, you can use the planning 

calendar to define a period length of two weeks starting on the Wednesday and ending on the Tuesday, 

two weeks later. The period lot size can also be set accordingly so that, on the one hand, the requirements 

are always grouped together within the defined period length, and on the other, the order proposals are 

planned in such a way that the delivery date lies at the end of the period. 

Note 

If you want to determine flexible procurement dates, the planning calendar is assigned to the material 

with the appropriate lot size in the material master record. 

Activities for maintaining the planning calendar 

 1. Create the planning calendar. 

1. Enter a key of up to three characters and a short description for the calendar. 

2. Enter a minimum period in workdays for the calendar. 

You use the minimum period to define a period that you require to reprocess the planning calendar. 

Calendars that are valid for a fewer number of days than is specified in the minimum period are proposed 

for maintenance when you select the function Cal. no longer valid 

3. Determine whether the SAP system is to choose either the previous or the following workday is a 

procurement date falls on a day that is not defined in the factory calendar. 

4. Select a calculation rule. 

The calculation rule determines the period split used to calculate the procurement date (for example, 

whether the period lengths are to be calculated per week, month, or year). 

5. Enter your date specifications in the period split. 
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6. Select, "Calculate periods". 

7. Enter a start date and a finish date to define the validity period of the planning calendar. The finish 

date must be greater than the minimum period. 

8. If necessary, change the periods displayed. 

Note 

If you want to determine the procurement dates for a material using the planning calendar, you must note 

that the receipts created in the planning run must lie within the validity period of the planning calendar. 

Otherwise the planning run will be terminated. 

Therefore, you must always make sure that sufficient calendar periods are available. 

Change planning calendar 

In this workstep, you can also change the calculation rule or the individual periods of the planning 

canendar as you require. 

You can also calculate new periods for a planning calendar that is no longer valid. For this purpose, the 

function Maintain calendars that are no longer valid in workstep, Change PPS planning 

calendar. 

1. Select the planning calendar that you want to change by entering the name of the planning calendar 

or you can select the "Calendar overview" button and in the following dialog box select the calendar 

you want to change. 

2. Change the planning calendar accordingly. 

3. Renew the calendar by selecting the function Cal.no longer valid. 

4. If necessary, create new periods. 

Displaying the planning calendar 

To display a planning calendar, proceed as follows: 

Select the planning calendar that you want to display by entering the name of the planning calendar or 

you can select the "Calendar overview" button and in the following dialog box select the calendar you 

want to display. 

1. Then select the appropriate function for displaying the planning calendar you are interested in. 
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26.5.4.6 MRP Areas 

In this IMG activity you define whether MRP is to be carried out with MRP areas. In addition, you 

define the MRP areas for each plant in which you would like to carry out this type of materials 

requirements planning. 

The MRP area represents an organizational unit which carries out materials requirements planning 

independently. The results of the planning run are displayed specifically for each MRP area. An MRP 

area can include one or several storage locations of a plant or stock with a subcontractor. 

You can assign a material to various MRP areas. 

Basically, there are three types of MRP areas: 

- Plant MRP Area 

Initially, the plant MRP area includes the plant with all its storage locations and stock with 

subcontractors. When you have defined MRP areas for storage locations and for subcontractors and 

you have assigned the materials, the plant MRP area is reduced by exactly this number of 

subcontractors and storage locations, as they are now to be planned separately. 

- MRP Areas for Storage Locations 

You can define an MRP area that consists of a particular storage location by creating an MRP area 

and assigning the storage location to it. Material requirements for this storage location are then 

planned separately from the rest of the plant. You can also group several storage locations into one 

MRP area by creating an MRP area and assigning the storage locations. These storage locations are 

then planned together. 

- MRP Areas for Subcontractors 

You can also define an MRP area for each subcontractor. Using an MRP area, it is possible to plan 

the components to be provided in subcontracting, by defining an MRP area for each subcontractor 

and assigning the components to be provided. You can therefore plan the requirements to be 

provided for these components for one subcontractor separately from the usual requirements. 

Up to now, MRP at plant level had been carried out. The various requirements were combined in the 

planning run and procurement elements were created for these pegged requirements with unknown 

sources. 

The introduction of MRP areas enables you to carry out material requirements planning and know the 

source of the pegged requirements and to be able to distinguish between them. The source of the pegged 

requirements can be, for example, production on a particular assembly line or a subcontract order. 

Material requirements planning for each MRP area allows you to have specific control over the staging 

and procurement of important in-house production parts and purchased parts for each shop floor and 

assembly area. 

26.5.4.6.1 Define MRP Areas 

In this IMG activty, you define the MRP area for every plant for which you would like to carry out 

material requirements planning separately. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 368 

When creating an MRP area, you enter the number, which must have at least 5 digits to avoid any 

overlapping with the plant MRP area, the description and the MRP area type. You must also enter a 

storage location as a receiving storage location. This storage location must, however, belong to the MRP 

area. Finally, you assign the storage location or the vendor number of the subcontractor to the MRP areas. 

You asssign the materials to the MRP areas by creating a segment for the MRP area in the material master 

record. 

There are basically three types of MRP areas: 

- Type 01 for Plant 

The plant MRP area initially contains the plant together with all its storage locations and stock 

with subcontractors. The plant MRP area is created automatically when you convert the existing 

planning file entries to planning file entries for MRP areas. When you have defined MRP areas for 

storage locations and for subcontractors and you have assigned the materials, the plant MRP area 

is reduced by exactly this number of subcontractors and storage locations, as they are now to be 

planned separately. If you have not assigned a material to an MRP area, that is, you have not 

created an MRP area segment in the material master record, the material will continue to be 

planned in the plant MRP area. 

- Type 02 for Storage Locations 

You choose this type for MRP areas that consist of one or more storage locations. A storage location 

can only be assigned to one MRP area. 

- Type 03 for Subcontractors 

You choose this type if you would like to define an MRP area for a subcontractor. You can only 

assign one subcontractor to an MRP area of the subcontractor type. 

Example 

You specifically want to plan the requirements for components of an assembly line. To do this, you define 

an MRP area of the type storage location  and assign the storage location from which you are taking 

the components that are required on the line. 

Requirements 

- You have converted the existing planning file entries at plant level to planning file entries at MRP 

area level. 

- You have activated material requirements planning for MRP areas. 

Activities 

To define a new MRP area, proceed as follows: 

1. Starting from the MRP area overview, choose New entries. 

2. Enter the number and description of the MRP area. You can choose an alphanumeric MRP area 

number; it must, however, be 5 digits long. 
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3. Choose Save and then Exit. 

4. Call up the IMG activity Define MRP areas again and select the MRP area and choose Storage 

location if you want to define an MRP area of the storage location type or choose Subcontractor if 

you want to define the MRP area for a subcontractor. 

5. You assign one or several storage locations to an MRP area of the storage location type. You assign 

a subcontractor to an MRP area of the subcontractor type by entering the supplier number in the 

field MRPa. Sub. 

6. Save the entries and choose Back. 

Further notes 

Due to the conversion of the planning file entries at plant level to MRP area level, the system has already 

created an MRP area of the type plant for every plant. 

26.5.4.6.2 Maintain Mass Data 

When you activate MRP with MRP areas, it may be necessary to assign a large number of MRP areas to a 

material. For example, this would be the case when materials for various automobiles are stocked in spare 

part warehouses for customer service technicians, and each automobile is planned as an individual MRP 

area. 

SAP provides six function modules (function group MD_MGD1), with which you can program your own 

mass transactions. 

These function modules include: 

- Copy with plant or MRP area template (MD_MRP_LEVEL_CREATE_AS_COPY) 

You create new MRP area segments as a copy of the plant MRP data or as a copy of an existing 

MRP area segment. 

- Creation with MRP/forecast profile (MD_MRP_LEVEL_CREATE_PROFILE) 

You create MRP area segments by assigning an MRP profile or a forecast profile, both of which are 

records of previously defined standard information that has been saved as a profile. 

- Creation with data (MD_MRP_LEVEL_CREATE_DATA) 

You create a new MRP area segment by entering concrete MRP or forecast data. 

- Change with MRP/forecast profile (MD_MRP_LEVEL_CHANGE_PROFILE) 

You change existing MRP area segments by assigning an MRP profile or a forecast profile. 

- Change with data (MD_MRP_LEVEL_CHANGE_DATA) 

You change existing MRP area segments by entering concrete MRP or forecast data. 

- Set deletion indicator (MD_MRP_LEVEL_CHANGE_DELETION) 

You set or delete the deletion flag for MRP area segments. 

Requirements 
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- You have converted the existing planning file entries on plant level into planning file entries on 

MRP area level. 

- You have activated MRP for MRP areas. 

- Where appropriate, you have created at least one MRP area segment. 

- Where appropriate, you have created an MRP profile or a forecast profile. 

Standard settings 

SAP provides the example report RMMDDIBE, which integrates all the function modules. You activate 

the report by using the menu path System --> Services --> Reporting. You can save the result of the 

report and check it by using transaction SLG1. 

The report is only an example, and is neither maintained nor developed further by SAP. 

Activities 

Where appropriate, program your own mass transactions based on the report provided. 

26.5.4.7 Independent Requirements Parameters 

In this step, you define the independent requirements parameters: 

- planning strategies, that is, possible requirements types for planning independent requirements and 

customer requirements 

- consumption mode per plant for the consumption of planned independent requirements by customer 

requirements 

26.5.4.7.1 Planning Strategy 

In this step, you define the possible planning strategies for demand management and sales order 

maintenance. Here, you also group the strategies into strategy groups which, in a third step, can be 

assigned to an MRP group. 

The planning strategy defines the procedure to be used for the planning of a material. Technically 

speaking, it is controlled via the requirements types. If a planning strategy has been defined for a 

material, this material is then automatically assigned the correct requirements type in demand 

management and in sales order maintenance. 

- Strategy 

The planning strategy represents the procedure to be used to plan a material. 

The planning strategy is either defined by; 
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- a requirements type from demand management or 

- by a requirements type from sales order maintenance, or 

- by a sensible combination of both a requirements type from demand management and a 

requirements type from sales order maintenance 

The strategies available for creating the demand program can be found in step, "Define strategy". 

- Strategy group 

You use the strategy group to group together the available planning strategies. This means that you 

can allow several planning strategies for one particular material. 

- Allocate a strategy group to an MRP group You can allocate the strategy to an MRP group. 

Two options are available for finding the correct requirements type in sales order maintenance and 

in demand management: 

1. You assign the strategy group to an MRP group and then you enter this MRP group in the material 

master record of the appropriate materials. This means that you can allocate more than simply the 

strategy group to a material as other control parameters for the planning run are also contained in 

the MRP group. 

2. You can also enter the strategy group directly in the material master record. 

Actions 

1. Check the planning strategies 

2. Assign the strategy(ies) into strategy groups 

3. If necessary, assign the strategy groups to the MRP groups 

26.5.4.7.1.1 Define Strategy 

The planning strategy represents a procedure to be used for planning a material. 

It is defined by; 

- a requirements type from demand management, or 

- a requirements type from sales order maintenance, or 

- a combination of both that makes sense 

Default settings 

The planning strategies are predefined in the standard SAP system. 

Recommendation 
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SAP recommends that you use the standard SAP planning strategies. 

Actions 

Enter new planning strategies, if necessary. 

26.5.4.7.1.2 Define Strategy Group 

In this step, you specify which strategies are to be grouped together into a strategy group. You can 

determine a main strategy as well as a maximum of seven alternative strategies. 

Note 

The main strategy is proposed in demand management or sales order management but it can be 

overwritten by another planning strategy defined in the strategy group, if necessary. 

You can assign the strategy group to the material directly in the material master record or you can first 

assign the strategy group to an MRP group and then in a second step, you can assign the MRP group to 

the material in the material master record. 

Default settings 

In the standard SAP system, the strategy groups are preset. 

Actions 

1. Check the strategy groups contained in the standard SAP System. 

2. Specify new strategy groups, if necessary. 

26.5.4.7.1.3 Assign MRP Group to Strategy Group In this step, you allocate a 

strategy group to the MRP group. 

If an MRP group is maintained for a material, the strategies specified in the strategy group are allowed for 

this material. 

In order to find the correct requirements type in demand management and in sales order management, you 

have to: 

a) allocate the strategy groups to the MRP groups, and 

b) allocate the MRP groups to the materials to be planned in the material master record. 

or 

Enter the strategy group directly in the material master record of the material to be planned 
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Actions 

Maintain the allocation of strategy groups to MRP groups. 

26.5.4.7.2 Define Consumption Mode and Period of Adjustment 

In this step, you define the (time) control parameters per plant and MRP group for the consuption of 

planned independent requirements and customer requirements/sales orders. You also define the period of 

adjustment. 

Consumption parameters 

The consumption parameters are used for all planned strategies where consumption takes place. 

The plant parameters are only used if no material-specific consumption mode and/or consumption 

interval has been maintained. 

- Consumption mode 

The consumption mode defines the direction on the time axis in which requirements are consumed. 

If no entry has been made in the field, Consumption mode, the system will only carry out 

backward consumption, that is, customer requirements only consume planned independent 

requirements that lie before the customer requirements. 

- Consumption interval (forward/backward) 

- The consumption interval determines the interval in which a consumption should take place. 

The consumption intervals are maintained in calendar days. 

If no consumption interval has been maintained, the customer requirements can only consume the 

planned independent requirements that are planned on exactly the same day. 

Period of adjustment and adjustment indicator 

You use the adjustment function to define that only customer requirements are relevant for the planning 

run in a predefined period (that is the period of adjustment). The system creates no order proposals in the 

planning run for planned independent requirements that lie within the period of adjustment and for which 

no firmed receipts and no firmed order proposals have been planned. The period of adjustment is 

maintained in calendar days. 

You can use the adjustment indicator to define whether the number of days are to be calculated from the 

current date in the past or in the future. Or, whether the period of adjustment is valid for planned 

independent requirements of all planning strategies or only for those in which consumption takes place. 

Note 

The period of adjustment is only valid if the adjustment indicator has been maintained as well. 

Actions 

Define the consumption mode as well as the consumption interval at plant level. If necessary, maintain 

the period of adjustment and the adjustment interval. 
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26.5.5 Planning 

In this step, you make settings required for the planning run and the planned orders of material 

requirements planning. 

26.5.5.1 Define Scope of Planning for Total Planning 

Note 

This IMG activity is only relevant if you plan some of your materials using classic MRP. If you plan all 

your materials using MRP Live, this IMG activity is irrelevant.  

In this IMG activity, you define the scope of planning and the sequence of the organizational units to be 

planned. These are either plants or, if you have converted MRP to MRP at MRP area level, the MRP 

areas that you plan together in a total planning run. 

You enter the key for the planning run in the initial screen of the total planning run. The total planning 

run then carries out MRP for the plants or MRP areas defined in the scope of planning. 

You can enter as many plants or MRP areas as you like in the scope of planning. You can also only enter 

one MRP area. MRP is then only carried out for one MRP area. 

If you have activated MRP for MRP areas, when you enter a plant, this includes all MRP areas of this 

plant. 

Activities 

1. Choose New entries. 

2. Enter a key and a description for the scope of planning that you would like to define. Save your 

entries. 

3. Select the scope of planning and choose Sequence of plants/MRP areas. 

4. Choose new entries and enter the plants or the MRP areas in the sequence in which they are to be 

planned. The counter determines the sequence. 

5. Save your entries. 

Further notes 

- You can carry out the total planning run for the scope of planning online or in background mode. 

The planning run, however, must always be started with parallel processing. 
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- Planning file entries created via stock transfer are automatically taken into account in the planning 

run. This ensures that a material is also correctly planned in all plants affected even in the case of 

stock transfer processing. 

26.5.5.2 Define Creation Indicator 

Note 

This IMG activity is only relevant if you plan some of your materials using classic MRP. If you plan all 

your materials using MRP Live, this IMG activity is irrelevant. 

In the initial screen for the planning run, you can use the creation indicator to determine whether purchase 

requisitions are always to be created or whether they are only created in the opening period, or whether 

delivery schedules are to be created, and so on. 

In this step, you can define special creation indicators for the MRP groups: 

- creation indicator for purchase requisition 

- creation indicator for MRP lists 

- creation indicator for delivery schedules 

The values specified here are taken into account in the planning run The 

following is valid for total planning: 

The creation indicators that you manually entered at the beginning of the planning run only has default 

status. They are only valid, if the SAP system does not find any creation indicators via the MRP group. 

The following is valid for single-item planning: 

Here, only the settings in the initial screen are valid. The settings made in Customnizing have no effect. 

Actions 

Determine the creation indicators for the MRP groups. 

26.5.5.3 MRP Calculation 

In this step, you determine the settings required for the MRP calculation. 

26.5.5.3.1 Define Planning Time Fence and Roll Forward Period 

In this step, you define the planning time fence and the roll forward period. 

- Planning time fence 

You use the planning time fence to define a period during which the MRP list is to be protected 

from any automatic changes. In this period, no order proposals are automatically changed or created 

- depending on the fixing type maintained in the MRP type. Thus, the MRP controller can check the 
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planned order within this period (dates and capacitites) before the planning result effects the lower 

BOM levels. 

- Roll forward period 

To automatically update the master plan, you can set the system so that firmed planned orders that 

were scheduled before the roll forward period can be deleted during the planning run. With this 

function, all planned orders, for which there are no longer any requirements, are deleted. 

Note on roll forward period 

In step "check MRP types", you can maintain the indicator "Delete out-of -date planned orders" 

which is used to set the system so that firmed order proposals, that lie beforethe roll forward period, 

are deleted in in the planning run. At the same time, new planned orders are created that are adjused 

to the current situation. (Or depending on the fixing type the old order proposals are displaced to the 

end of the planning time fence.) 

Actions 

1. Define the planning time fence per plant and MRP group. 

2. Define the roll forward period. 

26.5.5.3.2 Stocks 

In step, "Stocks", you determine how the following stocks are to be dealt with in the planning run: 

- safety stock 

- stock in transfer 

- blocked stock 

26.5.5.3.2.1 Define Safety Stock Availability 

In this step, you define the percentage of the safety stock to be available for planning. This function is 

used to avoid a situation where order proposals are created unnecessarily by the system to cover small 

shortage quantities. 

In MRP, the system usually carries out the lot-size calculation for every shortage and creates an 

appropriate order proposal or - if already available - a firm receipt with a rescheduling proposal. 

However, it does not always make sense for a new order proposal to be created for every small shortage. 

These order proposals must all be managed, converted, placed in stock and settled. If you want to save 

yourself this effort, you can make a portion of the safety stock available for planning. This has the 

following consequences: 

- An order proposal is not created until the stock level has fallen below the safety stock available for 

planning 
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- If the shortage exceeds the portion of safety stock available for planning, then the system creates an 

order proposal in the planning run that covers this requirement and that also replenishes the safety 

stock. 

- The portion of the safety stock available for planning can only be determined using the MRP group. 

Therefore, to determine that a certain percentage of the safety stock of a particular material is to be 

available for planning, this material must have been given the appropriate MRP group in the 

material master record. 

Example: 

                           Mat. 1         Mat. 2         Mat. 3 

---------------------------------------------------------------------- 

-Safety stock:              100 pc         100 pc          100 

pc available for planning:      0%            50%             

50% Shortage quantity            1 pc           1 pc           

51 pc 

Order proposal quantity 

for lot-for-lot order qty    1 pc           0 pc           51 pc 

Actions 

Define per plant and per MRP group the percentage of the safety stock that is to be available for planning. 

26.5.5.3.2.2 Define Availability of Stock in Transfer/Blocked Stock/Restricted 

Stock 

In this step, you define whether stock in transfer (plant to plant) and/or blocked stock are included as well 

as restricted-use stock as available stock in the net requirements calculation. 

Stock in transfer is the quantity that has already been withdrawn from the issuing plant (movement type, 

remove from storage - plant) but that has not yet been received by the receiving plant (movement type, 

place in storage - plant) 

The system treats this stock as stock in transfer (plant to plant) for the receiving plant until the material is 

actually received and posted. 

Note 

Stock in transfer is the quantity transferred by a stock transfer in inventory management. It is NOT the 

quantity that is transferred due to stock transport orders. 

The quantity transferred due to stock transfer orders is posted to stock in transit. 

Actions 

Define the available stocks per plant and MRP group. 
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26.5.5.3.3 Define Rescheduling Check 

The rescheduling period represents the period in which the system checks whether the existing dates of 

the receipt elements that are no longer allowed to be changed automatically still suit the requirements 

situation. If the dates of these elements are no longer suitable, the system creates the following exception 

messages depending on the requirements situation: 

- Bring operation forward, if the date of the requirement lies before the date of the receipt element. 

- Postpone operation, if the date of the requirement lies after the date of the receipt element. 

- Reverse operation, if the requirement no longer exists. 

When determining the rescheduling period, take the period in which a precise planning run is to be 

carried out into account. You define the rescheduling period per plant or per MRP group. 

You use the tolerance values to determine whether a tolerance period exists in which no exception 

messages are created. 

The following receipt elements are not changed in the planning run. 

- firmed planned orders 

- firmed purchase requisitions 

- purchase orders 

- production orders 

- QM inspection lots 

You can define which of the above mentioned receipt element are to be provided with a rescheduling 

proposal for rescheduling in. Rescheduling proposals for rescheduling out are always created for all 

receipt elements. You can also determine a time tolerance for the rescheduling proposal, that is, a 

tolerance by which the requirements date is allowed to deviate from the order finish date or the delivery 

date. Only once this tolerance value is exceeded, will the system create a rescheduling proposal. 

Note 

- If you maintain no rescheduling period, the system will not carry out a rescheduling check. This 

means, the system does not create an exception message for firm order proposals. For every newly 

planned requirement, the system will create an appropriate receipt element without first checking the 

firmed receipts that already exist, although their dates are unsuitable. 

- The system calculates the rescheduling horizon from the end of the replenishment lead time in 

reorder point planning. 

Recommendation 

In joint production it is not possible to reschedule receipt elements at will, because the goods receipt 

depends on the planning run for another material. For this reason, it is best to use a very small 

rescheduling horizon. 

Actions 
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1. Define the rescheduling period for the plants or for the MRP groups. 

2. Decide which receipt elements are to be included in the rescheduling check. 

3. Define the tolerances for the plants and the MRP groups within which you want no rescheduling 

proposals. 

26.5.5.3.4 Define Error Processing in the Planning Run 

In this step, you specify how the system is to proceed if errors occur during the planning run. 

To do this, you specify the following: 

- Planning run 

- Maximum number of purchase order proposals per date 

If you have selected a fixed or maximum lot size, the number of purchase order proposals 

created during the planning run is determined in lot sizing. If more purchase order proposals 

are created during the planning run than the upper limit specified here, the planning run is 

terminated for the material in question and a termination message appears. 

- Substitute MRP controller for MRP 

If the system cannot determine the correct MRP controller when carrying out the planning run, 

it will then refer to the substitute MRP controller. If the system cannot determine an MRP 

controller during termination of the planning run, it will record the substitute MRP controller 

in the MRP document. These documents are found in the collective display of the MRP list - 

by selecting according to the substitute MRP controller. 

- Delete planning file entry 

If the planning run was terminated for a particular material, the entry usually remains in the 

planning file. This ensures that the material will be included in the next planning run. The MRP 

controller can select all terminated materials in the collective display of the MRP lists to correct the 

problem. In this step, you can set the system so that it deletes the planning file entry for certain 

termination situations and the material is excluded from the planning run if this situation, which 

means the error message, occurs. The material will then only be re-included in the planning run 

when it undergoes another change and the change is relevant to MRP, or when the MRP controller 

executes regenerative planning. Existing MRP lists for this material are not deleted. They can only 

be deleted by the MRP controller manually or by the appropriate report. 

Default Settings 

In the SAP standard system, no indicators for the planning file entry are made for the following error 

messages: 

- material does not exist 

- error reading forecast parameters 

- error reading forecast values 

Actions 
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1. Specify the maximum number of order proposals for the plants. 

2. Select a substitute MRP controller for each plant. 

3. Mark the error messages for which the indicator for the planning file entry in the planning file is to 

be deleted. 

26.5.5.3.5 Define Range of Coverage Profile (Dynamic Safety Stock) 

In this IMG activity, you specify the range of coverage profile for calculating the dynamic safety stock. 

With the dynamic safety stock, you can determine a safety stock based on requirements and range of 

coverage. The dynamic safety stock adapts automatically to the changed requirements and is fully 

available for planning purposes. 

You can limit the quantities used in the calculation of the dynamic safety stock by defining maximum and 

minimum ranges of coverage. You can also limit the period of time by defining different time periods in 

which the range of coverage is valid. 

Periods with different ranges of coverage 

Note 

In MRP, the dynamic safety stock is added to the order proposal quantity. 

You can display the parameters for calculating the dynamic safety stock in the MRP evaluations in the 

"Period Totals" display. 

The system uses the following formula to calculate the range of coverage: Average requirements * 

Range of coverage 

The individual parameters are described below: 

- Average daily requirements 

The following formula is used to calculate the average daily requirements: 

Requirements in the specified periods/Number of days for the total period length 

To calculate the average daily requirements, you have to maintain the following parameters: 

- Period indicator 

With this indicator, you specify the calendar period for which you want to calculate the 

average requirements. 

The following entries are possible in this case: 

* Weeks (W) 

* Months (M) 

* Planning calendar periods (K) 

- Type of period length 
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With this indicator, you specify the detailed period length. 

The following entries are possible in this case: 

* Workdays 

* Calendar days 

* Standard days 

If you set standard days as period length, you have to specify the number of days per period in 

field "Days per period". 

- Number of periods 

Here you specify how many periods you use for calculating the average requirements. 

- Defining the range of coverage 

You can specify a range of coverage for up to three different periods and you can maintain a 

different range of coverage for each period. 

To do this, you have to specify the ranges of coverage and the number of periods in the 'Define range of 

coverage' screen. 

If you only want to maintain one range of coverage with no period limitation, enter your range of 

coverage parameters for the first period and leave the field 'Number of periods' blank. 

You can also limit the range of coverage in each of the three periods by defining a maximum and 

minimum range of coverage. The system checks whether the actual range of coverage (available quantity 

/ average requirements) exceeds the maximum range of coverage or falls below the minimum range of 

coverage. If this is the case, the dynamic safety stock is calculated on the basis of the target range of 

coverage. 

Example 

- Average daily requirements 

- Requirements of the 1st period:   1000 

- Requirements of the 2nd period:   2000 

- Calendar period:                  Week 

- Period length:                    Standard days (5 days) 

- Number of periods:                2 

Calculation of the average requirements: 

(1000 + 2000)/(2*5) = 3000/10 = 300 

- Range of coverage 

- Range of coverage for period 1:     2 

- Period 1:                           2 weeks 

- Range of coverage for period 2:     4 
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- Period 2:                           3 weeks 

Average requirements * range of coverage 1: 

300 * 2 = 600 

That means, for the first two weeks from the MRP date, a safety stock level of 600 parts is planned. 

Average requirements * range of coverage 2: 

300 * 4 = 1200 

That means, for the first three weeks from the MRP date, a safety stock level of 1200 parts is 

planned. 

Activities 

Define the range of coverage profile. 

26.5.5.3.6 Define Period Profile for Safety Time/Actual Range of Coverage 

In this IMG activity, you define the period profile for the safety time/actual range of coverage. 

However, this is only necessary if you want to plan certain periods using a different actual range of 

coverage from the one you defined in the material master in the safety time / actual range of coverage 

field or you also want to take account of a safety time that is less than one day. 

Example 

During the christmas period, a higher actual range of coverage is to be used than in the other months. In 

this case, you define a period profile and define the period as well as the desired safety time (actual range 

of coverage). 

Activities 

1. You define the period profile. 

2. Define the period and the number of days. 

You can maintain several periods with various actual ranges of coverage for each profile. 

The periods, however, are not allowed to overlap. 

You can define the actual range of coverage as 0. 

3. Enter the period profile in the material master. 

Further notes 

In the planning run, the system checks whether a period profile has been defined and whether the 

requirements date falls in one of the defined periods. If yes, the system uses the actual range of coverage 

defined in the profile. If not, the system uses the value defined in the material master. 

26.5.5.4 Lot-Size Calculation 
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In this step, you define the lot-sizing procedure and the rounding profile. 

With the lot-sizing procedure you define how the order quantities are determined. 

The rounding profile is used to round order quantities either up or down to deliverable quantities. 

26.5.5.4.1 Check Lot-Sizing Procedure 

You use the lot-sizing procedure to determine how the system is to calculate the reorder quantity in the 

planning run. 

A lot size defining the lot-sizing procedure is assigned to every material master record applicable to 

materials planning. 

The lot size is defined in Customizing by the combination of the lot-sizing procedure and the lot-sizing 

indicator. 

Three procedures for lot sizing are available: 

- static lot-sizing procedures 

- period lot-sizing procedures 

- optimizing lot-sizing procedures 

You use the lot-size indicator to define the procedure. 

The following parameters are also available for controlling the lot-sizing procedure: 

- Short-term and long-term lot size 

You can split the lot-sizing procedure into a short-term and a long-term period. This means that you 

can select one lot-sizing procedure in the near future and a different one in the distant future. 

You define the periods in the section of the screen entitled "End of the short-term period/start of the 

long-term period". 

The valid from date of the long-term lot size area is defined via: 

- a periodicity 

- a number of periods 

The beginning of the long-term period is calculated by taking todays' date and adding the number of 

periods in the future; the long-term planning period then starts on the next complete period. 

Note 

For materials that are planned using the short and long-term lot size, it is recommended that you 

define a maximum MRP period. Defining the MRP period has the effect that materials after a 

certain period are included in planning even if no changes relevant to the planning run have 

occurred. This avoids a situation where order proposals created with the long-term lot size move 

into the short-term period because no changes relevant to MRP have occurred for the material. 

You define the maximum MRP period in the step, "Define maximum MRP period". A material that 

is planned on a regular basis should also be provided with an MRP type that contains the indicator 

for regular MRP. 

- Scheduling indicator 
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For period lot sizes, you can use the indicator for scheduling to determine whether the availability 

date; 

- is to be set to the first requirements date in the period 

- or is to be set to the beginning of the period 

- is to be set to the end of the period 

- or whether the period start represents the beginning of the planned order and the period end 

represents the availability date (repetitive manufacturing) 

- Interpretation of the delivery times 

For the lot-sizing procedure, you can also define whether the period start is to be interpreted as the 

delivery date or as the availability date using the indicator, "interpretation of the calendar times". 

NOTE 

The indicators, Scheduling and Interpr.deliv.times are mutually exclusive. 

- Indicator for the splitting quota 

For the quota arrangements, you can determine whether the requirements quantities are to be 

distributed to several items, that is, whether they are to be split. With the splitting quota 

arrangement, requirement quantities are not simply allocated to the smallest quota rating. Instead, 

they are distributed among various sources using the following formula: 

Quantity for source of supply X = Quota of source X * reqmts quantity 

                                  ------------------------------------ 

                                           Sum of all quotas 

- Overlapping indicator 

The overlapping indicator along with the cycle time in the material master record are used 

to split the planned orders into several partial quantities whereby the in-house production time 

overlaps by the cycle time. 

- Lot-sizing procedure for make-to-order production 

In make-to-order production, you can use the indicator, Lot size for make-to-order production to 

determine whether, 

- the order quantity is to be calculated using the exact lot size 

- the order quantity is to be calculated using the exact lot size and the system is also to take the 

rounding quantity or the minimum and maximum lot size into account 

- the order quantity is to be calculated using the lot-sizing procedure defined for the short-term area 

- Maximum stock level variant 

The system only displays the Maximum stock level variant field in the lot-sizing procedure, 

Replenishing to maximum stock level. The indicator only has an effect in connection with 

reorder point planning taking external requirements into account and in connection with material 

requirements planning and controls how the system calculates lot sizes. 

Standard settings 

In the SAP standard system, the lot-sizing procedures are preset. 
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Recommendation 

SAP recommends that you use the lot-sizing procedures in the standard system. 

Actions 

- If necessary, adjust the number of periods for the period lot size to the SAP standard delivery. 

- If you are using reorder point planning taking external requirements into account, check how the 

system is to calculate lot sizes using the lot-sizing procedure, Replenish to maximum stock level, 

and enter the appropriate indicator in the Maximum stock level variant field. 

- If necessary, define new lot-sizing procedures. 

- If necessary, maintain further parameters. 

26.5.5.4.2 Maintain Rounding Profile 

In this IMG activity, you define the rounding profile in order to adapt the units of measure in material 

requirements planning to the delivery and transport units, for example, if purchase orders can only be 

delivered in bundles of 10 pieces. 

With the rounding profile, you can define settings for rounding up/down order proposal quantities to 

deliverable quantities. 

There are two different types of rounding profiles; one for the core application and a rounding profile for 

Retail application: 

- Statistical rounding profile for MRP in the standard system 

- Dynamic rounding profile and quantity to be added/subtracted profile for Retail functions (see also: 

Rounding profiles in Purchasing). 

The statistical rounding profile for MRP is made up of: 

- Level 

- Threshold value 

- Rounding value 

You can define several combinations of threshold and rounding values for a rounding profile. The 

individual combinations are then assigned a level. 

The threshold value is the value from which the system rounds up to the next deliverable quantity. If the 

threshold value is not reached, the system rounds the quantity according to the next lower level. If the 

lowest level is not reached, then the system rounds up to a multiple of the rounding value, if the 

requirements quantity is larger than the threshold quantity. Otherwise, the requirements quantity remains 

unchanged. 

The rounding value is the value to which the system rounds the quantity if the threshold value is 

exceeded. 
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Examples 

A material has the base unit of measure 1 unit; the purchase order is to be supplied in layers (1 layer is 

equal to 5 units) or in palettes (1 palette is equal to 8 layers equal to 40 units). 

You maintain the profile as follows: 

From a requirement of 2 units, the system is to round up to 5; from a requirement of 32 units the system is 

to round up to 40. 

This results in the following order proposal quantities: 

Requirement of 1 -> 1 Requirement of 31 -> 35 

Requirement of 2 -> 5 Requirement of 32 -> 40 

Requirement of 6 -> 10 

Requirement of 7 -> 10 

Requirement of 41 -> 45 

Activities 

Maintain the rounding profiles. 

26.5.5.5 Scheduling and Capacity Parameters 

In this step, you define the following parameters: 

- the floats for determining the basic dates and lead time scheduling 

- the scheduling levels for capacity planning 

- the detailed control for lead time scheduling 

26.5.5.5.1 Define Floats (Scheduling Margin Key) 

In this step, you specify the floats for determining the basic dates of the planned orders. The floats are 

allocated to the material via the release period key in the material master record. 

- Opening period 

The opening period represents the number of workdays that are subtracted from the order start date 

in order to determine the order creation date. This time is used by the MRP controller as a float for 

converting planned orders into purchase requisitions or into production orders. 

- Float before production 

The float before production represents the number of workdays that are planned as a float between 

the order start date (planned start date) and the production start date (target start date). 

On the one hand, this float is intended to guarantee that delays in staging a material do not delay the 

production start. On the other hand, the production dates can be brought forward by means of the 

float to cope with capacity bottlenecks. 

- Float after production 

The float after production should provide a float for the production process to cope with any 

disruptions so that there is no danger that the planned finish date will be exceeded. You plan the 
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float after production between order finish date (planned finish date) and scheduled end (target 

finish date). 

- Release period 

The release period represents the number of workdays that are subtracted from the order start date in 

order to determine the production order release. The release period is only relevant for production 

order management. 

Recommendation 

The opening period should reflect the processing time the MRP controller needs to convert planned 

orders into purchase requisitions or production orders. The opening period should be at least as long as 

the interval between two MRP intervals, so that all planned orders can be taken into account during the 

conversion. 

Actions 

Specify the floats. 

26.5.5.5.2 Parameters for Determining the Basic Dates In this step, you can 

determine per plant, that the system will not automatically switch to 

forward scheduling in the calculation of the basic dates if the planned start 

date lies in the past. 

If this indicator is set, the system will only use the backward scheduling procedure for calculating the 

basic dates, even if the start date ends up in the past. 

Activities 

If required, maintain the indicator per plant. 

26.5.5.5.3 Define scheduling parameters for planned orders 
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In this step you define the parameters for scheduling planned orders for each plant, order type and 

production scheduler. This comprises the following settings: 

- date adjustment when deadlines are exceeded 

- scheduling control for detailed scheduling 

- reduction 

The parameters are described in detail in what follows: 

- In detailed scheduling you define: 

- how production dates are determined - whether capacity requirement are generated -

 In Adjust Scheduling you specify: 

- that the takt time/rate-based scheduling determines sequencing for planned order dates. 

If you select this indicator, the dates determined by takt time-/rate-based scheduling are not 

overwritten by those determined in lead time scheduling. The basic dates are also not 

adjusted. Lead time scheduling is used to calculate capacity requirements and their dates. 

- whether and how basic dates are adjusted to production dates (for example, when exceeding 

dates) and what the dates for dependent requirements should be 

- In scheduling control for detailed scheduling you specify the control parameters for 

detailed scheduling, among other things 

- Scheduling type 

Here you specify the scheduling direction. You can also specify that a scheduling run should 

only be used to generate capacity requirements. 

- Start date in the past 

Here you specify how many days an order may lie in the past before today scheduling  is 

automatically triggered. 

- Automatically calculate dates 

Here you specify whether scheduling is automatically carried out on saving 

- Display log automatically 

Here you specify whether the log is automatically displayed after scheduling. 

- Required date of material 

Here you specify where the required date for a component should be with respect to the 

operation. 

- Schedule exact to the break 

Here you specify that the break times should be taken into account exactly. 

- Under reduction you specify 

- whether in the order or in the collective order all the operations are reduced or only those on 

the critical path. Reduction along the critical path is only possible for production orders and 

planned orders with parallel sequences and for collective orders that contain production orders 

or planned orders. 
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- up to which maximum reduction level the reduction is to take place 

- to what percentage the floats before and after production in every reduction level should be 

reduced. 

Actions 

Define the scheduling parameters for planned orders. 

26.5.5.6 Procurement Proposals 

In this step, you define the control parameters for the planning of materials that are procured externally. 

You also define the item numbers for purchase requisitions and stock transfer reservations that are created 

in the planning run. 

26.5.5.6.1 Define External Procurement 

In this IMG activity, you define the default values for materials that are procured externally and that are 

relevant to MRP. 

You maintain the goods receipt processing time for Purchasing  as well as the purchasing group. 

The purchasing group that is maintained here is only taken into account in the planning run if no 

purchasing group was maintained for the material in the material master record. 

In addition, you can define the following parameters at plant level: 

- Scheduling via info record or outline agreement 

With this indicator, you define whether the planned delivery time agreed in the info record or in an 

outline agreement is used for scheduling in the planning run. 

If the system is to use the planned delivery time from the outline agreement, you have to enter the 

outline agreement as relevant to MRP in the source list of the material. You do this by entering an 

indicator relevant to MRP in the MRP  field. 

- Account assignment category for non-valuated materials. 

With this indicator, you define a default value for the account assignment of non-valuated materials. 

You must enter an account assignment with the consumption posting 'unknown' for non-valuated 

materials. This is usually account assignment 'U'. 

In this IMG activity, you can define the scheduling for each MRP group with a purchase info record, an 

outline agreement or the document type for the purchase requisition in MRP. 

You can enter the document types of purchase requisitions in the appropriate fields. The system uses the 

appropriate document type when creating a purchase requisition in MRP or when converting planned 

orders into purchase requisitions. You can choose from the following document types: 

- Standard purchase order 

- Subcontracting 

- Stock transfer 
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The document type of the purchase requisition has no control purpose in MRP. It is displayed in the MRP 

list or the stock/requirements list for information purposes only. 

Purchase requisitions for direct production are always created with the document type, standard purchase 

order (NB). 

You assign the MRP group to the material in the material master record. 

Default Settings 

Document types 

It is usually not necessary to enter document types. If no document type has been entered, the system uses 

document type NB to create purchase requisitions. 

Prerequisites 

Document types 

To set document types in MRP, you must have created the document types desired for the purchase 

requisitions in addition to the standard type NB in Customizing for Purchasing under Purchase 

Requisitions. 

Actions 

Define the parameters for external procurement. 

26.5.5.6.2 Define Line Item Numbers 

In this step, you define the item numbers for purchase requisitions and stock transfer reservations. These 

numbers are created automatically during the planning run. 

Stock transfer reservations are generated in storage location MRP. 

Actions 

Specify the item numbers per plant. 

26.5.5.7 BOM Explosion 

26.5.5.7.1 Define BOM Explosion Control 

Workstep Plant 

In this workstep, you define the following plant-specific parameters: 

- the explosion date for BOM 
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- whether the planning run is to create dependent requirements for bulk material in the appropriate 

plant 

- whether the planning run is to check whether sales order BOMs exist in the corresponding plant 

The explosion date determines which BOM (or which routing) is to be used for explosion in the planning 

run and, thus, for the calculation of the dependent requirements. This means, the system selects the BOM 

that is valid for the explosion date and creates dependent requirements for the components contained in 

this BOM. 

The following possibilities are available for the explosion date: 

- BOM explosion number/order start date 

The system checks whether a BOM explosion number exists for the material or the planned order. If 

yes, the fixed key date recorded in the BOM explosion number is used as the explosion date. If no 

BOM explosion number has been determined, the order start date of the planned order is used as the 

explosion date. 

- BOM explosion number/order finish date 

The system checks whether a BOM explosion number exists for the material or the planned order. If 

yes, the fixed key date recorded in the BOM explosion number is used as the explosion date. If no 

BOM explosion number has been determined, the order finish date of the planned order is used as 

the explosion date. 

- only the order start date is valid as explosion date 

- only the order finish date is valid as explosion date 

If you have set the indicator Exclude bulk material, no dependent requirements are created in the 

planning run for BOM items that are flagged as bulk materials. This reduces the system load. 

If the indicator is not set, the system also creates dependent requirements for bulk materials that can only 

be displayed in the planned order for information purposes but are not included in the net requirements 

calculation. That is, they are not planned in the planning run and they are not displayed in the 

stock/requirements list. 

If the indicator Procedure with sales order BOM/WBS BOM has been set, in the planning run, the 

system checks whether sales order BOMs or WBS BOMs exist for the materials to be planned. If these 

BOMs exist, the system explodes these BOMs. 

If the indicator BOM explosion number make-to-order/engineer-to- order prod. has been set, in the 

net calculation, the system checks whether a BOM explosion number exists for the corresponding 

requirements. If make-to-order or engineer-to-order production is concerned, this BOM explosion number 

is copied to the receipt elements which are generated subsequently. The BOM explosion number is 

ignored in make-to-stock production. 

Workstep MRP group 

In this workstep, you define the following parameters, which are specific to the MRP group: 

- the explosion date for the BOM and routing selections If no 

indicator is set, the plant settings are copied. 

- whether the planning run for bulk material should generate 

dependent requirements for the MRP group concerned 

If no indicator is set, the plant settings are copied. 
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Activities 

Set the parameters for the plant before setting the parameters for the MRP group. 

26.5.5.7.2 Define BOM Selection 

In this step, you specify the priority with which a BOM usage or routing usage is selected during the 

planning run. Here, a sequence is usually determined which is used to select a valid BOM via the 

criterion "Usage". 

Activities 

Define the selection ID for the BOM. 

Note 

For reasons of compatibility, you can determine the selection ID for the routings in Customizing for 

Material Requirements Planning/> under Planning -> Scheduling and Capacity Parameters -> 

Define Scheduling Parameters for Planned orders. 

  

26.5.5.8 Direct Procurement 

You can use direct procurement to order BOM components directly for a planned order, bypassing the 

warehouse. 

Direct procurement is also possible in connection with make-to-order production and engineer-to-order 

production. 

There are two alternative processes: 

- Using the special procurement key for direct procurement (analogously to the direct procurement 

processing) 

If direct production is to be used generally for a particular component, you enter this in the material 

master for the component. If direct production is to be used only for a particular BOM, you enter 

this in the respective BOM item. This entry overwrites the entry in the material master. 

- Using the item category for non-stock item  

You flag the components that are to be directly procured with the item category for a non-stock item 

in the BOM. This is the only type of processing possible for materials without a material master. 

We recommend the process using the special procurement key. 

In Customizing, you define at what time the direct procurement is to be triggered: during MRP or only 

once a production order has been converted or created. The system then triggers direct procurement 

automatically at the chosen time. 

For materials without a material master, the system does not generate dependent requirements, but does 

generate purchase requisitions directly. The long text for the BOM item is hereby copied to the purchase 

requisition. The system does not display the materials in the MRP list or stock/requirements list. 
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For materials with a material master, MRP generates dependent requirements and (according to the 

creation indicator for the planning run) planned orders for direct procurement or purchase requisitions for 

direct procurement. The system displays these in the MRP list and the stock/requirements list in a 

separate section for direct procurement. 

When the planned order for a finished product is converted into a production order, all planned orders for 

lower-level components that are procured directly are converted into purchase requisitions. 

Planned orders for direct procurement and purchase requisitions for direct procurement are adjusted to 

match changes in date and quantity for the higher-level assembly, even if they are firmed, so that 

inconsistencies in planning can be avoided. All changes are reversed. 

In the case of changes to firmed purchase requisitions for direct procurement, the buyer automatically 

receives a mail with the datafor the change. 

Note 

If direct procurement has been authorized for a material in the material master, the system treats the 

material in all BOMs as a material that is to be procured directly. 

By using the "No direct procurement" indicator in the explosion type, you can switch off direct 

procurement in individual BOMs. 

26.5.5.8.1 Settings for Direct Procurement 

In this step, you define settings at plant level for direct procurement. 

By using direct procurement, it is possible to procure components directly for an order, bypassing the 

warehouse. 

In this step, you can control, at plant level; 

- whether direct procurement is to be triggered by MRP or by production order maintenance, that is, 

whether the purchase order for the directly procured components is triggered by the planning run or 

only when the production order is opened. 

- how the account assignment category is pre-allocated for unknown account assignment. We 

recommend that you work with the account assignment category U. Purchase requisitions for direct 

procurement are then assigned to the account assignment category U and then reassigned to the 

production order after the higher-level planned order has been converted into a production order. 

Activities 

Define the default values for direct procurement per plant. 

26.5.5.8.2 Maintain Mail Partner for Direct Procurement 
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In this workstep, you make the settings required to control the sending of 

messages in direct procurement. 

Five different message types exist with the following content: 

- Set deletion indicator for firmed purchase requisition 

- Set deletion indicator for firmed purchase requisition with purchase orders 

- Important fields were changed in a firmed purchase requisition 

- Important fields were changed in a firmed purchase requisition with purchase order 

- Ordered quantity greater than required quantity - firmed purchase requisition 

The long texts or the various message types are only active in the delivery client. 

You can view the long texts by choosing Display output: direct procurement. To do this, double-click 

on a condition record and choose Document--> Display document. You can change the long texts by 

choosing Change output: direct procurement. To do this, double-click on a condition record and 

choose Document  --> Display document and then Document--> Change. 

If you have set in the parameters for direct procurement that the MRP controller is to be informed by mail 

if a purchase requisition for direct procurement is affected by changes to a higher-level planned order, 

you must determine the following data for each message type: 

- plant 

- partner role 

- message partner 

- message type 

- time of message send 

- language key 

Recommendation 

Enter the same mail partner for each message type. 

Actions 

Carry out the following steps per message type: 

1. Enter the plant in which mails are to be sent. 

2. Enter "MP" for mail partner as partner role. 

3. Enter the mail name of the purchaser to receive the message. 

4. Enter "7" (mail) as medium. 

5. Enter the time (for example, immediately). 

6. Enter a language. 
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These parameters can also be displayed or changed. 

26.5.5.9 Direct Production 

The aim of direct production is to jointly consider scheduling and costs for the finished products, 

assemblies, and components within a BOM structure. 

In direct production, the components are directly produced for the higher-level assembly, that is, they are 

not placed in the warehouse and no goods receipt or goods issue postings are made for components that 

are produced directly. 

If a material is to be produced directly in general for a particular component, this is entered in the material 

master for the component. If direct production is only to be used for a particular BOM, you enter this in 

the respective BOM item. This entry overwrites the entry in the material master. 

The system flags the dependent requirement for components that are produced directly. It creates a direct 

production segment for the components to be produced directly in the MRP list and the 

stock/requirements list. 

When the planned order for the finished product is converted into a production order, the system also 

converts all planned orders for lower-level components to be produced directly into production orders. 

The system adapts planned orders for direct production to changes in date and quantity in the higher-level 

assembly, even if they are firmed, so that the collective order remains consistent. Manual changes are 

reversed. 

When firmed planned orders for direct production are changed, the system automatically sends the MRP 

controller a mail with the data for the change. 

Note 

If direct production is allowed for a material, the material is treated as a material to be produced directly 

in all bills of material. 

You can use the indicator "No direct production" in the explosion key to switch off the direct production 

for individual BOMs. 

26.5.5.9.1 Maintain Mail Partner for Direct Production 

In this step, you make the settings required for sending messages in direct 

production. 

Four different message types with the following content exist: 

- Changing a firmed planned order for direct production 

- Changing a firmed planned order for direct production and re-exploding the BOM 

- Re-explosion of the BOM for a firmed planning order for direct production 

- Deleting a firmed planned order for direct production 

The long texts for the various message types are only active in the delivery client. 
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You can view the long texts over Display message for direct production. To do this, double-click 

on the condition record and choose Document --> Display document. You can change the long texts 

over Change message for direct production. To do this, double-click on a condition record and 

choose Document --> Display document and then Document --> Change. 

If you have defined in the parameters for direct procurement that the MRP controller is to be informed per 

mail if a firmed planned order for direct production is affected by changes to a higher-level planned order 

you must make the following settings here per message type: 

- plant 

- partner role 

- message partner 

- message type 

- time of the message send 

- language key 

Recommendation 

Enter the same mail partner for every message type. 

Activities 

Carry out the following steps per message type: 

1. Enter the plant in which the mails are to be sent. 

2. Enter "MP" for mail partner as the partner role. 

3. Enter the mail name of the MRP controller to receive the messages. 

4. Enter "7" (mail) as medium. 

5. Enter the time (for example, immediately). 

6. Enter a language. 

You can also change or display these parameters. 

26.5.5.10 Define the Maximum MRP Period 

In this step, you specify the maximum MRP interval for materials to be planned regularly. 

Regular materials planning means that these materials are planned in a certain time interval the 

maximum MRP interval - even if no changes relevant to the planning run have occurred. 

This is especially important if materials are planned using the long-term lot size. With the maximum 

MRP interval you can avoid a situation where order proposals, created with the long-term lot size, slide 

into the short-term area because no changes relevant to the planning run occurred for the material. 
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Activities 

Specify the maximum MRP interval. 

Further notes 

Materials to be planned ahead regularly must receive an MRP type that is provided with the indicator for 

regular materials planning. 

26.5.5.11 Activate Requirements Grouping for Individual Project Planning 

In this work step you activate  requirements grouping in individual project planning 

26.5.5.12 User Exit: Material Selection for Planning Run 

Note 

This IMG activity is only relevant if you plan some of your materials using classic MRP. If you plan all 

your materials using MRP Live, this IMG activity is irrelevant. 

In this workstep, you define the key and the description texts for the user exit function for selecting 

materials for the planning run. 

Using the user exist, you can limit the planning run (MRP, MPS, long-term planning) to materials with 

certain criteria (which you can define). 

Example 

For example, for each plant, you can define that in the selected plant the system will only plan; 

- Materials to be planned using MRP procedures 

- Materials of a certain MRP controller 

- Externally procured materials or materials produced in-house 

Requirements 

The user exist must be activated in the SAP extension concept. The name of the extension is M61X0001. 

In the documentation for this extension, you will find information on the use of user exits. 

For more information on the extension concept, please refer to the appropriate documentation. 

Note 

This workstep must only be carried out if you want to use the user exit. 
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Activities 

Maintain the key and the description of the user exit. 

26.5.6 Procurement Proposals 

In this step, you define the settings for planned orders and for the conversion of planned orders and 

purchase requisitions. 

26.5.6.1 Planned Orders 

In this step, you make the necessary configurations for processing planned orders. 

26.5.6.1.1 Define Order Profile 

In this IMG activity, you define the order profile that specifies the procurement. 

You have to define the following parameters used to control procurement: 

- order type 

- procurement type 

- special procurement type 

- account assignment category 

When creating planned orders, you have to specify an order profile which is valid for planned orders. 

Note 

If a planned order provided for in-house production is converted into a purchase requisition, you 

have to specify a new order profile which is then valid for the purchase requisitions. 

In the planned order profile for planned orders and purchase requisitions, only the following account 

assignment categories are allowed: - Make-to-order production 

- Engineer-to-order production 

- Account assignment unknown 

- No account assignment 

Other account assignment categories are not constantly taken into account in Material Requirements 

Planning, that is, only in the case of the account assignment catergories make-to-order production, 
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engineer- to-order production, account assignment unknown (U), is the account determination triggered 

when a purchase requisition is subsequently converted into a purchase order. If you have chosen another 

account assignment category, the account determination will therefore not be triggered when converting 

the purchase requisition. 

Standard Settings 

Order profiles are preset in the SAP system. 

Activities 

1. Check the order profiles contained in the SAP system. 

2. If necessary, specify new order profiles per plant and MRP group. 

26.5.6.1.2 Define Availability Check for Components 

In this step, you control the availability check for requirements planning by defining the checking group 

and the checking rule at plant level or per MRP group. 

The availability check can be carried out in MRP for the depedendent requirements. This means that the 

availability check can directly check whether sufficient material is available for the production of the 

assembly. The availability check is initiated from planned order processing. It is not carried out 

automatically in the planning run for each requirement of an assembly. 

In the checking group, several checking rules are grouped together. Therefore, you can define different 

checking rules for different business application areas (sales and distribution, MRP, production orders, 

inventory management) or for different business operations. If you require different checking rules for 

different business operations, you can create several checking groupes with the appropriate checking 

rules or you can assign another checking rule using the MRP group. The checking group is assigned to 

the material in the material master record, MRP 2 screen, in field "Availability check". 

The combination of the checking group and the checking rule determines the scope of the availability 

check. That is, which stocks, requirement elements and receipt elements are to be included in the 

availability check. Moreover, per combination, you define whether the system is to carry out the check 

with or without the replenishment lead time: 

- In the check with the replenishment lead time: 

Here, the availability check is carried out within the replenishment lead time. Requirements that lie 

outside the replenishment lead time are automatically considered available by the system. 

- In the check without the replenishment lead time: 

Here, the system checks the complete time axis for availablity. This means that requirements can 

only be committed once receipts or stocks of the appropriate quantity have been scheduled or are 

available. 

Note 

The replenishment lead time includes: 
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- For external procurement: planned delivery time and goods receipt processing time (MRP 1 screen) 

as well as the processing time required by the purchasing department. 

- For in-house production: in-house production time plus the goods receipt processing time 

(MRP 1 screen) or the total replenishment lead 

time (MRP 2 screen) 

A checking period is also defined in the checking rul for inventory management. This checking period 

determines the number of days into the future that the system checks whether missing parts exist for the 

material. Within the checking period, a mail is sent from inventory management which informs the MRP 

controller that a goods receipt has been made for a missing part. The receiver of this mail is maintained in 

section MRP controller. 

Note 

- For backorder processing, you can define a separate checking rule for backorder processing in the 

plant parameters. 

The checking group is assigned to the material in the material master record in the Availability 

check field in the MRP 2 screen. 

- In material requirements planning do NOT use the checking rules whose keys start with either A or 

B as these areas are used by sales and distribution. 

Actions 

1. Define the key and the short description for the checking rule(s). 

2. Assign the checking rule(s) to one or more checking groups and define the following per checking 

rule: 

- Scope of checking 

- whether with or without the replenishment lead time 

- if necessary, define the checking period for processing missing parts (inventroy management) 

3. Assign the checking rule(s) to one or more plants. 

4. Assign the checking rules to the MRP groups. 

26.5.6.1.3 Carry Out Collective Availability Check 

In this step, you define the list layout profile for the planned order overview and the component list in 

collective availability. 

The profiles control which fields the system displays in the lists and how the system groups and sorts 

data. The order view profile controls the layout for the list of planned orders and the component view 

controls the layout of the component list. 

You can define your own user-specific profile. 
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Standard settings 

The following profiles have been defined in the standard settings: 

- Order view profile 000001 (standard profile) 

- Component view profile 000001 (standard profile) 

Recommendation 

If you want to create a new profile, you can copy and then change the existing profile. 

Activities 

To create a new profile, proceed as follows: 

- Create the field selection profile and define the field selection for the profile. You can select a 

maximum of 11 fields. 

- Define the group criteria profile and set according to which field the system is to carry out the 

grouping of planned orders. In the standard profile, the planning plant is defined as the grouping 

criteria. You can define a maximum of 2 criteria. 

- Define the profile for the sort criteria and determine according to which criteria (for example, the 

order start date) the system is to sort the planned orders. You can enter a maximum of 4 criteria. 

- Create the order view profile and assign your subprofiles to a field selection, sorting criteria and 

grouping criteria. 

- To create a new profile for the component view, use the same procedure as above. 

26.5.6.1.4 Define Layout for Component List 

In this step, you define the layout to be used for printing the component list (for example, for printing the 

components from the planned order). 

You first maintain the following profiles: 

- for field selection (key, Field selection profile) 

- for grouping criteria (key Grouping criterial profile) 

- for sort criteria (key sort criteria profile) 

Then select the key Layout/print profile and group together the individual profiles mentioned above to a 

total profile using the function List profile. 

You can assign the total profile to an application using the function Layout and print parameters. 

You can maintain layout and print parameters for the following applications: 

- planned order BOM 

- backflushing (repetitive manufacturing) 

- pull list - totals view 
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- pull list - stock transfer view 

- pull list - details view 

- pick list 

- reprocessing list 

Note the following for the direct print: 

You also maintain the output device in the function Layout and print parameters. If you also maintain 

a user parameter (CLD), the systen uses the output device from the user parameter. 

Standard settings 

Delivery is made with SAP standard settings. 

Activities 

Check whether you can work with the SAP standard settings. If necessary, define your own profile and 

parameters. 

26.5.6.1.5 Define Storage Location and Supply Area Determination in BOM 

Explosion 

In this step, you define the strategy the system uses to find the storage location (issue storage location) for 

the components in BOM explosion, when backflushing and in MRP. This logic is also used in supply area 

determination. 

In BOM explosion, the system tries to find a storage location in the BOM item (component). If no issue 

storage location has been defined in the BOM item, the system reads the MRP group that has been 

maintained  for the assembly or the finished product and thus determines the strategy to use for storage 

location (supply area) determination. 

Here, the system proceeds as follows: 

- If you set indicator 1 Only components, the system checks to see whether the issue storage 

location has been maintained in the material master record of the components and uses this storage 

location. This storage location is then used as the withdrawal storage location and is displayed in the 

component list of the planned order. You use this procedure for detemining the withdrawal storage 

location if you always withdraw one particular component from the same storage location. That is, 

every component is used at a specific storage location in the plant. 

- If you set indicator 2 Only assembly, the system checks to see whether the proposal withdrawal 

location has been maintained in the production version of the assembly or finished product. If this 

has been maintained, the system uses this withdrawal storage location for all components and 

displays it in the components list in the planned order. If no proposal withdrawal location has been 

maintained, the system uses the assembly#s receiving storage location as the withdrawal storage 

location for the components. You can define the receiving storage location in the production version 
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of the assembly in field To location or in the material master record of the assembly in field Issue 

stor.location. If neither of these entries has been maintained, you can enter the receiving storage 

location (goods receipt storage location) in the backflush transaction in Repetitive Manufacturing 

which is then used as the withdrawal storage location for the components. You should use this 

procedure when all components lie together in one storage location close to the production line 

where they are required. 

- If you set indicator 3, the system first proceeds as for indicator 1 described above. If it cannot find a 

storage location using indicator 1, it then proceeds as described above for indicator 2. 

- If you set indicator 4, the system first proceeds as for indicator 2 described above. If it cannot find a 

storage location using indicator 2, it then proceeds as described above for indicator 1. 

Standard settings 

No entry is delivered in the standard system. The system searches as described for indicator 1. That is, it 

searches for the issue storage location in the material master record of the compoennts. 

Activities 

Define the strategy to determine the issue storage location or supply area of the components per plant and 

MRP group. 

Further notes 

The same strategies are used to find the supply area. You can maintain the supply area in the same places 

as you can the issue storage location. 

Use : 

- In KANBAN, the supply area is relevant if you use the automatic kanban calculation. In the kanban 

calculation, the system only uses dependent requirements that refer to a supply area. Therefore, you 

must have maintained a supply area in either the BOM item, in the material master record or in the 

production version so that the system can find it in the planning run. In BOM explosion, the supply 

area of the components can also be determined using the logic of the supply area determination. 

- If you work with Warehouse Management, you use the supply area to be able to determine the 

storage bin in production (usually close to the production line) where the components are provided 

and withdrawn for production. You assign the material and the supply area to the storage bin in the 

control cycles. 

26.5.6.2 Conversion of Procurement Proposals 

In this step, you make the settings required for the conversion of order proposals. 
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The conversion of order proposals can either be carried out from the MRP list or the stock/requirements 

list or when processing the planned orders. 

26.5.6.2.1 Define Order Type for Conversion to Production/Process Order 

In this step, you define the order type that is automatically set when converting planned orders into 

production orders or process orders. 

Note 

The order type set in the MRP group is only used for individual conversion and not for the collective 

conversion function. 

Actions 

Define the order type for the conversion of planned orders to production orders or process 

orders per plant. Select a valid order type. 

26.5.6.2.2 Define Conversion of Purchase Requisition into Purchase Order 

In this step, you define the parameters for the conversion of purchase requisitions into purchase orders. 

Thus, you determine whether the entries are to be made automtically or manually by the system. The 

following entries can be made automatically: 

- selection of the purchase requisition items before the transfer 

- transferring the purchase requisition items into the purchase order 

- transferring the purchase requisition items into the purchase order and posting the document 

Actions 

Define the parameter with the corresponding settings per plant. 

Note 

These parameters are only active if the are allocated to the user in the iser master record via the parameter 

ID "EVO". 

26.5.7 Evaluation 

In this step, you define the system settings for the MRP list and for the stock/requirements list. 

Note 
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If you want to define reports yourself, there is an extra function in the menu for Master Production 

Scheduling. You use this function to define user-specific evaluation layouts. These evaluations can be 

defined for individual materials, for product groups, and cross-plant. 

26.5.7.1 Configure MRP List / Stock/Requirements List 

You have numerous possibilities to influence the selection and optical format of the data in the MRP list, 

the stock/requirements list, and the collective dislays of these lists. This makes working with the lists 

more flexible and easier, and system performance is improved. 

Company-Specific Configuration (Customizing) 

- Definition of navigation profiles 

In navigation profiles, you define transaction calls and group them to profiles for particular user 

roles. General transaction calls and specific transaction calls for individual MRP elements are 

possible. 

- Definition of filters 

With selection rules, you define which MRP elements and which stocks are taken account of in the 

quantity and stock calculation, and therefore define your own business views. With display filters, 

you define which MRP elements and which MRP segments are displayed, and therefore reduce the 

information displayed to a clear selection. 

- Definition of screen sequence in header details 

You define the sequence of the tab pages in the header details for a material and, when necessary, 

create a tab page with additional information. 

- Display of material groupings 

If a material is part of an active material grouping, such as a supersession chain in SAP APO or a 

product group, you can specify that the MRP elements of all materials belonging to a material 

grouping are to be displayed in the stock/requirements list. 

- Programming of additional columns (Customer Exit) 

You can use Customer Exit M61X0002 to program up to three columns for the individual line 

display and the period totals. These columns can be filled with additional data, which you can call in 

the lists using pushbuttons. 

- Programming of customer-specific access to the lists (reports) 

By using reports RMMD07EX and RMMD07DB, you can program your own access to the 

collective display of the stock/requirements list. 

- Programming of customer-specific lists (function module) 

Function module LM61XU11 MD_STOCK_REQUIREMENTS_LIST_API includes the 

basic functions for setting up the MRP list and the stock/requirements list. Use this function module 

to program lists, which are exactly tailored to the requirements of your company. 

- Further configuration possibilities 
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Group the exception messages and change the texts for the exception group; Change the MRP 

element texts, define the period display and the individual period split, and define the receipt days' 

supplies. 

User-Specific Configuration 

- Definition of settings for access to the lists 

You define which settings are active as standard when you access the evaluation lists (overview tree, 

header details, filter, navigation profile, period totals display, and so on) and select, if appropriate, a 

filter, navigation profile and period split. You can save the settings permanently. 

- Navigation between materials with overview tree 

- By double-clicking on a material in the overview tree, you directly call the list for the selected 

material. 

- You switch the overview tree between worklist tree, order tree, and product group tree. 

- You select which information should be displayed in the overview tree, sort/group the 

materials displayed according to your needs, and save the settings permanently. 

- Definition of individual transaction calls 

You add individual transaction calls to the navigation profiles, which are available to all users. The 

transaction calls are for transactions to which you personally wish to go from the evaluation lists. 

The transaction calls can be general, which means relevant to the material, or specific, relevant to 

individual MRP elements. 

- Configuration of columns in the lists 

You adjust the sequence and width of all columns that are displayed as standard to your needs and 

save these settings permanently in display variants. Additional columns that are only displayed 

when they are filled are exempted from these settings. 

- Saving of selection parameters when accessing the collective display of the MRP list When you 

access the collective display of the MRP list, you permanently save the settings for selecting the data 

and limiting the selection. 

- Definition of traffic light values 

The materials are displayed with particular traffic light values (red, yellow, green) in the overviews 

of the collective displays and in the worklist tree. Red traffic lights next to particular materials warn 

you immediately that these materials are critical and urgently need to be processed. The traffic light 

display is controlled by ranges of coverage and exception groups. You change the standard settings 

for the traffic light values according to your needs and save them permanently. 

- Definition of print settings 

Before you print the collective overviews and the individual list, a list is displayed, which can be 

printed and processed. In this list, you sort and filter the information, define the column sequence 

and widths, and permanently save the settings in display variants. 
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Activities 

Define the access, setup, display, and output of the lists so that the work methods of different user groups 

have optimum support. 

26.5.7.2 Display Material Groupings 

Use 

In this IMG activity, you can specify that in the stock/requirements list in addition to the classical 

individual material view the integrated planning situation for several materials belonging to a so-called 

material grouping is to be presented as a further view. 

You have the following options for the selection of a material grouping: 

- APO supersession chains:The planning situation shows the planning data of all interchangeable 

materials belonging to a supersession chain (from APO). 

- Product groups: All materials belonging to a product group are integrated in the planning situation 

to an organizational unit (plant or MRP area). 

- Cross-plant material grouping: The planning situation comprises the planning data of a material in 

all plants (and MRP areas) in which the stipulated material has been created. 

- Customer-specific-defined material grouping: Here you can display the consolidated planning 

situation for a self-defined material grouping (defined and controlled via BADI). 

These views can then be displayed as required on your own tab pages that can be switched on in 

Customizing in addition to the individual material view. 

The new views thus provide you with an overview of the integrated planning situation for all materials 

that are part of a material grouping. This ranges from the integrated stock situation to the time sequence 

of requirements and receipts of the members and the horizons of the materials involved. 

Under the personal settings for the stock/requirements list (Settings -> Settings), you can also specify 

whether: 

- The planning data is to be displayed in aggregated or non-aggregated form: In the aggregated 

view, the stock data is cumulated and the available quantity is calculated jointly for the integrated 

list of all materials. In the non-aggregated view, the stocks and horizons are listed for each material 

individually and the available quantity calculated for each individual material. 

- Stock transfers are to be shown or hidden: If they are hidden, you directly see the original 

requirement and the final requirement coverage element compared with each other. 

Which views are offered in addition to the individual material view can be specified in this Customizing 

transaction. You can also change there the basic settings in your personal settings made here again on a 

user-specific basis: 
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- You can specify that the tab pages for the material groupings are to be displayed automatically. The 

system then automatically determines for the material entered whether it belongs to an APO 

supersession chain, a product group, several plants, or a customer-specific-defined material material 

grouping and automatically shows the corresponding tab pages. In the process, however, only those 

groupings that you have already selected in Customizing are displayed. Without membership of a 

grouping, only the individual material view without tab pages is displayed. 

- You can specify that the tab pages are  always to be displayed. Here, too, you must previously have 

selected the groupings in Customizing. Even if the material is not part of a grouping with this 

setting, at least the Individual List tab page is displayed in the stock/requirements list. 

- You can specify that irrespective of the Customizing settings the groupings are never  to be 

displayed. In this case, you see only the usual individual material view (without tab pages). 

With the Business Add-In MD_CREATE_GROUPING, you can also create customer-specific-defined 

material groupings of your own. No Customizing setting is necessary for the display of the customer's 

own groupings, but the setting Never must not have been made in the stock/requirements list. 

26.5.7.3 Exception Messages 

Note 

This IMG activity is only relevant if you plan some of your materials using classic MRP. If you plan all 

your materials using MRP Live, this IMG activity is irrelevant. 

Exception messages are generated during the planning run when a situation needs to be checked by the 

MRP controller. In these cases, the planning results usually need to be reprocessed manually. 

In the MRP list, which reflects the result of the last planning run, more exception messages are set as the 

net requirements calculation is carried out automatically. 

You can define the following parameters in this segment: 

- Whether exception messages are generated for particular exception situations 

- The priority of the exception messages 

- How exception messages are grouped to exception groups 

- The long text of the exception groups 

- Which exception messages generate MRP lists 

26.5.7.3.1 Define and Group Exception Messages 
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Note 

This IMG activity is only relevant if you plan some of your materials using classic MRP. If you plan all 

your materials using MRP Live, this IMG activity is irrelevant. 

In this step, you define the following parameters for exception messages: 

- Whether exception messages are displayed for particular exception situations If a particular 

exception message is not relevant to your company, select the field No exception message. In the 

planning run, this exception message is then no longer created for this situation. 

- The priority in which exception messages are to be displayed 

If several exception messages exist for one MRP element, you can assign priorities to determine 

which exception message is to be displayed in the MRP evaluations. The system always displays the 

exception message with the highest priority directly in the list. The exception message selected with 

the next highest priority can be displayed in the list by accessing the additional data. 

You enter the priority of the exception messages in the field entitled Excep.mssge priority. You 

can see the sequence of priorities by selecting the possible entries pushbutton on the input field. 

Thus, you can gain an overview of the previous sequence of the exception messages. The exception 

messages with the higher number also has higher priority. 

- How exception messages are grouped to exception groups 

For the collective display of the MRP list and the stock/requirements list, as well as for all material 

lists created as a result of the single-item, multi-level planning run, exception messages are grouped 

into exception groups. In the standard system, a grouping exists that you can change, if necessary, 

in the field entitled Selection group. You can adapt the long text of the exception group in the step 

<DS:SIMG.SIMG_CFMENUOPP1OM0L>Check Exception Group Texts. 

- Depending on which exception messages MRP lists are created 

In the initial screen of the planning run as well as in in the MRP group, you can define that the 

system is only to create an MRP list if certain exceptional situations exist (creation indicator "Create 

MRP list - depending on exception messages"). The exception messages that lead to the creation of 

the MRP list are selected in the field entitled Create MRP list. 

Actions 

1. Define whether the exception message is set. 

2. Define the priority of the exception message. 

3. If necessary, change the exception groups. 

4. If necessary, select the exception for the creation of the MRP lists depending on the exception 

messages. 

Further notes 

The assignment of exception message 98 Abnormal end of materials planning to exception group 8 

Terminations is specified by the system and cannot be changed. 
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26.5.7.3.2 Check Exception Group Texts 

Note 

This IMG activity is only relevant if you plan some of your materials using classic MRP. If you plan all 

your materials using MRP Live, this IMG activity is irrelevant. 

The exception groups are displayed with the texts defined here at various places in the system, for 

example, when you access the collective display of the MRP list. 

Standard settings 

SAP provides a fixed assignment of group numbers and texts. 

Exception group 8 Terminations is the only group to which you cannot assign different exception 

messages and whose text, therefore, you cannot change. 

Recommendation 

You should work with the SAP standard system, in which case you do not need to carry out any activities. 

Activities 

If necessary, change the texts for the exception groups so that they match your company-specific 

assignment of exception messages to exception groups. 

26.5.7.4 Check Texts for the MRP Elements 

The MRP elements are displayed in the MRP list and in the stock/requirements list with the short texts 

defined here. 

SAP recommendation 

You should work with the SAP standard system. Then you do not need to carry out any activities. 

Aktivities 

If necessary, change the shorts texts for the MRP elements. 

26.5.7.5 Period Totals 

The period totals display is a display form in the MRP list and in the stock/requirements list. It 

periodically sums up the planning results. 
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In this step, you define 

- which periodicities can be displayed in the period totals display 

- whether the periods are split, which means whether a less specific period split is divided and 

displayed in more specific period splits for certian time periods. 

26.5.7.5.1 Define Individual Period Split for Period Totals 

In this step, you define whether a period split takes place for the period totals display in the MRP list and 

the stock/requirements list. This means whether a less detailed period split is divided and displayed in a 

more detailed period split in particular time intervals. 

The months entered in the first column are displayed in days, those entered in the second column are 

displayed in weeks. 

Note 

You can call the individual period split in the period totals display of the evaluation lists. 

Example 

A monthly display is to be divided up as follows: the 

first two months in days, the next three months in 

weeks the following periods in months 

Standard settings 

The SAP standard system contains settings for the following period splits: 

- Standard 

- Daily display 

- Weekly display 

- Monthly display 

Aktivities 

1. If necessary, define new period splits. 

2. Assign the period split defined here to a specific plant in the IMG activity Define Period Display for 

Period Totals. 

26.5.7.5.2 Define Period Display for Period Totals 
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In this step, you specify which periods are to be displayed in the period totals display of the MRP list and 

the stock/requirements list. 

If you want to split the monthly or the weekly display into a finer split, you must define this split in the 

section Define Individual Period Split for Period Totals. 

Note 

The planning calendar entered here for the periods after the planning calendar is only valid, if no planning 

calendar is entered in the material master record. 

The planned calendar entered here is also used as a default for the periodicity of capacity planning. 

Default Settings 

The following default values are specified in the SAP system: 

- Day 

- Week 

- Month 

These periods are always displayed. 

Actions 

If necessary, define additional periods for the period totals display. 

26.5.7.6 Quantity Distribution 

26.5.7.6.1 Maintain Distribution Function 

Use 

In this IMG activity, you specify the distribution function for the representation of the order quantities in 

the display functions of material requirements planning. 

26.5.7.6.2 Define Distribution Keys 
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Use 

You can use this IMG activity to define the distribution key in dependence on the plant. A distribution 

key is needed to specify the distribution of the order quantities in the evaluation transactions of material 

requirements planning. 

The distribution key is composed of the distribution function and the distribution type: 

- Distribution function 

You specify the distribution function the system is to use (such as equal distribution). A 

distribution function specifies the percentage of the quantities that are produced or consumed 

after a certain percentage production duration. 

- Distribution type 

This specifies whether the requirement is distributed discretely at the points defined in the function 

or linearly as defined by the distribution function. 

Notes 

- The distribution key is effective in material requirements planning for planned orders, production 

orders, and process orders. 

- You can use the BAdI MD_ADAPT_DISTRIBUTION to adjust the start and end 

dates/times for the distribution function. See also: Examples of Equal Distribution 

Activities 

1. First define the distribution function. 

2. Then specify the distribution key. 

3. Specify the distribution key in the production version if you want to use quantity distribution at the 

level of the header material of orders. 

4. As an alternative to quantity distribution at the header material level, you can use quantity 

distribution at component level. 

In this case, you must assign a distribution key to the components in the bill of material. This makes 

sense if you are working with continuous component feed. Note that if you are using basic-date 

scheduling, you should stage the components at the outset (function ANF). You must use the 

function GLEI for the components if they are to be equally distributed. 

26.5.7.6.3 BAdI: Adjustment of Start and End Dates/Times 

Use 
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You can use this Business Add-In in the component PP-MRP-PE to adjust the following parameters for 

the distribution of order/requirement quantities: 

- Start and end date of the distribution 

- Valid factory calendar for the distribution 

In the standard behavior, the relevant planned order quantities are distributed between basic start and 

basic end date or the component requirement quantities between between earliest and latest requirement 

date. In some applications, however, especially in the process industry, it may be useful to stipulate a 

distribution interval that is better geared to the actual production dates here. Thus, for example, you can 

stipulate in the BAdI that the production dates determined by the system in lead-time scheduling are to be 

used for the quantity distribution. 

The following methods are available: 

- You can use the ADAPT_ORDER_DATES method to adjust the start and end date for the 

distribution of the order quantity (quantity of header material). The distribution function at the level 

of the order header is effective only in the display transactions of material requirements planning, 

not for the planning. 

- You can use the  ADAPT_DEP_REQ_DATES method to adjust the start and end date for the 

quantity distribution of the components. 

These changes are effective not only in the display transactions of material requirements planning, 

but also for the planning. 

If you have activated the BAdI, the system displays the BAdI Modif. indicator in the Header Details of 

the Stock/Requirements lists and MRP lists and represents the distribution of quantities on the basis of 

the new start and end dates or the new factory calendar in the following transactions: 

At header/order level in the transactions: 

- Stock/Requirements List (MD04) 

- Planned Order transactions - Distribution at header/component level function (MD12, 

MD13) 

- Display Planning Result - Change Order (MD02, MD03, MD43) 

- Availability Overview (ATP) (CO09) 

At component/requirement level in the transactions: 

- Stock/Requirements List (MD04) 

- Planned Order transactions - Distribution at Component Level function (MD12, MD13) 

- Display Planning Result (MD02, MD03, MD43) 

- MRP List (MD05) 

The same function is also effective in the corresponding transactions of long-term planning and master 

production scheduling. 

Requirements 
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You have stored a distribution key that you previously defined in Customizing for Material 

Requirements Planning under Evaluation --> Quantity Distribution in the production version of a 

material or in the bill of material for a component. 

Standard settings 

- In the standard system, the Business Add-In is not active. 

- The Business Add-In is not filter-dependent. 

- The Business Add-In can be used multiple times. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

In the example implementation for the method ADAPT_ORDER_DATES, you will find three scenarios 

with pessimistic and optimistic approaches and with a distribution between the production dates. 

See also: Example of Use of the BAdI 
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Please note that the parameter CV_CHANGED must be set in the return for the implementation changes 

to become effective. 

26.5.7.7 Define Receipt Elements for Receipt Days' Supply 

In this IMG activity, you define which receipt elements are used to calculate receipt days' supplies. The 

receipt days' supply indicates how many days a material will last. It takes the current plant stock and 

predefined receipts into consideration. 

The receipt days' supply is calculated in each MRP run, and online when the stock/requirements list is 

accessed or changed. 

Two receipt days' supplies are displayed in the evaluations of the MRP run. They are calculated using 

different receipt elements. 

You can define that the first receipt days' supply takes less binding receipt elements into consideration, 

and that the second receipt days' supply takes only the binding receipt elements, such as production 

orders and shipping notifications, into consideration. 

In the safety stock field, you can also define that the days' supply is calculated up until the physical 

warehouse stock is fallen short of. You can define this for the range of coverage and the receipt days' 

supply. The system then documents the number of days until the stock sinks below 0. The standard 

setting is such that the days' supply is calculated until the safety stock is fallen short of. 

Example 

You can define receipt days's supply 1 to include purchase requisitions, as well as shipping notifications, 

and schedule lines. To do this, enter indicator 1 in the PReq/SN/SchLn field, and indicator 2 in the 

Shipping notifications field. 

Activities 

Enter the corresponding indicators to define the receipt elements per plant that are to be used to calculate 

receipt days' supplies 1 and 2. 

26.5.7.8 Define Evaluation Profile for Range-of-Coverage Data 

Use 

In the evaluation profile, you specify the following: 

- Threshold values for stock and receipt days' supplies. 

These threshold values are the material-specific limit values for displaying the traffic-light status 

(red, yellow, green lights) in the header details on the Ranges of Coverage tab page. You can 

display the evaluation of the ranges of coverage (days' supplies) in the header details of the MRP 

list, stock/requirements list, and in the planning results. Here you obtain the information about the 

current range-of-coverage (days' supply) values of a material. The system compares the current 

values with the limit values you have defined in the evaluation profile and displays the 

corresponding traffic lights. 
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You assign an evaluation profile to the plant parameters and an MRP group. In this way, you can 

assign the desired limit values to a certain group of materials. 

- Default period for the creation of the period statistics in the header details of the stock/requirements 

list and in the MRP list. 

The Period Statistics is a tab page in the header details that lists the receipt and requirement 

quantities of the near future. 

The default period is then the period applied for the calculation of the period statistics. If, for 

example, you define Month as the default period, the system calculates the total of the requirements 

from the current month, the total of the requirements of the next month, and the total of the 

requirements in the month after next. The same applies to the receipt elements. 

You can also adjust the values assigned in the evaluation profile in your current system under the current 

settings for material requirements planning. 

Activities 

To be able to use the limit values you have defined in an evaluation profile for the range-of-coverage 

evaluation, proceed as follows: 

1. Create an evaluation profile. 

2. Assign the evaluation profile as follows: 

a) To all materials in a plant via the plant parameters (Customizing for Material 

Requirements Planning --> Plant Parameters --> Overall Maintenance of Plant 
Parameters --> Maintain --> Reporting --> Evaluation Profile). This evaluation profile 

then serves as the default parameter for all materials in the plant. 

b) To the materials of an MRP group via overall maintenance of the MRP groups 

(Customizing for Material Requirements Planning --> MRP Groups --> Overall 

Maintenance of MRP Group --> Maintain --> Evaluation Profile). You must then assign 

the MRP group to the desired materials. 

The evaluation profile you have assigned to the MRP group has higher priority and overrides 

the plant parameters. 

3. In order for the values you have defined in the evaluation profile to then be used for a certain 

material, you must set the material-specific limit values  and save them in the Define Traffic Lights 

dialog box in the Collective Display of the Stock/Requirements List. 

4. To be able to display the statistical evaluations in the header details, you must use the screen 

sequences N01 and N02. These screen sequences are set up in a similar way to the screen sequences 

001 and 002. The two screen sequences contain the following screens with which you can run 

comprehensive statistical evaluations based on the evaluation profile. 

- Ranges of coverage (days' supplies) 

- Stocks 
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- Period statistics 

- Statistics 2 

To be able to show these screens as tab pages in the header details, you must proceed as follows: 

- Check the new screen sequences N01 and N02 in the IMG activity Define Screen Sequence 

Header Details in Customizing for Material Requirements Planning You can also use the two 

screen sequences as a template when defining your own screen sequences. 

- You must now assign one of the two new screen sequences to the MRP type used in the IMG 

activity Check MRP Type in Customizing. In this way, all materials that have this MRP type 

now have the new tab page in the header details. 

26.5.7.9 Define Screen Sequence for Header Details 

In this IMG activity, you define the screen sequence of the header details for the evaluations for MRP. 

The header details show an overview of master and movement data for the respective material. This data 

is grouped by topic to individual screens; the screens can be accessed by clicking the respective tab page 

in the MRP list or the stock/requirements list. 

The MRP type controls which screens are displayed in the evaluations of MRP. The screen sequences are 

given a number, which is assigned to the MRP type. This enables you to display different master data for 

the evaluation of consumption-based materials from the evaluation of planning-based materials. 

Standard settings 

In the SAP standard system, the following screen sequences are predefined: 

Key for screen sequence MRP type 

001 PD, M0, M1, M2, M3... (plng-based MRP) 

002 PD, M0, M1, M2, M3... (plng-based MRP) 

003 VB, VM (reorder point planning) 

004 R1, R2 (time phased materials planning) 

005 VV     (forecast-based planning) 

These screen sequences can be assigned to the MRP types recommended here. 

Screen sequence 002 is a (shorter) alternative to screen sequence 001 and therefore refers to planning-

based MRP. 

Screen number 300 includes specific data for the MRP list and is only displayed there. 

If you want to use the enhanced statistical evaluations in the header details, you can use the screen 

sequences N01 and N02. These screen sequences are similar to the screen sequences 001 and 002. 

However, they contain screens with which you can run more comprehensive statistical evaluations: 
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- Ranges of coverage (days' supplies) 

- Stocks 

- Period statistics 

- Statistics 2 

Activities 

Define screen sequence 

1. Enter a sequence number for each screen sequence number. The sequence number defines in which 

sequence the screens are displayed. 

2. Enter the number of the required screen to the sequence number. You can select the valid screens 

using the F4 Help. 

By using the function key Display screen, you can simulatively display the screens. 

Link materials with screen sequences 

1. In the Customizing activity Check MRP Types, assign a screen sequence to an MRP type. 

2. Enter the MRP type of the material in the material master record. This links the material with a 

screen sequence. 

If you do not assign a sequence number to an MRP type, the MRP type is automatically assigned the 

"Material Data Overview". 

Create your own screens 

1. Copy screen 0100 in the SCREEN PAINTER of the ABAB/4 WORKBENCH in program 

SAPLM61K, and enter a new screen number. Start your new screen number with 9.., otherwise there 

may be overlaps with the SAP predefined screens. 

2. Define a short text for the new screen, using "Screen attributes". 

3. Select the required fields, and copy them in the defined frames. Delete any fields that you do not 

require. 

4. Save and generate the new screen 9... . 

5. In this Customizing activity, assign the new screen to an existing or new screen sequence. 

Note that the creation of a new screen is a (non-critical) modification. It is important that the new screen 

is transported correctly into the target system. 

Further notes 
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Special features of particular screens: 

- Screen 300: 

This screen appears only when you display an MRP list. This is true of MRP lists for operational 

planning and long-term planning. 

- Screen 310: 

This screen appears only for MRP with the display of the result, for example, for single-item, single-

level or multi-level planning. 

- Screen 320: 

This screen appears only in the planning table for Repetitive Manufacturing 

- Screen 800: 

This screen shows the consumption values for the last periods in comparison with last year. Its 

number is fixed. The screen cannot be renamed or changed. 

26.5.7.10 Define Navigation Profiles 

In this IMG activity, you define navigation profiles for the MRP list and the stock/requirements list. 

Navigation profiles enable you to navigate faster and more flexibly between transactions. For each 

profile, you define: 

- a record of generall transaction calls 

- a record of specific transaction calls for each MRP element required 

Each user can assign a navigation profile in the respective list, under the menu path Environment --> 

Navigation profile -->  Assign or under Settings. The system then offers transactions suitable for the 

users work, without the user having to define the jumps. 

After saving, the general transaction calls appear under the menu path Environment --> Navigation 

profile, and in the application toolbar. The transaction calls per MRP element appear in the application 

toolbar for the detail dialog box. 

In detail, you define: 

- the number of the transaction call 

- if applicable, the indicator for the MRP element (only for transaction calls per MRP element) 

- the transaction code 

- if applicable, the icons 

- the icon text, menu text, information text 

- the parameters, which enable you to skip the initial screen of the transaction 

- the conditions, which must be given, for the transaction call to be offered (only for general 

transaction calls) 

- the application component: operational and/or long-term planning 
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The number of transaction calls possible is not limited. However, in the MRP list and the 

stock/requirements list, only the following are displayed: 

- the first five general transaction calls that are valid in the given context, 

- the first two transaction calls per MRP element that are valid in the given context. 

The determining factors for the selection are the conditions entered, the application component, and the 

respective navigation number. 

Standard settings 

SAP provides a number of predefined navigation profiles from the SAP name range. Profile SAP0000000 

is the profile in which the examples for user-specific definitions are stored (see below). 

Activities 

If applicable, create further navigation profiles for the individual user roles for the MRP list and the 

stock/requirements list in your company: 

1. Enter the name and description of the new profile. 

2. Select the row with your entries, and, in the structure tree to the left, choose (by double-clicking) 

General transaction calls or transaction calls per MRP element. 

3. Save you entries in each screen. 

Further notes 

In addition to the company-specific predefined transaction calls, the user can create user-specific 

transaction calls in the MRP list and the stock/requirements list. These can be general transaction calls or 

transaction calls per MRP element. SAP provides the user with various examples (see above). 

26.5.7.11 Filter 

A selection rule consists of certain MRP elements and stocks that are grouped together to a 

rule. This rule controls the selection of the data in the stock/requirements list and the planning table in 

Repetitive Manufacturing: 

- Only the MRP elements that are selected in the selection rule are displayed. 

- Of the MRP elements that are displayed, only those flagged as relevant to availability in the 

selection rule are used to calculate the quantity available and the ranges of coverage. 

- Only the stocks defined in the selection rule are used to calculate unrestricted-use stock. 
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This forms a new business view on the data in the lists. 

A display filter consists of certain time information, MRP elements, and MRP segments grouped 

together to a filter. The filter controls the display of the MRP list and the stock/requirements list. 

- The system displays MRP elements only in the time period defined in the display filter. 

- Within this period, the system displays MRP elements only for the segments selected in the display 

filter. 

- Within these segments, the system displays only the MRP elements selected in the display filter. 

This reduces the data in the list to a clear selection. 

In contrast to a selection rule, the calculation of the quantity available and the ranges of coverage is not 

affected by display filters. 

26.5.7.11.1 Define Selection Rules 

In this workstep, you define specific business views in selection rules for all the information in the 

stock/requirements list and the planning table in Repetitive Manufacturing. 

In detail, you define: 

- which MRP elements are selected to set up the respective evaluation list and/or to calculate the 

quantity available and the ranges of coverage 

- do not consider: the element is not displayed and is not used to calculate the quantity available and 

the ranges of coverage 

- display: the element is displayed but is not used in the calculation 

- show affecting availability: the element is displayed and is used in the calculation 

- which stocks are used to calculate the stock available 

- whether schedule lines in the display are replaced by the more current forecast delivery schedules or 

JIT delivery schedules 

- whether dependent requirements and dependent reservations for bulk materials are displayed and, if 

necessary, also calculated 

- which period (selection horizon) should be represented. 

You determine the selection horizon either directly or allow the user to make this setting in the 

respective transaction. 

When you use a selection rule in the stock/requirements list and in the planning table for Repetitive 

Manufacturing, the selection logic is as follows: 
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- MRP elements are displayed only for the period that is defined in the selection horizon. 

- Only those MRP elements selected in the selection rule are displayed. 

- Of the MRP elements displayed, only those flagged in the selection rule as affecting availability are 

used to calculate the quantity available and the ranges of coverage. 

- Only the stocks defined in the selection rule are used to calculate the quantity available. 

Example 

- In make-to-stock production and pre-planning strategies, quantities available are of interest based on 

the basis of planned independent requirements but also based on sales orders that have actually been 

received. This is why planned independent requirements should be displayed but should not change 

the quantity available. 

- For consumption-based material or bulk material, reservations and dependent requirements should 

be displayed and, if necessary, included in the calculation (not possible with the standard setting). 

- Only consumption, which means only requirements and stocks, should be dislayed. 

- Only replenishment elements, which means receipts, should be displayed. 

Standard settings 

Several predefined selection rules from the SAP name range are provided in the standard system. 

Activities 

If necessary, define further selection rules. 

26.5.7.11.2 Define Display Filter 

In this step, you use display filters to define how the display of information in the stock/requirements list 

and the MRP list can be reduced to a certain clear selection. The calculation of the quantity available and 

the ranges of coverage is not affected when you work with display filters, in contrast to selection rules. 

You define, in particular: 

- which MRP elements are displayed 

- of the MRP elements that you select, and that are procurement proposals (planned order, purchase 

requisitions, schedule lines), whether only the firmed elements are displayed 

- which MRP segments are displayed 

- which period (display horizon) is displayed 
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You either directly define the display horizon or allow the user to make the setting in the respective 

transaction. 

- whether the MRP elements selected should be further limited using certain additional selections (for 

example, customer, vendor, storage location) 

You either define these additional selections directly or allow the user to define them in the 

respective transaction. 

The display logic, when you use display filters in the stock/requirements list and the MRP list, is as 

follows: 

- MRP elements are displayed only for the period selected in the display horizon. 

- Within this period, MRP elements are displayed only for the segments selected in the display filter. 

- Within these segments, only the MRP elements that are selected in the filter are displayed and that, 

if necessary, correspond to particular additional selections (for example, customer, vendor, storage 

location). 

Example 

- In production, the production scheduler needs an overview of the MRP elements for in-house 

production (production orders, process orders, maintenance orders, dependent reservations plus 

planned orders) or of the MRP elements for a particular production line. 

- An MRP controller requires the display of only sales orders for a particular customer or only 

purchase requisitions for a particular vendor. 

Standard settings 

There are a number of predefined display filters from the SAP name range in the standard system. 

Activities 

If required, define additional display filters. 

26.5.7.12 Customer Exit: Program Additional Columns 

In this step, you use customer exit M61X0002 to program company-specific additional information in 

your own columns for the display of the MRP list and the stock/requirements list. 

You can define that additional data fills each of up to three columns in the display of the individual lines 

and the period totals. The user uses pushbuttons to access this additional data in the lists. 

The information in the first two columns of the period totals display can also be shown as additional lines 

in the planning table for Repetitive Manufacturing. 

Example 
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You want to display your suppliers telephone number in its own column. 

Requirements 

The customer exit has to be activated in the course of the SAP- Enhancement concept. The name of the 

enhancement is M61X0002. 

Activities 

Program additional columns if you want to display information that is not available as standard. 

Further notes 

Please also see the documentation for this enhancement. 

26.5.7.13 BAdI: Change in Stock/Requirement List for Fashion 

Use 

This Business Add-In (BAdI) is used in the Production Planning for Fashion (LO-FSH-PP) component. 

Change MRP Data 

Change Stock and Requirement Situation 

Change Stock/Requirement List for Fashion 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

26.5.7.14 Reports, Function Modules: Program Customer-Specific Lists 

In this work step, you create your own programs in the context of the stock/requirements list and the 

MRP list. To do this, SAP provides you with two example reports, BAPIs, and a function module. 

Example reports for customer-specific entry to MD07: 
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Use these example reports as templates to define your own access to the collective display of the 

stock/requirements list. 

Report RMMD07EX is recommended when you work without MRP areas. When you call the report in 

the form defined by SAP, you can choose several plants and several MRP controllers for access to the 

collective display. In the standard SAP version, only one plant and one MRP controller can be selected. 

Report RMMD07DB is recommended when you work with MRP areas. When you call the report in the 

form defined by SAP, you can choose one MRP controller and several MRP areas for the access to the 

collective display. In the standard SAP version, only one MRP area can be selected. 

Report RMMD07NEW facilitates high-performance selection according to a number of parameters with 

interval display by means of a separate selection module. With it, you can carry out high-performance 

selection according to several MRP controllers (by entering an interval), for example. This new report is 

intended to supersede the other two as a template for newer entry reports. 

The report RMMD06NEW provides the same options for the MRP lists. 

You can use these reports to realize programs that include further selection options and combinations of 

selection options. Example: You wish to display all materials for which production orders exist in the 

next two months. 

BAPI Methods for Planning Data The following 

BAPI methods are available: 

- GetStockRequirementsList 

This method enables you to select the current stock/requirements list for a material. The method 

selects all relevant stock, requirement, and receipt information for the material from the desired 

planning environment. 

More information is available in the BAPI Explorer under Logistics General --> Logistics Basic 

Data --> Material --> GetStockRequirementsList or in the documentation for the function 

module BAPI_MATERIAL_STOCK_REQ_LIST. 

- GetMRPList 

This method enables you to select the MRP list for a material. The method outputs the details (lines 

in the MRP list) in the desired display types in addition to the header of the MRP list. 

More information is available in the BAPI Explorer under Logistics General --> Logistics Basic 

Data --> Material --> GetMRPList or in the documentation for the function module 

BAPI_MATERIAL_MRP_LIST. 

Function modules LM61XU11 MD_STOCK_REQUIREMENTS_LIST_API and MD_MRP_LIST_API 

The function module MD_STOCK_REQUIREMENTS_LIST_API contains the basic functions for the 

setup of the stock/requirements list. You can use this function module to program evaluations that are 

exactly tailored to the requirements of your company. 

Function module MD_MRP_LIST_API is used for the MRP lists and contains the same functions. 
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Mass extraction of planning data without BAPI 

The extraction reports RMDMRPEXTRACT01 and RMDMRPEXTRACT02 can be used to extract 

selected planning data from requirements planning or long-term planning for customer-specific 

evaluations. In comparison with the BAPIs for individual extraction, high-performance parallelization of 

the data extraction is additionally integrated into these reports. 

Activities 

Create your own programs, if necessary using the example reports and function module, for the 

stock/requirements list. 

26.5.7.15 Define MRP Views 

In this step, you define the user-specific MRP views; that means, you define which selection criteria you 

as the user want to use for selecting materials, for which you are interested in the planning result. 

These MRP views are necessary for certain MRP-specific reports (reports for mini-applications in the 

ERP system and for displaying ERP exception messages in the alert monitor in APO). In these views, you 

define which data is to be used as a basis for the report. 

The selection of materials is very similar to the selection when using the collective display for MRP lists 

or stock/requirements lists. 

As a user, you can create as many MRP views for yourself as you wish. 

26.5.7.16 Define Profiles for Order Report 

Use 

In this process step, you can define profiles for the multi-level order report. In the 

profile, you can define the following: 
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- Whether additional materials such as bulk material, or co-products and by-products should be 

displayed 

- Settings for the availability check 

- Conditions for exceptions messages 

Here you can activate the determination of exception situations in accordance with MRP logic or the 

activate the calculation of multilevel delay. 

Standard settings 

Im standard system, the following profiles are supplied: 

- SAP000000001 for MD4C 

You use this standard profile for the order report in material requirements planning. 

- SAP000000002 supplied for CO46. 

You use this profile for production orders. 

In the standard system, the following settings for multilevel delay are supplied in both standard profiles: 

- The indicator for activating the calculation of multilevel delay is set. 

- The optimistic calculaton is selected. 

- Threshold values 

Non-critical: 0 days, Critical: 1 day, Highly critical: 1 day 

As a result of this setting, all MRP elements without a delay get the green icon @5B@. 

As soon as a delay occurs, they get a red icon @5C@. 

Note 

You can also use the profiles for the order report in the order progress report (transaction CO46), if 

you do not use the list-based progress report. 

Activities 

1. Define which profiles you want to use for the order report. 

2. If necessary, define new profiles for the order report. 

26.5.7.17 Activate Workflow for Mail to MRP Controller 
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In this activity, you make the necessary settings in order to send a mail from the MRP list or the 

stock/requirements list to the MRP controller for the material displayed and to be able to integrate this 

mail connection into a little workflow. 

If you integrate the sending to the MRP controller into a workflow, the system automatically also sends 

the stock/requirements list for the material. You can thus be sure that the recipient actually calls up the 

list and checks it. 

In this activity, you define which system users can use the function. If you do not make this setting, the 

workflow cannot be started. 

Requirements 

Make sure that the Basis customizing for the application component WFM (Workflow-Management) has 

been executed fully. 

Recommendation 

SAP recommends that you define the tasks in the workflow as general tasks. They are then available for 

all system users. 

Activities 

1. Start the activity Assign agents to tasks. 

2. Expand the branch  MRP: Mail to MRP controller. 

3. Click once on the task displayed. 

4. Choose Attributes. A dialog box appears. 

5. In the dialog box, choose General task and Copy. 

6. Repeat the procedure for the other tasks. 

26.5.7.18 Define Extraction Mode 

Use 

In this IMG activity, you specify the extraction mode for the extraction of planning data. The extraction 

mode controls the process of mass extraction of selected data for customer- specific evaluations. It is 

needed in the extraction reports RMDMRPEXTRACT01 and 

RMDMRPEXTRACT02. 

With the extraction mode, you define the filtering and output format of the planning data. 
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Requirements 

You have defined a selection (read-in) rule in Customizing for Material Requirements Planning. 

Standard settings 

You create several extraction modes (for instance, an extraction mode or stock information, an extraction 

mode for due production orders, etc. You must assign the following parameters to each extraction mode: 

- Selection rule (read-in rule) 

This selection (read-in) rule is used as a filter in the subsequent data extraction (for the targeted 

extraction of production orders only, for instance). With the selection rule, you also define the 

selection (read-in) horizon. This is the period from which the MRP elements are to be filtered out. 

- Output category 

With the output category, you define the structure in which the extracted data is to be outputted (e.g. 

in the form of period totals). 

- Period 

If you choose the output category "period totals display" you must specify a period. The system then 

aggregates the quantities in the selected period. 

26.5.8 Forecast 

In this step, you define the following settings for the forecast: 

- the weighting groups for the weighted mean average 

- the split of the forecast requirements for MRP 

- the allocation of forecast errors to error classes 

26.5.8.1 Weighting Groups for Weighted Moving Average 

In this step, you define the weighting groups for the forecast model "weighted moving average". 

In the forecast calculation, the weighting group in the material master record makes it possible to assign a 

weighting factor to the historical values. This means, for example, that you can weight the historical 

values in the near past more than the values in the more distant past. This weighting value is allocated per 

consumption value. 

Behind each weighting group are several weighting factors. Every weighting factor is allocated to a 

historical value. 
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Actions 

Maintain the weighting groups. 

26.5.8.2 Define Splitting of Forecast Requirements for MRP 

In this step, you define: 

- the periodicity in which forecast requirements are taken into consideration and are split on the time 

axis in MRP 

- for how many periods the forecast requirements are taken into consideration in the net requirements 

calculation 

The splitting indicator is defined depending on the period indicator. 

The period indicator defines the periodicity used to record the historical values for the forecast and the 

periodicity to be used to output the forecast values. 

However, this periodicity may be too large for the planning run. Therefore, you can use the splitting 

indicator to, 

- split monthly values into daily and weekly forecast requirements, and to - split weekly forecast 

values into daily forecast forecast values. 

In this step, you can also limit the number of forecast requirements for which the net requirements 

calculation is to be carried out. 

To split the forecast requirements for a material, the splitting indicator defined here is assigned in the 

material master record. 

Note 

The splitting of the forecast requirements is only relevant for capying forecast values to MRP. It has no 

influence on the forecast execution. 

Example 

Month                1   2   3   4   5   6 

Forecast values     100 100 100 100 100 100 

The planning run should provide the following forecast values: 

in the 1st month   daily        

2nd month   weekly 

  3rd - 6th month   is also taken into account 

Here, you must set the following defaults in the system: 
Number of days = 1 

Number of weeks = 1 

Periods = 4 

The following forecast values result for material requirements planning: 
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Month 1: forecast requirements are created for every workday 

Month 2: on the first workday of the week, a requirement of 25 is created Month 3 to 6: on 

the first workday of the month, a requirement of 100 is created Planned orders are not created 

for the entire planning horizon but only for 6 months. 

Actions 

Define the following in the field entitled, "No. of days": - how 

many periods are to be calculated to the day in MRP Define the 

following in the field entitled, "No. of weeks": - how many 

periods are to be calculated 'to the week' in MRP Define the following in 

the field entitled, "No. of periods": 

- for how many periods - in addition to the periods to be split - is the system to carry out the net 

requirements calculation in the planning run. 

26.5.8.3 Assign Forecast Errors to Error Classes 

You can assign errors that occur in the forecast run to different error classes (for example, according to 

the degree of importance). 

You then use these error classes to correct the forecast errors in subsequent processing of the forecast. 

Actions 

Maintain the assignment to error classes. 

26.5.9 Authorization Management 

In this segment, you allocate profiles and authorizations to the users for their activity areas. 

Authorization objects define the authorization by the entry of fields that are required for carrying out a 

particular activity. For example, the fields User group and Actions. 
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The authorization specifies the authorization object. For example, for the field User group you can define 

"MRP controller" and for the field Actions yoiu can define "Dispaly planned order". 

Profiles group together individual authorizations into a group. 

26.5.9.1 Material requirements planning 

In this step, you are informed of which authorization objects are defined for the individual functions of 

the application in the standard system. In the SAP system you can maintain authorizations for these 

objects. 

Note 

Four authorization objects are defined for MRP that control the functions of the following areas: 

- material requirements planning 

- planned order processing 

- long-term planning 

- backorder processing 

The individual functions such as, carry out single-item planning, carry out total planning, access MRP 

list, single-item display and process, etc. are assigned via the activity type. This means, with one 

authorization object, you can define various authorizations using the activity type. You can access more 

information on the activity types by double-clicking the mouse on the appropriate object in the following 

list. 

You can find all the authorization objects in the authorization class materials management material 

requirements planning. 

Authorization objects 

The following list displays which authorization objects are checked in the individual functions of the 

application. 

Functions for... 

Material requirements planning 

Authorization object 

MRP-Total planning M_MTDI_ORG 

(Class: Materials Management: MRP) 

MRP-Single-item planning M_MTDI_ORG 

(Class: Materials Management: MRP) 

MPS, Single-level M_MTDI_ORG 

(Class: Materials Management: MRP) 

MPS, Multi-level M_MTDI_ORG 

(Class: Materials Management: MRP) 
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MPS, Interactive M_MTDI_ORG 

(Class: Materials Management: MRP) 

MPS, Total planning M_MTDI_ORG 

(Class: Materials Management: MRP) 

Display stock/req.list M_MTDI_ORG 

(Class: Materials Management: MRP) 

MRP list, Individual display M_MTDI_ORG 

(Class: Materials Management: MRP) 

MRP list, Collective display 

Planned order processing 

M_MTDI_ORG 

(Class: Materials Management: MRP) 

Process planned order M_PLAF_ORG 

(Class: Materials Management: MRP) 

 

Display planned order M_PLAF_ORG 

(Class: Materials Management: MRP) 

Planned order, list display M_PLAF_ORG 

(Class: Materials Management: MRP) 

Convert planned order M_PLAF_ORG 

(Class: Materials Management: MRP) 

Firm planned order 

Long-term planning 

M_PLAF_ORG 

(Class: Materials Management: MRP) 

LTP-Total planning M_LFPL_ORG 

(Class: Materials Management: MRP) 

LTP, Single-item planning M_LFPL_ORG 

Multi-level (Class: Materials Management: MRP) 

LTP, Dingle-item planning M_LFPL_ORG 

Single-level (Class: Materials Management: MRP) 

Stock/reqts list M_LFPL_ORG 

Process (Classe: Materials Management: MRP) 

MRP list, Individual display 
M_LFPL_ORG 

(Class: Materials Management: MRP) 

MRP list, Collective display M_LFPL_ORG 

(Class: Materials Management: MRP) 
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Create planning scenario M_LFPL_ORG 

(Class: Materials Management: MRP) 

Change planning scenario M_LFPL_ORG 

(Class: Materials Management: MRP) 

Display planning scenario M_LFPL_ORG 

(Class: Materials Management: MRP) 

Calculate simulative M_LFPL_ORG 

opening stock  (Class: Materials Management: MRP) 

Set up data M_LFPL_ORG 

for PURCHIS 

Backorder processing 

(Class: Materials Management: MRP) 

Backorder processing M_MIPA_ORG 

execute (Class: Materials Management: MRP) 

Backorder processing M_MIPA_ORG 

display (Class: Materials Management: MRP) 

Standard Settings 

In the standard system, authorizations are provided for all authorization objects in the application. 

You will find both maintenance authorizations and display authorizations for authorization objects. 

The standard authorizations apply to all organization units. 

Activities 

1. Check whether the authorizations that come with the standard system cover your 

needs. Proceed as follows: 

a) Choose the object class of the application. 

A list of the authorization objects in this class is now displayed. 

b) Choose an object. 

A list of the authorizations for this object is now displayed. 

2. If necessary, create new authorizations to meet your requirements. Proceed as 

follows: 

a) Choose Authorization -> Create. 

b) Enter the authorization and a short text. 

c) Maintain the values of each field one by one. 

d) Save your entries. 

e) Activate the new authorization. 

Note 
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The profile generator lets you create authorizations and profiles. 

This function makes it much easier for you to customize your authorizations. You should use this function 

if you are working in a new installation. 

The individual configuration steps for the profile generator are described in Customizing underBasis 

Components - System Administration - Users and Authorizations - Maintain authorizations and profiles 

using profile generator. 

Description of the authorization objects 

Object: M_MTDI_ORG Organization levels of MRP 

Definition 

Organizational authorizations for material requirements planning 

This authorization object controls whether an MRP controller is authorized to carry out the planning run 

for one or more plants or which specific activities the MRP controller is authorized to execute. 

Defined fields 

The authorization contains three fields: 

- Activity categories in MRP (Field MDAKT) 

Possible values: 

BMRP: Total planning 

EMRP: Single-item planning 

 O MRP: Project planning 

 M MRP: Sales order planning 

 A MRP: Stock/requirements list 

LMRP: MRP list, individual display 

S MRP: MRP list, collective display / planned order, collective conversion 

RMRP: Current materials overview 

H MRP: Create planned order 

 V MRP: Change planned order 

FMRP: Firm planned order 

 U MRP: Planned order, individual conversion 

PMRP: Generate planning file entries 

 W MRP: Stock value display in the collective display graphic 

1 Long-term planning: Total planning 

2 Long-term planning: Single-item, multi-level planning 

3 Long-term planning: Single-item, single-level planning 

4 Long-term planning: Display stock/requirements list 

5 Long-term planning: Display MRP list 

J Long-term planning: Sales order planning 

KLong-term planning: Project planning 

 Y Multi-level MPS 

ZSingle-level MPS 

I Interactive MPS 

CMPS, total planning 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 437 

- Plant (Field WERKS) 

Here, you must enter all the plants for which materials planning can be carried out. 

- MRP controller (Field DISPO) 

Here, you must enter the MRP controller(s), who are authorized to carry out the activities. 

Object: M_PLAF_ORG Organization levels of planned order processing 

Definition 

Organization authorization for processing planned orders 

This object controls which options the MRP controller has for processing planned orders and in which 

plants. 

Defined fields 

The authorization object contains three fields: 

- Activity categories of materials planning Possible values:         'H': Create 

                         'V': Change 

                         'A': Display 

                         'L': List display 

                         'S': Collective conversion 

                         'U': Individual conversion 

                         'F': Fixing 

(For the conversion of planned orders into production orders only the values 'S' and 'U' are of relevance.) 

- Plant 

Here, you must enter all the plants for which planned order processing can be carried out. 

- MRP controller 

Here, you must enter the MRP controller(s) who are authorized to process planned orders. 

26.5.9.2 Define Profiles 

Profiles contain authorization objects for distinct working areas. 

Default Settings 

Profiles are preset in the SAP system. 

Actions 

1. Check the standard profiles. 

2. Create new profiles, if necessary. 
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26.5.10 Planning File Entries 

In this step, you make the necessary settings required to set up the planning file entries. 

The entries in the planning file controls which materials are included in the net change planning run. All 

materials that have undergone a change relevant to MRP are planned. Once the planning run has been 

carried out, the net change planning indicator is reset. 

Two steps are involved in this IMG activity: 

- Set up planning file and perform consistency check 

- Specific settings for planning file entries and goods movements 

26.5.10.1 Define Planning File Entries for Goods Movements 

Further notes 

Planning file entries are also created in inventory management. However, in the standard system, not all 

goods movements trigger a planning file entry. 

A differentiation is made between materials that are planned using reorder point planning and 

other materials. For materials that are not planned using reorder point planning, the system always creates 

a planning file entry if no reference exists to a reservation (for example, an order). If such a reference 

does exist, a planning file entry is only created for the material, if: - More than the remaining open 

rest quantity is placed in stock or issued from stock. 

- Less than the remaining open rest quantity is placed in stock or issued from stock and the final 

delivery indicator is set. 

- The requirements date/receipt date of the reservation lies in the future (not valid for purchase 

orders). 

You can also define tolerance values for the first two points. This means that a planning file entry is only 

created when the quantity deviation is greater than the specified tolerance value. You can define this 

customizing setting for individual plants. 

For a material that is planned using reorder point planning, the system only creates a planning file entry if 

the stock level lies below the reorder point at the time of the goods receipt. In the case of a goods issue, a 

planning file entry is only created if the stock level falls below the reorder point after the goods issue. 
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You can also instruct the system to create a planning file entry for each goods movement. 

26.5.11 Define Parallel Processing in MRP 

Note 

This IMG activity is only relevant if you plan some of your materials using classic MRP. If you plan all 

your materials using MRP Live, this IMG activity is irrelevant. 

With the help of parallel processing procedures, you can significantly improve the runtime of the total 

planning run. 

To process in parallel, you can either select various sessions on the application server or various servers. 

Parallel processing runs according to packages using the low-level code logic: 

The work package, with a fixed number of materials that are internally defined in the program, is 

distributed over the individual servers/sessions. Once a server/session has finished processing a package, 

it starts processing the next package. 

If a low-level code is being planned, the servers/sessions that have finished must wait until the last 

server/session has finished its package to avoid inconsistencies. Then the next low-level code is 

processed per packages. 

The parallel processing procedure is switched on in the initial screen of total planning. 

Activities 

Define the application server with the number of sessions that can be used: 

- If you want to define various servers for parallel processing, enter the server with the number 

of sessions. 

- If you only want to use one server, but several sessions, enter the application server and the 

appropriate number of sessions. 

Further notes 

Parallel processing shortens the time required for calculation, however, it cannot shorten the database 

time as the system still only operates using one database. 

26.5.12 Business Add-Ins for Requirements Planning 

Note 

This IMG activity is only relevant if you plan some of your materials using classic MRP. If you plan all 

your materials using MRP Live, this IMG activity is irrelevant. 

Use 
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In requirements planning, Business Add-Ins (BAdIs) are available for the following functions: 

- General requirements planning 

- Subcontracting logic- BAdI MD_SUBCONT_LOGIC 

- Importing MRP data - BAdI MD_CHANGE_MRP_DATA 

- Requirements scheduling of stock transfers BAdI MD_STOCK_TRANSFER 

- User-defined MRP elements in MRP/LTP - BAdI MD_ADD_ELEMENTS 

- Flexible planned independent requirement consumption/reduction - BAdI 

MD_PIR_FLEX_CONS 

- Change to planning parameters - BAdI MD_MRP_PARAMETERS 

- Changing calendar for the days' supply calculation BAdI MD_CHANGE_CALENDAR 

- Requirements planning planning evaluation (PP-MRP-BD) 

- Updating MRP list - BAdI MD_MRP_LIST 

- Changing display in MD04/MD05 - BAdI MD_DISPLAY_ELEMENT 

- Planning monitor - BAdI MD_PLANNING_RESULT 

- Additional columns in the material overview - BAdI MD_ADD_COL_OVERVIEW 

- Additional columns in the evaluation of requirements planning - BAdI 

MD_ADD_COL_EZPS 

- Export of order tree - BAdI MD_EXPORT_TREE (enhancement spot MD_ORDER 

REPORT) 

- Determining customer-specific grouping - BAdI MD_CREATE_GROUPING 

- Selection tab page additional selection on initial screen of collective displays - BAdI 

MD_EXCLUDE_MATERIAL 

- Material-specific range-of-coverage limit values for traffic light status- BAdI 

MD_SET_TRAFFIC_LIGHTS_DS 

- Extraction of planning data - BAdI MD_SR_LIST_EXTRACT 

- Requirements planning procurement proposal (PP-MRP-PP) 

- Changing purchase requisitions - BAdI MD_PURREQ_CHANGE 

- Updating purchase requisitions - BAdI MD_PURREQ_POST 

- Changing planned orders - BAdI MD_PLDORD_CHANGE 

- Updating planned orders - BAdI MD_PLDORD_POST 

- Source determination in MRP  - BAdI MD_MODIFY_SOURCE 

- Determining the production version in MRP - BAdI MD_MODIFY_PRODVERS 
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- Reacting to time stamp problems - BAdI MD_PLDORD_TIME_STAMP 

- Scheduling planned orders - BAdI MD_PLDORD_SCHEDULING 

- Deactivating release strategy for MRP PReqs - BAdI MD_PURREQ_REL_STRAT 

- Deactivating compulsory BOM explosion in CIF - BAdI MD_PLDORD_BOMEX_CIF 

- Requirements planning planning execution (PP-MRP-PR) 

- Packet size in parallel planning runs in requirements planning - BAdI 

MD_MRP_RUN_PARALLEL 

- Deactivation of changeability of MRP elements - BAdI MD_INTERACT_PLANNING 

- Long-term planning / simulation (PP-MP-LTP) 

- Additional parameters in the planning scenario - BAdI MD_PLANNING_SCENARIO 

- Order report (PP-MRP-PE) 

- Export Order Tree - BAdI MD_EXPORT_TREE (Enhancement spot 

MD_ORDER_REPORT) 

Activities 

To activate the Business Add-In, you must create an active implementation. To do this choose Tools -> 

ABAP Workbench -> Utilities -> Business Add-Ins -> Implementation in the SAP Menu. 

The system display a dialog box in which you enter a name for the implementation. 

If implementations have already been created for this BAdI, a dialog box is display in which the existing 

implementation are displayed. 

In this dialog box, choose Create and proceed as follows: 

1. In the dialog box, in the field Implementation enter a name for the implementation of the BAdI and 

then choose Create. 

The system displays the initial screen for creating BAdI implementations. 

2. In the field Implementation Short Text enter a short text for the implementation. 

3. Choose the tab page Interface. 

On this tab page, the field Name of implementing class is automatically filled, becauase the 

system assigns a class name on the basis of your implementation name. 

4. Save your entries, and assign a package. 

5. Position the cursor on a method and double-click to go to method processing. 

6. Between the statements method <Interface-Name>~<Name der Methode>. and 

endmethod.  enter the coding you want to use for the implementation. 

7. Save and activate your coding and navigate back to the screen Change Implementation. 

8. Save in the scrren Change Implementation. 
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Note: It is also possible to create an implementation for a BAdI first and activate it later. To do this, 

finish processing at this point. 

9. Choose Activate. 

When the application program is executed the coding you have saved in the method is executed. 

26.5.13 Apps for Material Requirements Planning 

26.5.13.1 General Settings 

26.5.13.1.1 Define Supply and Demand Profiles 

Use 

In this Customizing activity, you can group supply and demand elements for the various supply and 

demand matching evaluations. The grouping of the supply and demand elements is relevant for the 

evaluation of material shortages. 

The supply and demand profiles that you create here are assigned to the material shortage profile  that you 

create in a second customizing step. 

Standard settings 

The standard system comes with predefined versions of the supply and demand profiles that typically 

need not be changed. The recommendation is that you check that the standard profiles meet your 

requirements and use them. 

Activities 

This Customizing activity is divided into two steps: 

1. Definition of the Supply Profile 

In this step, you group the supply elements. The evaluation of shortages distinguishes between four 

supply groups (stock, execution supplies, ordered supplies, and planned supplies) to which you can 

assign appropriate supply elements. 

2. Definition of the Demand Profile 

In this step, you group the demand elements. The evaluation of shortages distinguishes between five 

different demand groups (negative stock, execution demands, ordered demands, planned demands, 

and forecast demands) to which you can assign appropriate demand elements. 

In addition, when creating the demand profile you can define a category importance  and a sales 

demands importance  to prioritize your sales demand elements. This priority information is used in 
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the uncovered demand calculation as an overall sorting criterion. That is, for example, it determines 

which demand element has the highest delivery priority, the next highest, and so on. 

26.5.13.1.2 Define Material Shortage Profiles 

Use 

In this Customizing activity, you can create material shortage profiles. One material shortage profile can 

contain several  material shortage definitions that each provide a set of rules the system is to use when 

calculating material shortages and uncovered demand, for example. These rules define the scope of the 

shortage calculation meaning the supply and demand elements to be considered as well as the conditions 

that have to be met to be a relevant shortage. 

The material shortage definitions are displayed in the SAP Fiori Apps for Material Requirements 

Planning such as Monitor External Requirements or Monitor Material Coverage. They appear in the 

Shortage Definitions drop-down list and provide different views on the calculation of material shortages. 

Requirements 

Before maintaining your material shortage profiles, you should first have checked that the standard supply 

and demand profiles in the Customizing activity Define Supply and Demand Profiles meet your 

requirements. 

Standard settings 

The standard system comes with predefined material shortage profiles with material shortage definitions. 

Check whether these standard settings are sufficient for your business needs. If not, copy the standard 

profiles and make any necessary changes. 

Activities 

The maintenance of the material shortage profile can be divided into three steps: 

1. Create the Material Shortage Profile and Assign Supply and Demand Profiles You copy the standard 

material shortage profile and assign the appropriate supply and demand profiles. 

2. Maintain Material Shortage Definition 

You define exactly which supply and demand groups are to be considered for each material shortage 

definition. This determines which supply and demand elements are to be considered for supply and 

demand matching. 

Here, you also define the evaluation horizon in workdays and by selecting the Calculate Uncovered 

Demand checkbox, you can define that uncovered demands are to be calculated in addition to 

material shortages. 

3. Maintain Material Shortage Threshold Type 
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If you have created a material shortage definition to calculate material shortages only (that is you 

have not selected the Calculate Uncovered Demand checkbox), then you also have to define the 

material shortage threshold type. This specifies when a planning situation is to be considered as a 

relevant shortage to be displayed in the material list. If you have created a material shortage 

definition and have selected the Calculate Uncovered Demands checkbox so that uncovered 

demands are also calculated, you cannot maintain the threshold type manually. In this case, the 

system automatically sets the threshold type to Available Quantity Below Zero and determines a 

material shortage when the available stock quantity falls below zero. 

Example 

You have created a material shortage profile with the following four material shortage definitions: 

1. Stock Days' Supply 

Supply Groups: Stock 

Demand Groups: All Demands 

Definition Type: Material Shortage Calculation (Calculate Uncovered Demands checkbox is not 

selected) 

2. All Supplies vs. All Demands (MRP Standard Logic) 

Supply Groups: All Supplies 

Demand Groups: All Demands 

Definition Type: Material Shortage Calculation 

3. Planned Supplies vs. Ordered Demands 

Supply Groups: Planned Supplies 

Demand Groups: Ordered Demands 

Definition Type: Material Shortage Calculation + Uncovered Demands Calculation 

(Calculate Uncovered Demands checkbox is selected) 

4. Ordered Supplies vs. Planned Demands 

Supply Groups: Ordered Supplies 

Demand Groups: Planned Demands 

Definition Type: Material Shortage Calculation + Maximum Coverage Calculation 

(MaxCovCalc checkbox is selected) 

As a result, all four shortage definitions would be available in the SAP Fiori apps Monitor Material 

Coverage and Monitor Production Orders or Process Orders. However, only shortage definition 3 would 

be available in the apps Monitor External Requirements and Monitor Internal Requirements. 

26.5.13.1.3 Assign Material Shortage Profile to Users 

Use 

In this Customizing activity, you can assign material shortage profiles to users. This controls which 

material shortage definitions the user can choose from in the SAP Fiori Apps for Material Requirements 

Planning. 
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Standard settings 

In the standard system, this Customizing table is empty and the system automatically uses the SAP 

standard profile SAP000000001 for all users. If necessary, you can change this standard behavior. 

Activities 

If you make no changes in this Customizing table, the system automatically uses the SAP standard profile 

SAP000000001 as the default value. 

If you want to assign the SAP standard profile (or an alternative profile that you have already created) to 

the majority of your users but want to assign a different profile to certain users, you can enter * in the 

User field and assign the appropriate material shortage profile. 

You can then enter other individual users to whom you want to assign different profiles and assign the 

appropriate material shortage profile. 

26.5.13.1.4 Specify Contact Person Function 

Use 

In this Customizing activity, you can specify the contact person functions for vendors and for customers 

that are relevant for SAP Fiori apps for MRP. These settings are used to determine the contact person for 

solution cards and quickviews in the application. 

Requirements 

In transaction Change Vendor (Purchasing) (MK02), you have entered a contact person and assigned a 

function. 

In transaction Change Customer (Centrally) (XD02), you have entered a contact person and assigned a 

function. 

Example 

You have entered two contact persons for a specific vendor. One contact person is assigned the function 

Head of Sales and the other is assigned the function Executive Board. In this Customizing activity, you 

have entered the function Head of Sales. 

When you open a solution card in the SAP Fiori apps for MRP, data for the contact person with the 

function Head of Sales is displayed. 
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26.5.13.2 System Enhancements and Business Add-Ins 

26.5.13.2.1 BAdI: User-Defined Field Transport for Purchase Orders 

Use 

This Business Add-In (BAdI) is used in the Purchasing (MM-PUR) component. You can use this BAdI 

to transport user-defined fields using OData services as follows: 
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You can import user-defined fields from the front end to the back end. 

You can export user-defined fields from the back end to the front end. 

You can use the following BAdI methods: 

- EXPORT_CONVERSION (Export User-Defined Fields (READ and after CREATE)) 

You can use this BAdI method to export user-defined fields, when a purchase order is read or has 

been created in the back end. 

- IMPORT_CONVERSION_FOR_CREATE (Import User-Defined Fields) 

You can use this BAdI method to import user-defined fields, when a purchase order is created in the 

back end. 

- IMPORT_CONVERSION_FOR_UPDATE (Update Imported User-Defined Fields) 

You can use this BAdI method to update imported user-defined fields, when a purchase order is 

updated in the back end. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

See also 

For information about implementing BAdIs as part of the enhancement framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver 

Library: Function-Oriented View -> Application Server -> Application Server ABAP -> Application 

Development on AS ABAP -> ABAP Customer Development -> Enhancement Framework. 

26.5.13.2.2 BAdI: User-Defined Field Transport for Purchase Requisitions 

Use 
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This Business Add-In (BAdI) is used in the Purchasing (MM-PUR) component. You can use this BAdI 

to transport user-defined fields using OData services as follows: 

You can import user-defined fields from the front end to the back end. 

You can export user-defined fields from the back end to the front end. 

You can use the following BAdI methods: 

- EXPORT_CONVERSION (Export User-Defined Fields (READ and after CREATE)) 

You can use this BAdI method to export user-defined fields, when a purchase requisition is read or 

has been created in the back end. 

- IMPORT_CONVERSION_FOR_CREATE (Import User-Defined Fields) 

You can use this BAdI method to import user-defined fields, when a purchase requisition is created 

in the back end. 

- IMPORT_CONVERSION_FOR_UPDATE (Update Imported User-Defined Fields) 

You can use this BAdI method to update imported user-defined fields, when a purchase requisition 

is updated in the back end. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

See also 

For information about implementing BAdIs as part of the enhancement framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver 

Library: Function-Oriented View -> Application Server -> Application Server ABAP -> Application 

Development on AS ABAP -> ABAP Customer Development -> Enhancement Framework. 

26.5.13.2.3 BAdI: Extensibility of Stock/Requirements and Shortage Lists 

Use 
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This Business Add-In (BAdI) is used in the Material Requirements Planning component (PP-MRP, PP-

MRP-PE). You can use this BAdI to add additional columns to the stock/requirements list (supply and 

demand items list) in the details view and to the shortage list in the solution view of the following MRP 

apps: 

- Manage Material Coverage  

- Manage Internal Requirements 

Manage External Requirements 

Manage Production Orders or Process Orders 

Requirements 

You have inserted an append structure in the include structure 

PPMRP_SUPPLY_DEMAND_ITEM_INCL and added your new, customer-specific field to this append 

structure. 

Standard settings 

The Business Add-In is not active in the standard system, it is not filter-dependent and it can be reused. 

Activities 

Create an implementation for the two methods of the BAdI: 

PPMRP_ENHANCE_SDIV_DETAILS 

- ENHANCE_SDIV_DETAILS 

- ENHANCE_SOL_SDIV_DETAILS 

This fills the additional columns of the tables CT_ENTITY_SDIV_DET_TAB and 

CT_ENTITY_SOL_SDIV_TAB with content. 

For more information about redefining the OData model and implementing extension points in the UI, 

see the extensibility documentation for the apps on the Help Portal under http://help.sap.com/fiori. 

Choose SAP Fiori Apps -> SAP Fiori Apps for SAP ERP -> Apps for Logistics -> Production Planning 

and Control (PP) -> Material Requirements Planning. 

Example 

You can find an example implementation in the BAdI Builder on the Enhancement Spot Element 

Definitions tab in the Implementation Example Classes section. 

The following example implementation is available: 

- CL_EX_PPMRP_ENH_SDIV_DETAILS # Example Implementation Enhance Stock/Requirements 

List and Solution View 
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See also 

BAdI method documentation: 

- ENHANCE_SDIV_DETAILS  - Enhance Stock/Requirements List (Supply and Demand 

Items List) 

- ENHANCE_SOL_SDIV_DETAILS  - Enhance Shortage List 

For information about implementing BAdIs as part of the Enhancement Framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 
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Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

26.5.13.2.4 BAdI: Extensibility of Material List 

Use 

This Business Add-In (BAdI) is used in the Material Requirements Planning component (PP-MRP, PP-

MRP-PE). You can use this BAdI to add columns to the material list of the Monitor Material Coverage 

app. 

Requirements 

You have inserted an append structure in the include structure 

PPMRP_SUPPLY_DEMAND_ITEM_INCL and added your new, customer-specific field to this append 

structure. 

Standard settings 

The Business Add-In is not active in the standard system, it is not filter-dependent and it can be reused. 

Activities 

Create an implementation for the BAdI method PPMRP_MAP_MATSHORT. This fills the additional 

columns of the table CT_SHORTAGE with content. 

For more information about redefining the OData model and implementing extension points in the UI, 

see the extensibility documentation for the apps on the Help Portal under http://help.sap.com/fiori. 

Choose SAP Fiori Apps -> SAP Fiori Apps for SAP ERP -> Apps for Logistics -> Production Planning 

and Control (PP) -> Material Requirements Planning. 

See also 

BAdI method documentation: 

 - MAP_MATERIAL_SHORTAGE - Enhance Material List 

For information about implementing BAdIs as part of the Enhancement Framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 
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Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

26.5.13.2.5 BAdI: Extensibility of Manufacturing Orders List 

Use 

This Business Add-In (BAdI) is used in the Material Requirements Planning component (PP-MRP, PP-

MRP-PE). You can use this BAdI to add additional columns to the production orders list or to the process 

orders list of the Monitor Production Orders or Process Orders MRP app. 

Requirements 

You have inserted an append structure in the include structure 

PPMRP_SUPPLY_DEMAND_ITEM_INCL and added your new, customer-specific field to this append 

structure. 

Standard settings 

The Business Add-In is not active in the standard system, it is not filter-dependent and it can be reused. 

Activities 

Create an implementation for the one method of the BAdI, PPMRP_MAP_MFGORD. This fills the 

additional columns of the tables CT_MFG_ORDER with content. 

For more information about redefining the OData model and implementing extension points in the UI, 

see the extensibility documentation for the apps on the Help Portal under http://help.sap.com/fiori. 

Choose SAP Fiori Apps -> SAP Fiori Apps for SAP ERP -> Apps for Logistics -> Production Planning 

and Control (PP) -> Material Requirements Planning. 

See also BAdI method 

documentation: -



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 453 

 MAP_MFGORD - Enhance 

Manufacturing Order List 

For information about implementing BAdIs as part of the Enhancement Framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

26.5.13.2.6 BAdI: Extensibility of Uncovered Requirements List 

Use 

This Business Add-In (BAdI) is used in the Material Requirements Planning component (PP-MRP, PP-

MRP-PE You can use this BAdI to add additional columns to the external requirements list of the 

Monitor External Requirements app and to the internal requirements list of the Monitor Internal 

Requirements app. 

Requirements 

You have inserted an append structure in the include structure 

PPMRP_SUPPLY_DEMAND_ITEM_INCL and added your new, customer-specific field to this append 

structure. 

Standard settings 

The Business Add-In is not active in the standard system, it is not filter-dependent and it can be reused. 

Activities 

Create an implementation for the one method of the BAdI, PPMRP_MAP_UNCDEM. This fills the 

additional columns of the table CT_UNCDEM with content. 

For more information about redefining the OData model and implementing extension points in the UI, 

see the extensibility documentation for the apps on the Help Portal under http://help.sap.com/fiori. 

Choose SAP Fiori Apps -> SAP Fiori Apps for SAP ERP -> Apps for Logistics -> Production Planning 

and Control (PP) -> Material Requirements Planning. 

See also 

BAdI method documentation: 
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 - MAP_UNCDEM - Enhance Uncovered Requirements List 

For information about implementing BAdIs as part of the Enhancement Framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

26.5.13.2.7 BAdI: Extensibility of Manufacturing Order Components List 

Use 

This Business Add-In (BAdI) is used in the Material Requirements Planning component (PP-MRP). You 

can use this BAdI to change the list of order components that is returned by the OData service for the 

component view in the Manage Production Orders or Process Orders app. 

Standard settings 

- In the standard system, the Business Add-In is not active. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate this BAdI, you must create an active implementation. 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

BAdI method documentation: 

- MODIFY_SELECTION - Modify Selected Component List 

- CHANGE_RESULT - Change Fields of Resulting Component List 

For more information about redefining OData models, see SAP Help Portal at 

http://help.sap.com/nwgateway. Open the Developer's Guides and choose SAP NetWeaver Gateway 

Cookbooks -> OData Channel Cookbooks -> Getting Started with the Service Builder -> Redefining 

Services -> Redefining OData Services (GW). 

26.5.13.2.8 BAdI: Extensibility of Manufacturing Order Milestones List 
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Use 

This Business Add-In (BAdI) is used in the Material Requirements Planning component (PP-MRP). You 

can use this BAdI to change the list of order milestones that is returned by the OData service for the 

milestones view in the Manage Production Orders or Process Orders app. 

Standard settings 

- In the standard system, the Business Add-In is not active. 

- The Business Add-In is not filter-dependent. 

Activities 

To activate this BAdI, you must create an active implementation. 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

BAdI method documentation: 

- CHANGE_RESULT - Change Fields of Resulting Milestone List 

For more information about redefining OData models, see SAP Help Portal at 

http://help.sap.com/nwgateway. Open the Developer's Guides and choose SAP NetWeaver Gateway 

Cookbooks -> OData Channel Cookbooks -> Getting Started with the Service Builder -> Redefining 

Services -> Redefining OData Services (GW). 

26.5.13.2.9 BAdI: Extensibility of Manufacturing Order Operations List 

Use 

This Business Add-In (BAdI) is used in the Material Requirements Planning component (PP-MRP). You 

can use this BAdI to change the list of order operations that is returned by the OData service for the 

operation views in the Manage Production Orders or Process Orders app. 

Standard settings 

- In the standard system, the Business Add-In is not active. 

- The Business Add-In is not filter-dependent. 
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Activities 

To activate this BAdI, you must create an active implementation. 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

BAdI method documentation: 

- MODIFY_SELECTION - Modify Selected Operation List 

- CHANGE_RESULT - Change Fields of Resulting Operation List 

For more information about redefining OData models, see SAP Help Portal at 

http://help.sap.com/nwgateway. Open the Developer's Guides and choose SAP NetWeaver Gateway 

Cookbooks -> OData Channel Cookbooks -> Getting Started with the Service Builder -> Redefining 

Services -> Redefining OData Services (GW). 

26.5.13.2.10 BAdI: Extensibility of Quickviews 

Use 

This Business Add-In (BAdI) is used in the Material Requirements Planning component 

(PP-MRP, PP-MRP-PE). You can use this BAdI to add columns to the quickviews of the apps Monitor 

Material Coverage, Manage Material Coverage, Manage External Requirements, Manage Internal 

Requirements, and Manage Production Orders or Process Orders. 

Requirements 

You have inserted an append structure in the include structure 

PPMRP_SUPPLY_DEMAND_ITEM_INCL and added your new, customer-specific field to this append 

structure. 

Standard settings 

The Business Add-In is not active in the standard system, it is not filter-dependent and it can be reused. 

Activities 

Create an implementation for the BAdI method ENHANCE_QUICKVIEW. This fills the additional 

columns of the structure CS_QUICKVIEW with content. 

For more information about redefining the OData model and implementing extension points in the UI, 

see the extensibility documentation for the apps on the Help Portal under http://help.sap.com/fiori. 
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Choose SAP Fiori Apps -> SAP Fiori Apps for SAP ERP -> Apps for Logistics -> Production Planning 

and Control (PP) -> Material Requirements Planning. 

Example 

BAdI method documentation: 

- ENHANCE_QUICKVIEW - Enhance Quickview 

For information about implementing BAdIs as part of the Enhancement Framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

26.6 Shop Floor Control 

This section contains all the information for implementing shop floor control in production planning. 

Caution 

Starting from a total of 100 000 orders (including the other order categories) you should definitely 

consider note 45290 in OSS. If you have no access to OSS you should contact the SAP hotline. 

26.6.1 Master Data 

In this section, you maintain the settings for master data which are important when the production order is 

created. 

Master data includes: 

- routings 

- bills of material 

- production resources/tools 

- trigger points 

26.6.1.1 Order 
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In this section, you make settings which refer to the master data of a production order. 

Among other things, you specify the following: 

- order type 

- parameters depending on order type 

- number ranges 

- status profile 

26.6.1.1.1 Define Order Types 

In this step you define order types. An order type contains control information that you need for 

managing orders. You have to assign every order to an order type. 

The order category (= 10, production order) in this step is a fixed setting and cannot be changed.  The 

order categories are predefined in the SAP System and characterize the technical properties of the orders. 

Other order categories are, for example, process order and network. 

With the order type, you define the following: 

- CO (Controlling) partner update 

You can specify whether a totals record is to be written per order if a CO partner object (for 

example, a cost center) is assigned to an order of this order type. 

- Order classification 

Here, you specify whether orders of this order type are to be taken into account in classification for 

order summarization and the order selection. 

- Open item management 

You can specify for every order type whether you want to use open item management. 

- Order residence time 

Here, you define how long completed orders remain in the SAP System before they are archived. 

- Settlement profile 

In this profile, you specify the objects to which orders of this order type may be settled. 

- Functional area 

You can enter a functional area for the order type. 

- Collective order with goods movement 

This indicator controls whether goods movements can take place for production orders that are 

linked to a collective order. 

- Status management 

An order can go through several processing statuses. Among other things, the status controls which 

business transactions are allowed in the order. 
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- Number assignment 

You have to assign a number range to every order type. 

Note 

In addition to the general order parameters at client level, there are also parameters at plant level, which 

you can process in the work step Define order-dependent parameters. 

Requirements 

You must have processed the menu option Define number ranges for orders. 

Default Settings 

Order types are preset in the standard system. 

Activities 

1. Classify the orders with regard to their distinguishing features (for example, order category, number 

range, and so on). 

2. Determine for each order category whether you want to use status management. 

3. If necessary, define your own order types. 

26.6.1.1.2 Define Order-Type-Dependent Parameters 

In this step, you define the parameters that are valid for each order type and plant. The parameters are 

split up as follows on the tab pages: 

Planning 

- Master data 

Here, you define the data that influences master data selection or order master data maintenance: 

- You can decide whether production versions are selected automatically or manually. 

- The task list application is predefined as 'P'. However, you can also specify an additional task 

list application. 

- The routing selection ID defines, for example, the ranking order for routing selection. 

- Routing selection defines whether routings are to be selected and if so, how (manually or 

automatically) and whether reference operation sets can also be selected. 

- Alternative sequences and sequence exchange define whether alternative sequences are 

permitted and how the sequences are to be exchanged. 

- The task list type defines which routing type is permitted for production orders. 
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- Operation dtl check defines whether operation detail screens are to be checked when the 

operations are transferred to the order. 

- Routing text defines that the text from the routing header is copied into the order. 

- You can activate the entry tool for operations to help you when you create operations. 

- BOM application defines how the BOM alternatives are to be automatically selected. 

- Search procedure defines how batch determination is to take place. 

- General 

- Substitute MRP controller/substitute production scheduler are proposed when you create 

production orders if an MRP controller or production scheduler are not specified in the 

material master, or if there is no reference to material. 

- Reservation/Purch. req. specifies whether certain order objects (operation, components) are 

relevant to MRP. 

- Collective purch.req. enables collective purchase requisition per order for externally processed 

operations or non-stock items. 

- Inspection type defines how a quality inspection is to be carried out. 

Implementation 

- Status change documents 

Here, you define whether you want change documents to be written if a status change occurs. You 

also define the level at which the change documents are to be written. 

A status change document contains the following: 

- which status has been changed 

- who changed the status 

- whether the status has been activated or deactivated 

- the transaction in which the status change has been carried out 

In the production order, you can define the status at the following levels: 

- order header level 

- operation level 

- material component level 

- production resource/tool level 

Status change documents can also be defined independently of each other, at each of these four 

levels. 

Note 

If you have defined these parameters such that status change documents are written for a particular 

order level, the SAP System only writes a status change document for a status change from this 
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point in time if the order (or operation/component/PRT) has been created since the status change 

documents have been activated. 

- Shop Floor Information System 

You can specify, for example, whether order data is to be stored in the Shop Floor Information 

System. You can carry out reports using this system, for example, for materials, orders and work 

centers. 

- Documentation of goods movements 

Here, you can specify that goods movements are to be documented with reference to an order. Then 

you can display goods movements, for example, using the order information system. 

You can enter a profile for displaying documented goods movements on the tab page "Display 

profiles". 

- PDC 

PDC active allows data to be exchanged with a PDC system. 

- Workflow 

Workflow for PO chg. defines that a workflow is generated when quantities or dates that affect 

existing purchase orders are changed in the order. In addition, a default rule for the split is displayed 

on this screen. So that this indicator is also valid for production orders the appropriate settings must 

be made in Customizing for the Project System. 

- Progress determination in orders 

You can determine that progress values are calculated for order progress reports. 

Controlling 

- Controlling 

Here, you define the parameters relevant to controlling, such as, for example, costing variants for 

planned and actual costs and a results analysis key. 

- Distribution rule 

Default (distribution) rule defines an automatically generated distribution rule for CO settlement. 

Display profiles 

- Collective order display 

Graphics profile defines how the collective order is to be displayed. 

- Graphic 

Here, you define parameters for displaying graphics of operations and sequences in the order. 

- Missing parts list 

ProfMissPrtsLstOrdNo/PrfMissPrtLstCollOr defines how the missing parts list is to be displayed. 

- Documentation of goods movements 

Goods movements defines which profile is used for displaying documented goods movements. 

Activities 

Create the necessary parameters for the order type. 
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26.6.1.1.3 Define Additional Settings for Production Orders 

Use 

In this IMG activity, define additional parameters for order types. These additional parameters enable you 

to control specific functions of SAP Mill Products. 

26.6.1.1.4 Define status profile 

In this IMG activity you define status profiles. 

Activities 

1. Enter a Status Profile. 

2. Assign the status profile to an Object Type. 

3. Define the User Status. 

4. Assign Business Transactions to user statuses. 

5. Translate the status profile and user statuses. 

Defining a status profile. 

To define a status profile, proceed as follows: 

Create status profile 

To create a status profile, proceed as follows: 

1. Select "Edit -> New entry". 

2. Enter a name for the status profile. 

3. Enter a description. 

4. Enter a maintenance language for the status profile. 

Changes and supplements to the status profile can only be made in the maintenance language, and 

must then be translated into the respective foreign languages. This guarantees that the entries in the 

status profile are complete and unambiguous. 

5. Choose "Enter" to include the new status profile in the list. 
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6. Choose "Save". 

Assign status profile to an object type 

To be able to use a status profile for objects of a certain object type, you need to assign the profile to 

the corresponding object type: 

1. In the screen "Change Status Profile: Overview", position the cursor on the status profile you want 

to assign. 

2. Choose Goto -> Object types. 

3. Select the object types for which the status profile is valid. 

Note that there are four object types relevant for the Project System: 

- Project definition 

- WBS element 

- Network header - Network activity 

4. Choose Save. 

Define user status 

To define user status for a status profile, proceed as follows: 

1. In the screen "Change Status Profile: Overview", position the cursor on the status profile you want 

to maintain. 

2. Choose Goto -> User status. 

3. For each user status you must enter a four-digit, language- specific key to identify the status. 

4. For each user status you can enter the following: 

a) In "Stat. no." field, enter a status number 

The sequence number determines the sequence in which the statuses contained in a status 

profile can be set. 

b) Specify a lowest and highest sequence number in the "Low" and "High" columns. 

c) Enter a short text. 

The short text contains a short description of the status. 

d) Enter a long text for the user status. Choose Goto -> Long text. 

e) Select a user status as an initial status, if necessary. 

If you select a user status as an initial status, it is set automatically when you create a cost 

object. Within a status profile, you can define only one initial status with a sequence number, 

but as many as you require without a sequence number. 

f) You use "Position" to specify the position in which the status is displayed in the order header. 

g) You use "Priority" to specify which priority the user status has on a particular position if the 

same position is defined for more than one active status. 
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5. Save your entries. 

Assign business transactions to a user status 

To assign business transactions to your user statuses, proceed as follows: 

1. Position the cursor on the desired user status. 

2. Choose Goto -> Business transaction control. 

3. Choose Edit -> New lines to display a list of the existing business transactions. 

4. Assign the corresponding transactions to your user status. 

5. You use "Influencing" to activate the following fields for each transaction: 

a) "No influence" 

The business transaction is not influenced by the current user status. 

b) "Allowed" 

The business transaction is allowed by the current user status. 

c) "Warning" 

The business transaction is allowed by the current user status but a warning message is 

displayed. You can decide whether to heed the warning or not. 

d) "Disalld" 

The business transaction is not allowed by the current user status. 

To use a business transaction, the following is required: 

- At least one active status must allow the business transaction. 

- No active status may disallow the business transaction. 

6. You use "Next action" to specify what effect a particular business transaction has on the respective 

statuses: 

a) "No action" 

The status is neither set nor deleted by the business transaction. 

b) "Set" 

The business transaction sets the respective status. 

c) "Delete" 

The business transaction deletes the respective status. However, you cannot use this to delete a 

user status that has a sequence number. 

These statuses can only be deleted by setting a subsequent status, which also has a sequence 

number. 

7. Save your entries. 

Translate status profile and user status 
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You can translate the status profile and the user statuses assigned to it into other languages. 

If you wish to translate, note the following: 

- User statuses can only be created, changed, and deleted in the original maintenance language. 

- Unless all the user statuses within a status profile are translated, the system shows them all in the 

original maintenance language. 

If you wish to translate a status profile, proceed as follows: 

1. Choose Extras -> Profile translation in the status profile overview. 

2. You can call up a list of foreign language ID codes using the F4 key. 

3. Select one using the F2 key. 

4. Choose "Enter". 

5. Translate the name of your status profile into the foreign language. 

6. Save your translation. 

To translate user statuses, proceed as follows: 

1. Position the cursor on the status profile in question. 

2. Choose Goto -> User status. 

The system lists all user statuses in the profile. 

3. Choose Goto -> Status translation. 

4. You can call up a list of foreign language ID codes using the F4 key. 

5. Select a list using the F2 key. 

6. Choose "Enter". 

7. Translate the key, the description and, if necessary, the long text in the required language. 

8. Save your translation. Additional information 

Status simulation 

You use this to simulate the status development for a particular object. 

Place the cursor on a status profile, use the function Goto -> Object types, and position the cursor on one 

of the allowed object types. 

- Choose Extras -> Status simulation to simulate the status changes that would result if you were to 

use the relevant business transactions, or maintain the status manually. 
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From the simulation, you can go directly to the status maintenance screen for each object type, 

where you can call up more detailed information on the allowed and disallowed transactions. 

- Each step you simulate is recorded by the system in a log displayed online. This enables you to 

trace the status development at all times. 

Status profile information 

Using this function on the screen "Change Status Profile: Overview" you can call up a list which 

summarizes the specifications in your status profile. 

The list is structured as follows: 

- The first section contains the object types allowed for this status profile. 

- The second section contains the user statuses that are defined for this profile. 

- In the third section, the system lists for each user status that business transactions are: 

- Allowed 

- Allowed, with warning message - Disallowed. 

Object type info 

Using this function on the screen "Change Status Profile: Object Types Allowed", you can call up a list 

that summarizes all the specifications on system statuses for a particular object type. 

The list is structured as follows: 

- The first section contains the valid system statuses for this object type. 

- The second section contains the allowed business transactions for this object type. 

26.6.1.1.5 Define selection profiles 

In this menu option you define selection profiles that you can use to specify status combinations for 

selecting objects (for example, orders or operations). A selection profile is especially useful if you select 

a large number of objects repeatedly according to the same selection conditions (for example, orders for 

printing shop papers, for collective release, or for creating order valuations). 

Selection procedure 

The selection conditions are evaluated top-down. Here the following rule applies: 

- Several lines following one another that are linked by an OR are combined and evaluated together. 

From the block at least one selection condition must be fulfilled. 

AND links blocks or individual conditions. All the blocks or individual conditions linked with 

AND must be fulfilled. An order is no longer part of the evaluation as soon as a block or individual 

condition is not fulfilled. That means that with every freshly inserted AND a bracket is inserted 
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around the preceding expressions (conjunctive normal form). To select the desired status 

combinations a reforming of the selection conditions is necessary. 

- In general one can say that OR links more strongly than AND! 

Example 

You want to define a selection profile with which orders with the following status combinations are 

selected: 

- REL (released) 

- CRTD UND MACM (created and material committed) 

To do this formulate: 

REL OR (CRTD AND MACM) 

But the system interprets: 

(REL OR CRTD) AND MACM 

Orders with the following status combinations are selected: 

- REL AND MACM 

- CRTD AND MACM 

Thus the original formulation must be reformulated by "multiplying out" to: 

(REL OR CRTD) AND (REL OR MACM) 

Status 'active', 'inactive', or 'never active' 

You can also define the state of a status according to which a selection is to be made: 

- If you set the state active the system searches for objects where the given status is presently active. 

- If you set the state inactive the system searches for objects where the status entered is presently 

inactive. 

- If you set the state never active the system searches for orders where the status entered was never 

active. 

Example 

The following is an example of a selection profile that should select all released orders that either have a 

missing material or a missing PRT. 

 link status state 

 REL (released) active 

 AND MMAT (missing material availability) active 

 OR MPRT (missing PRT availability) active 

The selection is carried out in two steps: 
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First, all released operations are selected (that is, orders with the active status 'REL'). 

- Out of this group the system selects all the orders with missing material or PRT availability (that is, 

orders with the active status 'MMAT' or 'MPRT'). All the orders are selected with the following 

status combinations: 

- RELEASED and MMAT 

- RELEASED and MPRT 

- RELEASED and MMAT and MPRT 

Indicator 'not' 

With this indicator you can reduce the effort required when maintaining selection conditions in particular 

cases. Many status conditions can be represented more simply by setting the indicator 'not'. 

Example 

Selection conditions without 'not' indicator: 

 link not state 

 <Status> _ inactive 

 OR <Status> _ never active 

Same selection condition with indicator 'not': 

 link not state 

 <Status> X inactive 

Recommendation 

For performance reasons, conditions that limit the selection strictly should be placed at the start of the 

selection profile. 

System status/user status 

You can enter both system status and also user status in a selection profile. If you want to select objects 

according to user status, you must enter the appropriate status profile. 

If you have maintained a status profile in the status selection profile, you have to assign this status profile 

to all objects. Selection is restricted via the status selection profile only if you have assigned the status 

profile to the objects. If you enter a system status in addition to entering a status profile, the system will 

ignore it unless it has been assigned to the status profile. 

The status profile is assigned to the objects via 

- the project profile for the project definition and the WBS elements 

- the network type for the network header and the activities 

Language dependence of a selection profile 
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If a selection profile has been created in a language then it can be used in all languages 
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defined in the system. If user statuses are defined in a selection profile then you should make sure that the 

user statuses are translated in the corresponding status profile. If no translation exists then you must enter 

the user status in the language in which it was created. 

Action 

Define your own selection profiles if necessary. 

26.6.1.1.6 Define number ranges for orders 

In this menu option, you define the number ranges for orders. 

Within a  client, every order is uniquely identified by an order. 

Each order is assigned to a number range group via its order type. You can assign several order types to 

the same number range, that is to the same number interval. 

There are two different types of number assignment: 

- Internal number assignment 

The system automatically assigns a sequential number when an order is created from the number 

range specified by the user. 

- External number assignment 

You must specify a number from the allotted number interval when an order is created. 

Requirements 

To define number ranges for orders, you need an authorization for the number range object AUFTRAG. 

This object is checked in the authorization object S_NUMBER. 

Default Settings 

Number ranges for orders are preset in the default settings. 

Actions 

1. Change or delete number ranges which are contained in the standard system, if necessary. 

2. Specify number ranges and number intervals for the order types. 

3. Allocate a group to every order type. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 
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All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.6.1.1.7 Define number ranges for confirmations 

In this menu option, you define the number ranges for confirmations. 

Every operation is uniquely identified in the production order by an operation number within a client. 

You enter this number when you confirm an order. 

Note 

The number range "01" is predefined for confirmation numbers. Only internal number assignment is 

possible. 

Requirements 

To define the number intervals for confirmations, you require the authorization for the number range 

object AUF_RÜCK. This number range object is checked in the authorization object 

S_NUMBER. 

Default Settings 

Number ranges for confirmations are predefined in the standard SAP System. 

Actions 

1. Create the number range "01" for confirmation numbers. 

2. If necessary, create a new number interval. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.6.1.1.8 Define number ranges for reservations 
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In this menu option, you define number ranges for reservations. 

All components in the production order are identified by a reservation number assigned per order, and a 

sequential counter. 

The allocation to a number range is carried out via the object type "Production order" and the object 

"Reservation". 

Note 

Only internal number assignment is allowed for reservation numbers within production orders. 

Requirements 

To define number intervals for reservations, you need authorization for the number range object "RESB". 

This number range object is checked in the authorization object "S_NUMBER". 

Default Settings 

In the standard SAP system, number ranges are predefined for reservations. 

Actions 

1. Change or delete the number ranges that are contained in the standard system, if necessary. 

2. Define the number ranges and number intervals for the object type "production order" and the 

object "reservation". 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.6.1.1.9 Define number ranges for operations 

In this menu option, you define the number ranges for the operations of an order. 

All operations and sequences in the production order are identified by an order task list number (assigned 

per order) and a sequential counter. 

Number ranges are assigned per order category (that is production order, maintenance order). 

Note 
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For the order task list number, only one internal number assignment is allowed. 

Requirements 

To define the number intervals for order routing numbers, you need authorization for the number range 

object "AUF_PLAN". This number range object is checked in the authorization object "S_NUMBER". 

Default Settings 

In the standard SAP system, number ranges are predefined for operations. 

Actions 

1. Change or delete the number ranges that are contained in the standard system, if necessary. 

2. Define the number range and the number interval for order category "10" (production order). 

&ADDITIONAL HINTS& 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.6.1.1.10 Define number ranges for capacity requirements 

In this menu option, you define number ranges for capacity requirements. 

All capacity requirements in the production order are identified by a requirement tracking number 

(assigned per order) and a sequential counter. 

Note 

For the requirement tracking number, number range "01" is predefined. Only one internal number 

assignment is allowed. 

Requirements 

To define the number intervals for requirement tracking numbers, you need authorization for the number 

range object "KBED". This number range object is checked in the authorization object "S_NUMBER". 

Default Settings 

In the standard SAP system, number ranges are preset for capacity requirements. 
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Actions 

1. Create the number range "01" for the requirement tracking numbers. 

2. Define a new number interval, if necessary. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

26.6.1.1.11 Make Settings for Full-Text Search 

Use 

In this IMG activity, you find out which settings you hae to make to be able to carry out a full-text search 

for production and process orders. The full-text search is available to you in the input help and in the 

order information system (transactions COOIS and COOISPI). To be able to use the full-text search 

facility, you must first create an index for the production and process orders. This index then contains the 

following texts: 

- All table fields and short texts of the order in the language in which the user who started the 

index run was logged on. These include: 

- Order header 

- Order items 

- Sequences (for production order only) 

- Operations 

- Phases (process order only) 

- Components 

- Document links (production order only) 

- Serial numbers (production order only) 

- Characteristics and values of variant configuration of all order items in the form "characteristic 

name = characteristic value" (for example, "color = red"). The technical key is indexed as well 

as the description in all languages in which the characteristic name has been created. 

- All long texts of the order in all languages in which a long text has been created. These include 

the long texts for: 
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- Order header 

- Sequences (production order only) 

- Operations 

- Phases (production order only) 

- Components 

The system uses TREX as the search engine for production and process orders. TREX is the central SAP 

NetWeaver search engine. More information on TREX is available in the SAP Library under SAP 

NetWeaver Library --> SAP NetWeaver by Key Capability --> Information Integration: Key Areas 

--> Search and Classification TREX --> TREX 7.0 for SAP NetWeaver 7.0. 

Requirements 

You have made the system settings for the search engine service. 

Activities 

1. You create the index for the orders in the transaction SES_ADMIN by choosing Create/Activate 

Indices in from the Index menu. A dialog box appears. 

2. In the dialog box, choose BUS2005 (production order) or BUS0001 (process order) and the value 

1 as object type. 

A line appears for the business object in the ALV list Index Monitor. 

3. Choose the business object BUS2005 (production order) or BUS0001 (process order) from the list 

and choose the function key Index Immediately. A dialog box appears in which you choose the 

indexing mode Full. The system immediately creates a full-text index. 

4. In transaction SE38, create a variant for the program COM_SE_DISPATCHER. In the variant enter 

BUS2005 oder BUS0001 as the business object and the value 1 as the object type. In addition, 

make the following settings: 

- Select delta indexing 

- Set the Object Selection indicator 

- Do not set relationship indexing 

5. To ensure that the index is always up to date, you must schedule the variant of the program 

COM_SE_DISPATCHER as a regular job. 

26.6.1.1.12 Business Add-Ins (BAdIs) for Order Split 

26.6.1.1.12.1 Customer-Specific Enhancements (Default Values etc.) 

Use 

You can use this Business Add-In (BAdI) to control the following activities: 
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- Selection of Split Method area: 

- Setting of default value for selection of split method per dropdown listbox -

 Distribution of Co- and By-Products (Split Quotient) area: 

- Adding of own calculation methods to determine the split quotient 

- Setting of default value for selection of split quotient per dropdown listbox 

- Execution of calculation methods to determine the split quotient 

- Distribution of by-/co-products in background (without user dialog) 

Standard settings 

Distribution of Co- and By-Products (Split Quotient) area: 

The adjusted quantities of co- and by-products in the parent and child order are adopted by the system. It 

is not possible to add further by- and co-products to the component list. Neither can by- and co- products 

be deleted from the component lists using this BAdI method. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 
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9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

26.6.1.1.12.2 Goods Receipt Valuation of By-Product in Order Split 

Use 

You can use this Business Add-In (BAdI) to carry out the goods receipt valuation of a by-product at the 

time of order split. 

If an order is split, costs of the parent order already incurred should be passed on to the child order on a 

pro rata basis. This is achieved via a by-product with a valuated batch. 

The BAdI has two methods that are relevant to goods receipt valuation: 

- SET_PRICE method: 

You can use this method to stipulate the price for the by-product at the time of order split. No 

further calculation of the goods receipt value then takes place. 

- SET_PRICE_AFTER_CALCULATION:method: 

You can use this method to change the price for the by-product at the time of order split. 

The system proceeds as follows to determine the goods receipt value: 

1. The SET_PRICE method is invoked to determine the price. 

2. If a price has been pre-stipulated as mandatory, the price determination process ends at this point. 

3. If no mandatory price has been stipulated, the price is calculated in accordance with the target costs 

up to the split operation. The split operation is not included in the calculation. 

4. The price can be changed using the SET_PRICE_AFTER_CALCULATION method. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 
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3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

26.6.1.1.13 Administer selection profile for the combination 

Activities 

1. Enter a four-character name for the selection profile. 

2. Enter the description for the selection profile. 

(For example, standard profile for PP) 

3. Assign the order type (for example, PP01). 

4. Define how the combined order is created. 

5. Choose the type of combination. 

Further notes 

When the order is combined, the system uses the order type in the selection profile and not the order type 

in the reference order. If a selection profile has not been chosen, the system copies the order type from the 

reference order. The chosen order type must be assigned to a relevant source structure. 

If the order is combined via the reference order, the system issues a warning if the order type of the 

selection profile and the order type in the reference order are different. 

26.6.1.1.14 Fast Entry of Characteristics in Production Order 
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26.6.1.1.14.1 Define Application Group for Characteristic Display 

Use 

In this IMG activity, you can define application groups for transactions. 

You can use application groups to define which characteristic displays are available for the fast entry of 

characteristics in the individual transactions. 

Note 

If you do not make any settings in this IMG activity, all characteristic displays are available for selection 

in the transactions that have characteristics fast entry. 

Activities 

1. Choose the New Entries button. 

2. In the Transact field, select a transaction and in the ApplGroup enter an application group. You can 

assign the same application group to several transactions in order to group together transactions. 

Note 

If you want all characteristic displays to be available in a transaction, enter '*' in the 

ApplGroup field. 

3. Assign this application group to a characteristic display in the IMG activity Define characteristic 

display for overview screen. 

Example 

In this IMG activity, you have assigned application group MM to the transactions Purchase order and 

Goods receipt. 

In the IMG activity Define characteristic display for overview screen (mySAP Mill Products), you 

assigned this application group to characteristic displays Steel_girder1, Iron_ore_pur and Pipe_single. 

In the purchase order transactions (ME21N, ME22N, ME23N) and the Goods Movement transaction 

(MIGO), these characteristic displays are then available: Steel_girder1, Iron_ore_pur and Pipe_single. 

26.6.1.1.14.2 Define Characteristics Display for Overview Screen 

Use 

In this IMG activity, you use characteristic displays to define which characteristics are available to you in 

characteristics fast entry. 

You can also use the application group to define the transaction in which characteristics display is 

available for selection. You can use the characteristics displays defined here in the following transactions: 
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- Sales documents (inquiry, quotation, order, scheduling agreement and contract) 

- Enjoy purchase order 

- Goods movements 

- Production order 

- Time ticket for production order 

- Trading Contract 

Note 

The characteristic displays are available not just for characteristics fast entry but also for the 

Configuration tab in the sales documents. 

Activities 

1. Enter a name and description for the characteristic display. 

2. If necessary, enter an application group for the characteristic display. 

You define application groups in the IMG activity Define application group for characteristic 

display. 

3. Select the characteristic display and choose Characterist assignment on the left of the screen. 

4. Enter the characteristics that you want to make available for fast entry with the help of this 

characteristic display. 

Here, you can define which characteristics are displayed, and in what sequence. 

26.6.1.1.15 Define Profiles for Selection by Characteristics 

In this IMG activity, you can create selection profiles for the selection of objects and stocks by 

characteristics. 
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26.6.1.2 Routing Data 

In this section, you maintain the routing data for production orders. 

26.6.1.2.1 Define control key 

Using the control key of the operation you determine 

- which business functions you want to carry out 

- how an operation should be dealt with The most important functions are: 

- Scheduling 

With this indicator you control whether the operation is scheduled 

- Capacity planning 

With this indicator you control whether capacity requirements records are written for the operation 

- Inspection characteristics 

With this indicator you control whether inspection characteristics have to be maintained for the 

operation 

- Automatic goods receipt 

With this indicator you determine that the yield quantity is posted to the warehouse automatically 

when the operation is confirmed 

- Costing 

With this indicator you control whether the operation is to be taken into account in costing. 

- External processing 

With this indicator you control whether the operation is to be processed externally. 

- Printing shop papers 

You can use indicators to control whether time tickets or completion confirmation slips should be 

printed for an operation 

- Processing of confirmations 

With this indicator you control 

- whether the confirmation of an operation is allowed, possible or required 

- whether the operation is to be marked as a partial completion confirmation 

Actions 

Check the existing control keys. 

26.6.1.2.2 Setup 
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In this menu option you define the setup. 

The setup includes: 

- Setup type key 

With this key you define the setup type per plant. 

- Setup group category 

This category is used to classify and to categorize setup groups. A setup group category is valid per 

plant. 

- Setup group 

The setup group groups together operations with the same or a similar setup condition. With the 

setup group, you can carry out an optimization of the sequence within capacity leveling. The setup 

group depends on the setup group category. 

With the setup type key you define the setup type plant-specifically. The setup type key is used to 

optimize the order sequence with respect to the setup time. 

A setup group groups together operations with the same or similar setup conditions. Via the setup group, 

you can carry out an optimization of the sequence during capacity planning. 

The setup group depends on the setup group category. With the setup group category 

- you classify the setup group plant-specifically 

- you group together the setup groups plant-specifically 

Actions 

1. Define your setup type keys for every plant. 

2. Maintain the setup group category. 

3. Maintain the setup groups. 

26.6.1.2.3 Define wage group 

In this step you define wage groups for operations and work centers. 

By assigning an operation or a work center to a wage group you can evaluate the work to be performed in 

the operation from a job evaluation point of view (for instance suitable for unskilled  labor or requiring 

special training). When you confirm the operation, you enter the wage group that was actually used. 

In the standard system the wage group does not affect payroll accounting in the ERP system. 

Note: 

A SAP enhancement is available for the interface between production planning and incentive wages (see, 

IMG for incentive wages, Integration with Logistics) You can use this enhancement to adapt the 

interface so that the wage group is transferred to the time ticket as the pay scale groups that are generated 

in incentive wages with reference to an order or a confirmation. Please note however that, 
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- Wage groups and pay scale groups are maintained in different tables 

- Wage groups have three figures, pay scale groups eight 

- Wage groups depend on the plant, pay scale groups depend on the pay scale area, the pay scale type 

etc. 

In this case you yourself must make sure that the data is consistent. 

Activities 

Define the wage groups that you want to use in your plant. 

26.6.1.2.4 Define suitability 

In this menu option, you can define the suitability required in a plant for carrying out certain tasks. In 

addition, you can determine whether suitability is copied or used as a reference. 

Example 

Suitability for a task can be: 

- Certificates 

- Courses of study 

- Short-term training 

Actions 

1. Enter the plant for which you want to define the suitability. 

2. Define the suitability. 

26.6.1.2.5 Define User-Defined Fields 

In this menu option you maintain the user-defined fields. 

You can specifically define these fields in the routing using a key word ID. The key word ID contains the 

appropriate key words for the user-defined fields. 

Actions 

Define the user-defined fields. 

26.6.1.3 Bill of Material 
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In this section you define the parameters which are important for a BOM explosion in the production 

order and for component maintenance. 

26.6.1.3.1 Define item categories 

In this menu option you define the item categories which determine the features and functions of a 

component. You assign an item category to a component when creating component items in the 

production order. 

The item category also determines the screen selection and the screen layout of the component detail 

screens. 

From a production order point of view, the item category specifies 

- whether a material entry is required 

- whether it is an item with inventory management on a quantity basis 

- whether the item is a pure text item 

- whether individual sizes are to be entered for the item 

- whether a +/- sign is permitted 

Note 

- You cannot use item categories defined for plant maintenance elements or for documents. 

- The item category displays the same category which is used in BOM maintenance (where it is 

usually maintained). 

Default Settings 

The following item categories are contained in the standard system: 

- document item (not in production order) 

- item kept in stock 

- text item 

- non-stock item 

- variable-sized item 

- PM structure element (not in production order) 

Actions 

Define new item categories, if necessary. 
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26.6.1.3.2 Define variable-size item formulas 

In this menu option, you define formulas for variable-sized items used to calculate the quantity of a 

variable-sized item. 

- Variable-sized item 

With the variable-sized items, you can predefine certain dimensions for a material. 

- Variable-size quantity 

The variable-size quantity of a variable-sized item is calculated as follows: 

- If you did not specify a formula key for the item, the sizes entered are multiplied with each other. 

- If you specified a formula key, the calculation is carried out according to the algorithm which you 

stored under the formula key. 

Default Settings 

In the standard system, formulas for variable-sized items are preset. 

Actions 

Define new formula keys if necessary. 

26.6.1.4 Production Resources/Tools 

In this section you maintain the necessary data for PRTs used in production orders. 

26.6.1.4.1 Define PRT control keys 

The PRT control key determines whether a PRT is taken into account when carrying out the following 

business transactions on a task list or order: 

- Scheduling 

- costing 

- Printing of production orders 

- confirmations 

Actions 

Define PRT control keys that will be of use in your company. 
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26.6.1.4.2 Formulas 

The total quantity or the total usage value of a PRT that you need for an operation is calculated in  

production resource/tool management with the help of formula parameters and formulas. 

For example, you include the order lot size in the formula for calculating the required quantity or usage 

value. 

26.6.1.4.2.1 Define formula parameters 

In the PRT management you need formula parameters to define: 

- formulas that are used to calculate the required total quantity and the total usage value of a 

production resource/tool 

- formula constants in PRT master records of the category "Other" 

Note 

You also need formula parameters for work center maintenance to 

- describe standard values 

- define formulas 

These formulas are used to calculate the capacity requirements, the lead times and the costs in 

capacity planning, scheduling and costing (general). 

Actions 

Define the formula parameters that are used in your company. 

26.6.1.4.2.2 Define formulas 

Formulas are used in PRT maintenance to calculate the required quantity and the required usage value of 

a PRT. 

Note 

Formulas are also used in capacity planning, scheduling and <GL:costing (general)>costing (general) to 

calculate capacity requirements, execution times and costs. 

Actions 

Define the formulas that are used in your company. 
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26.6.1.5 Trigger Point 

In the following steps, you perform the configurations that you need for the standard trigger point. 

26.6.1.5.1 Define (standard) trigger point usage 

In this step you specify the usage for standard trigger points and trigger points. 

Use 

Via the usage, you can group (standard) trigger points as desired. 

Grouping (standard) trigger points logically via the usage has the following advantages: 

- It makes trigger point creation more clear. 

If you enter the usage when you create a trigger point, the system lists all standard trigger points 

with this usage. 

- You recognize more quickly which functionality is triggered by a trigger point. You can, for 

example, group all (standard) trigger points that trigger similar functions via a usage. 

Activities 

Determine the usages. 

26.6.1.5.2 Define group for standard trigger points 

You can group several standard trigger points under one generic term as a trigger point group. Trigger 

point functions which are frequently carried out at the same time can be grouped in trigger point groups 

in order to make the data entry more efficient. 

Activities 

Define the trigger point groups according to your requirements. 

26.6.1.5.3 Workflow for trigger points in the production order 

A trigger point is an object that can be assigned to an operation specifically to trigger a function. You can 

use the function Start workflow task to start single-step tasks or multistep tasks. The start of the 

workflow task depends on changes in the status of the operation to which the trigger point is attached. 

When a trigger point is reached, the MRP controller who is responsible for the production order can be 

informed. The MRP controller receives a work item in his or her inbox and can maintain the production 

order from there. 
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Activities 

1. Maintaining processor assignment 

Link the standard task TS00200047 to your possible processors. 

2. Linking MRP controllers to the organizational management 

If you only want the MRP controller who is responsible for the production order to receive a work 

item, rather than all possible processors that are assigned to the standard task TS20000623, link the 

MRP controller (organizational object type T024D) to the SAP organizational management. 

3. Maintain Event Linkage 

Ensure that the following is entered in the type linkage table: 

Object type: MLST_PROD 

Event: 

Receiver type: 

Started 

Receiver FM: 

Check Function: 

SWW_WI_CREATE_VIA_EVENT 

Receiver type FM: 

Destination: 

CN_MS_EVENT_RECEIVER_TYPE_GET 

Global: X 

Enabled: X 

Further notes 

For more information, for example, about how to inform the production scheduler instead of the MRP 

controller, see the SAP Library under SAP Business Workflow -> Workflow Scenarios in Applications 

-> Production Planning and Control ->  Trigger Points (PP-SFC). 

26.6.1.6 Define Production Scheduling Profile 

In this step, you can create production scheduling profiles for specific plants. 

In a production scheduling profile, you can: 

- Specify that certain business transactions or processes are to be carried out in parallel in a 

production or process order 

- Order release at the time the order is opened 

- Generation of document link from the material master when the order is opened 

- Generation of document link from a BOM when the order is opened 

- Printing at the time of order release 

- Scheduling upon order release 

- Generation of document link from the material master upon order release 

- Generation of document link from a BOM upon order release 

- Specify whether only partial quantities are to be confirmed at the time of an availability check 
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- Specify that an automatic goods receipt is to take place 

- Specify an overall profile for capacity leveling 

- Specify how the capacity requirements of the operations are to be taken into account in the 

basic load 

- Specify when capacity scheduling is to be carried out in the capacity availability check -

 Specify that in the case of the confirmation: 

- No short quantities are to be updated 

- No excess quantities are to be updated 

- Neither short nor excess quantities are to be updated 

- An adjustment of the operation and component quantities to the actual values is to take place 

- Make various specifications in the area of batch management: 

- Automatic batch creation when an order is opened 

- Branching to batch classification when a batch is changed 

- Extended batch classification via Customer Function Call 

- Specify that only transport requirements are to be created if transport requirements can be 

generated for all the components of the operation 

- Specify that either the committed quantities or the required quantities are to be taken into 

account when transport requirements are generated 

- Specify that the creation of transport requirements is to take place automatically 

- Specify which order type is to be suggested depending on the business process 

(make-to-stock, make-to-order, make for individual project, order without material) You can 

assign a production scheduling profile to a: 

- Material (Work Scheduling screen in material master) 

- Production supervisor (Customizing) 

The assignment to a material takes higher priority. 

The production scheduling profile is adopted in the production or process order at the time the order is 

opened. 

Activities 

1. Create the necessary production scheduling profiles. 

2. Assign the profiles to the appropriate materials or production supervisors. 

26.6.1.7 Define Production Supervisor 
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In this step, you define the production schedulers for your plants. In addition to this, you can assign a 

control profile to each production scheduler. 

By assigning production schedulers to materials within the application, you can define responsibilities for 

a materials within production activity control. 
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1. Create your production schedulers. 

2. If necessary, assign profiles to your production schedulers. 

26.6.1.8 Define Matchcode 

In this section, you can edit and redefine the existing matchcodes for production orders. 

Before you process matchcodes, please read the following sections for further information. 

- Matchcode concept 

This section describes how matchcodes are structured in the SAP System. 

- Create matchcode 

This section describes how you proceed to create a matchcode in the ABAP/4 Dictionary. 

- Matchcode utility 

This section describes the handling of matchcode utilities. The matchcode utility is used to set up 

matchcodes that are stored physically. 

Further notes 

Matchcode maintenance requires technical knowledge of the ABAP/4 Dictionary. Please leave 

matchcode maintenance to the system administrator. 

Please note that a large number of matchcodes can affect system performance.  Check which matchcodes 

you want to use for your work area. You can deactivate matchcodes that you do not want to use. 

Matchcodes are valid for all clients. 

Standard settings 

The production order is delivered with the following matchcodes: 

- The matchcode with the identification "A" enables you to search by controlling area or allocation 

group. 

- The matchcode with the identification "B" enables you to search by order type or controlling area. 

- The matchcode with the identification "D" enables you to search by MRP controller. 

- The matchcode with the identification "F" enables you to search by production scheduler. 

Activities 

1. Check whether the matchcodes in the standard delivery are sufficient for your requirements. 

2. Extend the existing matchcode objects by further matchcode ID's or create new matchcodes 

if necessary. 
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26.6.2 Operations 

In this section, you enter the settings which are important for the functions in production order control. 

These functions include: 

- selecting a task list 

- selecting a bill of material 

- checking material availability 

- scheduling the order 

- planning capacities 

- confirming operations 

- printing shop floor papers 

- dispatching background jobs 

26.6.2.1 Task List Selection 

In this section, you determine the criteria according to which routings/alternative routings are selected in 

PPC. 

A routing is selected 

- when creating a routing using the copy function 

- at the time of order creation 

- during scheduling 

- during costing 

26.6.2.1.1 Define User Selection 

In this menu option, you can permit the user to select task lists. 

You can define separate ABAP/4 routines for each of the following parameters: 

- Task list application 

- Task list type 

- Selection ID 
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These parameters are then automatically used to select a routing or a routing alternative. 

Determine the task lists the user can select. 

26.6.2.1.2 Select Automatically 

In this menu option, you determine the selection criteria for the automatic planned selection of 

alternatives using the selection ID. 

You can define several selection priorities for every selection ID. You allocate the selection criteria to 

these priorities in each case. 

An alternative routing is searched for during the automatic planned selection of alternatives that 

corresponds to the selection criteria. 

Selection criteria are, for example: 

- Routing type 

- Task list usage 

- Routing status 

If no alternative routing can be calculated, the SAP System continues searching with the selection criteria 

of the next lowest selection priority. 

Note 

The selection ID is determined by the order type within the production activity control. 

Actions 

Define the following for every selection ID: 

- Selection priority 

- Routing type 

- Task list usage 

- Routing status 

26.6.2.1.3 Define Default Values 

In this step, you specify which data is contained in an operation that is automatically created during order 

creation. 

Within order creation, you can determine that an operation is created automatically if no routing exists for 

the material to be produced or no routing can be selected. 
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The automatically created operation should contain the following data, for example: 

- control key 

The control key specifies how an operation is processed (for example, whether it is scheduled, 

costed, etc.) 

- operation number 

- operation short text 

- material group (only for external processing) 

- work center where the operation is carried out 

Actions 

Specify the data for operations automatically created by the system. 

26.6.2.2 Bill of Material Selection 

In this section, you specify the process used to automatically select an alternative BOM during order 

creation. 

A material can have several bills of material with varying BOM usages. In the case of a multiple BOM, a 

bill of material of a particular BOM usage may have several alternatives. 

To be able to explode a bill of material correctly, a process for automatic alternative determination must 

be available. 

An alternative is determined using the following steps: 

- First, a BOM usage is determined 

- Then a specific alternative is determined for multiple BOMs. 

26.6.2.2.1 Define Priorities for BOM Usages 

In this menu option, you can specify different sequences of priorities of BOM usages. 

Every process relating to automatic alternative determination is represented via an application. Among 

other things, a selection ID is calculated via this application. The selection ID conceals a certain sequence 

of priorities of BOM usages. 

Note 

- When specifying the selection ID, you must know the required applications. 
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- If you use only one BOM usage, you must define a selection ID with priority 1. 

Specify different sequences of priorities of BOM usages according to your requirements. 

26.6.2.2.2 Define Applications 

In this menu option, you define the processes relating to automatic alternative determination. 

Every process is represented via an application. You need this application in order to explode a BOM 

during order creation. 

The alternative determination is controlled both by the application and the settings in the material master. 

In the material master, you can specify in the field "Alternative selection" whether you want an 

alternative to be selected according to one of the following parameters: 

- order quantity 

- date 

- production version 

Via the application, you specify the following criteria: 

- priority sequence for BOM usage (selection ID) 

- priority of a certain alternative for a special multiple BOM dependent on date You can specify per 

application whether the settings should be taken into account for the alternative selection for 

multiple BOMs. These settings are only taken into account if you selected the alternative selection 

according to date in the corresponding material master. 

- take production version into account 

If you selected the alternative selection according to production version in the material master, you 

can specify here for every application whether this setting should be taken into account. If this 

setting is not to be taken into account, the alternative selection is carried out for the corresponding 

material and application according to order quantity. 

- Indicator of the BOM status 

During alternative determination, only those bills of material are taken into account whose status at 

least contains the indicators specified here. 

Note 

During order creation, the application is determined on the basis of order type. 

Requirements 
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You must have processed the menu option "Alternative selection for multiple BOMs". 

Actions 

Define the applications according to your requirements. 

26.6.2.2.3 Define Alternative Determination for Multiple BOMs 

In this menu option, you can specify for multiple BOMs that a certain BOM alternative should be 

selected as of a certain date. 

Note 

However, these settings are only taken into account if 

- you have defined the applications accordingly and 

- you have selected "alternative selection according to date" in the material master. Actions 

Specify, if necessary, an alternative for certain multiple BOMs, according to the date. 

26.6.2.2.4 Define Alternative Determination for Production 

In this menu option, you define how automatic alternative determination is to run from the point of view 

of production. 

Requirements 

First process menu option "Define applications". 

Actions 

Enter an application depending on plant and order type. 

26.6.2.3 Availability Check 

In this section, you make the settings which are important for checking the availability of material 

components in a production order. 

To carry out a material availability check you need a checking group and a checking rule. 
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You allocate the checking group to the individual material in the material master. You specify the 

checking rule for each application. Together, the checking group and checking rule determine the scope 

of the check. 

26.6.2.3.1 Define Checking Group 

In this step, you define checking groups. 

You must allocate each material you want checked for availability to a checking group. You can allocate 

the material in the material master. The checking group groups together materials checked according to 

the same criteria. Materials can be grouped according to material type and/or MRP type, for example. 

You can also use the checking group to control whether 

- the quantities confirmed in the availability check are to be locked 

- during the check the normal ATP quantity or the cumulated ATP quantity is to be used. 

Notes 

You allocate the checking group to the material in the material master under the availabilty check field 

in the MRP data screen. 

If you have not maintained a checking group for a material, the material will not be checked for 

availability. 

Activities 

Define the necessary checking rules. 

26.6.2.3.2 Define Checking Rule 

Use 

In this step, you can define checking rules for the following applications: 

- Sales and distribution 

- MRP 

- Production order processing 

- Maintenance order processing 

- Service processing 

- Inventory management 

You can thus carry out various application-related checks for a material. 
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Actions 

For the company, define whether there is a need to check on a differentiated basis for each application. 

26.6.2.3.3 Define Scope of Check 

In this menu option, you define the check scope. Checking group and checking rule together specify the 

scope of the check. 

You can specify the following: 

- which elements relevant to MRP (inward goods movements/outward goods movements) are taken 

into account (for example, purchase requisition, purchase order, planned order) 

- which stock categories are taken into account 

- whether replenishment lead time is checked 

Actions 

Specify 

- which inward goods movements and which outward goods movements are to be included in the 

availability check 

- which stocks are to be included in the availability check - whether the check should take into 

account the replenishment lead time - whether the availability should always be checked at plant 

level. 

26.6.2.3.4 Define Checking Control 

In this activity, you define the check control. The checking rule together with the checking group specify 

the scope of the check. 

You can make the checking rule as well as the actual check itself dependent on the following parameters: 

- plant 

- order type 

- operation 

The operation can have the following characteristics: 

- order created 

- release(d) order 

Control parameters for the operation 'create' 
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In addition to this, you can specify whether a planned order can be converted to a production order 

or process order using collective conversion in the case of: 

- missing parts 

- missing PRTs or 

- insufficient capacity 

'Release' control parameters for operation 

In addition, you can control whether an order can be released in the case of 

- missing materials 

- missing PRTs 

- insufficient capacity 

Actions 

Define the following: 

- whether an availability check is to be carried out when you create or release an order 

- whether an availability check is to be carried out when you save an order that has been created or 

released 

- which checking rule is to be used 

- what effect a material shortfall is to have on the creation or release of an order 

Maintenance orders (PM)/Service orders (CS) 

The automatic check at time 1 (create), is not executed for maintenance orders, or service orders. 

You can only carry out the check manually before you have released your maintenance orders or service 

orders. 

The automatic check at time 2 (release) is executed if it is switched on. (See "no check" switch). 

26.6.2.3.5 Define Checking Rule for Backorder Processing 

In this menu option, you can determine a checking rule per plant for backorder handling. 

The checking rule determines the scope of check for backorder handling. 

Recommendation 

We recommend that you use the same checking rule for backorder handling as you do for availability 

checks. 
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Actions 

Define the necessary checking rules. 

26.6.2.4 Stock and Batch Determination for Goods Movement 

In this step you define parameters for the automatic stock and batch determination for each plant, order 

type and business transaction: 

- You assign a stock determination rule - You can switch stock or batch determination off. 

The business transactions for production orders are: 

- Backflushing of components for confirmations 

- Picking 

Requirements 

For stock determination you need a strategy according to which stocks are reduced. The withdrawal 

strategy is assigned to the combination of checking rule (plant/order category) and checking group 

(material master)(Define strategy). 

For batch determination you need a Search procedure for inventory management. You assign this to the 

individual movement types  for Determining goods movements. 

Activities 

1. Enter the plant, order category and business operation. 

2. Enter the type of check (no check, checking rule). 

26.6.2.5 Scheduling 

In this menu option, you determine the data which is required when scheduling an order. 

It includes: 

- control data for scheduling: 

- scheduling type 

- control parameters 

- routing data required for calculating the operation dates: 

- standard value key 

- location group 
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- reduction strategies and reduction levels time units 

Further notes 

More detailed information on scheduling as well as a detailed example calculation of the operation dates 

can be found in the document "PP - production orders". 

Requirements 

To calculate the operation dates and the capacity requirements, you must have processed the following 

menu options: 

- "Release periods" 

- "Determine standard value key" 

- "Determine performance efficiency rate key" 

- "Set formula parameters" and "Set up formula definition" 

- "Define shift sequence" 

- "Define factory calendar" 

- "Capacity category" 

26.6.2.5.1 Define Scheduling Parameters for Production Orders 

In this step you define for each plant, order type and production scheduler the parameters for scheduling 

production orders. This comprises maintaining 

- date adjustment when dates are exceeded 

- date control for detailed scheduling 

- reduction 

The parameters are described in what follows in details: 

- In detailed scheduling you define: 

- how production dates are to be calculated 

- whether capacity requirements are generated 

- In date adjustment you specify whether and how the basic dates are adjusted to the 

production dates (for example, when deadlines are exceeded) and how dates for dependent 

requirements are to lie. 
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- In Scheduling control for detailed scheduling you specify the control parameters for 

detailed scheduling, among other things the 

- scheduling type 

Here you specify in which direction scheduling is to be carried out and whether it is 

to be carried out to an exact time. Among other things you can specify that a scheduling run 

only be used to generate capacity requirements. 

- Start date in the past 

Here you specify how many days an order may lie in the past before today scheduling is 

triggered. 

- Calculate dates automatically 

Here you specify whether scheduling is carried out automatically on saving. 

- Display log automatically 

Here you specify whether the log is displayed automatically on scheduling. 

- Required date of material 

Here you specify where the required date of a component should be with respect to an 

operation. 

- Schedule exact to the break 

Here you specify that the exact time a break occurs must be taken into account. 

- Dates to be specified 

Here you specify that when you create or change an order the user must enter schedules dates 

(production dates) instead of basic dates. 

- Move order 

Here you specify whether the order can be moved if partially confirmed operations exist. 

- In reduction you specify 

- whether in the order or in the collective order all the operations are to be reduced or only those 

along the critical path. 

- Reduction along the critical path is only possible for networks, production orders and planned 

orders with parallel sequences and for collective orders that contain production orders or 

planned orders. 

- up to which maximum reduction level the reduction takes place 

- to what percentage the float before and after production in every reduction level is to be 

reduced. 

Actions 

Define the scheduling parameters for production orders. 
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26.6.2.5.2 Specify Scheduling Type 

In this step you define the scheduling type, which determines how the SAP System should carry out 

scheduling. There are the following options: 

- Forwards 

- Backwards 

No scheduling 

"Today" scheduling 

- Basic dates with times (only for process orders) 

You can save the scheduling type in the control data for scheduling depending on the order type. It is then 

proposed by the SAP system when an order is created. 

Recommendation 

Scheduling types are predefined in the SAP standard package. We recommend that you work with these 

predefined scheduling types. 

26.6.2.5.3 Define Time Units 

In this step, you define the time units (for example, second, minute, decade, etc.) required for scheduling. 

Note 

You have to define the time units in the table which contains the units of measurement for all dimensions. 

Default Settings 

Time units are preset in the standard system. 

Actions 

Define new time units, if necessary. 

26.6.2.5.4 Define Formula Parameters 

In this step, you define the parameters required to 

- maintain standard value keys 

- define formulas (for example, for scheduling, costing or calculating standard values with 

CAPP) 
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Parameters are identified by parameter IDs. 

The parameter ID specifies 

- what meaning and what keyword are assigned to a parameter 

- what dimension a parameter has 

- the name used to address a parameter in a formula 

You distinguish between parameters by their origin. You can maintain the following origins for a 

parameter in Customizing: 

- Standard value: The parameter that goes in a formula is assigned a standard value by means of a 

standard value key. 

- Formula constant in the work center: The parameter is assigned a fixed value in the work center 

which then goes in the formula. 

- General operation value: The parameter is assigned a field directly from the general operation 

data. The value of this field goes directly into the formula. Typical fields include: 

- lot size 

- base quantity 

- number of splits (partial lots) 

- number of employees 

- User field from operation: The parameter is assigned a user- specified data field for the operation. 

The value of this field goes in the formula. 

- Value from PRT assignment: The parameter is assigned a field within PRT assignment. The value 

of this field goes into the formula. This may involve both the quantity and the usage value of the 

PRT. 

This parameter can only be used for formulas within PRT management. 

- PRT constants: The parameter is assigned a fixed value in the PRT master record which then goes 

into the formula. 

This parameter can only be used for formulas within PRT management. 

Note 

The meaning of the fields is defined by the key words. 

Recommendation 

You should choose short terms that are easy to remember if you would like to use the parameters in a 

formula definition at a later time. 

Actions 
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Define the parameters. 

26.6.2.5.5 Define Formulas 

In this menu option, you can set up formula definitions which can be used in the following areas: 

- Capacity planning 

Scheduling 

Costing 

You can use the formula parameters to which you have previously assigned values. You can then link the 

formula parameters mathematically by using, for example, the following operators: 

- Addition => + 

- Subtraction => - Multiplication => * 

- Division => / 

Actions 

1. Check the formula parameters that can be used. 

2. Set up the formula definitions required in your company. 

26.6.2.5.6 Define Standard Value Keys 

In this menu option you can maintain standard value keys. The standard value key determines the 

meaning of the standard values. It is used to assign parameter IDs to the six standard values of operations 

and the work in network activities.  

These parameter keys determine the following: 

- the key word displayed for the standard value on the screen, for example, setup, machine, labor, tear 

down 

- the dimension (for example, time, quantity, volume) of the standard value 

At the same time, the parameter IDs are the names used for the standard values for the calculation of:  

- execution time 

- capacity requirements 

- costs 

Note 
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A parameter which is to be used in a standard value key must have the origin "2". 

Actions 

1. Define the parameter IDs for the standard standard values. 

2. Define the standard value key. 

26.6.2.5.7 Define Key for Performance Efficiency Rate 

In this menu option, you create  performance efficiency rates. 

You use the performance efficiency rate to define the relationship between the actual work done by an 

employee and the fictional, average work done. 

You take efficiency rates into account in scheduling, capacity planning and costing. 

You use the efficiency rate to correct standard values in the operation according to the work which you 

actually expect to be done. 

You can use the efficiency rate key to 

- combine the same values for the efficiency at several work centers -

 maintain various values for the efficiency rate depending on the date 

- if necessary, maintain different efficiency rates for scheduling and for 

costing. 

Example 

If a group of employees has an efficiency rate of 150% then the system calculates that this group can 

perform a job, which an average group would require an hour (100%) to do, in 0.66 hours (150%). 

Further notes 

The value of an efficiency rate is usually greater than 100%. 

Activities 

1. Define the efficiency rate key. 

2. Define the temporal validity of the efficiency rate key. 

26.6.2.5.8 Define Scheduling Margin Key 

In this menu option, you specify time floats for order scheduling as well as the release period for order 

release. 
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The following floats are defined: 

- float before production 

This is the time between the order start date and the scheduled start date. 

- float after production 

This is the time between the order finish date and the scheduled finish date. 

The release date is calculated by adding the release period. The order release is carried out on this date. 

Via the release period key you can specify the following for each material: 

float before production float 

after production 

- release period 

Note 

The following parameters are always defined in days: 

- float before production 

- float after production 

- release period 

Actions 

Define the release period key for the material. 

26.6.2.5.9 Define Move Time Matrix 

In this menu option you define the location group and the move time matrix. In the move time 

matrix you can maintain the planned values for the move time within a location group as well as 

between two location groups. 

For each entry you can maintain a minimum and a normal move time. In the case of a 

reduction scheduling is carried out with the minimum move time. 

Requirements 

You can only calculate a move time using the move time matrix if both the source and the target 

work centers are assigned to a location group and the location groups are defined in the move 

time matrix. 

Recommendation 

So that the matrix does not become too large you should combine the work centers that are 

near one another in one location group. 
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Aktions 

1. Define your location groups. 

2. Maintain the matrix for the move time. 

26.6.2.5.10 Define Reduction Strategies 

In this step, you specify the reduction strategy to be used when the reduction measures are carried out on 

operations. Scheduling reduces the lead_time automatically if the basic dates given are not adhered to, 

that is if the scheduled dates lie outside the basic dates. 

In this work step, you also define the reduction levels. The reduction takes place level by level no further 

than the level that you have specified in the control parameters. 

You can specify a reduction strategy in every operation. 

- Reduction strategies 

You use the reduction strategies to determine how the operation lead time can be reduced step by 

step. You can enter a reduction strategy in every operation. 

- Reduction levels 

You can define up to six reduction levels for each reduction strategy. For every reduction level you 

can enter what is to be reduced and by how much. 

The SAP system carried out reduction step by step no further than the reduction level specified in the 

scheduling parameters. 

Note 

The order/network is rescheduled after every reduction level. To improve performance we recommend 

that you keep the number of reduction steps to a minimum. 

Standard settings 

The reduction levels are predefined in the SAP standard package. 

Activities 

1. You should define the reduction strategies. 

2. You should define the reduction levels for all the reduction strategies. 
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26.6.2.6 Capacity Requirements Planning 

In this section, you store data that is used to calculate the capacity requirements and the available 

capacity of work centers. 

Note 

You should define capacity data even if you do not use the capacity planning function, sicne in certain 

cases you the data is needed for scheduling. 

26.6.2.6.1 Define Capacity Category 

You can assign several capacities of different capacity categories to a work center. 
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Capacity categories can be, for example: 

- Machine 

- Personnel 

- Setup personnel 

- Emissions 

You have to define the availability for every capacity of the work center (for example, work start, work 

finish, calendar, etc.). You can create these values as default values for each plant and capacity category. 

Actions 

1. Define the possible capacity categories. 

2. Define the default values for the capacity categories. 

26.6.2.6.2 Determine Capacity Planner 

In this menu option, you determine the person/group of people responsible for planning capacities. 

Actions 

Determine the capacity planners. 

26.6.2.6.3 Define Shift Sequence 

In this step you define the following: 

- Grouping 

Using the grouping you can create shift sequences and shift definitions for special areas (for 

example, different plants or different areas of a plant) and when maintaining the available capacity 

choose from between work centers. 

- Work break schedule 

Here you define parameters that describe the individual work break schedules in more detail, as for 

example: 

- Start 

- Finish 

- Break times 

- Shift definition 
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Here you define the parameters common to several work centers that describe the individual shifts 

in more detail, for example: 

- Start 

- Finish 

- Break times 

- Validity period of a shift 

In Logistics (LO) you can reference daily work schedules from the personnel system (HR). If you 

reference a daily work schedule in LO from HR and this is changed in HR then this change has a 

direct effect on changes in LO. 

- Shift sequences 

You can assign the shift sequence of a capacity category as the available capacity at the work 

center. 

You define a sequence of shifts per weekday. The shift sequence represents a collection of shift 

definitions. 

In capacity planning the system uses the predefined values from the shift definition to 

determine the available capacity of a work center. The system calculates the following 

values: 

- the capacity 

- the actual operating time for the capacity 

Standard settings 

The SAP standard package contains settings for various shift sequences. 

Activities 

You should define the following: 

1. groupings 

2. shift sequences 

3. shift definitions 

4. work break schedules 

26.6.2.6.4 Define Formula Parameters 

In this menu option, you define the formula parameters by specifying standard values for work center 

maintenance. 

You can assign any function to these standard values. The most common standard values are 
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setup time or machine time per unit. Under certain circumstances you need to specify further standard 

values, such as labor time or cleaning time, for planning purposes. 

Complex production processes may also require further planning options, such as the calculation of 

energy requirements or spatial requirements. 

You also need formula parameters for formula definitions. 

Note 

Please note that the meaning of the fields for work center usage and task list usage is determined by the 

key words. 

Recommendation 

You should select easily identifiable ID codes if you want to enter the formula parameters into the 

formula definition at a later point in time. 

Actions 

1. Set up the formula parameters. 

2. Check the summary of the formula parameters for the standard value keys. 

3. Check the usage of the formula parameters in the formula definitions. 

26.6.2.7 Change Management for Production Orders (OCM) 

In this section you maintain the profile for change management for production orders (OCM). 

26.6.2.7.1 Define Overall Change Profile 

In this step you define overall change profiles that are used to control change management for production 

orders (OCM). 

In an overall change profile change profiles are combined that are valid for the following change 

processes: 

- Sales order change 

- Master data change 

- Assembly order change 

Activities 

1. Define the overall change profiles to control change management for production orders. 

2. Assign change profiles to change processes. These change profiles must already have been defined. 
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3. Assign the overall change profiles to the materials (tab page work scheduling in material master) 

that are to be part of change management. 

26.6.2.7.2 Define Change Profile 

In this step you define change profiles that are used to control order change management for production 

orders (OCM). Change profiles are assigned to the individual change processes when defining overall 

change profiles. 

The parameters of the change profile are subdivided as follows: 

- General 

You can specify that: 

- changes are also automatically copied to the order if a warning has occurred during the check. 

In this case the changed objects in the order are marked. 

- objects added manually are not deleted by automatic change steps 

- individual change steps can be carried out even if there are change steps that cannot be carried 

out automatically because of a conflict. This setting is only effective for networks and 

assembly orders. 

- Handling conflict situations 

You can specify whether particular actions in change management represent a conflict depending 

on the processing state of the order or the objects involved. The objects, actions and conflicts 

involved are: 

- Objects 

Operations, suboperations, components, directly-produced components, production 

resources/tools 

- Actions 

Change, delete, create, reassign 

- Level of conflict 

No conflict, information, warning, error 

For each object and action there are various situations for which you can specify which level of 

conflict should apply. The following are examples of possible settings: 

- change a released operation: Information 

- delete a released operation: warning 

- delete a partially-released operation: Error 
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For directly produced components, you can specify whether multi-level changes in the 

collective order are allowed. 

Activities 

1. Define change profiles to control change management for production orders. 

2. Assign these change profiles to the individual change processes when defining the overall change 

profiles: sales order change, master data change, assembly order change. 

26.6.2.8 Confirmation 

In this section, you create settings for completion confirmations. You can confirm all operations and sub-

operations in production orders which, according to their control key, require or allow confirmation. 

26.6.2.8.1 Define Confirmation Parameters 

Use 

In this IMG activity, you define the confirmation parameters per plant and order type. The parameters are 

distributed among tab pages as described in the following. 

General Settings 

- Control 

- The properties of the control key process control are defined at another point in Customizing 

(invocation also with the symbol next to the control key). It controls the execution of the 

confirmation processes. 

- You can specify how the quantities are to be determined in the case of automatically generated 

confirmations (milestone/progress confirmation). 

- Checks 

Via the checks you can specify: 

- What is to happen if the sequence of operations is not adhered to in the confirmation, or 

- What is to happen if you want to confirm a larger quantity than was confirmed for the 

previous operation 

You can choose between a termination message, an error message, a warning message, and an 

information message 

- Whether the total confirmed quantity of an operation is to be checked against an under- or 

overdelivery tolerance in the order header. 
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Which influence a QM results recording has on the confirmation. 

- Whether dates (such as the posting date, end of execution time, etc.) are allowed to be entered 

as dates lying further in the future than the time of entry. 

- HR update 

You can use the No HR Update indicator to activate the decoupling of HR and PP. 

- Selection 

You specify that only open orders are to be selected in the order network/collective order. 

- Propose time units 

You can choose a time unit that is to be proposed in the confirmation. 

- Goods movements 

You can use the All Components indicator to specify that all components assigned to the operation 

(i.e. not only backflush components) are to be displayed in the overview of goods movements. 

However, if you do not branch to the material overview in the confirmation, only the backflush 

components will continue to be withdrawn. 

Individual Entry General 

- Confirmation function 

Here you can specify whether in the case of a confirmation the system is to propose a partial 

confirmation, final confirmation, or a final confirmation with clearance of open reservations. 

- Error handling/logs 

- You can use the Actual Costs indicator to specify that the log is also to be displayed if no 

error messages exist (i.e. if just warning or information messages exist). 

- You can use the Error Handling indicator to specify that an error log is to be displayed in the 

case of faulty items of goods movements (for backflushing or automatic goods receipts). This 

gives you another chance to correct these items using the material overview. 

- Shift 

In the Proposal field, you can specify whether the Shift field is to be shown in the confirmation, 

whether a shift is to be proposed there and, if so, how the system is to determine the shift to be 

proposed. See also Define Proposal for Shift 

- Customer-specific fields 

You can integrate customer-specific fields in certain confirmation transactions. In this workstep, 

you can specify whether or not these fields are to be shown in the operation confirmation and in the 

order header confirmation. See also: Define Customer-Specific Fields 

- Subdivision of quantities 

You can subdivide the Yield, Scrap, and Rework fields into further fields in order to be able to 

enter and evaluate certain specific quantities. Thus, for example, you can subdivide the Scrap field 

into several scrap fields (e.g. scrap due to bent parts, scrap due to scratched parts etc.). To do so, 

proceed as follows: 
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- In the workstep Define Quantity Layout, enter the new quantity fields. 

In the workstep Assign Quantity Layout, assign the previously defined quantity layout to a 

plant and an ID. If you make no assignment, the system uses the standard layout. In the 

standard layout, the fields Yield, Scrap and Rework are displayed. 

See also: Define and Assign Quantity Layout 

- Notification type 

If the system is to automatically generate a quality notification at the time of confirmation, you must 

specify a notification type for Quality Management. In addition, you must make the following 

settings for the quantity types for which a quality notificaiton is then to be generated in the workstep 

Define Quantity Layout: 

- Code group 

- Code 

- Number of Defects 

- Reason 

With these settings, you satisfy the preconditions for the system to generate a quality notification in 

the background in the case of the following confirmation transactions: 

- Time Ticket (Single-Screen Entry) CO11N/COR6N 

- Confirmation of Production/Process Order (Order Header) CO15/CORK 

In the administrative data of the display and cancellation transactions for the confirmation, you can 

display the quality notification that the system automatically created at the time of confirmation. 

Double-click on the number of the quality notification to display the latter. This is possible in the 

following transactions: 

- Display Confirmation CO14/CORT 

- Cancel Confirmation CO13/CORS 

Individual Entry Operation Initial Screen 

- Propose data to be confirmed 

You can have the still-open confirmation data proposed for entry. In the case of the quantities and 

activities, the SAP system then proposes the difference between the standard and already confirmed 

values. Otherwise the standard values are proposed as confirmation data in each case. 

- Display confirmed data/Display standard values 

For information purposes, you can display both the already confirmed data and the standard values. 

- Screen control time ticket 

If you do not choose an entry screen on the initial screen, you can invoke the following alternative 

entry screens through parameterization: 
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- Screen with the most important actual data without display of already confirmed values and 

standard values 

- Screen with quantities and activities and display of already confirmed values and standard 

values 

Screen with quantities and activities, forecast standard values, and a display of the already 

confirmed values and standard values 

Selection 

You specify that confirmable/confirmed operations are selected when the confirmation processes are 

carried out. 

Activities 

Define the parameter settings for the confirmations in your plant for the possible order types. 

Further tips 

You will find information on the validity of the IMG activities in relation to the transactions for entering 

confirmations under Validity of IMG Activities for Confirmation. 

26.6.2.8.2 Confirmation Parameters for Collective Confirmation/Fast Entry 

In this work step you determine for each confirmation type and category, 

- how quantities are to be proposed 

- how activities are to be proposed 

- whether confirmations are identified by the order number or the confirmation number 

Activities 

Define the parameter settings for collective confirmation, fast entry or confirmation from the order 

information system. 
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Further notes 

For information about the validity of IMG activities relating to the transaction for confirmation entry, 

refer to Validity of IMG Activities for Confirmation . 
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26.6.2.8.3 Single Screen Entry 

In this section you maintain the profile and texts for single screen entry of confirmations and reprocessing 

of confirmations. 

26.6.2.8.3.1 Define Single Screen Entry 

In this step you define the confirmation profile for single-screen entry of time ticket confirmations 

and also for postprocessing time ticket confirmations containing errors. 

You can define the layout of the entry screen. When you do this, you define which input and output fields 

are displayed and in which order. These definitions are saved in profiles. A profile is assigned to an 

individual user in the user parameter CORUPROF. 

Postprocessing 

The postprocessing indicator defines whether the profile is to be used for single screen entry or for the 

postprocessing of time ticket confirmations with errors. Under a profile name, there can be one definition 

for each application case. 

Standard profile 

With the 'Standard prof. indicator, you can define that the profile is to be used as the standard profile. 

Only one profile each can be defined as the standard profile for single-screen entry and the 

postprocessing of time ticket confirmations with errors. The standard profile is then used if no profile has 

been assigned to the user in the user parameter CORUPROF or if the profile that has been assigned does 

not exist. 

Area selection 

In the header area you can define which data is to identify the operation or phase to be confirmed. Here, 

for example, you can define whether only the confirmation number and/or order, sequence and 

operation/phase can be entered. 

In the detail areas, you define which information can be entered for the operation/phase to be confirmed 

and in which order the fields in question are displayed. You can select up to seven detail areas, each 

containing one group of possible entry fields. Note that every input and output field can only be outputted 

once. When you save, the system automatically checks whether this rule has been adhered to. To carry 

out this check beforehand, choose the pushbutton Check area selection. 

Titles can be assigned to the detail areas, which are reproduced on the pushbuttons above the 

corresponding area. You can use these pushbuttons to open and close the areas. This means that the 

number of fields on the screen can be kept to a minimum. With the Closed indicator you define that the 

area is to be closed when the function is first called up. 

You can display a preview of the individual area and also of the entire entry screen. To do this, 

choose the corresponding pushbutton (Header area preview, Detail area preview, List screen 

preview) Defaults 

- Confirmation function 
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You define whether a partial confirmation, final confirmation or a final confirmation with posting of 

open reservations is to be proposed. 

- Default value 

You can define the time of default determination for quantities and/or activities: 

- no proposal 

- immediate proposal 

- proposal when saving 

For default determination 

- the quantity that is still to be confirmed is calculated 

- the activities are calculated in proportion to the quantities 

- Shift 

You can stipulate how the system is to proceed to determine the shift to be proposed. 

- Subdivision of quantities 

In this area you define which quantity layout the system is to show at the time of confirmation. The 

quantity layout enables you to subdivide the quantity fields Yield, Scrap, and Rework into further 

fields to enter and evaluate certain quantities on a targeted basis. Thus, you can subdivide the 

Scrap field into several scrap fields such as scrap due to bent parts, scrap due to scratched parts, 

etc. 

- Customer-specific fields 

In the Show field, you can specify whether the system is generally always to show the part of the 

screen with customer-specific fields in the time ticked (single-screen entry CO11N and COR6N), 

or in the case of certain order types only. 

- Activities/forecast 

For both the activities and forecast values, you can define 6 texts that are displayed during 

confirmation entry. These texts are overwritten with the texts from the standard value key in the 

work center/resource after you have chosen ENTER. If you want to prevent this from happening, set 

the indicator Fix text. You can hide activities or forecast values for which you do not want to enter 

a confirmation by setting the indicator Hidden. 

Maintain language-dependent texts 

The texts entered for the pushbuttons in the detail areas, as well as for the activities and forecast values, 

are saved in the logon language. If you want to process the texts in several languages, use the IMG 

activity "Maintain Language-Dependent Texts". 

Profile assignment 

The confirmation profile assigned to a user depends on the application and the CORUPROF parameter 

entry in the user parameters: 

- Single screen entry 

The profile that matches the CORUPROF parameter entry, and in which the Postprocessing 

indicator has not been set, is used. 
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- Postprocessing 

The profile that matches the CORUPROF parameter entry, and in which which the Postprocessing 

indicator has been set, is used. 

If the user has not been assigned a confirmation profile in the CORUPROF user parameter or the assigned 

profile does not exist, then the standard profile for the application (single screen entry, postprocessing) is 

used. If there is no standard profile, a firmly defined user interface is presented. 

Activities 

1. Define the confirmation profile. 

2. Display the preview of each profile and check the profiles. 

3. Enter the texts for the profile in other languages, if necessary (IMG activity Maintain Language-

Dependent Texts). 

4. In the user parameter CORUPROF, assign confirmation profiles to the individual users. 

Further notes 

For the detail areas, there are also 3 screens available whose layout you can define yourself. The 

definitions required for this are made via the user exit CONFPP07. 

For information about the validity of the IMG activities relating to transactions for entering 

confirmations, refer to: Validity of IMG Activities for Confirmation. 

26.6.2.8.3.2 Maintain Language-Dependent Texts 

In this step, you can maintain the texts in the profile for single screen entry of confirmations in several 

languages: 

- Push button text in the header area 

- Push button texts in the detail areas 

- Activity texts 

- Forecast texts 

Activities 

Maintain the confirmation profile texts in the languages required. 

Further notes 
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For information about the validity of IMG activities relating to the transactions for confirmation entry, 

refer to Validity of the IMG Activities for Confirmation. 

26.6.2.8.4 Define Time for Confirmation Processes 

Use 

In this IMG activity you define parameters that specify when confirmation processes run. You must 

specify the order category for the key (10 PP production order, 20 network, 30 maintenance order, 40 

process order). 

You can specify the execution time for the following confirmation processes: 

- automatic goods receipt 

- backflushing 

- determination of actual costs 

The following execution times are available: 

- at once online 

- at once as an update 

- later in the background 

Standard settings 

In the standard settings there are no control profiles. That means that all confirmation processes run 

online. 

Use this function when you want to improve performance in the area of confirmations. 

Activities 

1. Create a key to control the confirmation process. 

2. Assign this key to the desired order type by entering it in the Process control field under Define 

control parameters for confirmations. 

3. Make sure that the Parallelization type is defined under Parallelized confirmation processes for 

the processes that you want to parallelize. 

4. Plan the background job for confirmation processes under Plan background job for confirmation 

processes (program CORUPROC). You can create variants for the individual confirmation 

processes. 

Further notes 
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For more information about the validity of IMG activities relating to the transactions for confirmation 

entry, refer to Validity of IMG Activities for Confirmation . 

26.6.2.8.5 Define Paralleling Type for Confirmation Processes 

In this step you define how confirmation processes are parallelized. You must carry out this step to 

activate parallelization. 

You identify the individual confirmation processes using: - a confirmation 

process (goods movements, actual cost determination) You make the following 

specifications on parallelization: 

- Maximum number of work processes 

- Name of a logon/server group 

- Maximum number of items in material document (only for confirmation procedure goods 

movements) 

Activities 

1. Ascertain for which confirmation processes you must define the parallelization type. 

2. Identify the confirmation processes. 

3. Define the type of parallelization. 

4. 

Further notes 

For information about the validity of IMG activities relating to the transactions for confirmation entry, 

refer to Validity of IMG Activities for Confirmation. 

26.6.2.8.6 Define Reasons for Variances 

In this menu option, you define the causes of variances. You thus define the reasons that can be given if a 

variance occurs, in order to document this variance. 

Example 

Variances might be: 

- scrap on a quantity basis 

- excess consumption of activities 

- longer execution time - other resource, etc. 
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Actions 

Define the possible causes of variances that could occur in your company. 

26.6.2.8.7 Define Field Selection for Confirmation 

In this step, you can make a field selection for the confirmation screens. 

All screens for which you can make a field selection are combined into individual screen groups.  For 

example, all the detail screens for confirmation of a process order. 

Modifiable and influencing fields are defined for each screen group: 

- Using indicators, you can define how the individual modifiable fields are displayed in the 

screen: 

- The field is ready for input (standard setting) 

- The field requires an entry (required entry) 

- The field is only displayed 

- The filed is hidden 

- The field is highlighted 

If, for example, you define in the order that the resource is a required entry for the list and detail 

screens, you have to maintain the resource for all confirmations. 

- For the influencing fields, you define how the modifiable field is shown on the screen 

dependent on a value.  For example, that the resource is a required entry for a particular order 

type. 

Notes 

The field selection settings can be transported and are retained at releases and upgrades. 

If a modifiable field becomes a required entry due to a change made to an influencing field, the system 

does not check whether this field is filled in all existing objects. 

Standard settings 

No standard settings are delivered for the field selection. 

The modifiable and influencing fields are defined for each screen group and cannot be extended. 

Proceed as follows to define field selection: 

There are several ways of defining field selection. 

You maintain the indicator of the modifiable fields, independently of an influencing value 

1. Place the cursor on a screen group. 
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2. Select the function key Modifiable. 

The system displays all the fields that you can modify for this screen group. 

3. Maintain the indicators and save your entries. 

You maintain an influencing value for an influencing field.  You then maintain the indicators for 

the modifiable fields. 

1. Place the cursor on a screen group. 

2. Select the function key influencing. 

The system displays all the fields for which you can maintain influencing values. 

3. Double-click to select the influencing field for which you want to maintain a value. The system 

displays all the fields that can be modified for the influencing value. 

4. Maintain a value in the field Influencing val. and the respective indicators for the modifiable fields. 

5. Press Enter. 

Your entries are accepted by the system. 

6. Maintain further values for the influencing field or select further fields using the function key 

Influencing. 

7. Save your entries. 

You maintain an indicator for a modifiable field and define the values of the influencing fields. 

1. Place your cursor on a screen group. 

2. Select the function key Modifiable. 

The system displays all the fields that you can modify for this screen group. 

3. Double-click to select a modifiable field for which you want to maintain influencing values. The 

system displays all the influencing fields. 

4. Place the cursor on an influencing field for which you want to store a value and select New values. 

The system displays a pop-up. 

5. Maintain the value and indicator for the influencing field and press Continue. Your entries are 

accepted by the system. 

6. Save your entries. 

Activities 

1. Define the screen group for which you want to modify fields. 

2. Maintain the indicators for the modifiable fields and the values for the influencing fields. 

3. Transport your settings if necessary.  Select Field selection -> Transport. 

26.6.2.8.8 Define List Layout 

In this step, you specify the layout of individual lines for the following overviews: 

- "Operation overview" for data entry 
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- "Summary confirmation" for data entry 

Overview of the sub-operations of an operation -

 "Confirmation overview" for canceling and displaying data The 

following line categories are possible for these overviews: 

- header line 

- operation line 

- sub-operation line 

- confirmation line 

In each case the individual lines are edited in a separate FORM routine which you can set in this menu 

option. Any display data is transferred by memory so that you can also store the FORM routine in an 

external report. 

Observe the following restrictions to support the help function and the possible entries function: 

- You must define every line category in a separate FORM routine. 

- You can use a maximum of two lines of data for each line category. 

- The layout of every line must be defined using the Data Dictionary with the help of the language 

element "INCLUDE STRUCTURE". 

- You must use the first "INCLUDE STRUCTURE" specification in the FORM routine to describe 

the first display line. 

Actions 

1. Define the layout of the individual line categories. 

2. Define the structure in a FORM routine of an ABAP/4 program. 

3. Enter the FORM routine and the program name in the table. 

26.6.2.8.9 PDC Data Transfer 

In this section, you set up the PDC data transfer. 

26.6.2.8.9.1 Define Communication Parameters 

In this workstep, you define the following parameters for the communication channel: 

- which of the data that can be transferred will actually be transferred 

- whether the confirmations received are to be updated immediately 

- to which user the system is to send an express mail if an error occurs 

In addition, you get information on the dates when the following actions were carried out last: 
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- initial download 

- delta download 

- upload request 

- upload 

- update 

Note 

The definitions you make here are also taken for the background jobs to be scheduled. 

Requirements 

1. Define groupings for subsystems 

2. Define subsystem configuration 

3. Transfer configuration data to the subsystem 

26.6.2.8.9.2 Schedule Background Jobs for PP-PDC 

In this step, you schedule the background jobs for transferring the data required for plant data collection.  

You need to make the following settings: 

- Initial screen: 

- any job name 

- if required, target computer on which the job should run 

- Start date: when the job should be started and whether it should be carried out periodically, for 

example, in the case of delta download. 

- Steps: No entries since the ABAP/4 program to be started is already entered on the corresponding 

screen.  You only need to save the entry. 

Standard settings 

The background jobs are already defined by SAP, however, they are not yet scheduled. 

Activities 

Schedule the desired background jobs. 

Further notes 

You will find general information on how to define and schedule background jobs in extended help. 
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26.6.2.8.10 Fast Entry of Characteristics in the Confirmation 

26.6.2.8.10.1 Define Application Group for Characteristic Display 

Use 

In this IMG activity, you can define application groups for transactions. 

You can use application groups to define which characteristic displays are available for the fast entry of 

characteristics in the individual transactions. 

Note 

If you do not make any settings in this IMG activity, all characteristic displays are available for selection 

in the transactions that have characteristics fast entry. 

Activities 

1. Choose the New Entries button. 

2. In the Transact field, select a transaction and in the ApplGroup enter an application group. You can 

assign the same application group to several transactions in order to group together transactions. 

Note 

If you want all characteristic displays to be available in a transaction, enter '*' in the ApplGroup 

field. 

3. Assign this application group to a characteristic display in the IMG activity Define characteristic 

display for overview screen. 

Example 

In this IMG activity, you have assigned application group MM to the transactions Purchase order and 

Goods receipt. 

In the IMG activity Define characteristic display for overview screen (mySAP Mill Products), you 

assigned this application group to characteristic displays Steel_girder1, Iron_ore_pur and Pipe_single. 

In the purchase order transactions (ME21N, ME22N, ME23N) and the Goods Movement transaction 

(MIGO), these characteristic displays are then available: Steel_girder1, Iron_ore_pur and Pipe_single. 

26.6.2.8.10.2 Define Characteristics Display for Overview Screen 

Use 

In this IMG activity, you use characteristic displays to define which characteristics are available to you in 

characteristics fast entry. 
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You can also use the application group to define the transaction in which characteristics display is 

available for selection. You can use the characteristics displays defined here in the following transactions: 

- Sales documents (inquiry, quotation, order, scheduling agreement and contract) 

- Enjoy purchase order 

- Goods movements 

- Production order 

- Time ticket for production order 

- Trading Contract 

Note 

The characteristic displays are available not just for characteristics fast entry but also for the 

Configuration tab in the sales documents. 

Activities 

1. Enter a name and description for the characteristic display. 

2. If necessary, enter an application group for the characteristic display. You define application groups 

in the IMG activity Define application group for characteristic display. 

3. Select the characteristic display and choose Characterist assignment on the left of the screen. 

4. Enter the characteristics that you want to make available for fast entry with the help of this 

characteristic display. 

Here, you can define which characteristics are displayed, and in what sequence. 

26.6.2.8.11 Maintain confirmation parameters in the combination 

Setting the parameters for quantity distribution among the original orders in the case of the combined 

order being confirmed. 

Activities 

1. Selection of quantity distribution brought forward or quantity distribution put back. The two other 

parameters depend on this setting. Once you change the quantity distribution type, choose ENTER 

and then maintain the other two parameters. 

For quantity distribution brought forward, you can configure that the total quantity in the 

confirmation can be displayed or can be changed. 

For quantity distribution put back, you can also hide the quantity distribution. 
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2. Selection of whether the total quantity in the confirmation can be changed or not in the case of 

quantity distribution brought forward. 

3. Selection of whether quantity distribution is displayed or not in the case of quantity distribution put 

back. 

If quantity distribution is not displayed, the confirmed quantities for the original orders are 

automatically determined in accordance with the planned quantity. In the case of error, however, 

quantity distribution is displayed. 

Further notes 

Quantity distribution is required when the last process (or phase) requiring confirmation in the combined 

order is confimed. 

26.6.2.9 Define Print Control 

In this step you make the settings necessary for printing shop floor papers from the production order. 

Further information: 

- Description of the printing procedure 

- Recommendations for print control 

New shop floor papers 

If you want to use new shop floor papers you first have to design a new SAPscript or 

PDF-based form. 

Use a standard layout set as a reference (for example PSFC_STD_LAYOUT) 

- write a new print report 

Use as a reference a print program that belongs to the standard layout set (for example, 

PSFCCONF) 

Note 

The form and the print program must match, in other words, if you use a PDF-based form, you 

must also use a print program that supports the output of PDF. For an overview of forms and 

programs that can be used together, see the documentation for the data element SAPscript forms 

and PDF-based forms. 

Actions 

To define the print control, proceed as follows: 

1. Maintain the list names. 

2. Define the spool parameters for the user. 

3. Maintain the reference order types. 
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4. Maintain the layout sets and maintain the relevant parameters for them. 

5. Maintain the print programs for each list. 

6. Specify the transactions from which you can print and maintain the relevant parameters for them. 

(list control for transactions). 

7. Maintain the printer specification. 

8. Specify the spool parameters for the print procedure 

9. If necessary define the table accesses for the individual fields in the lists. 

26.6.2.10 Schedule Background Jobs 

You can schedule background jobs in this section. 

26.6.2.10.1 Create with Planned Orders 

In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program PPBICO40 

This program is used for converting planned orders to production orders. A log can be produced for the 

process by  outputting either a conversion log, which contains all information messages, or an error log, 

which contains only those planned orders that could not be converted and have error messages. Those 

planned orders that could not be converted are also placed in a batch input session and can be further 

processed with batch input tools. You can produce a session for each MRP planner. 

26.6.2.10.2 Process Print Flags 

In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program PPPRBTCH 

The program prints order papers in the background. You have previously, created a print job in the 

production order. You can use the plant as the selection criterion. 

26.6.2.10.3 Background Print 
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In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program PPPRBSEL 

The program prints order papers in the background. You have previously created a print job online. You 

can use various selection criteria to identify the orders. 

26.6.2.10.4 Process Requests for Mass Processing 

In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program COWORKDISPATCHNEW 

This program is used to mark functions from mass processing. Schedule a program variant by marking 

the functions to be processed. 

26.6.2.10.5 Determine Production Order Progress 

In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program PPORPCRE 

This program determines the progress values of production orders based on requests. Progress values are 

used in order progress to see whether orders are running to time. 

26.6.2.10.6 Confirmation: Componentized Processes (GR, GI, HR, Actuals) 

In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program CORUPROC 

This program executes marked processes for confirmations. 

You can select the following processes: 

- Automatic goods receipt 

- Backflushing 

- Determine actual costs 

The 'Transfer of confirmation data to the HR system' process is conducted undamentaly using markings. 

For further information, refer to the programn documentation 
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Display documentation 

26.6.2.10.7 Confirmation: Fast Entry Requests 

In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program CORUPROC1 

This program processes future change records from the fast entry of confirmations. 

26.6.2.10.8 Set Deletion Flag/Indicator 

In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program PPARCHP1 

(corresponds to CO 78 Select deletion flag/deletion indicator) 

This program is used to prepare the reorganization of production orders. The program set the deletion flag 

(after checking) and the deletion indicator. 

26.6.2.10.9 OCM: Initiating Object Processing 

In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program CO_OCM_OBJECT_LISTH 

With this program you can execute all the functions for processing initiating objects. 

26.6.2.10.10 OCM: Procurement Element Processing 

In this step you dispatch a program in a background job. For details of what you have to bear in mind 

look at the document Dispatching of background jobs. 

Program CO_OCM_ORDER_LIST 

With this program you can execute all the functions for processing procurement elements. 

26.6.3 Integration 
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In this section, you maintain the settings which are important for integrated order functions. 

This includes: 

- valuation during goods receipt 

- movement types for goods issue 

- functions of order costing 

- order settlement 

26.6.3.1 Process Integration 

26.6.3.1.1 Standard Settings 

26.6.3.1.1.1 Adopt Predefined Characteristics 

In this step, you transport the process instruction characteristics and process message characteristics 

predefined by SAP from the SAP reference client to your logon client. 

You need these characteristics 

- for the message categories predefined by SAP 

- to create your own message and process instruction categories 

The names of the characteristics predefined by SAP all start with PPPI_. You 

cannot change these characteristics in your logon client. 

Activities 

Transport the predefined characteristics from the SAP reference client (000) to your logon client. 

Notes 

- Characteristics are created at client level.  Once you have carried out this step,  the standard 

characteristics are available in all plants of your client. 

- When you import these characteristics, the system will issue a warning which informs you that this 

data is of type "A".  Ignore this message. 

Notes on transport 

Characteristics cannot be transported.  Therefore, you must carry out this step in your production system 

as well before transporting the other settings for process management from your Customizing system to 

your production system. 
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26.6.3.1.1.2 Adopt Predefined Message Categories 

Use 

In this step, you copy the process message categories supplied by SAP from internal tables as 

Customizing settings in your plants. 

You need these message categories for: 

- Integration with PP, MM, and QM 

- Status management in the case of orders and control recipes 

The message categories are adopted with all their assignments (assignment of characteristics, 

destinations, and destination-specific target fields). 

You can change the copied settings in your plant. 

In the event of renewed copying of the process messages, your changes are overwritten. Characteristic 

assignments that were added are not deleted, however. 

Prerequisites 

You must first adopt the characteristics for process management/process integration supplied by SAP in 

your plants. 

Aktivitäten 

1. Copy the process message categories to your plants. 

2. Specify the Customizing context. 

If you make no specification, the PP-PI message categories are copied. 

Note 

To use process messages in manufacturing, first adopt the standard settings for process messages 

(Customizing context: no specification) and then enter the Customizing context PP to adopt the 

process messages for production orders. 

Further notes 

The names of the predefined process message categories start with PI_. 

The names of the predefined manufacturing message categories start with PP_. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 536 

26.6.3.1.1.3 Adopt Predefined Display Variants 

In this IMG activity, you transport the display variants for PI sheets predefined by SAP from the SAP 

reference client to your logon client. 

Display variants specify how the overview table of the worklist for PI sheets is to be prepared on the 

screen. It contains, for example, information about the columns of the list and sort criteria. 

You can assign display variants to a selection variant by choosing the IMG activity Control Recipes/PI 

Sheets -> Define Selection Variants for PI Sheets. 

The names of the display variants that have been predefined by SAP start with 0PI_. 

Activities 

To transport the predefined diplay variants from the SAP reference client (000) to your logon 

client, proceed as follows: 

1. Choose activity Transport Predefined Display Variants for PI Sheets. The initial screen for 

layout management appears. 

2. Choose Environment -> Import display variant. A dialog box appears. 

3. Enter source client 000 and choose Continue. 

The system displays the list of all standard display variants that you can import from client 000. 

4. Select the display variants you want to transport. 

5. Choose Layout -> Import. 

Further notes 

Display variants are created at client level. This means that after you have performed this activity, the 

standard display variants are available in all plants of your client. 

26.6.3.1.2 Control Instructions/Work Instructions 

26.6.3.1.2.1 Digital Signatures 

26.6.3.1.2.1.1 Settings in User Maintenance 
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Use 

In this Customizing activity, you specify the data in the user master record of the person who is to 

execute the signature. You enter the full name of the user and their time zone. When a signature is 

executed, the system copies the signatory name together with the local time according to the signatory's 

personal time zone to the signed document. 

Note 

You must enter the user data in the productive system, that is, in each system in which the digital 

signature is to be available, as the settings in the user master cannot be transported. 

Caution 

Each user can maintain his or her address data and default values under System -> User Profile -> Own 

Data. This data includes the general user settings and the SFF settings for the user. If you are working 

with the digital signature, you should therefore not allow all users authorization to maintain their own 

data. 

Requirements 

Basic Information for Digital Signature 

Activities 

Specify the general user settings: 

1. To do this, either execute the Customizing activity or choose Tools -> Administration -> User 

Maintenance in the SAP Easy Access menu. 

2. Enter the user ID of the user whose data you want to maintain and choose Change. 

3. Choose the Address tab and enter the user's first and last name. 

4. Choose the Defaults tab and enter the user's personal time zone. 

5. Choose Save. 

6. If you want to use the user signature, you must also enter the SSF information in the user master 

for the user who is to execute a digital signature: 

a) Choose the Address tab of the user. 

b) Choose the Other Communication pushbutton and double-click the SSF entry to open the 

dialog box for maintaining SSF addresses. 

c) Enter the SSF information for the security product used. 

How the entries must be structured depends on the security product you are using. For more 

information, see the document Maintaining User SSF Information in the SAP NetWeaver 

documentation. 

d) Choose Copy and save your entries. 
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Use 

In a set of work instructions, signatures can be executed with which the processor signs of a workstep or 

confirm an input value that lies outside the predefined value range. 

Depending on the control instruction destination, you can stipulate different types of signature for this 

purpose. 

In order for you to be able to execute a digital signature you must make first make certain settings. 

The basis application component Secure Store and Forward (SSF) is used to realize digital signatures 

in the SAP System. This section tells you how to make the following settings: 

- SSF settings for the digital signature 

Which settings you make here depends on the signature method you use (see Specify 

Signature Method for Approval Using Simple Signature and Define Signature Strategies) 

- The complete names of the users that are supposed to execute the signatures as well as their personal 

time zones 

When a signature is executed, the system copies the signatory name together with the local 

time according to the signatory's personal time zone to the signed document. 

Caution 

All users can maintain their address data and defaults by choosing System -> User profile -> Own 

data. The general user settings along with the SSF settings for the user are part of this data. Therefore if 

you use digital signatures, do not assign the authorization to maintain own data to all users. 

Requirements 

If you use the user signature as your signature method, you need an external security product that islinked 

to your SAP System by way of SSF. 

Note that you should not store the users' Personal Security Environment (PSE) in a file system but rather, 

for example, on a smart card. The PSE software does not comply with legal requirements for digital 

signatures. 

Standard settings 

The SSF settings for the system signature are contained in the standard system. 

Activities 

SSF Settings for the User Signature 

1. Go to Customizing for Basis Components, choose System Administration -> Digital Signature 

and carry out activity  Application-Dependent Parameters for SSF Functions. 
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2. Enter the SSF information for the users that are supposed to execute digital signatures. If you want, 

you can also make the general user settings now (see below). 

a) Go to user maintenance. 

b) Enter the user ID of the user whose data you want to maintain and choose Change. 

c) Go to the Address tab page. 

d) Choose Other communication and double-click SSF (Secure Store & Forw.). 

e) Enter the user's SSF information. 

How the entries must be structured depends on the security product you use. 

f) Choose Continue and save your entries. 

SSF Settings for the System Signature 

Check and, if required, maintain the standard settings. To do so, go to Customizing for Basis 

Components, choose System Administration -> Digital Signature and carry out the following 

activities: 

- Application-Dependent Parameters for SSF Functions 

- SAPSECULIB Maintenance Information 

General User Settings 

1. Go to user maintenance. 

2. Enter the user ID of the user whose data you want to maintain and choose Change. 

3. Go to the Address tab page and enter the user's first and last names. 

4. Go to the Defaults tab page and enter the user's personal time zone. 

5. Save your entries. 

26.6.3.1.2.1.2 Specify Signature Method for Approval Using Simple 

Signature 

Use 

When processing a set of work instructions, you can use signatures to do the following: 

- Sign off a process step or the complete set of work instructions 
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- Sign off a variance to confirm an input value that lies outside the predefined value range 

If just one signature is necessary for sign-off, you define the signature method in this section. This 

signature method is valid for all control instruction destinations for which you have not assigned a 

signature strategy. 

In the case of control instruction destinations with a signature strategy, the signature method specified in 

the signature strategy applies. 

Recommendation 

If you use the user signature with an external security product, you always work with verification in the 

production system. In the case of signatures without verification, the validity of the user certificate is not 

checked. This signature method should therefore be used for test purposes only. 

Activities 

Assign the desired signature method to the following signature objects: 

- Work Instructions Process Step 

This signature object also applies to the completion/closure of the entire set of work instructions. 

- Work instructions Acceptance of Disallowed Input Values 

26.6.3.1.2.1.3 Signature Strategy 

26.6.3.1.2.1.3.1 Define Authorization Groups 

Use 

In this workstep, you define authorization groups for digital signatures. 

Using authorization groups, you can restrict authorization to execute digital signatures in work 

instructions as follows: 

- You define different authorization groups for users with different task areas. 
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- In the user master record, you give each user authorization for the authorization group 

corresponding to his or her task area. (authorization object C_SIGN_BGR). 

- You define individual signatures that have to be entered by users belonging to a certain 

authorization group and use thhem in the signature strategies for work instructions. 

The authorization groups are not taken into account in the case of control instruction destinations or work 

instructions: 

- For which you use signatures without passwords or signatures with simple password checks (see 

Types of Signature) 

- In which worksteps or values are signed off with an individual signature without a signagure 

strategy 

Example 

In your enterprise, disallowed input values must be signed off by the line operator and the person 

responsible for the shift. You make the following settings: 
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You define the authorization groups OPER (line operator) and RESP (person responsible for 

shift). 

- The line operations receive authorization for the group OPER; the persons responsible for the shifts 

receive authorization for the group RESP. 

- For work instructions, you define two individual signatures, the first being assigned the 

authorization group OPER and the second the authorization group RESP. 

Activities 

1. Determine which user groups/task areas you have to differentiate between in your enterprise. 

2. Define an authorization group for each user group. 

Further notes 

Authorization groups are valid in all areas in which digital signatures are used. Before changing existing 

authorization groups or using them for your purposes, you should thus ensure that no conflicts of interest 

with other areas arise. 

26.6.3.1.2.1.3.2 Define Individual Signatures 

Use 

In this workstep, you define digital individual signatures, that have to be executed by users belonging to a 

certain authorization group. 

You can then use the individual signatures as partial steps of a signature strategy that is executed in the 

work instructions when you sign off a workstep or confirm an input value outside the permissible value 

range. 

You need not define any individual signatures: 

- If you use signatures without a password or signatures with a simple password check in your control 

instruction destinations (see Types of Signature) 
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If you sign off worksteps or values in your control instruction destinations with an individual 

signature without a signature strategy. 

Example 

In your enterprise, disallowed input values must be signed off by the line operator and the person 

responsible for the shift. You define the following individual signatures: 

- S1 with the authorization group OPER 

- S2 with the authorization group RESP 

Requirements 

Define Authorization Groups 

Activities 

Define the individual signatures that have to be executed in the work instructions when a workstep or a 

disallowed input value is signed off. 

Further notes 

Individual signatures also apply in other areas in which digital signatures are used. Before changing 

existing individual signatures or using them for your purposes, you should thus ensure that there are no 

conflicts of interest with other areas. 

26.6.3.1.2.1.3.3 Define Signature Strategies 

Use 

In this workstep, you define signature strategies. In doing so, you make the following settings: 

- You group together individual signatures of different user groups to form a signature process. 

- You specify which signature method is used when the signature process is executed. 
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After this, you can specify at the following points which signature strategy is used in the work 

instructions when a workstep or disallowed input value is signed off: 

In the control instruction destination for all associated work instructions 

- In a process instruction if the strategy defined in the control instruction destination is not to be used 

You do not need a signature strategy: 

- If you are using signatures without passwords or signatures with simple passwords/SAP system 

passwords in your control instruction destinations (see Types of Signature) 

- If you sign off worksteps or values in your control instruction destinations with an individual 

signature without a signature strategy 

Requirements 

Define Individual Signatures 

Activities 

To create a new signature strategy, perform the following steps: 

1. Choose New Entries and enter the key, name, and signature method of the signature strategy. 

2. Assign Individual Signatures 

3. Define Signature Sequence 

4. Define Release Statuses 

Further notes 

Signature strategies are also valid in other areas in which digital signatures are used. Before changing 

existing signature strategies or using them for your purposes, you should thus ensure that no conflicts of 

interest with other areas arise. 
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26.6.3.1.2.2 Destination of Control Instructions 

26.6.3.1.2.2.1 Define RFC_Destination for Control Instructions 
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Use 

In this workstep, you define the remot function call (RFC) destination of the external systems that you 

want to use as control instruction destinations. 

The RFC destination must be defined for a TCP/IP connection. 

Activities 

Define the RFC destinations of the external systems to which you want to send the control instructions. 

26.6.3.1.2.2.2 Define and Set Up Control Instruction Destinations 

Use 

In this section, you make the necessary settings for the destination of the control instructions that you 

want to use in your plant. 

You can use the following control instruction destination categories: 

- Category 2 (download to ext. system initiated by SAP process coordinator). 

The control instruction destination is an external system. The transfer of control instructions to the 

external system is to be initiated by the SAP system. 

For the transfer of control instructions with XSteps to an external system, the Generation of 

XSteps Blocks indicator must have been set. (More information on the use of XSteps with the 

connection of external systems is available in the SAP Library under Production Planning 

Process Industries -> Process Management -> XSteps ). 

- Category 4 (transfer to browser-based PI sheet). 

The control recipe destination is a processor group for the work instructions that are outputted in 

HTML layout on the screen. 

You define the control instruction destinations with their addresses as well as the following additional 

information where appropriate: 

- Details re the type of signature to be used in work instructions (e.g. signature with password check 

or digital signature) 

- Data that influences system performance when work instructions are displayed 

- In the case of destinations whose control instructions are prepared as work instructions, you specify 

the actions in the work instructions for which a log is to be kept and whether a signature has to be 

executed during the logging of these actions. 

Requirements 

- If the control instruction destination is an external system you must define an RFC destination (see 

Define RFC Destination). 
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- In the following cases, you must define a signature strategy that you want to assign to the control 

instruction destination (see Define Signature Strategies): 

- If a signature strategy with one individual digital signature is to be necessary for signing purposes. 

- If a signature strategy with several individual digital signatures is to be necessary for signing 

purposes. 

Standard settings 

The standard SAP system supplied contains examples of control instruction destinations. 

Activities 

To create a new control instruction destination, proceed as follows: 

1. Choose New Entries. 

The detail screen for the control instruction destination appears. 

2. Enter the key, name, category, and address of the control instruction destination. 

3. If just one signature is necessary for signing purposes, you have the following options for control 

instruction destinations of category 4: 

- You set the Digital Signature indicator. 

This setting has the effect that the signature method entered in the individual signature 

automatically applies to all control instruction destinations to which not signature strategy has 

been applied. 

- You set the Digital Signature indicator and specify a signature strategy with one individual 

signature in the following cases: - For signing-off a workstep 

- For the confirmation of disallowed input values 

4. If several individual digital signatures are to be necessary for signing purposes, specify which 

signature strategy is to be used: 

- To sign off a workstep 

- To confirm disallowed input values 

If you want to use a different signature strategy for individual execution steps, you can assign them 

directly to the process instruction. 

5. If a log is to be created in the work instructions, specify in the section Logging in Work 

Instructions: 

- Which actions are to be recorded in the log 

- Whether a signature must be executed in the log 

- Which signature strategy is to be used in the case of logging with digital signature 

6. Save. 

(1) Types of signature: 
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The work instructions support the following types of signature: 

Digitale signature 

- If just one signature is necessary for signing purposes, you have the following options: 

- Individual signature with signature method 

If you set just the Digital Signature indicator, the signature method entered in the individual 

signature is automatically used for all control instruction destinations to which no signature 

strategy has been assigned. 

In the case of the individual signature, you assign the desired signature method to the 

following signature objects: 

- PI sheet process step 

- PI sheet acceptance of disallowed input values 

To make settings for the individual signature, in Customizing for Process Integration choose 

Control Instructions/Work Instructions -> Digital Signature -> Define Signature Method 

for Approval with Individual Signature. 

- Signature strategy with one individual signature 

Additionally assign a signature strategy with an individual signature to the control instruction 

destination or the process instruction (execution step). 

- If more than one signature is necessary for signing purposes, you have the following option: 

- Signature strategy with several individual signatures 

Additionally assign a signature strategy with several individual signatures to the control 

instruction destination or the process instruction (execution step). 

To make settings for the signature strategy, use the workstep Control Instructions/Work 

Instructions -> Digital Signature -> Signature Strategy in Customizing for Process Integration. 

You need the following authorizations to execute a signature: 

- In the authorization object of the work instructions: 

Authorization for the activity Execute Digital Signature and any activity defined in the process 

instruction. 

- In the authorization object of the digital signature: 

If you work with signature strategies, authorization for the authorization group of the relevant 

individual signature. 

You can enter a comment for the signature. In the case of signatures for disallowed input values, the 

comment is mandatory. 

26.6.3.1.2.3 Send Control Instructions/Recipes 

Use 

In this step, you define a background job for sending control instructions in your client. You must make 

the following settings: 

- Initial screen 

- Any job name 
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- Job class A or B 

- Where appropriate target computer in which the job is to be run 

- Start date/time of job 

- The job is to be started each time a new set of control instructions has been generated in your 

client: After event SAP_NEW_CONTROL_RECIPES 

Event parameter <client> 

Execute job periodically 

- The job is to be run periodically at certain time intervals: Date/Time option, whereby you 

define the time interval as a period value 

- Steps to be performed 

- The job should start the ABAP/4 program RCOCB006. 

Recommendation 

If the event occurs frequently at short time intervals, for performance reasons the job should be 

started on a time-dependent basis (start after "Date/Time"). 

Activities 

Define the background job for your client. 

26.6.3.1.2.4 Selection Variants for Work Instructions 

26.6.3.1.2.4.1 Define Selection Variants for Work Instructions 

Use 

In this section, you can define the selection variants for choosing work instructions. 

In doing so, you can proceed as follows: 

1. You define your selection variants. 

2. You assign one of the following display variants to your selection variants: 

- Standard display variants 

- Self-defined display variants 

You must previously have created display variants in the list overview of the worklist. 

When defining your own selection variants, you are advised to use the standard selection variants as 

copying templates. 

Selection variants predefined by SAP with the associated display variants are available for each of the 

following four transactions: 

Transaction Selection variant Display variant 

Find Work Instructions SAP&PI_SEARCH 0PI_SEARCH 
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Process Worklist SAP&PI_WL_WRK 0PI_WL_WRK 

Check Worklist SAP&PI_WL_CHK 0PI_WL_CHK 

Complete/Close Worklist SAP&PI_WL_CLS 0PI_WL_CLS 

For more information as to the criteria covered by the standard selection variants and standard display 

variants, refer to the SAP Library under Logistics -> Production Planning and Control -> Production 

Planning for Process Industries (PP-PI) -> PP - Production Planning  - Process Industries -> 

Process Management -> PI Sheets -> Worklist for PI Sheets. 

Activities 

To define a selection variant, proceed as follows: 

1. Choose the workstep Define Selection Variant for Work Instructions. 

The initial screen for the ABAP editor appears. 

2. Enter the program name RCOPOC_WKLT and choose Goto -> Variants. 

The initial screen for variant maintenance appears. 

3. Using the input help, choose the variant you want to copy. 

4. Choose Variants -> Copy... A dialog box appears. 

5. Enter a new name for the selection variant you want to create in the To Variant field and choose 

Continue. 

The standard selection variant has now been copied under the new name. 

6. Choose Change to define your selection criteria in the new variant. The selection screen for the PI 

sheet appears. 

7. Enter here the desired selection criteria. To see all selection fields, choose Edit -> All Selections. 

8. If you want to use the display variant entered in the selection variant, proceed with step 9. Otherwise 

specify a different display variant and proceed with step 9. 

9. Save your selection variant. 

Further notes 

You can also define selection variants directly in one of the above-mentioned four transactions. You can 

change existing selection variants in dialog mode at any time. The changes are effective immediately you 

restart the transaction. 
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26.6.3.1.2.4.2 Assign Selection Variant to User 

In this IMG activity, you can enter user parameters in your user master record. You can assign both your 

own or standard selection variants to a user parameter. As a result, the worklist that the system displays 

after you called the corresponding transaction is created: 

- Exactly according to the selection criteria specified in the selection variant 

- Exactly according to the list layout defined in the display variant 

If you do not assign a selection variant to a user parameter, the system first displays a selection screen 

after you have called the relevant transaction. This selection screen contains the selection criteria that 

have been predefined for the user parameter. You can change these criteria. The worklist only appears 

after you have chosen Execute. 

There are user parameters along with standard selection variants and standard display variants for the 

following transactions: 

 TransactionUser Parameter Standard Selection Variant Standard Display 
Variant 

 Worklist-maintain PI_VAR_WL_WRKSAP&PI_WL_WRK0PI_WL_WRK 

 Worklist-check PI_VAR_WL_CHK SAP&PI_WL_CHK 0PI_WL_CHK 

 Worklist-complete PI_VAR_WL_CLS SAP&PI_WL_CLS 0PI_WL_CLS 

Activities 

To assign user parameters and selection variants to your user master record, proceed as follows: 

1. Choose activity Assign Selection Variant to User. The initial screen for user maintenance 

appears. 

2. Enter your user and choose Change. User maintenance appears. 

3. Choose the Parameters tab page. 

4. Enter the user parameters in the Parameters column and, if required, the selection variant in the 

Value column. 

5. Save your entries. 

Further notes 

If you use standard selection variants, you can also enter a plant and an operating group in your user 

master record. If you do so, the system does not prompt you for the plant and operating group after you 
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have called the transaction but takes you directly to the worklist. The system automatically takes into 

account the plant and parameters assigned to your user master record. 

Use the following parameters for the plant and operating group: 

- The WRK parameter for the plant 

- The STADR parameter for the operating group 

26.6.3.1.3 Process Messages 

In the following section, you make all the system settings for process messages. 

26.6.3.1.3.1 Process Message Characteristics 

In the following sections, you make system settings for process message characteristics, and define the 

characteristics you want to use in your process messages. 

26.6.3.1.3.1.1 Define Characteristics Groups for Process Messages 

In this step, you define the characteristics groups in which you want to combine your message 

characteristics, and you release these groups for use in process messages.  Only characteristics contained 

in these groups can be assigned to process message categories. 

Standard settings 

The SAP system contains a characteristics group for the message characteristics defined by SAP. 

Recommendation 

Define your own characteristics groups for your message characteristics. 

Activities 

1. Check the existing characteristics groups and define new ones if necessary. 

2. Release the characteristics groups for use in process messages. 

Further notes 

The Customizing view in which you define your characteristics groups also contains all characteristics 

groups for other applications. 

26.6.3.1.3.1.2 Define Characteristics for Process Messages 
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In this IMG activity, you define the characteristics you want to use in your process messages. 

Standard settings 

The standard system contains process message characteristics for the process messages predefined by 

SAP. The names of these characteristics start with PPPI_. Note 

The characteristics for shop floor control also start with PPPI_. 

Activities 

Check the existing process message characteristics and define new ones to suit your requirements 

Notes on Characteristic Maintenance 

Basic Data tab 

- Here, you have to assign a characteristics group released for use in process messages. 

- Under Format, do not enter a unit of measure or a currency since this can cause errors in process 

messages during further processing. 

- In process messages, only single-value characteristics are supported. You cannot use characteristics 

with interval values. 

- You can flag a characteristic as mandatory independently of the process message. To do so, set the 

Entry Required indicator. 

Using the Proc. mgmt pushbutton on the Basic Data tab, you can call up a dialog box with the 

following settings: 

- Automatic value assignment section: 

Here you can specify that automatic assignment of a characteristic value is to be carried out in the 

process order, production order, control recipe, or control instructions provided that the 

characteristic value has not previously been assigned manually. 

This setting is important because message characteristics are generally also used in process 

instructions. 

The following types of automatic value assignment are available: 

- In the Value Assignment Function field, you can specify a function module that is to be used to 

determine the characteristic value. 

- If the characteristic value to be assigned is to be taken from the order, resource, or material, you can 

enter the corresponding table and its field in the Table and Field fields instead. 

- By setting the Only Automatic indicator, you determine that the characteristic value cannot be 

assigned manually in process instructions. This indicator is ignored when you manually create a 

process message. 

- Input help section: 

Here, you can make the following settings: 

- Input help and value check using a foreign key dependency that takes the dependencies between 

values of different characteristics into account. 
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- Input help using a matchcode 

Note the following: 

- For the system to be able to take your settings for the foreign key and matchcode into account, you 

must define function module COC1_PPPI_CHAR_VALUES on the Values tab for the value check. 

- You cannot add to the foreign key table. For information on the foreign keys available, refer to the 

input help, choose Display, and call up the foreign key for the corresponding reference field. 

Note: 

If you want more than just the foreign key to be taken into account when checking values, you can 

write your own function module that is similar to function module COC1_PPPI_CHAR_VALUES 

and assign it on the Values tab. Note that for the input help you need a function module with the 

same name and suffix _F4. You can use function module COC1_PPPI_CHAR_VALUES_F4 as a 

template for it. 

- In the Conversion field, you can specify a routine that is used to convert between the characteristic 

value displayed on the screen and its internal representation. This option is mainly required for 

characteristics predefined by SAP that refer to objects already defined in the system (for example, 

process orders). 

- By setting the Value is long text indicator, you determine that a long text is to be assigned to the 

characteristic in process instructions and in process messages. In this case, the formatting definitions 

on the Basic Data tab are ignored. 

CAUTION! 

Never use the Characteristic -> Rename... function for a characteristic that you have already 

assigned to a process instruction category or a message category. In process management, 

characteristics are identified by their name. Thus, when you rename a characteristic, all process 

messages and instructions containing this characteristic become invalid. 

Notes on Automatic Value Assignment 

The standard system contains a number of predefined function modules for the automatic assignment of 

characteristic values. For information on the individual function modules, proceed as follows: 

1. Call up the information system by choosing the Possible entries function on the Val.assignmnt 

funct. field, and choose Execute. 

The system displays a list of the existing function modules. 

2. Position the cursor on the function module whose documentation you want to display and choose 

Display. 

3. Choose Function module documentation. 

In addition to the predefined function modules, you can also call up your own function for assigning 

characteristic values via a function exit. This requires that: 

- You assign function module COAV_CUSTOMER_EXIT_001 to the characteristic for automatic 

value assignment 
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- You adjust function exit EXIT_SAPLCOAV_001 in the SAP enhancement SAPLCOAV 

For further information on maintaining the function exit, see Use Function Exit for Automatic 

Characteristic Value Assignment. 

Notes on Transport 

Characteristics cannot be transported using the Customizing transport function. 

The section Transport Predefined Characteristics describes how you can transport the characteristics 

defined by SAP to your clients. 

Using Application Link Enabling (ALE), you can transport characteristics you have created manually to 

your production system. 

You can very easily configure a distribution in your system using ALE. 

26.6.3.1.3.1.2.1 Use Function Exit for Automatic Char.Value Assignment 

To assign values to characteristics automatically, you can use the SAP enhancement 

SAPLCOAV. 

Activities 

1. Create the enhancement. 

To do this, either create a new enhancement project or use an existing one. 

2. Activate the project. 

Your enhancement is effective only after the project has been activated. 

Further notes 

Unlike modifications, enhancements are release-insensitive as they are not located in the SAP original but 

in a name range reserved for customers. 

For information on the general procedure for creating enhancements, choose Utilities -> Manual. 

Each enhancement is documented.  To access this documentation, use the Display SAP doc. 

pushbutton in the enhancement transaction. 

26.6.3.1.3.2 Process Message Destinations 

26.6.3.1.3.2.1 Define SAP Function Module 
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In this step, you define the function modules you want to use as destinations for process messages in 

order to process the messages for your own specific requirements. 

To enable process messages to be received and processed correctly by your function module, you must 

observe the following points: 

- Use the COCD function group as a template. It contains the sample function module 

COCD_MESSAGE_DEST_TEMPLATE and all necessary Includes. 

- The function module must not transmit any COMMIT WORK. This is executed via process 

management. 

- The function module must not execute a dialog. No dialog boxes, for example, may be called and no 

messages may be issued in the status line. 

Errors, warnings and information messages must be transferred instead via the internal SCOMP 

table (see sample function module). 

- The function module may not execute a CALL TRANSACTION. 

- It may not trigger terminations and exceptions. 

- The function module should be programmed so that it can be called several times over during a 

transaction. Only when all messages in the transaction have been processed does process 

management execute a COMMIT WORK. 

- Updates may only be carried out asynchronously as update1 (CALL FUNCTION ... IN UPDATE 

TASK). 

Example 

You can use the following function modules as samples: 

- The standard function modules listed below 

- The copying template COCD_MESSAGE_DEST_TEMPLATE 

Standard settings 

The standard system contains the following function modules in the function group COCI. These function 

modules are used as message destinations: 

Function module task 

COCI_CONFIRM_MATERIAL_PROD Posting of goods receipts 

COCI_CONFIRM_MATERIAL_CONS Posting of goods receipts 

COCI_CONFIRM_INSPECTION_CHAR Results confirmation for inspection 

characteristics (summary) 

COCI_CONFIRM_OPERATION Confirmation of time events for 

phases 

COCI_CONFIRM_ACTIVITY Confirmation of time events for 

variable services 
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COCI_CONFIRM_OPERATION_USER_ST Updating of user status for 

operation and phase 

COCI_CONFIRM_CONTROL_RECIPE Updating of control recipe status/ 

control instruction status 

COCI_CONFIRM_CNTRL_REC_TO_PO Updating of order status 

in accordance with control recipe 

status/ 

control instruction status 



 

 

 

 



 

 

 


